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Get Started
Welcome
This Help provides in-depth information on how to use the SignalVu™ Vector Signal Analysis Software.

Using the signal analysis engine of the RSA5100 and RSA6100 Series real-time signal analyzer, this vector signal analysis software helps
you move your analysis of acquisitions off the instrument.

Note: Some of the screen illustrations in this document are taken from the vector signal analysis software version that runs on the
RSA5100 Series Real-time Signal Analyzers. These instruments support additional hardware-based functionality and buttons that
are not present in the SignalVu™ or SignalVu-PC application.

Options
To view a listing of the optional application licenses (options) installed in your application, select Help > About Tektronix Real Time
Signal Analyzer.

Application licenses can be added to your software. For the latest information on available licenses, see the Tektronix Web site.

Available product documentation
In addition to this Help, the following documents are available. For the most up to date documentation, visit the Tektronix Web site
www.tektronix.com/manuals.

Product documents
• SignalVu Reference (Tektronix part number 077-0224-XX). This document provides a brief overview of the SignalVu software. It

identifies elements of the SignalVu screen, elements of different displays and includes a menu tree. The ReferenceManual is provided
as a printable PDF file.

• SignalVu Programmer Manual (077-0223-XX). This document provides supplementary information about the remote commands for
the SignalVu software. The Programmer Manual is provided as a printable PDF file. For detailed descriptions of the remote commands,
see the RSA6100 Series Real-Time Spectrum Analyzers, RSA5100 Series Real-Time Signal Analyzers Programmer Manual and
the MSO/DPO5000/B, DPO7000/C, DPO70000/B/C/D/DX/SX, DSA70000/B/C/D, and MSO70000/C/DX Series Digital Oscilloscopes
Programmer Manual.

• SignalVu Printable Help Document (077-0225-XX). A PDF file version of this Help can easily be printed.

The most recent versions of the product documentation, in PDF format, can be downloaded from www.Tek.com/manuals. You can find the
manuals by searching on the product name and selecting the Manuals filter.

Available demonstration guide and handbook
Available for download on www.Tek.com.

• 5GNR

There are two documents, 5G New Radio Demonstration Guide and 5GNR AWG Handbook.

In the 5G New Radio Demonstration guide, you will learn how to analyze Uplink and Downlink frames of 5G signal using the 5GNR
analysis plugin installed on SignalVu analysis software.

In the 5GNR AWG handbook, you will learn how to create 5GNR waveforms in uplink or downlink directions, single or multiple carriers
at the desired center frequency.
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Video tutorials
You can browse the Tektronix YouTube channel (www.youtube.com/user/tektronix) to find video tutorials about various topics related to
your product. You can also subscribe to the Tektronix YouTube channel to keep up with new postings.

Searching for topics
For example, you can watch a video tutorial about performing basic EMI testing with a spectrum analyzer, or how to use WLAN presets
and connect to an MDO4000C oscilloscope. To find a video on a topic, do the following. The following image shows you what the Tektronix
YouTube Channel looks like.

1. Click on the search icon located just above the video you see when the page first loads.

Note: This icon allows you to search the Tektronix YouTube channel specifically. The search icon located at the top of the
page allows you to search all of YouTube.

2. Type in the key phrase you are looking for in the search field. For example, “WLAN”.
3. Click the search icon to start the search.
4. Videos related to the topic will appear. Click a video to view it.

How to activate/de-activate the 5GNR analysis license
You can activate the 5GNR analysis license as follow:

1. Make sure that the SignalVu software is installed on the instrument and the 5GNR option is enabled.
2. Open the NI License Manager application in the instrument where SignalVu is installed.
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3. Note down the version number with NI-RFmx NR displayed in the left side panel. For example in the following picture, the NI-RFmx
NR version number is 20.0

4. Click Computer Information toolbar button. Note down the Computer ID.

5. Contact your local Tektronix Account Manager and share the NI-RFmx NR version number to get the activation codes for the 5GNR
analysis.

Note: An activation code consist 20 alphanumeric characters separated by a hyphen between every 4 characters. You will
receive two activation codes.

6. Disconnect the internet connection from the instrument.
7. Open the NI License Manager application in the instrument where SignalVu is installed.
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8. In the NI License Manager window, click Activate Software to view the activation window.

9. In the Activation Software window, select Enter activation codes in the drop-down list.
10. Enter the activation code in the textbox and click ACTIVATE button.
11. Follow the above step to activate the second activation code.
12. Make sure that the NI-RFmx NR and RFmx Analysis-Only Mode are marked as Licensed in the NI License Manager window to

confirm that the activation was successful.

13. Connect the internet connection to the instrument.
14. -

You can de-activate the 5GNR analysis license as follow:

1. Open the NI License Manager application in the laptop or equipment where SignalVu is installed.
2. In the NI License Manager window, click Local Licenses to see the list of installed licenses.
3. Locate the NI-RFmx NR entry and expand it. Right click NR Deployment item to open a context menu. Click Deactivate menu item to

deactivate the license.
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4. Locate the NI-RFmx Analysis-Only Mode entry and expand it. Right click Analysis-Only Mode (Multi-Vendor) item to open a context
menu. Click Deactivate menu item to deactivate the license.

Connecting Signals and Selecting the Analysis Channel
SignalVu analyzes signals acquired by the oscilloscope. The SignalVu software analyzes one, two, or four signals at a time, so you need to
specify which oscilloscope input channels to use. Math and Ref channels can also be selected.

To specify which oscilloscope channel is analyzed:

1. Select Settings > Acquire to display the Acquire control panel.
2. Select the desired signal type from the Signal Input drop-down list along the left side of the control panel. Available choices are RF

(uses one oscilloscope channel), IQ (uses two channels), and Diff IQ (uses four channels).
3. Use the Source drop-down list from the Vertical tab to select the channels to analyze.
4. Use the oscilloscope controls in the TekScope application to achieve a stable, triggered signal.

For information on the oscilloscope input signal capabilities and how to trigger on a signal, see the oscilloscope's Help. Note that SignalVu
does not control triggering on the oscilloscope; you will need to use the oscilloscope triggering functions to achieve a stable, triggered
signal on the oscilloscope.
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Front-panel controls
The front-panel controls remain dedicated to oscilloscope control functions when SignalVu is running. The front-panel buttons and knobs of
the oscilloscope do not have any effect on the SignalVu software settings.

One button that affects the SignalVu software is the Run/Stop button. Pressing the Stop button will halt data acquisition in the SignalVu
software.

Touch Screen Actions
You can use the touch screen to change marker settings and how waveforms are displayed by using the Touch-screen Actions menu.

To use the Touch-screen Actions menu, touch the display in a graph area and hold for one second, then remove your finger. You can also
use a mouse to display the Touch-screen Action menu by clicking the right mouse button.

Icon Menu Description

Select Selects markers and adjusts their position.

Span Zoom Zooms the graph area about the selected
point. Right-click in the graph display at
a point of interest and drag to increase
or decrease the span about the point
of interest. Span Zoom adjusts the span
control.

CF Pan Adjusts the Center Frequency according to
horizontal movement.

Table continued…
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Icon Menu Description

Zoom Adjusts horizontal and vertical scale of
the graph. The first direction with enough
movement becomes the primary scale of
adjustment. Adjustment in the secondary
direction does not occur until a threshold of
30 pixels of movement is crossed.

Dragging to the left or down zooms out and
displays a smaller waveform (increases the
scale value). Dragging to the right or up
zooms in and displays a larger waveform
(decreases the scale value).

Pan Adjusts horizontal and vertical position of the
waveform. The first direction with enough
movement becomes the primary direction
of movement. Movement in the secondary
direction does not occur until a threshold of
30 pixels of movement is crossed.

- Reset Scale Returns the horizontal and vertical scale and
position settings to their default values.

- Marker to peak Moves the selected marker to the highest
peak. If no marker is turned on, this control
automatically adds a marker.

- Next Peak Moves the selected marker to the next peak.
Choices are Next left, Next right, Next lower
(absolute), and Next higher (absolute).

- Add marker Defines a new marker located at the
horizontal center of the graph.

- Delete marker Removes the last added marker.

- All markers off Removes all markers.

Touch-Screen Menu for Spurious Display
The Touch-screen actions menu in the Spurious display has some minor changes compared to the standard version used in other displays.
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Icon Menu Description

- Single-range Changes the current multi-range display
to a single range display. The displayed
range is the range in which you display
the touchscreen-actions menu. Selecting
Single-range from the menu is equivalent
to selecting Single on the Settings >
Parameters tab.

- Multi-range Changes the current single-range display to
a multi-range display. Selecting Multi-range
from the menu is equivalent to selecting
Multi on the Settings > Parameters tab.

- Marker > Sel Spur Moves the selected marker to the selected
spur.

SignalVu Markers Menu
The SignalVu Markers menu appears when you right-click (or touch and hold) on a marker. The SignalVu Markers menu enables you
to assign a marker to a different trace, synchronize markers with oscilloscope, cursors and pan the trace to place the marker at the
measurement frequency.
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Icon Menu Description

- Pan to marker Adjusts horizontal position of the waveform
to locate the selected marker at the
measurement frequency.

- Assign to trace Assigns the selected marker to Trace 1,
Trace 2, Trace 3 or the Math trace. A trace
must be enabled to assign a marker to it.

- Sync scope C1 Synchronizes the position of oscilloscope
Cursor 1 with the location of the selected
marker. Turns on cursors if necessary.

- Sync scope C2 Synchronizes the position of oscilloscope
Cursor 2 with the location of the selected
marker. Turns on cursors if necessary.
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Elements of the Display
General application window areas. The main areas of the application window are shown in the following figure.

Specific elements of the application display window. Specific elements of the display are shown in the following figure. More detailed
information is available in the Main menu overview on page 544 section.
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Ref number Setting Description

1 Recall Displays the Open window in order to recall setup files, acquisition data files, or trace files.

2 Save Opens the Save As dialog in order to save setup files, pictures (screen captures),
acquisition data files, or export measurement settings.

3 Undo/Redo Undoes or redoes the previous edit to a display or measurement settings, a preset, or a
measurement change.

4 Displays Opens the Select Displays dialog box so that you can select measurement displays.

5 Settings Opens the Settings control panel for the selected display. Each display has its own control
panel.

6 Acquire Opens the Acquire control panel, which displays the Sample Rate and Record length of the
recalled waveform file.

7 Analysis Opens the Analysis control panel so that you can define the analysis settings such as
frequency, analysis time, and units.

Table continued…
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Ref number Setting Description

8 Amplitude Opens the Amplitude control panel so that you can define the Reference Level, configure
internal attenuation, and specify external gain/loss corrections.

9 GNSS/Antenna Opens the GNSS/Antenna control panel so that you can configure and activate an internal
or external GNSS receiver and antenna.

10 Favorite User Presets Click to select from a list of custom favorite User presets and load the selected preset. For
more detailed information, see the topic.

11 Preset Recalls the preset.

12 Replay Runs a new measurement cycle on the existing acquisition data record using any new
settings. See the topic for more details.

13 Run

and

Run/Stop toolbar

(Only available when
connected to an RSA306,
RSA306B, RSA500A series,
and RSA600A series,
RSA7100 series, or
MDO4000B/C.)

• Run menu and Run/Stop toolbar

Starts and stops data acquisitions and specifies the run conditions. For example, if
you select Single in the Run/Stop toolbar (or Run Single in the Run menu), a single
measurement cycle is run. If you select Continuous in the Run/Stop toolbar (or Run
Continuous in the Run menu), the data acquisition runs until stopped.

• Run menu

The Run menu also includes Resume and Abort.

Resume restarts data acquisition, but does not reset accumulated results, such as Average
or MaxHold. This allows you to stop acquisitions temporarily, then continue.

Abort immediately halts the current acquisition/measurement cycle. In-process
measurements and acquisitions are not allowed to complete.

See the topic for more details.

14 Reference Level Displays the reference level. To change the value, click the text and enter a number using a
keyboard, or use a mouse scroll wheel.

15 Center Frequency Displays the Center Frequency. To change the value, click the text and enter the frequency
with a keyboard. For fine adjustments, you can use the mouse wheel.

16 Main menu bar Contains access to menus. For detailed information, see the topic.

Table continued…

Get Started

SignalVu™ Vector Signal Analysis Software Printable Help 28



Ref number Setting Description

17 The Edit Favorites icon allows you access the below menu, which allows you to edit the
contents of the Favorites bar. For more information, see the topic.

Restoring Default Settings
To restore the software to its factory default settings:

1. Select Presets > Preset Options.
2. In the Presets tab of the Options control panel, click to the view the Preset type drop down menu and select Main.
3. Click to the view the Presets drop down menu and select Original.
4. Click the red X icon in the top right corner of the Options control panel to close the panel.
5. Select Presets > Main from the menu bar to return the software to its original factory default settings.

Note: You can also click the Preset button on the right-hand side of the menu bar to load the Main preset.

Presets
Main menu bar: Presets 

SignalVu includes a set of standard configurations that are tailored to specific applications or types of analysis. These configurations,
referred to as Presets, open selected displays and load settings that are optimized to address specific application requirements. You can
also make your own User presets to fit your application. Any User preset can be added to the Favorites bar, enabling one-button access to
your most used setups.

Preset Options
Select the Presets > Preset Options menu to open the Options control panel. Once you have chosen these settings, you can access any
preset or list of presets from Presets on the menu bar.
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• Preset type: Select the Preset type.
• Presets: Select the specific preset you want to display for the selected preset type.
• Preset action: Selecting a preset from the Preset drop down menu results in one of two actions depending on which item you choose

in the Preset action list: Recall selected preset will immediately execute a preset when it is selected from the Presets menu. Show
list will display a list of presets subtypes from which you can then select the preset you want to recall.

Available Presets
Select Presets from the menu bar to access the presets shown in the following table. Preset subtypes are managed in the Presets >
Preset Options on page 29 menu.

Preset Description
Main This Preset is the original factory preset used with your original

SignalVu software. This version of the factory preset is included
to allow you to maintain compatibility with existing remote control
software.

Standards
WLAN Measurements Overview on page 167 This preset sets the analyzer to display the WLAN Summary, WLAN

Constellation, and SEM displays. After you select the standards
and bandwidth, the software configures these displays to apply the
parameters appropriate for typical WLAN analysis tasks.

P25 Overview on page 276 This preset sets the analyzer to display the P25 MCPR, Summary,
P25 Constellation, and Time Overview displays. After you select
the standard and modulation type, the software configures these
displays to apply the parameters appropriate for typical P25
analysis tasks.

Bluetooth Analysis on page 381 This preset loads a set of Bluetooth displays and test setup to
perform Bluetooth SIG RF tests. The software configures these
displays to apply the parameters appropriate for Bluetooth analysis
tasks.

LTE Overview on page 311 This preset loads a set of LTE displays and a test setup,
frame structure, and channel bandwidth to perform LTE tests.
The software configures these displays to apply the parameters
appropriate for LTE analysis tasks.

5GNR Analysis This preset loads a set of 5GNR displays and a test setup,
frame structure, and channel bandwidth to perform 5GNR tests.
The software configures these displays to apply the parameters
appropriate for 5GNR analysis tasks.

Overview of 802.11ad and 802.11ay on page 197 This preset loads a set of standards (Control PHY and Single carrier
PHY) for 802.11ad and 802.11ay for offline analysis.

Application
Application Preset: Modulation Analysis on page 35 The Modulation Analysis setup application preset provides you with

the most common displays used during modulation analysis. Only
present when Option SVM is installed.

Table continued…
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Application Preset: Pulse Analysis on page 35 The Pulse Analysis application preset provides you with the most
common displays used during pulse analysis, and makes changes
to the default parameters to settings better optimized for pulsed
signal analysis. Only present when Option SVP is installed.

Application Preset: Time-Frequency Analysis on page 36 The Time-Frequency preset configures the analyzer with settings
suited to analyzing signal behavior over time.

Application Preset: Spectrum Analysis on page 36 The Spectrum Analysis application preset provide you with the
settings commonly used for general purpose spectrum analysis.

Application Preset: Spur Search Multi Zone 9k-1GHz on page 37 The Spur Search application preset sets the analyzer to display all
spurs that exceed the Threshold and Excursion values for the entire
9 kHz through 1 GHz range.

User (Favorites)
User Preset 1 This preset sets the analyzer to show these displays: Frequency

vs Time, Time Overview, Spectrogram, and Spectrum. Settings
commonly used for general purpose analysis are loaded.

User Preset 2 This preset sets the analyzer to show the Spurious display. Settings
commonly used for spur analysis are loaded.

Other user presets User presets you create and save will appear in the Preset drop
down menu of the User Presets window. Any User preset that you
have designated as a Favorite will be marked with an *.

Recalling a Preset

To recall a preset, select Presets and then the desired preset type.

Note: You can set which presets to recall from the Presets > Preset Options on page 29 control panel.

Note: You can also click the Preset button on the top right side of the menu bar to load the Main preset.

Configuring a User Preset
After you have selected a preset, adjust the span to show the necessary detail.

User (Favorites) Presets
Select the Presets > User (Favorites) menu to open the User Presets window. The Presets drop-down list shows the three default user
presets provided with the software.
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• User Preset 1: Sets up the Spectrum, Time Overview, Spectrogram, and Frequency vs Time displays.
• User Preset 2: Sets up the Spurious display.

Make a User preset
You can add your own User presets to the list that appears in the User Presets dialog box as follows:

1. Select Save As from the File menu to open the Save As dialog box.
2. Select to save to C:\SIGNALVU\User Presets.
3. Enter a file name. The name you give the file will appear in the User Presets dialog box list.
4. Select the .Setup file type file from the Save as type drop-down list.
5. Click Save.

Make a User preset a Favorite preset. You can place one or more User presets on the Favorites bar as a Favorite preset for quick
access. Do this as follows:

1. Select Presets > User to open the User Presets window.
2. Select the desired preset from the Presets drop-down list.
3. Click the Add Favorite button. The preset will now have an * next to it. You can do this for more than one preset.
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4. If desired, add a note for this preset in the Notes field and then click the Save button. Whenever you recall this preset, this note will
appear in a separate window, as shown below.

5. Click the OK button in the User Presets window.

6. Click on the  icon on the Favorites bar and you will see the recently added Favorite preset listed.

7. When you are ready to recall a Favorite preset, click  and select the preset from the list that appears.
8. To remove a Favorite preset, select it from the User Presets window and click the Remove Favorite button. The * should disappear

from the list.
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Standards Presets

The Standards presets allow you to recall preconfigured displays for the standards that you select. You can select from the following
standards groups.

• WLAN: The IEEE wireless LAN (WLAN) standards specify the wireless interface between two wireless clients or a wireless client and a
base station. The WLAN presets allow you to access displays preconfigured for the WLAN standards and bandwidths you select.

Note: More information is available about WLAN standards WLAN Measurements Overview on page 167. You can also
watch a video tutorial about WLAN Presets at www.youtube.com/user/tektronix. Click here for information about searching the
Tektronix YouTube channel for videos.

• P25: The Project 25 (P25) TIA-102 standards specify the design of interoperable digital two-way wireless communications products.
The P25 presets allow you to access displays preconfigured for the P25 standards you select. You can choose either the Phase 1
(FDMA) standard or the Phase 2 (TDMA) standard.

Note: More information is available about P25 standards P25 Overview on page 276.

• Bluetooth: The Bluetooth standards specify short range RF signals. The Bluetooth presets allow you to access displays preconfigured
for the specific Bluetooth standards you select: Basic Rate, Low Energy, and Enhanced Data Rate (EDR).

Note: More information is available about Bluetooth standards Bluetooth Analysis.

• LTE: The LTE standards ensure that the RF signals meet 3GPP measurements specifications. The LTE presets test setups load
pre-configured displays and control setting as suggested by the selected standard to accelerate the test setup of the analyzer.
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Note: More information is available about LTE standards and test setups on page 311.

• 5GNR: The 5GNR standards ensure that the RF signals meet 3GPP measurements specifications. The 5GNR presets test setups load
pre-configured displays and control setting as suggested by the selected standard to accelerate the test setup of the analyzer.

Note: More information is available about 5GNR standards and test setups 5GNR Overview .

• 802.11ad and 802.11ay: Supports the set of standards for 802.11ad (Control PHY and Single carrier PHY) and for 802.11ay (single
carrier PHY at RF up to 70 GHz in DPO70000 DX series oscilloscopes, the DPO70000SX (with ATI) series oscilloscopes, and on
personal computers running SignalVu-PC for offline analysis. The ATI oscilloscope supports real time data analysis at RF, without any
downconverters.

Note: More information is available about 802.11ad and 802.11ay standards 802.11ad and 801.11ay Overview.

Application Preset: Modulation Analysis

The Modulation Analysis application preset opens the following displays:

• Signal Quality: Shows a summary of modulation quality measurements (EVM, rho, Magnitude Error, Phase Error, and others).
• Constellation: Shows the I and Q information of the signal analyzed in an I vs Q format.
• Symbol Table: Shows the demodulated symbols of the signal.

To use the Modulation Analysis preset (assuming the Preset action is set to Show list in the Presets tab of the Options control panel):

1. Select Presets > Application. Select Modulation Analysis and then click OK.
2. Set the measurement frequency.
3. Set the reference level so that the peak of your signal is about 10 dB below the top of the Spectrum display.
4. Set the modulation parameters for your signal. This includes the Modulation Type, Symbol Rate, Measurement Filter, Reference Filter,

and Filter Parameter. All of these settings are accessed by selecting Tools > Settings.

For most modulated signals, the Modulation Analysis application preset should present a stable display of modulation quality. Additional
displays can be added by selecting Setup > Displays, and other settings can be modified to better align with your signal requirements.

Application Preset: Pulse Analysis

The Pulse Analysis application preset opens the following displays:

• Time Overview: Shows amplitude vs. time over the analysis period.
• Pulse Table: This shows a full report for the user-selected pulse measurements. If you want to clear the Pulse Table results for a new

acquisition, open the Time Overview window and select Autoscale. This causes the pulse table to refresh.
• Pulse Trace: Shows the trace of the selected pulse and a readout of the selected measurement from the pulse table.
• Pulse Cumulative Histogram: Shows a histogram that support statistics over multiple acquisitions. It shows basic pulse measurements

and has user definable bins for the cumulated pulses. It provides detailed information about the bins and its content.
• Pulse Cumulative Statistics Table: Shows a statistics table that provides information on Standard Deviation, Average, Max, and Min

over different acquisitions.
• Pulse-Ogram: Shows a correlated Amplitude Time vs Time and frequency vs time display, where Y is pulse parameter, X is pulse

duration, and Z is number of pulses. It shows you a definable number of stacked pulses in amplitude versus time (reference being
the trigger time), as well as in amplitude versus frequency. This display will also show the information as an 'ogram, where the pulse
number is being scanned over time.
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You can make a selected pulse and measurement appear in the Pulse Trace display by highlighting it in the Pulse Measurement Table.
Key pulse-related parameters that are set by the Pulse Analysis application preset are:

• Measurement Filter: No Filter-Max BW
• Measurement Bandwidth: This is set to the maximum real-time bandwidth of the instrument.

Note: The label on the “Measurement Bandwidth” setting is just “Bandwidth”. Like the main instrument Preset command and
the other application presets, the Pulse Analysis application preset also sets most other instrument controls to default values.

• Analysis Period: This is set to 2 ms to ensure a good probability of catching several pulses for typical signals.

To use the Pulse Analysis preset (assuming the Preset action is set to Show list in the Presets tab of the Options control panel):

1. Select Presets > Application. Select Pulse Analysis and then click OK.
2. Set the Center Frequency control to the carrier frequency of your pulsed signal.
3. Set the Reference Level to place the peak of the pulse signal approximately 0-10 dB down from the top of the Time Overview display.

You may need to trigger on the signal to get a more stable display. This is set up with the oscilloscope's controls. A rising-edge trigger
works well for many pulsed signals.

4. Set the Analysis Period to cover the number of pulses in your signal that you want to analyze. To do this, click in the data entry field of
the Time Overview window and set the analysis length as needed.

Application Preset: Spectrum Analysis

The Spectrum Analysis application preset opens a Spectrum display and sets several parameters. The Spectrum Analysis preset sets the
analyzer as follows.

• Spectrum Analysis : Sets the frequency range to maximum for the analyzer, and sets the RF/IF optimization to Minimize Sweep
Time.

To use the Spectrum Analysis preset (assuming the Preset action is set to Show list in the Presets tab of the Options control panel):

1. Select Presets > Application. Select Spectrum Analysis and then click OK.
2. Set the measurement frequency using the front-panel knob or keypad.
3. Adjust the span to show the necessary detail.

Application Preset: Time-Frequency Analysis

The Time-Frequency Analysis application preset opens the following displays:

• Time Overview: Shows a time-domain view of the analysis time ‘window’.
• Spectrogram: Shows a three-dimensional view of the signal where the X-axis represents frequency, the Y-axis represents time, and

color represents amplitude.
• Frequency vs. Time: This display's graph plots changes in frequency over time and allows you to make marker measurements of

settling times, frequency hops, and other frequency transients.
• Spectrum: Shows a spectrum view of the signal. The only trace showing in the Spectrum graph after selecting the Time-Frequency

Analysis preset is the Spectrogram trace. This is the trace from the Spectrogram display that is selected by the active marker. Stop
acquisitions with the Run button because its easier to work with stable results. In the Spectrogram display, move a marker up or down
to see the spectrum trace at various points in time.

The analysis period (scale) is set to 5 ms.

To use the Time-Frequency Analysis preset (assuming that Time-Frequency Analysis is the selected preset on the list of Application
Presets and Preset action is set to Recall selected preset):
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1. Select Presets > Application. Select Time-Frequency Analysis and then click OK.
2. When the preset's displays and settings have all been recalled and acquisitions are running, adjust the center frequency and span to

capture the signal of interest.
3. Set the Reference Level to place the peak of the signal approximately 0-10 dB down from the top of the Spectrum graph.
4. If the signal is transient in nature, you might need to set a trigger to capture it. You will need to use the oscilloscope triggering functions

to capture the signal.

When the signal has been captured, the spectrogram shows an overview of frequency and amplitude changes over time. To see frequency
transients in greater detail, use the Frequency vs. Time display.

The Time-Frequency Analysis preset sets the analysis period to 5 ms. The Spectrum Span is 40 MHz. The RBW automatically selected for
this Span is 300 kHz. For a 300 kHz RBW, the amount of data needed for a single spectrum transform is 7.46 μs. A 5 ms Analysis Length
yields 671 individual spectrum transforms, each one forming one trace for the Spectrogram to display as horizontal colored lines. This
preset scales the Spectrogram time axis (vertical axis) to -2, which means that the Spectrogram has done two levels of time compression,
resulting in one visible line for each four transforms. This results in 167 lines in the Spectrogram for each acquisition, each covering 29.84
μs.

Application Preset: Spur Search Multi Zone 9k-1GHz
The Spur Search Multi Zone 9k-1GHz application preset opens the Spurious display, which is set to display all spurs that exceed the
Threshold and Excursion values for the entire 9 k through 1 GHz range.

To use the Spur Search Multi Zone 9k-1GHz preset (assuming that Preset action is set to Recall selected preset):

1. Select Presets > Application. Select Spur Search Multi Zone 9k-1GHz and then click OK.
2. Click Setup > Settings when the preset's display and settings have all been recalled and acquisitions are running.
3. Select the Ranges and Limits tab in the Spurious Settings control panel to view the spur information. You can click the Expand button

to view the table in a separate window.

Note: You can read more about the Spurious display on page 124 and its various parameters and settings in the RF
Measurements section.

Setting Options
Main menu bar: Tools > Options

There are several settings you can change that are not related to measurement functions. The Option settings control panel is used to
change these settings.

Settings tab Description

Presets Use this tab to configure Presets. You can specify the action to take when a preset is recalled and
which preset to recall when the Preset button is selected.

Analysis Time Use this tab to specify the method used to automatically set the analysis and spectrum offsets when
the Time Zero Reference on page 499 is set to Trigger.

Table continued…
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Settings tab Description

Save and Export Use this tab to specify whether or not save files are named automatically and what information is
saved in acquisition data files.

GPIB Do not use this tab to set the GPIB address for the instrument. Use the Utilities > GPIB
Configuration control window in the TekScope application to set the instrument GPIB address.

Security Selecting the Hide Sensitive readouts check box causes the instrument to replace measurement
readouts with a string of asterisks.

Prefs Use this tab to select different color schemes for the measurement graphs and set markers to
automatically jump to the next peak when dragged. When this setting is deselected, you can drag a
marker to any point on the trace.

Presets
The Presets tab in the Options control panel allows you to specify actions taken when you press the Preset button. You can read more
about this tab here.

Analysis Time
The Analysis Time tab in the Options control panel is used to specify the method used to automatically set the analysis and spectrum
offsets when the Time Zero Reference on page 499 is set to Trigger. The available settings are:

• Include trigger point – Selects an algorithm that uses the measurements to determine how far in advance of the trigger to set the
analysis offset. The analyzer tries to ensure that data about the trigger point is included in the analyses.

• Start at trigger point (legacy) – The method used by the instrument in prior versions, which sets the Analysis Offset to zero when
possible. The analyzer tries to ensure that data following the trigger point is included in the analyses. Use this method if your
measurements or procedures depend on past behavior of the Auto Analysis Offset function.

Save and Export

The Save and Export tab allows you to specify whether or not files are saved with an automatically generated name, and how much data is
saved in an acquisition data file.

All files. The Automatically increment filename/number function can automatically name saved files by appending a number to a
base file name. Use this tab to enable/disable automatic naming of files. For example, if Automatically Increment Filename Number is
disabled, when you select Save from the File menu, you will have to enter a name for the file.

Acquisition data files. This setting specifies whether saved data files include the entire acquisition record or only the data for the analysis
length (a subset of the acquisition record).

TIQ acquisition data files. Specifies which data records to save. You can choose from the following:

• Current acquisition: Saves the current acquisition.
• Current frame: If Fast Frame is enabled, saves only the current frame. The current frame is the one most recently analyzed.
• Selected frames: If Fast Frame is enabled, saves the specified frames.
• All in history: Saves all acquisition records in the history.
• Save TIQ file now: Invokes the Save As dialog box with the Save as type drop-down list set to TIQ.
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Setup and data in MAT. Specifies which MATLAB data type to save. You can choose from the following:

• MAT v6 (Level 5)
• MAT v7.3 (Level 7.3)

MATLAB Level 5 file size is limited to 2 GB. If you try to save more than 2 GB in MATLAB Level 5 (v6 format), the following warning shows
and prompts you to select Level 7.3 format.

Security
The Security tab enables you to hide sensitive readouts in displays with readouts, such as the OFDM Summary display.

Prefs
The Prefs tab enables you to set properties that apply to all displays.

Color scheme. The Color scheme setting provides three color schemes for the measurement graphs. The color scheme setting does not
change the overall instrument application or Windows color scheme.

• Thunderstorm – This scheme displays graphs in shades of blue. This provides a less vibrant color scheme than the default setting.

• Blizzard – This scheme displays graphs with a white background to save ink when printing.

• Classic – The default setting. This scheme displays the graph area with a black background.

Markers snap to peaks when dragged. When selected, this setting causes makers to automatically jump to the next peak when you drag
them. When this setting is deselected, you can drag a marker to any point on the trace.

Show “Data from warm-up period” message. When selected, this setting allows the data warm-up message to show in the status area
of the display.

Show “External Connections enabled for traces” message. When selected, this setting allows the external connections message to
show.
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Show “Decimal separator warning” message. When unchecked, the message that warns users that the application only supports point
decimal separators is disabled. Check the box to allow the message to pop up when users enter non-point decimal separators.
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Measurements
Selecting Displays
Main menu bar: Setup > Displays 

Favorites toolbar:

Use the Select displays dialog to choose the displays that appear on the screen.

To select displays:

1. Select Setup > Displays or click the icon.
2. Select one of the choices under Measurements. The measurement chosen determines the choices available in Available displays.
3. Double-click the desired display in the Available displays box or select the desired display and click Add.
4. Click OK.

Interactions Between Displays

Measurements
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Different displays can require different settings, for example acquisition bandwidth, analysis length, or resolution bandwidth, to achieve
optimum results. The application automatically adjusts some settings to optimize them for the selected display. The check mark indicator
in the upper, left-hand corner of the display indicates the display for which the application is optimized. Depending on application settings,
some displays might stop displaying results if they are not the selected display.

Available Measurements
Available automatic measurements include RF power measurements, OFDM analysis, WLAN analysis, APCO P25 analysis, Bluetooth
analysis, LTE analysis, 5GNR analysis, 802.11.ad and 802.11ay, audio analysis, analog modulation measurements, digital modulation
measurements, and pulsed RF measurements.

See the specific measurement topic in this document for information about how to take a measurement.

Power measurements

Measurement Description

Channel Power The total RF power in the selected channel (located in the Chan Pwr and ACPR display).

Adjacent Channel Power Ratio
(ACPR)

Measure of the signal power leaking from the main channel into adjacent channels.

Signal Strength Measure of signal strength (channel power and peak channel power).

Multi-Carrier Power Ratio (MCPR) The ratio of the signal power in the reference channel or group of channels to the power in adjacent
channels.

Peak/Avg Ratio Ratio of the peak power in the transmitted signal to the average power in the transmitted signal
(located in the CCDF display).

CCDF The Complementary Cumulative Distribution Function (CCDF) shows how much time a signal spends
at or above a given power level relative to the average power of a measured signal.

OFDM analysis

Measurement view Description

Channel Response Plots the channel response (magnitude or phase) versus the subcarrier or frequency. Here, the
channel refers to all sources of signal frequency response impairment up to the analyzer input,
including the transmitter itself, as well as any transmission medium through which the signal travels
between the transmitter and the analyzer.

Constellation Shows the WLAN signal modulation amplitude and phase in I (horizontal) versus Q (vertical) form.
For multicarrier WLAN OFDM signals, the points show all data symbol subcarriers' modulation. For
single-carrier 802.11b, each point corresponds to a single modulated chip.

EVM The normalized RMS value of the error vector between the measured signal and the ideal reference
signal over the analysis length. The EVM is generally measured on symbol or chip instants and is
reported in units of percent and dB. EVM is usually measured after best-fit estimates of the frequency
error and a fixed phase offset have been removed. These estimates are made over the analysis
length. Displays RMS and Peak values with location of Peak value.

Table continued…
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Measurement view Description

Flatness Ratio of the peak power in the transmitted signal to the average power in the transmitted signal

Mag Error The RMS magnitude difference between the measured signal and the reference signal magnitude.
Displays RMS and Peak values with location of Peak value.

Phase Error The RMS phase difference between the measured signal and the ideal reference signal. Displays
RMS and Peak values with location of Peak value.

Power shows the data symbols' individual subcarrier Power values versus symbol interval (time) and
subcarrier (frequency).

WLAN measurements

Measurement view Description

Channel Response Plots the channel response (magnitude or phase) versus the subcarrier or frequency. Here, the
channel refers to all sources of signal frequency response impairment up to the analyzer input,
including the transmitter itself, as well as any transmission medium through which the signal travels
between the transmitter and the analyzer.

Constellation Shows the WLAN signal modulation amplitude and phase in I (horizontal) versus Q (vertical) form.
For multicarrier WLAN OFDM signals, the points show all data symbol subcarriers' modulation. For
single-carrier 802.11b, each point corresponds to a single modulated chip.

EVM The normalized RMS value of the error vector between the measured signal and the ideal reference
signal over the analysis length. The EVM is generally measured on symbol or chip instants and is
reported in units of percent and dB. EVM is usually measured after best-fit estimates of the frequency
error and a fixed phase offset have been removed. These estimates are made over the analysis
length. Displays RMS and Peak values with location of Peak value.

Flatness Ratio of the peak power in the transmitted signal to the average power in the transmitted signal

Mag Error The RMS magnitude difference between the measured signal and the reference signal magnitude.
Displays RMS and Peak values with location of Peak value.

Phase Error The RMS phase difference between the measured signal and the ideal reference signal. Displays
RMS and Peak values with location of Peak value.

Power vs Time The signal power amplitude versus time. For 802.11b signals, the packet Power-On and Power-Down
ramp times are also measured.

Summary Shows several measurements of WLAN signal quality.

Symbol Table Shows decoded data values for each data symbol in the analyzed signal packet. For OFDM
(non-802.11b) signals, results are presented with subcarrier (frequency) indices in the horizontal
dimension and symbol (time) intervals in the vertical dimension. For 802.11b signals, the Preamble,
Header, and Data (PSDU) symbol values are presented sequentially, with symbol indices in the left
column.
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802.11ad and 802.11ay measurements
This option is available for offline analysis only.

Measurement view Description

Constellation Shows the 802.11ad/ay signal modulation amplitude and phase in I (horizontal) versus Q (vertical)
form.

EVM vs Time Shows the EVM plotted against time in seconds or symbols. The analysis region in which the
measurement is done is indicated by a purple line in the Time Overview display to indicate the region
of analysis.

Symbol Table Shows decoded data values for each data symbol in the analyzed signal packet.

Summary Shows several measurements of 802.11ad/ay signal quality.

Audio measurements

Measurement Description

Audio Spectrum Shows audio modulation characteristics. You can choose to show just the spectrum of the audio
signal or show the audio spectrum of the signal and the results of distortion measurements. The
Audio Spectrum display can show a table listing the frequency of a Harmonic Distortion (HD) and
Non-Harmonic Distortion (NHD) and its level. The Spectrum graph indicates these harmonics and
non-harmonics with special markers.

Digital Modulation measurements

Table 1: Measurements for all modulation types except nFSK, C4FM, OQPSK and SOQPSK

Measurement Description

EVM The normalized RMS value of the error vector between the measured signal and the ideal reference
signal over the analysis length. The EVM is generally measured on symbol or chip instants and is
reported in units of percent and dB. EVM is usually measured after best-fit estimates of the frequency
error and a fixed phase offset have been removed. These estimates are made over the analysis
length. Displays RMS and Peak values with location of Peak value.

Phase Error The RMS phase difference between the measured signal and the ideal reference signal. Displays
RMS and Peak values with location of Peak value.

Mag Error The RMS magnitude difference between the measured signal and the reference signal magnitude.
Displays RMS and Peak values with location of Peak value.

MER (RMS) The MER is defined as the ratio of I/Q signal power to I/Q noise power; the result is indicated in dB.

IQ Origin Offset The magnitude of the DC offset of the signal measured at the symbol times. It indicates the magnitude
of the carrier feed-through signal.

Table continued…

Measurements

SignalVu™ Vector Signal Analysis Software Printable Help 44



Measurement Description

Frequency Error The frequency difference between the measured carrier frequency of the signal and the user-selected
center frequency of the instrument.

Gain Imbalance The gain difference between the I and Q channels in the signal generation path. Constellations with
gain imbalance show a pattern with a width that is different form height.

Quadrature Error The orthogonal error between the I and Q channels. The error shows the phase difference between I
and Q channels away from the ideal 90 degrees expected from the perfect I/Q modulation. Not valid
for BPSK modulation type.

Rho The normalized correlated power of the measured signal and the ideal reference signal. Like EVM,
Rho is a measure of modulation quality. The value of Rho is less than 1 in all practical cases and is
equal to 1 for a perfect signal measured in a perfect receiver.

Table 2: Measurements for OQPSK and SOQPSK modulation types

Measurement Description

EVM The normalized RMS value of the error vector between the measured signal and the ideal reference
signal over the analysis length. The EVM is generally measured on symbol or chip instants and is
reported in units of percent and dB. EVM is usually measured after best-fit estimates of the frequency
error and a fixed phase offset have been removed. These estimates are made over the analysis
length. Displays RMS and Peak values with location of Peak value.

Offset EVM Offset EVM is like EVM except for a difference in the time alignment of the I and Q samples. For EVM,
I and Q samples are collected at the same time, for every symbol decision point (twice the symbol
rate for offset modulations). For Offset EVM, the I and Q symbol decision points are time-aligned
before collecting the I and Q samples. In this case, one I and one Q sample is collected for each
symbol (half as many samples as the same number of symbols for (non-offset) EVM.

Phase Error The RMS phase difference between the measured signal and the ideal reference signal. Displays
RMS and Peak values with location of Peak value.

Mag Error The RMS magnitude difference between the measured signal and the reference signal magnitude.
Displays RMS and Peak values with location of Peak value.

MER (RMS) The MER is defined as the ratio of I/Q signal power to I/Q noise power; the result is indicated in dB.

IQ Origin Offset The magnitude of the DC offset of the signal measured at the symbol times. It indicates the magnitude
of the carrier feed-through signal.

Frequency Error The frequency difference between the measured carrier frequency of the signal and the user-selected
center frequency of the instrument.

Gain Imbalance The gain difference between the I and Q channels in the signal generation path. Constellations with
gain imbalance show a pattern with a width that is different form height.

Table continued…
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Measurement Description

Quadrature Error The orthogonal error between the I and Q channels. The error shows the phase difference between I
and Q channels away from the ideal 90 degrees expected from the perfect I/Q modulation. Not valid
for BPSK modulation type.

Rho The normalized correlated power of the measured signal and the ideal reference signal. Like EVM,
Rho is a measure of modulation quality. The value of Rho is less than 1 in all practical cases and is
equal to 1 for a perfect signal measured in a perfect receiver.

Table 3: Measurements for nFSK modulation types

Measurement Description

Peak FSK err Peak value of the frequency deviation error at the symbol point.

RMS FSK Err RMS value of the frequency deviation error at the symbol point.

Peak Mag Err The Peak magnitude difference between the measured signal and the reference signal magnitude.

RMS Mag Err The RMS magnitude difference between the measured signal and the reference signal magnitude.

Freq Error The frequency difference between the measured carrier frequency of the signal and the user-selected
center frequency of the instrument.

Freq Deviation Frequency distance from the center frequency at the symbol point.

Symbol Rate Error This compares the user-entered symbol rate to the instrument calculated symbol rate of the analyzed
signal.

Symbol Rate When in Auto-symbol rate, the instrument calculates the symbol rate of the signal and the instrument
calculates the error between the user entered value and the instrument calculated value.

Table 4: Measurements for C4FM modulation type

Measurement Description

RMS Error Magnitude RMS value of the frequency deviation error at the symbol point.

Carrier Frequency Error Frequency difference between averaged signal frequency and the center frequency.

Deviation Frequency distance from the center frequency at the symbol point.

Length Number of symbols in the analysis area.

Analog Modulation measurements
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Table 5: Measurements for AM modulation

Measurement Description

+AM Positive peak AM value.

-AM Negative peak AM value.

Total AM Total AM value, which is equal to the peak-peak AM value divided by 2.

Table 6: Measurements for FM modulation

Measurement Description

+Pk Positive peak frequency deviation.

–Pk Negative peak frequency deviation.

RMS RMS value of the frequency deviation.

Pk-Pk/2 Peak-to-peak frequency deviation divided by 2.

Pk-Pk Peak-to-peak frequency deviation.

Table 7: Measurements for PM modulation

Measurement Description

+Pk Positive peak phase deviation.

–Pk Negative peak phase deviation.

RMS RMS value of the phase deviation.

Pk-Pk Peak-to-peak phase deviation.

APCO P25 measurements

Measurement Description

RF output power Measure of RF output power when the transmitter is connected to the standard load during defined
duty cycle.

Operating frequency accuracy Measure of the ability of the transmitter to operate on its assigned frequency.

Table continued…
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Measurement Description

Unwanted emissions (ACPR) Ratio of the total power of a transmitter under prescribed conditions and modulation to that of the
output power that falls within a prescribed bandwidth centered on the nominal frequency of adjacent
channels.

Frequency deviation Measurement of the amount of frequency deviation that results for a Low Deviation and High
Deviation test pattern.

Modulation fidelity Measures the degree of closeness to which the modulation follows the ideal theoretical modulation
determined by the rms difference between the actual deviation and the expected deviation for the
transmitted symbols.

Symbol rate accuracy Measures the ability of the transmitter to operate at the assigned symbol rate (4.8 kHz for Phase 1, 6
kHz for Phase 2).

Transmitter power and encoder
attack time 

Measures the time required for a transmitter to prepare and transmit information on the radio channel
after changing state from standby to transmit (applies to conventional mode).

Transmitter power and encoder
attack time with busy/idle
operations

Measures the time required for a transmitter to prepare and transmit information on the radio channel
after the receiving channel changes state from busy to idle.

Transmitter throughput delay Measures the time it requires for audio changes in the microphone to be encoded and transmitted
over the air.

Transient frequency behavior Measures the difference of the actual transmitter frequency and assigned transmitter frequency as a
function of time when the RF output power is switched on or off.

HCPM transmitter logical channel
time alignment

Measures the ratio of total transmitter power under prescribed conditions and modulation to the peak
power that falls in a prescribed bandwidth centered on the nominal frequency of the adjacent channel
during the transmitter power ramping interval.

Bluetooth measurements

Measurement Description

Modulation characteristics Verifies that the modulation characteristics of the transmitted signal are correct. This measurement
can only be done if the payload has the bit pattern 10101010 or 11110000.

Carrier frequency offset and drift Verifies that the carrier frequency offset and carrier drift of the transmitted signal is within the specified
limits for the Basic Rate and Low Energy standards. This test can be done only if the payload contains
10101010 bit pattern.

Output power Verifies the maximum peak and average power emitted from the EUT. The standard recommends this
test be done for a PRBS payload pattern.

Table continued…
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Measurement Description

In-band emission / ACPR Verifies that the in-band spectral emission is within limits. The standard document recommends
that this measurement be done with Hopping off, finding the integrated power in 1 MHz band (with
RBW 100 kHz) in 80 channels starting from 2401 MHz to 2481 MHz. The integrated power values
calculated in the adjacent channels are compared against recommended limits (except the three
channels around transmitted frequency). This measurement is referred to as ACPR in the Basic Rate
standards document.

20 dB bandwidth Verifies if the emissions inside the operating frequency range are within limits. This measurement is
done with Hopping off. The difference between frequency points at which the power level drops to 20
dB below the peak power of the emission is found as 20 dB bandwidth.

Frequency range These measurements verify if the emissions inside the operating frequency range are within the limits.

Power density This measurement verifies the maximum RF output power density.

Out-of-band spurious emission This measurement can be done for FCC or ETSI masks using the Spurious display.

Relative power Verifies the relative power in the GFSK and PSK part of the Enhanced Data Rate signal. This
measurement is supported only when an Enhanced Data Rate signal is detected.

LTE measurements

Measurement Description

Cell ID detection The Cell ID is detected from the input LTE signal.

For TDD and FDD.

Adjacent Channel Leakage Ratio
(ACLR)

The Adjacent Channel integrated power is calculated and shown. The relative power compared to the
reference signal is also computed. The computed power is compared against limits suggested by the
selected standard and pass/fail is reported.

For TDD and FDD.

Channel Power The channel power is calculated in the channel bandwidth.

For TDD and FDD.

Occupied Bandwidth The Occupied bandwidth is calculated as bandwidth containing 99% of the total integrated power in
the selected span around the selected center frequency.

For TDD and FDD.

Operating Band Unwanted
Emission

The power in the offset regions is calculated and presented and compared against limits set in the
offset and limits table and pass/fail is reported.

For TDD and FDD.

TOFF The power in off-slot region is computed and compared against selected limits.

For TDD only.
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5GNR measurements

Measurement Description
Modulation Accuracy (ModACC) It measures the deviation of the received symbol relative to the ideal transmitted symbol. The IQ data

is processed to identify the OFDM Symbol boundaries and FFT is performed using the various settings
under the Modulation Accuracy tab. The subcarrier data is equalized and then data and DMRS are
extracted to perform various EVM measurements as per the 3GPP Spec and then used for display in
Constellation Display. The Estimation tab provides advanced settings related to IQ Impairments and
Frequency Offset estimation and corrections.

Channel Power (CHP) The measurement is used to verify the maximum carrier output power across the frequency range. It
includes the measurement of individual carrier power under carrier aggregation mode. The Integrated
Bandwidth type can be chosen between Channel and Signal Bandwidth to include or remove the
Guard Bands between carriers respectively.

Adjacent Channel Power (ACP) It measures the power leakage from the carrier channels into the neighboring frequency channels,
commonly referred to as offset channels. The RBW, sweep time, and Spectral Window can be selected
from the measurement options tab. By default, 2 offset channels are enabled for measurement.

Spectral Emission Mask (SEM) It measures the spurious emissions of a transmitter in the immediate frequency bands and compares
against the limit chosen in the settings. The RBW settings and the width of the bands can be selected
from the measurement options tab. Predefined band settings as per 3GPP are also provided in the
options.

Pulse measurements

Measurement Description

Average ON Power The average power transmitted during pulse on.

Peak Power Maximum power during pulse on.

Average Transmitted Power The average power transmitted, including both the time the pulse is on and the time it is off, and all
transition times.

Pulse Width The time from the rising edge to the falling edge at the –3 dB / –6 dB level (50%) of the user selected
100% level. Level is user selectable for Volts or Watts.

Rise Time The time required for a signal to rise from 10% to 90% (or 20% to 80%) of the user selected 100%
level.

Fall Time The time required for a signal to fall from 90% to 10% (or 80% to 20%) of the user selected 100%
level.

Repetition Interval The time from a pulse rising edge to the next pulse rising edge.

Repetition Rate The inverse of repetition interval.

Duty Factor (%) The ratio of the width to the pulse period, expressed as a percentage.

Table continued…
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Measurement Description

Duty Factor (Ratio) The ratio of the pulse width to the pulse period.

Ripple Ripple is the peak-to-peak ripple on the pulse top. It does not include any preshoot, overshoot,
or undershoot. By default, the first 25% and the last 25% of the pulse top is excluded from this
measurement to eliminate distortions caused by these portions of the pulse. 

If the Amplitude units selected in the Amplitude panel (affects all amplitude measurements for the
analyzer) are linear, the Ripple results will be in %Volts. For log units, the Ripple results will be in
%Watts. The default for the general Units control is dBm, so the Ripple results default is %Watts.

See also Ripple on page 570.

Ripple dB The Ripple measurement expressed in dB.

Droop Droop is the power difference between the beginning and the end of the pulse On time. A straight-line
best fit is used to represent the top of the pulse. The result is a percentage referenced to the Average
ON Power.

Droop dB The Droop measurement expressed in dB.

Overshoot The amount by which the signal exceeds the 100% level on the pulse rising edge. Units are %Watts
or %Volts.

Overshoot dB The Overshoot measurement expressed in dB.

Pulse-ref-Phase Difference The phase difference between the current pulse and the first pulse in the analysis window. The
instantaneous phase is measured at a user-adjustable time following the rising edge of each pulse.

Pulse-ref Freq Difference The difference between the frequency of the current pulse and frequency of the previous pulse. The
instantaneous frequency is measured at a user-adjustable time following the rising edge of each
pulse.

RMS Freq Error The RMS Frequency Error measurement is the RMS average of the Freq Error vs. Time trace,
computed over the Measurement Time.

Max Freq Error The maximum frequency error is the difference between the measured carrier frequency of the signal
and the user-selected center frequency of the analyzer.

RMS Phase Error The RMS Phase Error measurement is the RMS average of the Phase vs Time trace, computed over
the Measurement Time.

Max Phase Error The phase is measured at each point during the pulse's ON time. The phase error for each point
is the difference between the measured phase value and the calculated ideal phase value. After
the phase error is calculated for all points in the acquisition record, the largest error in the positive
direction and the largest in the negative direction are determined. Whichever of these two values has
the greater absolute value is designated the Max Phase Error.

Freq Deviation The Frequency Deviation measurement is the difference between the maximum and minimum
measured values of the signal frequency during the Measurement Time.

Table continued…
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Measurement Description

Phase Deviation The Phase Deviation is the difference between the maximum and minimum Phase values measured
during the ON time of a pulse.

Impulse Response Amplitude The difference in dB between the levels of the main lobe and highest side lobe.

Impulse Response Time The difference in time between the main lobe and highest side lobe.

Absolute Frequency The absolute pulse frequency measured at a point specified by the user. The measurement includes
carrier frequency as well. The measurement point should be within the pulse width, starting from the
50% point.

Pulse-Pulse Frequency Difference The difference between the frequency of the current pulse and frequency of the previous pulse. The
instantaneous frequency is measured at a user-adjustable time following the rising edge of each
pulse. 

Pulse-Pulse Phase Difference The phase difference between the selected pulse and the first pulse in the analysis window. The
instantaneous phase is measured at a user-adjustable time following the rising edge of each pulse.

Measurements
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General Signal Viewing
Overview
The displays in General Signal Viewing (Displays > Measurements > General Signal Viewing) are:

• Amplitude vs Time
• Frequency vs Time
• Phase vs Time
• RF I & Q vs Time
• Spectrogram
• Spectrum
• Time Overview

These displays provide extensive time-correlated multi-domain views that connect problems in time, frequency, phase and amplitude for
enabling you to more quickly understand cause and effect when troubleshooting.

Time Overview Display
The Time Overview display shows the entire acquisition record and shows you how the spectrum time and analysis time fit within the
acquisition record. This enables you to see how you can adjust the spectrum time and analysis time to measure portions of the data.

You can specify the maximum number of trace points in the Time Overview display. You can set the maximum number of trace points to
1K, 10K, 100K, 1M points or to Never decimate. If the Acquisition Length includes more than 10,000 sample points (and Max trace points
is not set to Never decimate), the trace is decimated (using the +Peak method, similar to +Peak detection in a Spectrum display) to 10,000
points. This decimated trace is what is used for marker measurements.

The Time Overview window displays the Spectrum Length and Analysis Length. The Spectrum Length is the period of time within the
acquisition record over which the spectrum is calculated. The Analysis Length is the period of time within the acquisition record over which
all other measurements (such as Amplitude vs. Time) are made. The Spectrum Length and Analysis Length can be locked together so that
the data used to produce the Spectrum display is also used for measurement displays; however, they do not have to be tied together. They
are by default specified separately and used to analyze different parts of the acquisition record.

Elements of the Time Overview Display

General Signal Viewing
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Item Element Description

1 Time Select the type of time analysis to be performed. You can select Analysis, Spectrum, or
Linked.

2 Offset Sets the offset of the selected analysis time control.

3 Length Sets the length of the selected analysis time control.

4 Position and Scale Adjusts the vertical scale and position.

5 Scale indicators Shows the vertical scale.

6 Autoscale button Resets the horizontal scale to display the entire acquisition record and the vertical scale to
show all trace points.

7 Horizontal offset Adjusts the horizontal offset.

8 Results Timeline This fuchsia line indicates the portion of the record actually used for calculating the
selected result. For example: if a pulse measurement is selected, it shows the period
of the specific pulse. For a constellation display, it shows the points included in the
demodulation.

9 Amplitude vs. Time graph The trace represents the entire acquisition record (at full horizontal scale). The graph
indicates the Analysis Length or Spectrum Length on the graph with a darker background.

10 Horizontal Scale Adjusts the span of the graph. By decreasing the scale, the graph essentially becomes a
window that you can move over the acquisition record by adjusting the offset.

11 Spectrum Length and Offset
Indicator (red line, top of graph)

This red line indicates the Spectrum Length and Offset. The longer the time, the longer the
bar. Adjusting the offset shifts the bar left or right.

12 Analysis Length and Offset
Indicator (blue line, top of graph
below red line)

The blue line indicates the Analysis Length and Offset. The longer the time, the longer the
bar. Adjusting the offset shifts the bar left or right.

Note: The area with black background (not gray) in the Amplitude vs. Time Graph highlights the control selected in the Analysis
Time Control drop-down list.

Changing the Time Overview Display Settings

Time Overview Settings
Main menu bar: Setup > Settings 

The Setup settings for Time Overview are shown in the following table.
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Settings tab Description

Scale Adjusts the vertical and horizontal scale and offset of the display.

Trace Allows you to select the types of trace to display and its function.

Prefs Specifies whether or not certain display elements are shown.

Navigator View
The Time Overview Navigator View places the Time Overview display across the top of the application screen. This allows you to adjust
the area of interest in the Navigator View and see the results simultaneously in the other displays. For example, in the following image,
adjusting the mask in the Navigator View moves the trace and markers in all of the other displays.

Show Navigator View
To show the Navigator View, select View > Navigator View. To remove the Navigator View, deselect Navigator View in the View menu.

Trace Tab
The Trace Tab allows you to set the display characteristics of displayed traces.
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Setting Description

Show Shows / hides the selected trace.

Detection Sets the Detection method used for the trace. Not available for saved traces. Available detection
methods are +Peak, -Peak, +/-Peak, Avg (VRMS), and Sample. Not all detection methods are
available in all displays.

Function Selects the trace processing method. Available settings are: Normal, Average, Max Hold, and Min
Hold.

(Number of Traces) Sets the number of traces averaged to generate the displayed trace. (Present only when Function is
set to Average.)

Freeze Halts updates to the selected trace.

Save Trace As Saves the selected trace to a file for later recall and analysis.

Show Recalled trace Displays a saved trace instead of a live trace.

Detection

Trace Detection occurs when the trace is being decimated by the measurement. For example, if the maximum number of trace points is
100,000, and the selected analysis region is 200,000 samples, the measurement must decimate the 200,000 resulting trace points by 2 to
prevent exceeding the 100,000 trace point limit. Since only one value can be selected for each trace point, an algorithm must be used to
select (detect) the appropriate value to use.

The IQ samples in a data acquisition can be detected in a variety of ways. The number of IQ samples available to each trace point varies
with both analysis length and trace length. For example, with Spectrum Length set to ‘Auto’ in the Analysis menu, the instrument analyzes
just enough samples to produce one IQ sample pair per trace point. In this case, the detection method chosen has very little effect, as the
+Peak, -Peak, Avg (VRMS) and Sample values are all equal. Changing the Spectrum Length causes the available detection methods to
differ in value because they have a larger set of samples for the various detection methods to process.

The available detection methods (depending on the display) are:

• +Peak – Each point on the trace is the result of detecting the positive peak value present in the set of IQ samples available to that
trace point.

• -Peak – Each point on the trace is the result of detecting the negative peak value present in the set of IQ samples available to that
trace point.

• +/-Peak – Selects the highest and lowest values of all the samples contained in two consecutive acquisition intervals.
• Avg (VRMS) [Average VRMS] – Each point on the trace is the result of determining the RMS Voltage value for all of the IQ samples

available to the trace point. When displayed in either linear (Volts, Watts) or Log (dB, dBm), the correct RMS value results. When the
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averaging function is applied to a trace, the averaging is performed on the linear (Voltage) values, resulting in the correct average for
RMS values.

• Sample – The result is calculated based on the first sample available in the set of IQ samples for each trace point.

Trace Processing
Traces can be processed to display in different ways. The Function setting controls trace processing.

• Normal - Each new trace is displayed and then replaced by the next trace. Each data point contains a single vertical value.
• Average - Multiple traces are averaged together to generate the displayed trace. There is one vertical value for each underlying

frequency data point. Once the specified number of traces have been acquired and averaged to generate the displayed trace, each
new trace takes the place of the oldest trace in the calculation. The Number of Traces setting specifies how many traces averaged.

• Max Hold - Displays the maximum value in the trace record for each display point. Each new trace display point is compared to the
previous maximum value and the greater value is retained for display and subsequent comparisons.

• Min Hold - Displays the minimum value in the trace record for each display point. Each new trace display point is compared to the
previous minimum value and the lesser value is retained for display and subsequent comparisons.

Saving Traces
To save a trace for later analysis:

1. Select the Save icon  . This displays the Save As dialog box.
2. Navigate to the desired folder or use the default.
3. Type a name for the saved trace and click Save.

Recalling Traces
You can recall a previously saved trace for analysis or comparison to a live trace.

To select a trace for recall:

1. Select the trace into which the recalled trace will be loaded, from the Trace drop-down list.
2. Check the Show check box.
3. Click the ... button to display the Open dialog box.

4. Navigate to the desired file and click Open.
5. Check the Show Recalled Trace check box.
6. Verify that the trace's Show check box is selected (either on this tab or next to the drop-down list located at the top-left corner of the

graph).

Spectrum Display
To display a spectrum:

1. Click the Displays button or select Setup > Displays.
2. From the Measurements box, select General Signal Viewing.
3. Double-click the Spectrum icon in the Available displays box. This adds the Spectrum icon to the Selected displays box (and

removes it from the Available displays box). Alternatively, you can click the Spectrum icon and then click the Add button to select
Spectrum for display.

4. Click the OK button.
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Elements of the Spectrum Display

Item Display element Description

1 Vertical position Sets the top of graph value. This is only a visual control for panning the graph. The
Reference Level is adjusted in the Toolbar and the Amplitude control panel. By default,
Vert Position = Ref Level.

2 Units Sets the global Amplitude units for all the views in the analysis window. This will change
the Amplitude selection in the Units tab of Analysis Control panel.

3 dB/div Sets the vertical scale value. The maximum value is 20.00 dB/division.

4 RBW Sets the resolution bandwidth. Note that when the RBW is set to Auto, its value is
italicized.

5 VBW Enables the VBW (Video Bandwidth) filter. See Setup > Settings > BW Tab on page 78.

6 Autoscale Adjusts the Vertical and Horizontal scaling to display the entire trace on screen.

7 Position Default function is CF - center frequency (equivalent to the Freq setting). If Horizontal
scaling has been manually adjusted in Settings > Scale, then Offset will replace CF as the
setting at the bottom-left corner of the screen.

8 CF indicator Indicates the center frequency.

Table continued…
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Item Display element Description

9 Span / Scale Default function is Span - frequency difference between the left edge of the display and
the right edge. If Horizontal scaling has been manually adjusted in Settings > Scale, then
Scale will replace Span as the setting at the bottom-right corner of the screen.

10 Clear Restarts multi-trace functions (Avg, Hold).

11 Function Readout of the Detection and Function selections for the selected trace.

12 Show Controls whether the selected Trace is visible or not. When trace is Off, the box is not
checked.

13 Trace Selects a trace. Clicking here pops up a context menu listing the available traces, whether
they are enabled or not. If you select a trace that is not currently enabled, it will be made
enabled.

Changing the Spectrum Display Settings

Spectrum Settings
Main menu bar: Setup > Settings 

The settings for the Spectrum display are shown in the following table.

Settings tab Description

Freq & Span Sets frequency and span parameters for the Spectrum Analysis display.

BW Sets Resolution Bandwidth and windowing parameters.

Traces Sets Trace display parameters.

Traces (Math) Sets the traces used to create the Math trace.

Scale Tab on page 59 Sets vertical and horizontal scale and position parameters.

Prefs Tab on page 80 Specifies whether or not certain display elements are shown.

Scale Tab
The Scale tab allows you to change the vertical and horizontal scale settings. Changing the scale settings changes how the trace appears
on the display but does not change control settings such as Measurement Frequency. In effect, these controls operate like pan and zoom
controls.
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Setting Description

Vertical

Scale Changes the vertical scale.

Position Vertical Position adjusts the top of graph amplitude value. This control allows you to move (“pan”) the
traces up and down in the graph without changing the Reference Level.

Autoscale Resets the Offset so that the trace appears below the top of the graph.

Horizontal

Scale Allows you to change the range of frequencies shown in the graph without changing the span or
measurement frequency.

Position Allows you pan the graph.

Autoscale Resets Scale to the Span setting.

Reset Scale Resets all settings to their default values.

Log scale Resets the display to show the frequency axis in a logarithmic scale.

Spectrogram Display
The Spectrogram is a display with the vertical axis (time) composed of successive spectral displays, each having the amplitude
represented by color or intensity. The horizontal axis represents frequency. The most recently acquired spectrum results are added to
the bottom of the spectrogram. The addition of a new spectrum can occur at the fastest rate that new spectra can be plotted, or, if you
choose, new spectra can be added at a timed rate. The spectrogram view is well-suited to displaying long-term trends of spectral data. The
maximum number of lines that can be displayed in a spectrogram is 125,000.

The spectrogram can also be displayed in a 3-D waterfall format. In the 3-D waterfall format, the spectrogram displays the time axis along
a simulated Z-axis.

Note: Spectrogram data is shared with the Spectrum display.

To display a Spectrogram:

1. Select the Displays button or select Setup > Displays. This displays the Select Displays dialog box.
2. From the Measurements box, select General Signal Viewing.
3. Double-click the Spectrogram icon in the Available Displays box. This adds the Spectrogram icon to the Selected displays box.
4. Click the OK button. This displays the spectrogram view.
5. To display a 3-D version of the spectrogram, select the 3-D checkbox.

General Signal Viewing

SignalVu™ Vector Signal Analysis Software Printable Help 60



Elements of the Spectrogram Display

Item Display element Description

1 Check mark indicator The check mark indicator in the upper, left-hand corner of the display shows when the
Spectrogram display is the optimized display.

Note: When Best for multiple windows is selected in the Amplitude control
panel's RF & IF Optimization control, none of the measurement displays shows a
checkmark, as there is not a single optimized measurement.

2 Time/div Sets the length of time represented by each vertical division. Divisions are indicated by tick
marks along the left edge of the graph.

3 RBW Sets the resolution bandwidth. Note that when the RBW is set to Auto, its value is
italicized.

4 VBW Enables the VBW (Video Bandwidth) filter. See Setup > Settings > BW Tab on page 78 .

5 3-D checkbox Enables and disables the 3-D view.

Table continued…
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Item Display element Description

6 Shows the positions of the start and stop records selected on the Select data records
tab. Drag the indicators to select which records will be played by Replay All. Note that
these are not visible while acquisitions are running; the instrument must be stopped for the
indicators to be visible.

7 Selected records indicators Trigger indicator. This icon indicates the trigger point within the current acquisition.

8 Pos Position indicates the bottom line visible in graph. Changing this setting scrolls the window
up and down through the displayed acquisition records.

9 Autoscale Resets Vertical and Horizontal scale and Pos to default values.

10 CF Sets the Center Frequency.

11 Span Sets the span of the spectrogram display.

12 Current data record indicator A blue line indicates the current data record. When the analysis length is short, the blue
line appears as a thin line much like the selected indicator line. When the analysis length
is relatively long, the blue line appears more like a blue bar.

13 Position scroll bar Changes the position of the trace in the window. Changing the position scroll bar is the
same as adjusting the Pos setting.

14 Selected indicator This inverse-colored line indicates the Spectrogram line that will appear in the Spectrum
display when the Spectrogram trace is enabled. This line is attached to the selected
marker.

15 Clear Clears the spectrogram display; however, data records in acquisition history remain in
memory and are available for replay. To clear memory, select File > Acquisition Data Info
> Delete All Data.

16 Marker indicators These icons indicate the position of markers in the spectrogram. You can move markers
by dragging the desired marker indicator.

17 Detection setting Displays the selected Detection method (see Trace Tab on page 63 tab).

18 Marker readout Marker readout for the selected marker. In the Spectrogram display, the marker readout
includes a date and timestamp. The time is displayed in a 24-hour format. The timestamp
readout can be shown or hidden independently of the other marker readouts (see Prefs
Tab on page 80).

19 Time Scale status readout Three readouts can appear here depending on settings: Time/update, Spectrums/line, and
Overlap. See Time Scale Status Readout on page 62.

Time Scale Status Readout

Three types of readouts can appear in the display depending on settings:
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• Time/update – Displays minutes:seconds when Spectrum Monitor is selected in the Settings > Time & Freq Scale tab in the Vertical
(Time) section.

• Spectrums/line – Displays an integer number when vertical scale is Normal and each line contains the results from one or more
frequency transforms (whether zoomed out or not).

• Overlap – Displays the overlap percentage when vertical scale is Normal and each line's transform shares some points with the
transforms of lines before and after it (zoomed in). Overlap can only be done when the Analysis Length > 2x RBW frame length.

The Spectrogram can show results from one or multiple acquisitions and it can show one or multiple lines for each acquisition.

Changing the Spectrogram Display Settings

Spectrogram Settings
Main menu bar: Setup > Settings 

The Setup settings for the Spectrogram display are visible when Spectrogram is the selected display.

Settings tab Description

Freq & Span Tab Sets frequency and span parameters for the Spectrogram display.

BW Tab on page 78 Sets Resolution Bandwidth and windowing parameters.

Trace Tab on page 63 Sets Trace display parameters.

Amplitude Scale Tab on page 64 Selects between 2-D and 3-D, sets height scale, position and orientation for 3-D display. Sets color
parameters for the spectrogram trace.

Time & Freq Scale Tab Sets the vertical and horizontal scale parameters for the spectrogram trace. The Spectrum Monitor
controls are also on this tab.

Prefs Tab on page 80 Specifies whether or not certain display elements are shown.

Trace Tab
The Spectrogram Trace tab controls let you specify the Detection method, save traces, and recall saved traces for display. The
Spectrogram Trace tab does not have all the controls that other Trace tabs contain, however, it does have a unique display element, the
Selected Line readout. For details on Detection, Freeze, and saving and recalling traces, see the Traces Tab on page 75.

Selected Line
Displays the time at the Selected Line. If Markers are enabled, the selected line is positioned by the selected marker. If no markers are
enabled, the selected line is the first line in the current analysis period.
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Amplitude Scale Tab
The Amplitude Scale tab allows you to change the vertical and horizontal scale settings, enable the 3-D Waterfall display, and set the color
scheme used for the spectrogram trace.

Setting Description

Height (3-D only)

Scale Changes the vertical scale for trace Amplitude in the graph (not the vertical scale for Time).

Position Specifies the level displayed at the bottom edge of the graph. (Bottom front edge in the 3-D view).

Autoscale Adjusts the vertical position and scale of the trace lines to bring them into the visible portion of the
graph.

3–D Waterfall Displays the spectrogram in a 3-D format.

Northeast Shifts the perspective of the 3-D graph so that the oldest traces move back and to the right.

Northwest Shifts the perspective of the 3-D graph so that the oldest traces move back and to the left.

Reset Scale Resets the Height and Color settings to their default values.

Color (Power)

Color Displays a drop-down list that allows you to set the color scheme used for the spectrogram trace.

Max Sets the maximum power level represented by the top of the color scale.

Min Sets the minimum power level represented by the bottom of the color scale.

Time & Freq Scale Tab
The Time and Freq Scale tab allows you to change the vertical and horizontal scale settings, enable the 3-D Waterfall display, and set the
color scheme used for the spectrogram trace.
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Setting Description

Vertical (Time)

Normal For most Spectrogram applications. Primary time scale control is Time/div. Time scale can be zoomed
in or out.

Spectrum Monitor For long-term signal monitoring applications. In spectrum monitor mode, each line in the spectrogram
represents the period of time specified by the Time/update parameter. Time scale can be zoomed out,
but not zoomed in (no overlap).

Time/update Sets the time, in minutes and seconds, represented by each line of the spectrogram. Only available in
Spectrum Monitor.

Reset Scale Resets the Time/div and Pos settings to their default values.

Autoscale Scales the vertical (time) axis to compress all existing trace lines into the visible area of the graph.
Resets the Position value to zero, placing the most recent spectrogram line at the bottom of the
spectrogram display. Only Position is affected by Autoscale when Spectrum Monitor is selected.

Time/div Sets the time displayed per division.

Visible elapsed time Displays the length of time visible in the display. This does not represent the total time available to
view.

Position Adjusts vertical position of the trace within the graph area. Setting represents the offset, in divisions,
between the bottom of the graph and the bottom (most recent) line in the results trace.

Time at position Displays the time of the spectrogram line shown at the bottom of the graph. This time is relative to the
Time Zero Reference of the current acquisition.

Horizontal (Frequency)

Scale Sets the frequency range of the graph without changing the Span value.

Position Sets the frequency displayed at the center of the graph. Changing this value does not change the
Freq setting.

Autoscale Sets the frequency scale to the Spectrogram Span value.

Spectrum Monitor
Spectrum Monitor performs long term monitoring. The monitor mode compresses time into each line of the spectrogram, which enables
you to monitor long periods of time (from 1 second per line up to 600 minutes per line). You can capture up to 31,250 lines.

During each line's collection period, spectrum transforms are computed for each acquisition taken by the instrument. As each transform
completes, it is incorporated into the current spectrogram line. How each line of the spectrogram is created in spectrum monitor mode
depends on the detection setting (Settings > Trace). For example, if Detection is set to +Peak, each spectrogram line is effectively a peak
hold display of all the spectral data captured since the prior line.
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Amplitude Vs Time Display
The Amplitude vs. Time display plots the signal amplitude against time. The amplitude appears on the vertical axis while time is plotted
along the horizontal axis.

Note that the trace(s) in the Amplitude vs. Time display can be set to a maximum of 100,000 points (however, the actual number of trace
points can extend up to 1,000,000 points if Max trace points is set to Never Decimate). If the Analysis Length includes more than the
selected Max trace points value, the trace is decimated (using the method specified with the Detection control) to be equal to or less than
the Max trace points setting (except when Max trace points is set to Never Decimate). This decimated (or undecimated) trace is what is
used for marker measurements and for results export. You can set the Max trace points on the Settings > Prefs tab.

To show Amplitude vs. Time display:

1. Press the Displays button or select Setup > Displays.
2. In the Select Displays dialog, select General Signal Viewing in the Measurements box.
3. In the Available displays box, double-click the Amplitude vs. Time icon or select the icon and click Add. The Amplitude vs. Time icon

will appear in the Selected displays box and will no longer appear under Available displays.
4. Click OK.

Elements of the Display

Item Display element Description

1 Vertical scale adjustment Adjusts the vertical scaling.

2 Span Adjust the bandwidth of the data to be analyzed. (Not the period of time shown in the
display.)

3 Autoscale Adjusts the vertical and horizontal settings to provide the best display.

4 Offset Adjust the horizontal offset.

5 Max and Min readouts Displays the maximum and minimum amplitudes, as well as when those values occur.

6 Scale Sets the time spanned by the graph.

Table continued…

General Signal Viewing

SignalVu™ Vector Signal Analysis Software Printable Help 66



Item Display element Description

7 Clear button Restarts multi-trace functions (Avg, Hold).

8 Trace function Displays the current trace function setting (Settings > Trace tab > Function).

Reference. Changing Amplitude vs Time Display Settings

Amplitude Vs Time Settings
Main menu bar: Setup > Settings 

The settings for the Amplitude vs. Time display are shown in the following table.

Settings tab Description

Freq & BW Tab Sets the Bandwidth Method used for setting the measurement bandwidth.

Traces Tab on page 75 Allows you to select the type of trace to display and their functions.

Traces (Math) Sets the traces used to create the Math trace.

Scale Tab on page 80 Sets the vertical and horizontal scale parameters.

Prefs Tab on page 80 Specifies whether certain display elements are visible.

Freq & BW Tab
The Freq > BW (Bandwidth) tab allows you to specify the bandwidth parameters used for setting measurement bandwidth. This determines
what Acq BW the measurement will request. 

Settings Description

Time-domain Bandwidth filter Time-domain BW is a filter used to process the trigger input signal before the trigger system analyzes
the signal. The frequency edge trigger point must lie within the range of time domain bandwidth.
This makes the range of the frequency edge trigger = Center Frequency (Time Domain Bandwidth)
Measurement BW, no filter

Table continued…
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Settings Description

This control limits the bandwidth
of measurements. You use the
measurement bandwidth setting
to improve the signal-to-noise
ratio of the measurement,
resulting in lower measurement
uncertainty. However, if the
measurement bandwidth is set too
low, resulting in fewer samples
per second, it can reduce the
number of points within the
measurement length below the
256 stable samples required, thus
causing the analysis to fail.

Frequency Vs Time Display
The Frequency vs. Time Display shows how the signal frequency varies with time.

Note that the trace(s) in the Frequency vs. Time display can be set to a maximum of 100,000 points (however, the actual number of trace
points can extend up to 1,000,000 points if Max trace points is set to Never Decimate). If the Analysis Length includes more than the
selected Max trace points value, the trace is decimated (using the method specified with the Detection control) to be equal to or less than
the Max trace points setting (except when Max trace points is set to Never Decimate). This decimated (or undecimated) trace is what is
used for marker measurements and for results export. You can set the Max trace points on the Settings > Prefs tab.

To display the Frequency vs. Time Display:

1. Select the Displays button or Setup > Displays.
2. In the Select Displays dialog, select General Signal Viewing in the Measurements box.
3. In the Available displays box, double-click the Frequency vs. Time icon or select the icon and click Add. The Frequency vs. Time

icon will appear in the Selected displays box and will no longer appear under Available displays.
4. Click OK to display the Freq vs. Time display.
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Elements of the Display

Item Display element Description

1 Top of graph adjustment Use the knob to adjust the frequency range displayed on the vertical axis.

2 Offset adjustment Adjusts the frequency shown at the center of the display.

3 Autoscale button Adjusts the offset and range for both vertical and horizontal to provide the best display.

4 Maximum and Minimum
frequency readouts

Displays the maximum and minimum values, as well as when those values occur.

5 Horizontal Scale Sets the time spanned by the graph.

6 Clear button Restarts Average trace.

7 Trace function Displays the current trace function setting (Settings > Trace > Function).

Changing Frequency vs Time Display Settings

Frequency Vs Time Settings
Main menu bar: Setup > Settings 

The Setup settings for Frequency vs. Time are shown in the following table.

Settings tab Description

Freq & BW Sets the frequency and bandwidth parameters.

Table continued…
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Settings tab Description

Traces Sets the trace display parameters.

Scale Sets the Vertical and Horizontal scale and offset parameters.

Prefs Specifies whether certain display elements are visible.

Phase Vs Time Display
The Phase vs. Time display plots the signal phase against time. The phase appears on the vertical axis while time is plotted along the
horizontal axis.

Note that the trace(s) in the Phase vs. Time display can be set to a maximum of 100,000 points (however, the actual number of trace
points can extend up to 1,000,000 points if Max trace points is set to Never Decimate). If the Analysis Length includes more than the
selected Max trace points value, the trace is decimated (using the method specified with the Detection control) to be equal to or less than
the Max trace points setting (except when Max trace points is set to Never Decimate). This decimated (or undecimated) trace is what is
used for marker measurements and for results export. You can set the Max trace points on the Settings > Prefs tab.

To display Phase vs. Time:

1. Press the Displays button or select Setup > Displays.
2. In the Select Displays dialog, select General Signal Viewing in the Measurements box.
3. In the Available displays box, double-click the Phase vs. Time icon or select the icon and click Add. The Phase vs. Time icon will

appear in the Selected displays box and will no longer appear under Available displays.
4. Click OK to show the Phase vs. Time display.

Elements of the Display

Item Display element Description

1 Top of graph adjustment Adjusts the vertical scale. Use the knob to adjust the value of the top of the graph.

Table continued…
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Item Display element Description

2 Vertical offset adjustment Adjusts the phase error shown at the vertical center of the display.

3 Autoscale button Adjusts the vertical and horizontal settings so that the entire trace fits in the view.

4 Horizontal Offset Adjusts the horizontal position of the trace.

5 Max and Min readouts Displays the maximum and minimum value of the phase error within the analysis times
and the times at which they occurred.

6 Horizontal Scale Sets the time spanned by the graph.

7 Clear button Restarts multi-trace functions (Avg, Hold).

8 Trace function Shows the trace function as set on the Settings > Trace tab.

Changing the Phase vs Time Display Settings

Phase Vs Time Settings
Main menu bar: Setup > Settings 

The settings for the Phase vs. Time display are shown in the following table.

Settings tab Description

Freq & BW Sets the frequency and bandwidth parameters.

Traces Sets the trace display parameters.

Scale Sets the Vertical and Horizontal scale and offset parameters.

Prefs Specifies whether certain display elements are visible.

RF I & Q vs Time Display
This is a plot of the baseband In-Phase (I) and Quadrature (Q) components of a modulated carrier. The plot is in the time domain, with I
and/or Q values the Y-axis.

Note that the trace(s) in the RF I & Q vs. Time display can be set to a maximum of 100,000 points (however, the actual number of trace
points can extend up to 1,000,000 points if Max trace points is set to Never Decimate). If the Analysis Length includes more than the
selected Max trace points value, the trace is decimated (using the method specified with the Detection control) to be equal to or less than
the Max trace points setting (except when Max trace points is set to Never Decimate). This decimated (or undecimated) trace is what is
used for marker measurements and for results export. You can set the Max trace points on the Settings > Prefs tab.

To display an RF I & Q vs. Time display:

1. Select the Displays button or select Setup > Displays. This shows the Select Displays dialog box.
2. From the Measurements box, select General Signal Viewing.
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3. Double-click the RF I & Q vs. Time icon in the Available Displays box. This adds the RF I & Q vs. Time icon to the Selected displays
box.

4. Click the OK button.

Elements of the Display

Item Display element Description

1 Top of Graph adjustment Use the knob to adjust the vertical scaling.

2 Vertical offset adjustment Adjusts the level shown at the center of the display.

3 Autoscale button Adjusts the offset and scale for both vertical and horizontal to provide the best display.

4 Maximum and Minimum level
readouts

Displays the maximum and minimum values, within the Analysis Time, as well as the times
at which they occurred.

5 Scale Sets the time spanned by the graph.

6 Clear button Restarts multi-trace functions (Avg, Hold).

7 Trace function Displays the current trace function setting (Settings > Trace > Function). If the traces are
averaged, the number of averages is displayed.

8 Trace Control Selects which trace is displayed (using the drop-down list) and which trace is active (click
on the trace name to display a menu).

Changing the RF I & Q vs Time Display Settings

RF I & Q vs Time Settings
Main menu bar: Setup > Settings 
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The Setup settings for RF I&Q vs. Time are shown in the following table.

Settings tab Description

Freq & BW Tab Sets the frequency and bandwidth parameters.

Traces Sets the trace display parameters.

Scale Sets the Vertical and Horizontal scale and offset parameters.

Prefs Specifies whether certain display elements are visible.

Common Controls General Signal Viewing Shared Measurement Settings
The control panel tabs in this section are identical or very similar for each of the displays in the General Signal Viewing folder (Setup >
Displays). Some tabs are shared by all the displays, some tabs are shared by only a couple of displays.

For some tabs, the control values are shared across all the General Signal Viewing displays. For other control values, each display has
unique values for the controls. Details are provided for the specific tabs.

Table 8: Common controls for general signal viewing displays

Settings tab Description

Freq & Span Sets the frequency and span parameters.

Traces Sets the trace display parameters.

Traces – Math Sets the traces used to create the Math trace.

BW Sets the Bandwidth Method used for setting the measurement bandwidth.

Scale Sets the Vertical and Horizontal scale and offset parameters.

Prefs Specifies whether certain display elements are visible.

Freq & BW Tab — Freq vsTime, Phase vs Time, RF I & Q vs Time Display
The Freq & BW tab provides access to settings that control frequency settings for the Freq vs Time, Phase vs Time, RF I & Q vs Time
display.
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Setting Description

Measurement Freq The frequency at the which measurements are made. This value is the same as the setting for
Frequency in the Application bar.

Measurement BW This control limits the bandwidth of measurements. You use the measurement bandwidth setting to
improve the signal-to-noise ratio of the measurement, resulting in lower measurement uncertainty.
However, if the measurement bandwidth is set too low, resulting in fewer samples per second, it can
reduce the number of points within the measurement length below the 256 stable samples required,
thus causing the analysis to fail.

Link to Span When enabled, the measurement bandwidth of the RF I & Q display is determined by the span of the
analyzer. When unchecked, the measurement bandwidth is specified by the user, and no additional
filter is applied.

Set to max BW Sets the measurement bandwidth to the maximum acquisition bandwidth of the instrument.

Freq & Span Tab
The Freq & Span tab provides access to settings that control frequency settings for the trace display. The control values set in this tab are
shared by all the General Signal Viewing displays.

Setting Description

Frequency The frequency at the center of the selected span.

Start The lowest frequency in the span.

Stop The highest frequency in the span.

Span The difference between the start and stop frequencies. This is the measurement bandwidth for the
general signal viewing displays.

Step Size Sets the increment/decrement size for Frequency, Start, and Stop values.

Dwell time (DPX display only) The amount of time the DPX sweep remains in a frequency segment collecting data and updating the
bitmap and traces before moving on to the next higher frequency segment. The minimum Dwell Time
setting is 50 ms, the normal update rate for DPX computations. Maximum Dwell Time per frequency
segment is 100 s. The number of frequency segments and their start/stop frequencies are internally
determined based on span, acquisition bandwidth, RBW, and other parameters.

Table continued…
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Setting Description

Max Span Sets the span to the maximum value.

Auto checkbox Sets the Step Size and Dwell time automatically when checked.

Frequency, Start, Stop, and Span frequencies are correlated
Changing the values for center frequency, start frequency, stop frequency or span will change the values for the other settings,
depending on which setting you change. For example, if you change the center frequency, the start and stop frequencies will be adjusted
automatically to maintain the same span.

If, however, the start and stop frequencies are changed so that they are closer than the minimum span setting, the start and stop
frequencies will be adjusted to maintain the minimum span setting.

Setting changed manually Settings changed automatically as a result Setting not automatically changed

Start Center, Span Stop

Stop Center, Span Start

Center Frequency Start, Stop Span

Span Start, Stop Center

Traces Tab
The Traces Tab allows you to set the display characteristics of displayed traces.

Setting Description

Trace Selects a trace. (This setting is not present for every display.)

Show Shows / hides the selected trace.

Detection Sets the Detection method used for the trace. Not available for saved traces. Available detection
methods are +Peak, -Peak, +/-Peak, Avg (VRMS), Sample, CISPR Avg, CISPR Pk, and CISPR QPk.
Not all detection methods are available in all displays.

(CISPR detection requires Option SVQPNL or SVQPFL.)

Function Selects the trace processing method. Available settings are: Normal, Average, Max Hold, and Min
Hold.

Table continued…
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Setting Description

Count Sets the number of traces averaged to generate the displayed trace. (Present only when Function is
set to Average, Min Hold, or Max Hold.)

Freeze Halts updates to the selected trace.

Save Trace As Saves the selected trace to a file for later recall and analysis.

Show Recalled trace Displays a saved trace instead of a live trace. When a trace is recalled, controls such as show, freeze,
function, and detection of trace will be disabled.

Trace
Available traces for Spectrum are: Trace 1, Trace 2, Trace 3, Math, and Spectrogram. Other displays support fewer traces. Traces 1-3 are
based on the input signal and enable you to display the input signal using different processing. For example, you could display Trace 1 with
Function set to Normal, Trace 2 with Function set to Max Hold and Trace 3 with Function set to Min Hold.

The Math trace is the result of subtracting one trace from another.

The Spectrogram trace applies only to the Spectrum display and is available only if the Spectrogram display is shown. The Spectrogram
trace shows the trace selected in the Spectrogram as a spectrum trace.

Detection

Trace Detection is used to reduce the results of a measurement to the desired number of trace points. For example, if the maximum
number of trace points is 100,000, and a measurement over the selected analysis length yields 200,000 points, the measurement must
decimate these 200,000 trace points by 2 to prevent exceeding the 100,000 trace point limit. Since only one value can be represented for
each trace point, an algorithm must be used to select (detect) the appropriate value to use.

The results array from an analysis can be detected (or “decimated”) in a variety of ways. The number of results points produced for each
trace point varies with both analysis length and trace length. For example, the frequency transform used for the Spectrum display produces
just one output value for each desired trace point. In this case, the detection method chosen has no effect, as no decimation is required.
Increasing the Analysis Length (or for the Spectrum display, the Spectrum Length), causes the available detection method's output traces
to differ from each other because they have a larger set of samples for the various detection methods to process.

The available detection methods (depending on the display) are:

• +Peak – The highest value is selected from the results to be compressed into a trace point.
• -Peak – The lowest value is selected from the results to be compressed into a trace point.
• +/-Peak – Both the highest and lowest values are selected from the results to be compressed into a trace point.
• Avg (VRMS) [Average VRMS] – Each point on the trace is the result of determining the RMS Voltage value for all of the results values it

includes. When displayed in either linear (Volts, Watts) or Log (dB, dBm), the correct RMS value results.
• Avg (of logs) – The detector is used to emulate legacy spectrum analyzer results and for the specification of displayed average noise

level. In older swept analyzers, a voltage envelope detector is used in the process of measuring signal level, and the result is then
converted to Watts and then to dBm. Averaging is then applied to the resultant traces.

For CW signals, this method results in an accurate power measurement. However, with random noise and digitally modulated carriers,
errors result from this 'average of logs' method. For random noise, the average of logs methods results in power levels -2.51 dB lower
than that measured with a power meter, or with a signal analyzer that measures the rms value of a signal, and performs averaging on
the calculated power in Watts and not dBm or other log-power units.

This detector should be used when following a measurement procedure that specifies it, or when checking the Displayed Averaged
Noise Level (DANL) of the instrument. The 'average of logs' detection and trace function is used for DANL specification to provide
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similar results to other spectrum/signal analyzers for comparison purposes. Use of the Average of Logs method of measurement is not
recommended for digitally modulated carriers, as power measurement errors will occur.

Note: The Detection setting does not affect the trace until the spectrum length is longer than the Auto setting.

• Sample – The first value is selected from the set of results to be compressed into a trace point.
• CISPR Peak – The trace value is calculated by the methods described for peak detectors in the CISPR documents.
• CISPR QPk – The trace value is calculated by the methods described for quasi peak detectors in the CISPR documents.

(Requires Option SVQPNL or SVQPFL.)
• CISPR Avg – The trace value is calculated by the methods described for average detectors in the CISPR documents.

(Requires Option SVQPNL or SVQPFL.)

Trace Processing
Traces can be processed to display in different ways. The Function setting controls trace processing.

• Normal - Each new trace is displayed and then replaced by the next trace. Each data point contains a single vertical value.
• Average - Multiple traces are averaged together to generate the displayed trace, which will contain just one vertical value for each

underlying frequency data point. Once the specified number of traces have been acquired and averaged to generate the displayed
trace, additional traces contribute to the running average, except in Single Sequence run mode. In the case of Single Sequence, the
instrument stops running after the specified number of traces have been averaged together. The Number of Traces setting specifies
how many traces are averaged. The averaging is performed on the linear (Voltage) values, resulting in the correct RMS average).

• Max Hold - Displays the maximum value in the trace record for each display point. Each new trace's display point is compared to the
previous maximum value and the greater value is retained for display and subsequent comparisons.

• Min Hold - Displays the minimum value in the trace record for each display point. Each new trace's display point is compared to the
previous minimum value and the lesser value is retained for display and subsequent comparisons.

Saving Traces
To save a trace for later analysis:

1. Select the Save Trace As button. This displays the Save As dialog box.
2. Navigate to the desired folder or use the default.
3. Type a name for the saved trace and click Save.

Recalling Traces
You can recall a previously saved trace for analysis or comparison to a live trace.

To select a trace for recall:

1. Select the trace into which the recalled trace will be loaded, from the Trace drop-down list.
2. Check the Show check box.
3. Click the ... button to display the Open dialog box.

4. Navigate to the desired file and click Open.
5. Check the Show Recalled Trace check box.
6. Verify that the trace's Show check box is selected (either on this tab or next to the drop-down list located at the top-left corner of the

graph).
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Traces tab - Math Trace
This tab is not a distinct tab, it is just how the Traces tab appears when Math is selected in the Traces drop-down list. 

Trace 4 is a mathematically-derived trace defined as Trace A minus Trace B. You can select Trace 1, 2, or 3 to serve as either Trace A or
Trace B.

Setting Description

Trace When set to Trace 4 (Math), this tab is displayed.

Show Shows / hides the selected trace.

Freeze Halts updates to the selected trace.

Save Trace As Saves the selected trace to a file for later recall and analysis.

Trace minus Trace Selects which traces serve as Trace A and Trace B.

BW Tab
The BW (bandwidth) tab allows you to change Resolution Bandwidth and Video Bandwidth settings, and set the windowing method used
by the transform process by selecting a filter shape (not present for all displays).

Setting Description

RBW Sets the Resolution Bandwidth value to be used in the spectrum analysis view. The value is italicized
when Auto is selected.

Auto When Auto is checked, the RBW is calculated as a percentage of the Span. Kaiser is selected as
the windowing method. When Auto is unchecked, the RBW is set by the user. Selecting any Window
other than Kaiser changes the RBW setting to manual.

Span/RBW ratio If Auto is checked, this value is used to calculate the RBW. If Auto is unchecked, this setting is not
selectable.

Table continued…
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Setting Description

Filter Shape Specifies the windowing method used for the transform (when Auto is unchecked). (Spectrum and
Spectrogram displays only.)

VBW Adjusts the VBW (Video Bandwidth) value. (Spectrum and Spectrogram displays only.)

Filter shape settings
In the analyzer, computationally efficient discrete Fourier transform algorithms such as FFT (Fast Fourier Transform) or CZT (Chirp-Z
Transform) are generally employed to transform time-domain signals into frequency-domain spectra. There is an assumption inherent
in the mathematics of Discrete Fourier Transforms that the data to be processed is a single period of a periodically repeating signal.
The discontinuities between successive frames will generally occur when the periodic extension is made to the signal. These artificial
discontinuities generate spurious responses not present in the original signal, which can make it impossible to detect small signals in the
presence of nearby large ones. This phenomenon is called spectral leakage.

Applying a filter, such as Kaiser, to the signal to be transformed is an effective method to combat the spectral leakage problem. Generally
the filter has a bell shape. Multiplying the transform frame by the filter function eliminates or reduces the discontinuities at the ends of the
frame, however, at the expense of increased RBW.

Filter shape characteristics
The choice of filter shape depends on its frequency response characteristics such as side-lobe level, equivalent noise bandwidth and
maximum amplitude error. Use the following guidelines to select the best filter shape.

Filter Shape Characteristics

Kaiser (RBW) Best side-lobe level, shape factor closest to the traditional Gaussian RBW.

-6dB RBW (MIL) These filters are specified for bandwidth at their -6 dB point, as required by military EMI regulations.

CISPR These filters comply with the requirements specified in the P-CISPR 16 -1-1 document for EMI
measurements.

Blackman-Harris 4B Good side-lobe level.

Uniform (None) Best frequency resolution, poor side-lobe level and amplitude accuracy.

Flat-Top (CW ampl) Best amplitude accuracy, best representation of brief events captured near the beginning or end of the
time-domain data frame, poor frequency resolution.

Hanning Good frequency resolution, high side-lobe roll-off rate.

VBW
The VBW setting enables/disables the Video Bandwidth filter. VBW is used in traditional swept analyzers to reduce the effect of noise on
the displayed signal. The VBW algorithm in the analyzer emulates the VBW filters of traditional swept analyzers.

The maximum VBW value is 10 times the current RBW setting. The minimum VBW value is 1/10,000 of the RBW setting. VBW is disabled
when the Filter shape is set to CISPR.

Note: If you are following a procedure that says to "set VBW to three times the RBW value or greater", it means that the test
should be conducted with no VBW effects. In the SignalVu-PC software, this condition is met by disabling the VBW function.
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Scale Tab
The Scale tab allows you to change the vertical and horizontal scale settings. Changing the scale settings changes how the trace appears
on the display but does not change control settings such as Measurement Frequency. In effect, these controls operate like pan and zoom
controls.

The Scale tab values are unique to each display. Also, note that each display uses horizontal and vertical units that are appropriate for
the display. For example, for the Spectrum display uses power (dBm) units and frequency (Hz) units; the Amplitude vs. Time display uses
power (dBm) and time (seconds) units; and the Phase vs. Time display uses phase (degrees) and time (seconds) units.

Setting Description

Vertical Controls the vertical position and scale of the trace display.

Scale Changes the vertical scale.

Position Vertical position adjusts the reference level away from top of the graph.

Autoscale Resets the scale of the vertical axis to contain the complete trace.

Horizontal Controls the horizontal position and scale of the trace span of the trace display and position of the
trace.

Scale Changes the range shown between the left and right sides of the graph.

Position Changes the position of the acquisition record shown at the left edge of the graph.

Reset Scale Resets all settings to their default values.

Prefs Tab
The Prefs tab enables you to change parameters of the measurement display. The parameters available on the Prefs tab vary depending
on the selected display, but include such items as enabling/disabling marker Readout and switching the Graticule display on/off.

Each of the General Signal Viewing displays maintains its own separate values for the controls that appear on the Prefs tab. Some
parameters appear with most displays while others appear with only one display.

For example, in the following image, the Show Marker readout in graph check box appears in the Prefs tab for every display. However, the
Show Power Trigger level check box only appears on the Amplitude vs Time Prefs tab.
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The following image shows the Prefs tab for the Time Overview display.

The following image shows the Prefs tab for the DPX display when DPXogram or Split is the selected view.

The following image shows the Prefs tab for the DPX display when Spectrum is the selected view.

The following table explains the controls that can appear on the Prefs tab.

Setting Description

Show Sets the horizontal settings that appear below the graph area. You can select Start, Stop or Center,
Span.

Trace points Sets the number of trace points used for marker measurements and for results export.

Table continued…
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Setting Description

Max trace points

(Time Overview display only)

Sets the maximum number of trace points used for marker measurements and for results export.

Show trace legend Enables display of a legend in the measurements area that shows the Detection method and Function
setting for displayed traces. The color of the legend text matches the color of the associated trace.

Show graticule Check to display the graticule. Uncheck to hide the graticule.

Navigator View

(Time Overview display only)

Places the Time Overview display across the top of the application window, above all other active
displays.

Show parameter readouts For the DPX display, enables/disables the display of DPX parameters. The parameters readout shows
100% Probability of Intercept, Transforms/s, and FFT Points.

For the Spectrum display, enables/disables display of Sweep speed and FFT Points.

Note: Using the Cable Loss, RL/DTF, or Transmission Gain displays at the same time as
the Spectrum display can cause the sweep speed in Spectrum to be reduced. Closing the
non-Spectrum display will return the sweep speed to the correct speed.

Show Marker readout in graph
(selected marker)

Shows or hides the readout for the selected marker in the graph area.

Show timestamp in graph
(selected line)

For spectrogram displays, this readout shows or hides the timestamp associated with the selected line
or marker position.

DPX shows only trigger frames For the DPX Spectrum display, check to show only trigger frames.

Show Power Trigger Level Displays or hides a green line in the graph that indicates the level at which the power trigger is set.
The line is not displayed if Trigger is set to Free Run.

Show parameter readouts for DPX Spectrum
The elements of the Show parameter readouts are:

100% POI
This is the minimum event duration required to ensure 100% Probability of Intercept or event capture. This duration depends on interaction
between span, RBW, and FFT length. You can use the POI time value to determine if you are at risk of either missing a narrow transient or
of its captured amplitude being less than the actual signal.
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Table 9: Minimum signal duration for 100% probability of trigger at 100% amplitude

Frequency-Mask and DPX signal processing

Minimum signal duration, 100% probability of
intercept, Frequency-Mask and DPX density
trigger (μs)

Span RBW (kHz) FFT length Spectrums/sec Standard

Full amplitude -3 dB

165 MHz 20000 1024 390,625 15.5 15.4

10000 1024 390,625 15.6 15.4

1000 1024 390,625 17.8 15.7

300 2048 195,313 23.4 16.3

100 8192 48,828 44.5 23.4

30 32768 12,207 161.9 91.7

85 MHz 10000 1024 390,625 15.6 15.4

1000 1024 390,625 17.8 15.7

500 1024 390,625 20.2 15.9

300 1024 390,625 23.4 16.3

100 4096 97,656 44.5 23.4

30 16384 24,414 121.0 50.7

20 16384 24,414 161.0 55.6

40 MHz 5000 1024 390,625 15.8 15.4

1000 1024 390,625 17.8 15.7

300 1024 390,625 23.3 16.3

100 2048 195,313 39.4 18.3

30 4096 97,656 90.4 21.8

20 8192 48,828 140.7 36.3

10 16384 24,414 281.3 72.6

Table continued…
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Frequency-Mask and DPX signal processing

Minimum signal duration, 100% probability of
intercept, Frequency-Mask and DPX density
trigger (μs)

Span RBW (kHz) FFT length Spectrums/sec Standard

Full amplitude -3 dB

25 MHz 3800 1024 390,625 16.0 15.4

1000 1024 390,625 17.7 15.7

300 1024 390,625 23.4 16.3

200 1024 390,625 27.4 16.8

Transforms/s
This is the number of transforms/second being performed by the DPX engine. It is a function of the selected resolution bandwidth and
number of trace points. The desired RBW determines the number of points required in each transform, which alters the transform rate.
Additionally, the selected trace length may place requirements on the number of points required in the transform independent of the
selected resolution bandwidth.

FFT Points
The approximate number of points in the FFT of the input signal. FFT points provides an indication of frequency resolution, but it is not an
exact measurement. Note that higher numbers for FFT points mean that the instrument is taking a longer string of input samples for each
FFT, which decreases the time resolution.

Table 10: Minimum FFT length versus trace length - independent of span and RBW

Trace length (points) Minimum FFT length

801 1,024

2,401 4,096

4,001 8,192

10,401 16,384
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Analog Modulation
Overview
The displays in Analog Modulation (Displays > Measurements > Analog Modulation) are:

• AM
• FM
• PM

The Analog Modulation displays provide measurements and time-domain trace displays.

AM Display
The Amplitude Modulation Display is a graph of Modulation Factor vs Time. The AM display includes three numeric readouts. 

To show the AM display:

1. Select the Displays button or select Setup > Displays. This shows the Select Displays dialog box.
2. From the Measurements box, select Analog Modulation.
3. Double-click the AM icon in the Available Displays box. This adds the AM icon to the Selected displays box.
4. Click the OK button. This shows the AM display.

Elements of the Display

Item Element Description

1 Check mark indicator The check mark indicator in the upper, left-hand corner of the display shows when the AM
display is the optimized display.

Note: When Best for multiple windows is selected in the Amplitude control
panel's RF & IF Optimization control, none of the measurement displays shows a
checkmark, as there is not a single optimized measurement.

Table continued…
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Item Element Description

2 Top of Graph Sets the %AM indicated at the top of the graph by increasing or decreasing the vertical
scale. Changing the top value affects the bottom of graph value because the graph scales
about vertical center. Also, note that the top of graph setting interacts with the internal
vertical scale setting (which is not user settable).

3 Position Specifies the %AM shown at the center of the graph display.

4 Bottom Readout Displays the value of the modulation factor shown at the bottom of graph.

5 Measurement readouts Displays numeric values for the +AM (positive modulation factor), –AM (negative
modulation factor), and Total AM.

6 Position Specifies the horizontal position of the trace on the graph display.

7 Scale Adjusts the horizontal range of the graph. By decreasing the scale (time across the entire
graph), the graph essentially becomes a window that you can move over the trace by
adjusting the position.

8 Clear Erases the trace from the graph.

9 Trace Detection readout Displays the Settings > Trace > Detection setting.

Changing the AM Settings

AM Settings
Main menu bar: Setup > Settings 

The AM Settings control panel provides access to settings that control parameters of the AM Display.

Setting Description

Parameters Sets the Carrier Amplitude Detection method. You can choose either Average or Median.

Trace Sets Trace display parameters.

Scale Sets vertical and horizontal scale and position parameters.

Prefs Specifies whether or not certain display elements are shown. Specifies the maximum number of
points shown in the display graph.
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Parameters Tab
The Parameters tab enables you to specify two parameters that control the carrier amplitude detection.

Setting Description

Average Selects the Average method for computing the average baseline for measurements.

Median Selects the Median method for computing the average baseline for measurements.

Measurement BW Specifies the bandwidth about the center frequency at which measurements are made.

AM Modulation
An amplitude modulated carrier can be described mathematically by:

A, in the above equation, represents the carrier amplitude, a(t) represents the time-varying modulation and ω0 represents the carrier
frequency.

The signal modulation envelope is given by:

There are several ways to express the AM modulation depth, expressed as a percentage.

Peak method

Trough Method

Max-Min Method

In each case, the value of the carrier amplitude, A, needs to be estimated from the input signal.

The instrument represents signals in a sampled form. The sampled envelope can be expressed as a function of sample index K and
sampling period T as:
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The instrument allows the choice of two methods for estimating the carrier amplitude:

Average Method

Median Method

In both cases, the instrument computes the average and the median over the analysis period. It should be noted that the two methods give
the same result for sinusoidal modulation where the sampling frequency is much higher than the modulation frequency.

Trace Tab
The Trace Tab allows you to set the display characteristics of a trace.

Setting Description

Show Shows/hides the trace. If the instrument continues to run, the measurement results below the graph
display continue to update even if the trace is hidden.

Detection Sets the Detection method used for the trace. Available detection methods are +Peak, -Peak, and
Avg (VRMS). Not available for saved traces.

Function Selects the trace processing method. The only available setting is Normal.

Freeze Halts updates to the trace.

Save Trace As Saves the trace to a file for later recall and analysis.

Show recalled trace Displays a saved trace instead of a live trace.

Detection

Detection refers to the method of processing the data acquisition points when creating a trace. The IQ samples in a data acquisition can be
detected in a variety of ways. The number of IQ samples available to each trace point varies with both analysis length and trace length. For
example, with Spectrum Length set to ‘Auto’ in the Analysis menu, the instrument analyzes just enough samples to produce one IQ sample
pair per trace point. In this case, the detection method chosen has very little effect, as the +Peak, -Peak, and Avg (VRMS) are all equal.
Changing the Spectrum Length causes the available detection methods to differ in value because they have a larger set of samples for the
various detection methods to process.
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The available detection methods are:

• +Peak – Each point on the trace is the result of detecting the positive peak value present in the set of IQ samples available to that
trace point.

• -Peak – Each point on the trace is the result of detecting the negative peak value present in the set of IQ samples available to that
trace point.

• Avg (VRMS) [Average VRMS] – Each point on the trace is the result of determining the RMS Voltage value for all of the IQ samples
available to the trace point. When displayed in either linear (Volts, Watts) or Log (dB, dBm), the correct RMS value results. When the
averaging function is applied to a trace, the averaging is performed on the linear (Voltage) values, resulting in the correct average for
RMS values.

Trace Processing
Traces can be processed to display in different ways. The Detection setting controls trace decimation, when needed. When the trace points
each cover more than one sample data point, the vertical results values for multiple data points are combined into each trace point. Each
trace point ends up with a single vertical value.

• Average - Each trace point is computed by averaging together the multiple results points it represents.
• +Peak - Each trace point represents the highest vertical value among the results it includes.
• –Peak - Each trace point represents the lowest vertical value among the results it includes.

Saving Traces
To save a trace for later analysis:

1. Select the Save Trace As button. This displays the Save As dialog box.
2. Navigate to the desired folder or use the default.
3. Type a name for the saved trace and click Save.

Recalling Traces
You can recall a previously saved trace for analysis or comparison to a live trace.

To select a trace for recall:

1. Click the ... button to display the Open dialog box.
2. Navigate to the desired file and click Open.
3. Check the Show Recalled Trace check box.
4. Verify that the Show check box is selected.

Scale Tab
The Scale tab allows you to change the vertical and horizontal scale settings. Changing the scale settings changes how the trace appears
on the display but does not change control settings such as Measurement Frequency. In effect, these controls operate like pan and zoom
controls.
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Setting Description

Vertical

Scale Changes the range shown between the top and bottom of the graph.

Position Adjusts the level shown at the center of the graph.

Autoscale Resets the Position so that the entire trace is in the graph.

Horizontal

Scale Changes the range shown between the left and right sides of the graph.

Position Adjusts the position of the acquisition record shown at the left edge of the graph.

Autoscale Resets the Scale and Position settings to provide the optimum display.

Prefs Tab
The Prefs tab enables you to change appearance characteristics of the AM display.

Setting Description

Show graticule Shows or hides the graticule.

Show Marker readout in graph
(selected marker)

Shows or hides the readout for the selected marker in the graph area.

Max trace points The trace in the AM display can be set to a maximum of 100,000 points (however, the actual number
of trace points can extend up to 500,000 points if Max trace points is set to Never Decimate). If the
Analysis Length includes more than the selected Max trace points value, the trace is decimated (using
the method specified with the Detection control) to be equal to or less than the Max trace points
setting (except when Max trace points is set to Never Decimate). This decimated (or undecimated)
trace is what is used for marker measurements and for results export.

FM Display
The Frequency Modulation Display shows Frequency Deviation vs. Time. The vertical axis units are Hertz and the horizontal axis units are
seconds. When taking measurements, only the first burst in the Analysis period is analyzed. No trace points are shown for data outside the
first detected burst, nor are measurements made on data outside the first detected burst.

To show the FM display:
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1. Select the Displays button or select Setup > Displays. This shows the Select Displays dialog box.
2. From the Measurements box, select Analog Modulation.
3. Double-click the FM icon in the Available Displays box. This adds the FM icon to the Selected displays box.
4. Click the OK button. This shows the FM display.

Elements of the Display

Item Element Description

1 Check mark indicator The check mark indicator in the upper, left-hand corner of the display shows when the FM
display is the optimized display.

Note: When Best for multiple windows is selected in the Amplitude control
panel's RF & IF Optimization control, none of the measurement displays shows a
checkmark, as there is not a single optimized measurement.

2 Top of Graph control Sets the frequency indicated at the top of the graph. Since the Position value at the
vertical center of this graph remains constant as the Top of Graph value is adjusted,
the Vertical Scale increases as the Top of Graph value increases, which also affects the
bottom of graph readout. Vertical Scale can also be controlled from the Settings control
panel's Scale tab.

3 Position Specifies the frequency shown at the center of the graph display. Changing this value
moves the trace up and down in the graph, which affects the Top of Graph and Bottom of
Graph values as well.

4 Bottom of Graph Readout Displays the frequency value at the bottom of the graph.

5 Measurement readouts Displays numeric values for the +Pk (positive frequency deviation), –Pk (negative
frequency deviation), RMS (RMS value of the deviation), Pk-Pk (peak-to-peak frequency
deviation), and Pk-Pk/2 (peak-to-peak frequency deviation divided by two).

6 Position Specifies the horizontal position of the trace on the graph display.

Table continued…
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Item Element Description

7 Scale Adjusts the time range of the graph. By decreasing the scale (full-scale time over
10 divisions), the graph essentially becomes a window that you can move over the
acquisition record by adjusting the horizontal position.

8 Clear Clears the trace and numeric measurement results.

9 Trace Detection readout Displays the Settings > Trace > Detection setting.

10 Freq Error This readout can show Freq Error or Freq Offset. When it displays Freq Error, it shows
the difference between the instrument Frequency setting and the measured value of the
signal's carrier frequency. When it displays Freq Offset, it shows the frequency offset
specified on the Settings > Parameters tab. If Freq Error is displayed, it also indicates that
the Carrier frequency detection setting is Auto. If Freq Offset is displayed, it indicates that
the Carrier frequency detection setting is manual.

Changing the FM Settings

FM Settings
Main menu bar: Setup > Settings 

The FM Settings control panel provides access to settings that control parameters of the FM Display.

Setting Description

Parameters Sets the burst detection threshold, measurement bandwidth, and carrier frequency detection method.

Trace Sets Trace display parameters.

Scale Sets vertical and horizontal scale and position parameters.

Prefs Specifies whether or not certain display elements are shown. Specifies the maximum number of
points shown in the display graph.

Parameters Tab
The Parameters tab enables you to specify parameters for carrier detection. 
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Setting Description

Burst detect threshold This parameter specifies the power level used to determine whether a burst is present. A valid burst
is required to take measurements. The burst detected first is used for the analysis. The units for burst
detect threshold are dBc, relative to the maximum acquisition sample data points level.

Measurement BW Specifies the bandwidth about the center frequency at which measurements are made.

Frequency offset Displays the carrier signal's offset from the instrument's measurement frequency. Auto is used to
select the method for determining the carrier frequency. When Auto is selected, the instrument
determines the carrier frequency by analyzing the signal. When Auto is deselected, you can set the
carrier frequency offset using Frequency Offset.

Load from Marker Pressing this button sets the frequency offset to the frequency offset of the selected marker. (Pressing
this button automatically deselects Auto.)

Frequency Offset
In Auto (Auto is selected), the instrument scans the measurement bandwidth about the measurement frequency and looks for the
highest-powered signal. This is defined as the carrier frequency. In Manual (Auto is deselected), the carrier frequency is specified by
adding/subtracting the specified Frequency offset from the measurement frequency. Range: -(Measurement BW*1.1)/2 to +(Measurement
BW*1.1)/2. If the Load from Marker button is pressed, the frequency offset is determined from the phase difference between the two
markers on screen compared to the time between the two markers. This function is useful for removing frequency slope from the phase
modulated signal.

Load from Marker
When the Auto check box is selected, the instrument scans the measurement bandwidth about the center frequency and looks for the
highest-powered signal. This is defined as the carrier frequency. When the Auto check box is deselected, the carrier frequency is specified
by adding/subtracting the specified Frequency offset from the center frequency. Pressing the Load from Marker button loads the marker
frequency into the Frequency offset box.

Trace Tab
The Trace Tab allows you to set the display characteristics of displayed traces.
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Setting Description

Show Shows / hides the trace. If the instrument continues to run, the measurement results below the graph
display continue to update even if the trace is hidden.

Detection Sets the Detection method used for the trace. Available detection methods are +Peak, -Peak, and
Avg (VRMS). Not available for saved traces.

Function Selects the trace processing method. The only available setting is Normal.

Freeze Halts updates to the trace.

Save Trace As Saves the trace to a file for later recall and analysis.

Show Recalled trace Displays a saved trace instead of a live trace.

Detection

Detection refers to the method of processing the data acquisition points when creating a trace. The IQ samples in a data acquisition can be
detected in a variety of ways. The number of IQ samples available to each trace point varies with both analysis length and trace length. For
example, with Spectrum Length set to ‘Auto’ in the Analysis menu, the instrument analyzes just enough samples to produce one IQ sample
pair per trace point. In this case, the detection method chosen has very little effect, as the +Peak, -Peak, and Avg (VRMS) are all equal.
Changing the Spectrum Length causes the available detection methods to differ in value because they have a larger set of samples for the
various detection methods to process.

The available detection methods are:

• +Peak – Each point on the trace is the result of detecting the positive peak value present in the set of IQ samples available to that
trace point.

• -Peak – Each point on the trace is the result of detecting the negative peak value present in the set of IQ samples available to that
trace point.

• Avg (VRMS) [Average VRMS] – Each point on the trace is the result of determining the RMS Voltage value for all of the IQ samples
available to the trace point. When displayed in either linear (Volts, Watts) or Log (dB, dBm), the correct RMS value results. When the
averaging function is applied to a trace, the averaging is performed on the linear (Voltage) values, resulting in the correct average for
RMS values.

Trace Processing
Traces can be processed to display in different ways. The Function setting controls trace processing.

• Normal - Each new trace is displayed and then replaced by the next trace. Each data point contains a single vertical value.
• Average - Each trace point is computed by averaging together the multiple results points it represents.
• +Peak - Each trace point represents the highest vertical value among the results it includes.
• –Peak - Each trace point represents the lowest vertical value among the results it includes.

Saving Traces
To save a trace for later analysis:

1. Select the Save Trace As button. This displays the Save As dialog box.
2. Navigate to the desired folder or use the default.
3. Type a name for the saved trace and click Save.
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Recalling Traces
You can recall a previously saved trace for analysis or comparison to a live trace.

To select a trace for recall:

1. Click the ... button to display the Open dialog box.
2. Navigate to the desired file and click Open.
3. Check the Show Recalled Trace check box.
4. Verify that the Show check box is selected.

Scale Tab
The Scale tab allows you to change the vertical and horizontal scale settings. Changing the scale settings changes how the trace appears
on the display but does not change control settings such as Measurement Frequency. In effect, these controls operate like pan and zoom
controls.

Setting Description

Vertical

Scale Changes the range shown between the top and bottom of the graph.

Position Adjusts the frequency shown at the center of the graph.

Autoscale Resets the Position so that the entire trace fits within the graph.

Horizontal

Scale Changes the range shown between the left and right sides of the graph.

Position Adjusts the position of the acquisition record shown at the left edge of the graph.

Autoscale Resets the Scale and Position settings to provide the optimum display.

Prefs Tab
The Prefs tab enables you to change appearance characteristics of the FM display.
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Setting Description

Show graticule Shows or hides the graticule.

Show Marker readout in graph
(selected marker)

Shows or hides the readout for the selected marker in the graph area.

Max trace points The trace in the FM display can be set to a maximum of 100,000 points (however, the actual number
of trace points can extend up to 500,000 points if Max trace points is set to Never Decimate). If the
Analysis Length includes more than the selected Max trace points value, the trace is decimated (using
the method specified with the Detection control) to be equal to or less than the Max trace points
setting (except when Max trace points is set to Never Decimate). This decimated (or undecimated)
trace is what is used for marker measurements and for results export.

PM Display
The Phase Modulation Display shows Phase vs. Time. The vertical axis units are degrees and the horizontal axis units are seconds. When
taking measurements, only the first burst in the Analysis period is analyzed. No trace points are shown for data outside the first detected
burst, nor are measurements made on data outside the first detected burst.

Elements of the Display
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Item Element Description

1 Check mark indicator The check mark indicator in the upper, left-hand corner of the display shows when the PM
display is the optimized display.

Note: When Best for multiple windows is selected in the Amplitude control
panel's RF & IF Optimization control, none of the measurement displays shows a
checkmark, as there is not a single optimized measurement.

2 Top of Graph control Sets the phase value indicated at the top of the graph. Since the Position value at the
vertical center of this graph remains constant as the Top of Graph value is adjusted,
the Vertical Scale increases as the Top of Graph value increases, which also affects the
bottom of graph readout. Vertical Scale can also be controlled from the Settings control
panel's Scale tab.

3 Position Specifies the phase shown at the center of the graph display. Changing this value moves
the trace up and down in the graph, which affects the Top of Graph and Bottom of Graph
values as well.

4 Bottom of Graph Readout Displays the phase value at the bottom of the graph.

5 Measurement readouts Displays numeric values for the +Pk (positive phase deviation), –Pk (negative phase
deviation), Pk-Pk (peak-to-peak phase deviation), and RMS (RMS value of the phase
deviation).

6 Position Specifies the horizontal position of the trace on the graph display.

7 Scale Adjusts the time range of the graph. By decreasing the scale (full-scale time over
10 divisions), the graph essentially becomes a window that you can move over the
acquisition record by adjusting the horizontal position.

8 Clear Clears the measurement results.

9 Trace Detection readout Displays the Trace Detection setting (see Settings > Trace > Detection).

10 Freq Error This readout can show Freq Error or Freq Offset. When it displays Freq Error, it shows
the difference between the instrument Frequency setting and the measured value of the
signal's carrier frequency. When it displays Freq Offset, it shows the frequency offset
specified on the Settings > Parameters tab. If Freq Error is displayed, it also indicates that
the Carrier frequency detection setting is Auto. If Freq Offset is displayed, it indicates that
the Carrier frequency detection setting is manual.

Changing the PM Settings

PM Settings
Main menu bar: Setup > Settings

The PM Settings control panel provides access to settings that control parameters of the PM Display.
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Setting Description

Parameters Sets the Carrier Frequency Detection method. You can choose either Automatic or Manual. Sets burst
threshold and phase detection method.

Trace Sets Trace display parameters.

Scale Sets vertical and horizontal scale and position parameters.

Prefs Specifies whether or not certain display elements are shown. Specifies the maximum number of
points shown in the display graph.

Parameters Tab
The Parameters tab enables you to specify parameters that control the carrier frequency and phase detection. 

Setting Description

Burst detect threshold Specifies the power level used to determine whether a burst is present. A valid burst is required
to take measurements. The burst detected first is used for the analysis. The units for burst detect
threshold are dBc, relative to the maximum acquisition sample data points level.

Measurement BW Specifies the bandwidth about the center frequency at which measurements are made.

Frequency offset Displays the carrier signal's frequency offset from the instrument's Measurement Frequency. Auto
is used to select the method for determining the carrier frequency. When Auto is selected, the
instrument determines the carrier frequency by analyzing the signal. When Auto is deselected, you
can set the carrier frequency offset using Frequency Offset.

Load Δ from Marker Pressing this button disables the Auto Frequency Offset function and sets the Frequency offset to the
frequency offset calculated from the difference between MR (the marker reference) and the selected
marker (or M1 if MR is currently the selected marker).

Phase offset Displays the phase offset. When Auto is selected, the instrument determines the phase offset. When
Auto is deselected, the user sets the phase offset with this control.

Table continued…
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Setting Description

Load from marker Pressing this button sets the phase offset to the phase offset of the selected marker. (Pressing this
button automatically deselects Auto.)

Frequency Offset
In Auto (Auto is selected), the instrument scans the measurement bandwidth about the Measurement Frequency and looks for the
highest-powered signal. This is defined as the carrier frequency. In Manual (Auto is deselected), the carrier frequency is specified by
adding/subtracting the specified Frequency offset from the Measurement Frequency. Range: -(Measurement BW*1.1)/2 to +(Measurement
BW*1.1)/2. If the Load Δ from marker button is pressed, the frequency offset is determined from the phase difference between the two
markers on screen compared to the time between the two markers. This function is useful for removing frequency slope from the phase
modulated signal.

Phase Offset
In Auto (Auto is selected), the instrument sets the phase offset to fit the waveform to the screen centering 0° phase on the vertical axis.
The actual phase offset is indicated on the Phase Offset readout. In Manual (Auto is deselected), the instrument sets the phase offset
using the value specified in Phase offset. For example, when Phase offset is set to 10°, the waveform shifts upward by 10° on screen.
Selecting Load from marker sets the phase offset to the value of the selected marker. Range: –180 to +180°.

Trace Tab
The Traces Tab allows you to set the display characteristics of displayed traces.

Setting Description

Show Shows / hides the trace. If the instrument continues to run, the measurement results below the graph
display continue to update even if the trace is hidden.

Detection Sets the Detection method used for the trace. Available detection methods are +Peak, -Peak, and
Avg (VRMS). Not available for saved traces.

Function Selects the trace processing method. The only available setting is Normal.

Freeze Halts updates to the trace.

Save Trace As Saves the trace to a file for later recall and analysis.

Show Recalled trace Displays a saved trace instead of a live trace.

Detection

Detection refers to the method of processing the data acquisition points when creating a trace. The IQ samples in a data acquisition can be
detected in a variety of ways. The number of IQ samples available to each trace point varies with both analysis length and trace length. For
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example, with Spectrum Length set to ‘Auto’ in the Analysis menu, the instrument analyzes just enough samples to produce one IQ sample
pair per trace point. In this case, the detection method chosen has very little effect, as the +Peak, -Peak, and Avg (VRMS) are all equal.
Changing the Spectrum Length causes the available detection methods to differ in value because they have a larger set of samples for the
various detection methods to process.

The available detection methods are:

• +Peak – Each point on the trace is the result of detecting the positive peak value present in the set of IQ samples available to that
trace point.

• -Peak – Each point on the trace is the result of detecting the negative peak value present in the set of IQ samples available to that
trace point.

• Avg (VRMS) [Average VRMS] – Each point on the trace is the result of determining the RMS Voltage value for all of the IQ samples
available to the trace point. When displayed in either linear (Volts, Watts) or Log (dB, dBm), the correct RMS value results. When the
averaging function is applied to a trace, the averaging is performed on the linear (Voltage) values, resulting in the correct average for
RMS values.

Trace Processing
Traces can be processed to display in different ways. The Function setting controls trace processing.

• Normal - Each new trace is displayed and then replaced by the next trace. Each data point contains a single vertical value.
• Average - Each trace point is computed by averaging together the multiple results points it represents.
• +Peak - Each trace point is represents the highest vertical value among the results it includes.
• –Peak - Each trace point is represents the lowest vertical value among the results it includes.

Saving Traces
To save a trace for later analysis:

1. Select the Save Trace As button. This displays the Save As dialog box.
2. Navigate to the desired folder or use the default.
3. Type a name for the saved trace and click Save.

Recalling Traces
You can recall a previously saved trace for analysis or comparison to a live trace.

To select a trace for recall:

1. Click the ... button to display the Open dialog box.
2. Navigate to the desired file and click Open.
3. Check the Show Recalled Trace check box.
4. Verify that the Show check box is selected.

Scale Tab
The Scale tab allows you to change the vertical and horizontal scale settings. Changing the scale settings changes how the trace appears
on the display but does not change control settings such as Measurement Frequency. In effect, these controls operate like pan and zoom
controls.
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Setting Description

Vertical

Scale Changes the range shown between the top and bottom of the graph.

Position Adjusts the phase shown at the center of the graph.

Autoscale Resets the Position so that the entire trace in the graph.

Horizontal

Scale Changes the range shown between the left and right sides of the graph.

Position Adjusts the phase shown at the left edge of the graph.

Autoscale Resets the Scale and Position settings to show the entire trace within the graph.

Prefs Tab
The Prefs tab enables you to change appearance characteristics of the PM display.

Setting Description

Show graticule Shows or hides the graticule.

Show Marker readout in graph
(selected marker)

Shows or hides the readout for the selected marker in the graph area.

Max trace points The trace in the PM display can be set to a maximum of 100,000 points (however, the actual number
of trace points can extend up to 500,000 points if Max trace points is set to Never Decimate). If the
Analysis Length includes more than the selected Max trace points value, the trace is decimated (using
the method specified with the Detection control) to be equal to or less than the Max trace points
setting (except when Max trace points is set to Never Decimate). This decimated (or undecimated)
trace is what is used for marker measurements and for results export.
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RF Measurements
Overview
The displays in RF Measurements (Displays > Measurements > RF Measurements) are:

• CCDF
• Channel Power and ACPR
• Frequency and Phase Settling Time (Option SVT)
• MCPR
• Occupied Bandwidth
• SEM (Spectrum Emission Mask)
• Spurious

The RF Measurements power measurements and signal statistics help you characterize components and systems.

Power Measurements

Measurement Description

Channel Power The total RF power in the selected channel (located in the ACPR display).

Adjacent Channel Power Ratio Measure of the signal power leaking from the main channel into adjacent channels.

Multi-Carrier Power Ratio The ratio of the signal power in the reference channel or group of channels to the power in adjacent
channels.

Peak/Avg Ratio Ratio of the peak power in the transmitted signal to the average power in the transmitted signal
(located in the CCDF display).

CCDF The Complementary Cumulative Distribution Function (CCDF). CCDF shows how much time a signal
spends at or above a given power level relative to the average power of a measured signal.

Channel Power and ACPR (Adjacent Channel Power Ratio) Display
Use the Channel Power and ACPR measurement to measure channel power by itself, or adjacent channel leakage ratio with one main
channel.
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Measuring Adjacent Channel Power Ratio
1. Select the Displays button.
2. Select RF Measurements from the Measurements box.
3. Double-click Chan Power and ACPR in the Available displays box. Click OK to complete your selection.
4. Select Settings to display the Settings control panel for Chan Power and ACPR (the tab displayed will be the tab displayed the last

time the Settings panel was opened).

5. Select the Freq & RBW tab and adjust the frequency to that of your main channel. You can also change the frequency from the
Status bar found at the bottom left side of the display.

6. To set the number of adjacent channels, select the Channels tab. Enter the number of channels in the Number of adjacent pairs
value box. If zero is entered for the number of adjacent pairs, the resultant measurement will be channel power only.

Note: As you add adjacent channels, the span of the display is adjusted so that all the channels can be seen. Use the
horizontal scale and offset to zoom the display in on any portion of the trace.

7. To set the spacing between channel centers, enter the required value in the Channel Spacing value box.
8. To set the channel bandwidth, enter the required value in the Channel Bandwidth value box.
9. After you have configured the channel settings, click the close button in the Settings panel or press Settings again to remove the

Settings panel.
10. Press the Run button to take the measurements.

Viewing Results
Measurement results are displayed in a table below the graph and within the graph itself (which can be enabled/disabled in the Settings
> Prefs tab). To see all measurements, you might need to scroll the table. The size of the results table can be changed by dragging the
horizontal divider bar between the graph and table areas.
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Heading Description

Channel Identifies the displayed channels. A1 means the first adjacent channel. A2 means second adjacent
channel. Adjacent channels are numbered according to their offset from the Main channel. The
closest channel is numbered 1. The next closest channel is numbered 2; and so forth.

Lower The power measured for the lower adjacent channel. Adjacent channel power measurements are
displayed in dB relative to the Main channel.

Upper The power measured for the upper adjacent channel. Adjacent channels power measurements are
displayed in dB relative to the Main channel.

Avg Channel Power (Main) The power measured for the Main channel. The detection type used for measuring channel power and
adjacent channel powers is Average. This means that the average of the linear (pre-log) samples is
used to determine the power. The Main channel power is displayed in dBm.

Setting Channel Power and ACPR Settings Parameters

RF Channel Power Measurement
The RF channel power gives an indication of the total average (and other measures) RF power in a given channel.

For some communications systems, there is an “out-of-service” total power measurement defined in the specifications that calls for a
specified constant modulation. In this case, the output power should be relatively constant. For many measurements, this may not be the
case, and the Power Measurement results will vary as the signal varies.

Average power is the square root of the sum of the squares of the voltage samples over the measurement time.

The defined “channel” width for the Power Measurement defines the bandwidth and shape of the filter used to remove any RF power on
frequencies outside of the channel bandwidth.

Channel Power
The total RF power in the selected frequency band. The detection type used for measuring channel power is Average. This means that the
average of the linear (pre-log) samples is used to determine the channel power. To measure channel power, use the ACLR measurement,
and set the number of adjacent channels to zero. This results in only the channel power being measured.

Average Channel Power
The total RF power in the selected channel (located in the ACPR display).

Adjacent Channel Leakage Power Ratio
Adjacent Channel Leakage power Ratio (ACLR) is the ratio of the mean power centered on the assigned channel frequency to the mean
power centered on an adjacent channel frequency. In the 3GPP specification, both the main channel and adjacent channels are required to
be filtered with RRC (Root Raised Cosine) filters.

Adjacent Channel Power
Measure of the signal power leaking into nearby channels.

Channel Power and ACPR Settings
Main menu bar: Setup > Settings 
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The settings for the Channel Power and ACPR display are shown in the following table.

Settings tab Description

Freq & RBW Specify the frequency and resolution bandwidth used for the ACPR measurement.

Measurement Params Specify several parameters that control the measurement, such as channel filter, chip rate, averaging,
and correcting for noise floor.

Channels (ACPR) This tab specifies the BW and offset parameters of the Channels for the selected ACPR
measurement.

Scale Specifies the vertical and horizontal scale settings.

Prefs Specifies whether certain display elements are visible.

Restore defaults. Sets parameters for a 1-channel WCDMA measurement.

Channels Tab for ACPR
The Channels tab is where you specify parameters for the channels measured in the ACPR display.

Setting Description

Number of adjacent pairs Specifies the number of adjacent channel pairs. Range: 1 - 50; Resolution 1.

Channel Bandwidth Specifies the frequency width of each channel (all channels share the same value).

The maximum channel bandwidth is 39.6 MHz for USB instruments.

Channel Spacing Specifies the difference in frequency between the centers of each channel.

The following figure illustrates the settings controlled from the Channels tab.
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Changing the Number of Adjacent Pairs
1. Select Number of adjacent pairs number entry box.
2. Enter a value for the number of adjacent pairs using the knob or the keypad.

Note: As you change the value for the number of adjacent pairs, the analyzer will update the spectrum display to identify the
adjacent channels.

3. Select the Close box when you have finished making changes.

Changing the Channel Bandwidth
1. Select the Channel Bandwidth number entry box.
2. Enter a value for the number of adjacent pairs using the knob or the keypad.

Note: As you change the value for the number of adjacent pairs, the analyzer will update the display to indicate the channel
bandwidth.

3. Select the Close box when you have finished making changes.

Channel Spacing
1. Select Channel Spacing number entry box.
2. Enter a value for the difference in center frequency between channels using the knob or the keypad.

Note: As you change the value for the number of adjacent pairs, the analyzer will update the display to indicate the channel
bandwidth.

3. Select Close when you have finished making changes.

Signal Strength Display
Use the Signal Strength display to measure signal strength (channel power and peak channel power).

RF Measurements

SignalVu™ Vector Signal Analysis Software Printable Help 106



Measuring channel power and field strength
1. Select the Displays button.
2. Select RF Measurements from the Measurements box.
3. Double-click Signal Strength in the Available displays box. Click OK to complete your selection.
4. Tune the analyzer to the channel. To do this, you can enter the frequency directly into the Frequency field on the Basic Toolbar (see the

bottom of the above image), or you can use the Select Channel button on the Channel Navigation toolbar.
5. Press the Run button to take the measurements. If you are using a data acquisition file, click Replay.
6. If you are measuring a signal with a directional antenna, select the Audio check box located above the graph, on the left side.

When Audio is checked, the analyzer sounds a tone that varies in frequency with the channel power. If you change the direction of the
antenna and the channel power drops, the frequency of the audio tone will also drop. If the channel power increases, the audio tone
frequency will also increase.

As channel power changes, the vertical channel power bar graph located on the far right side of the measurement display will rise and
fall with the channel power.

Viewing Results
Measurement results are displayed below the graph and within the graph itself (the latter of which can be enabled/disabled in the Signal
Strength Settings > Prefs tab).

Figure 1: Results for Signal Strength measurement

Heading Description

Channel Power (Main) The integrated power measured for the Main channel.

Peak Channel Power (Main) The maximum integrated power measured for the Main channel.
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Signal Strength Settings on page 108

Signal Strength Settings
Menu Bar: Setup > Settings 

The settings for the Signal Strength display are shown in the following table.

Settings tab Description

Freq & RBW Specify the frequency and resolution bandwidth used for the signal strength measurements.

Measurement Params Specify several parameters that control the measurement, averaging. External amplitude corrections,
and display units.

Channels This tab specifies the BW

Scale Specifies the vertical and horizontal scale settings.

Prefs Specifies trace points, trace detection, and visible display elements ( graticule, marker readouts, etc )
for the Signal Strength measurement display.

Freq & RBW Tab for Signal Strength display
The Freq & RBW tab specifies frequency parameters for the signal strength measurements.

Setting Description

Meas Freq Specifies the center/measurement frequency.

Step The Step control sets the increment/decrement size for the adjustment of the center frequency. If Auto
is enabled, the analyzer will adjust the Step size as required.

RBW Select Auto or Manual. Adjusts the RBW for the entire measurement. This setting is Independent of
the Spectrum view's RBW setting.

Table continued…
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Setting Description

VBW Adjusts the VBW (Video Bandwidth) value. VBW Maximum = 10 times the current RBW value. VBW
Minimum = 1/10,000 RBW setting.

Note: While the center frequency and step settings on this control tab are shared between ACPR, MCPR and Occupied
Bandwidth, the RBW setting is not shared. The RBW setting is unique for each measurement.

VBW
The VBW setting enables/disables the Video Bandwidth filter. VBW is used in traditional swept analyzers to reduce the effect of noise on
the displayed signal. The VBW algorithm in the analyzer emulates the VBW filters of traditional swept analyzers.

The maximum VBW value is 10 times the current RBW setting. The minimum VBW value is 1/10,000 of the RBW setting.

Note: If you are following a procedure that says to "set VBW to three times the RBW value or greater", it means that the test
should be conducted with no VBW effects. In the application, this condition is met by disabling the VBW function.

Measurement Params Tab for Signal Strength display
The Measurement Params tab is where you set parameters that control the Signal Strength measurement.

Parameter Description

Average Enables/disables measurement averaging. Averaging can be enabled in either the Frequency
Domain or Time Domain.

Frequency domain This setting takes the average linear value of the traces (so that rms values are preserved). The
number of averages is user-defined. Frequency domain averaging is available in spans larger
(or smaller) than the maximum real time bandwidth. This is the mode to use unless you need to
extract maximum dynamic range from an ACPR measurement.

Time domain This setting takes the average linear value of the traces. It is useful if you need to extract
maximum dynamic range from an ACPR measurement. The number of traces is user defined.
But, the signals must be triggered and repeating. That is, the signal needs to be exactly the same
for each acquisition. When this condition is met, each waveform contains the same signal, but the
random noise changes from acquisition to acquisition and the average value of the random noise
is lowered, while the signal value remains constant. Time domain averaging is not available in
spans wider than the maximum real-time bandwidth.

Off This setting turns averaging off.

Number Specifies the number of acquisitions to be averaged when Averaging is set to Frequency Domain.
Specifies the number of successive capture records that are averaged when Averaging is set to
Time Domain.

Amplitude Units Opens the Units Tab on page 502 dialog box.

Ext Corrections Opens the External Gain/Loss Correction dialog box.

Correct for noise floor
When this setting is enabled, the instrument applies a correction to the ACPR or MCPR measurement to reduce the effect of instrument
noise on the results. It generates this correction by taking a preliminary acquisition to measure the instrument noise floor. Once this
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is done, the measurement proceeds, applying the correction to each result. When any relevant settings (reference level, attenuator,
frequency, or span) are changed, the instrument performs a new noise measurement and correction.

The noise correction signal is created by switching off the input to the RTSA and performing acquisitions of the instrument internal noise.
A minimum of 100 acquisitions are averaged to create the noise reference signal. It is possible to increase the number of acquisitions
for creation of the noise reference signal. When frequency domain averaging is enabled and the number of averages exceeds 100, the
number of frequency domain averages becomes the total number of acquisitions to determine the instrument internal noise. Noise is
measured for each channel defined by the measurement. The noise reference from each channel is subtracted from the incoming signal
power for each channel to create the corrected result. All calculations are performed in Watts, and then converted to the desired units.

The amount of noise correction is limited to 12 dB to avoid the possibility of a negative power measurement. This is a rare condition that
could occur if the subtraction of the reference power from the channel power results in a negative value (or'infinite' dBm).

The measured values differ from the displayed trace in two ways. First, any filtering applied to the channels is not displayed on the trace.
Second, the single value of measured noise for a channel is subtracted from each trace point in the channel, rather than offsetting the
entire channel by a single amount. This produces a smooth trace with no discontinuities at the channel edges.

Channels Tab for Signal Strength display
The Channels tab is where you specify the channel bandwidth measured in the Signal Strength display.

Changing the Channel Bandwidth
1. Select the Channel Bandwidth number entry box.
2. Enter a value for the channel bandwidth.
3. Select the Close box when you have finished making changes.

Scale Tab for Signal Strength display
The Scale tab allows you to change the vertical and horizontal scale settings. Changing the scale settings changes how the trace appears
on the display but does not change control settings such as Center Frequency.

Setting Description

Vertical Controls the vertical position and scale of the trace display.

Scale Changes the vertical scale units. This is only accessible when the vertical units are set to dBm.

Autoscale Automatically scales the vertical axis to contain the complete trace.

Table continued…
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Setting Description

Horizontal Controls the span of the trace display and position of the trace.

Scale Allows you to, in effect, change the span.

Autoscale Automatically scales the horizontal axis to optimize the display of the trace.

Reset scale Resets all settings to their default values.

Prefs Tab
The Prefs tab enables you to change parameters of the measurement display. The parameters include enabling/disabling Marker Readout,
switching the Graticule display on/off, and trace points and detection.

Setting Description

Trace Points Sets the number of trace points computed for each line. These are the points used for marker
measurements and for results export.

Show graticule Shows or hides the graticule.

Trace Detection +Peak: Shows the peak power in a bin (of chosen RBW) if there are multiple points to choose from
within a bin.

Avg (VRMS): Shows the average power in a bin (of chosen RBW) if there are multiple points to
choose from within a bin.

Show Marker readout in graph
(selected marker)

Shows or hides the readout for the selected marker in the graph area.

MCPR (Multiple Carrier Power Ratio) Display
Use the MCPR measurement to measure adjacent channel power ratio for multiple main channels or when adjacent channel pairs have
different offsets and/or bandwidths. The MCPR display show the Reference Power and the ratio of each adjacent channel to the Reference
Power. You can select whether the Reference Power is the total of all active channels or a single channel.

Measuring Multiple Carrier Power Ratio
1. Press the front-panel Displays button.
2. From the Select Displays window, select RF Measurements or P25 Analysis from the Measurements box.
3. Double-click the MCPR icon in the Available displays box. Click OK to complete your selection.
4. Press the Settings button. This displays the control panel for MCPR (the tab displayed will be the tab displayed the last time the

Settings panel was opened).
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5. Select the Freq & RBW tab and adjust the frequency to that of the main channel. You can also adjust the frequency on the Status
bar using the Frequency field on the bottom left of the display.

6. Click on the Channels tab. To set the number of Main channels, enter the number of Main channels in the Number text entry box
under Main Channels.

Note: As you add channels, the span of the display will be adjusted so that all the channels can be seen.

7. To set the bandwidth of all main channels, enter a value in the BW value box.
8. To set the spacing between the main channels, enter a value in the Spacing value box.
9. To prevent a main channel power level from being included in the Power Reference (Total) calculation, select the channel to be

excluded in the Inactive box.
10. To add adjacent channels, click the Add button under Adj Chans.

11. To edit Frequency Offset or Bandwidth, click within the value box and use the front-panel knob or your keyboard to set the value.
Click Close to save your changes.

Note: Frequency Offset is the difference between the center frequency of the selected channel and the Measurement
Frequency. All channels (Main or Adjacent) are specified by their offset from the Measurement Frequency.

12. To enable and define power limits, check the Enable Power Limits box and enter the desired Upper and Lower limits. You can read
more about power limits here.
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13. After you have configured the Main and Adjacent channels, click the close button in the Settings panel or the Settings button to
remove the settings panel.

14. Click the Run button to take the measurements. Click the Replay button if you are using a recalled acquisition data file.

Viewing Results
MCPR measurement results are displayed both in the spectrum graph and in a table below the spectrum display. Individual Main channel
power measurements appear in the graph under their channel identifiers. Individual adjacent channel power ratios also appear in the graph
under the adjacent channel identifier.

The following table details the entries in the results table.
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Heading Description

Ch Identifies the adjacent channels. Adjacent channels are numbered according to their offset from the
Main channel. The closest channel is numbered 1. The next closet channel is numbered 2; and so
forth. The prefix “L” means lower; “U” means upper.

Offset The offset is the difference in frequency between the Measurement Frequency and the center
frequency of the channel.

Lower Displays the ratio of the lower adjacent channel power to the Power Reference.

Upper Displays the ratio of the upper adjacent channel power to the Power Reference.

L. Limit Displays the lower power limit.

U. Limit Displays the upper power limit.

Power Reference Depending on the selected Power Ref, this readout displays either the power of the selected main
channel or the total power in the active main channels.

Depending on the number of adjacent channels, to see all the measurements, you might need to drag the divider bar between the main
display and the results table at the bottom of the window to change the height of the results table.

Setting MCPR Measurement Parameters

Setting Power Limits
When power limits are enabled (Settings > Channels > Add or Settings > Channels > Edit), the comparison of the actual results of an
adjacent channel is done against the limits. If there is a failure, the Lower and Upper power cells in the MCPR table will be red and the
failure segments of the trace display will be red. The words Fail in red will also appear in the top left corner of the display (even if one
adjacent band fails). See the following image for an example.
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Multiple Carrier Power Ratio
The ratio of the signal power in an adjacent channel to the power in one or more main channels.

MCPR Settings
Main menu bar: Setup > Settings 

Favorites toolbar:

The Setup control panel tabs for MCPR (Multiple Carrier Power Ratio) are:

Settings tab Description

Freq & RBW Specify the frequency and resolution bandwidth used for the MCPR measurements.

Measurement Params Specifies parameters controlling how the MCPR measurement is made.

Channels Specifies the parameters of the channels to be measured.

Table continued…
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Settings tab Description

Scale Specifies the vertical and horizontal scale and offset values.

Prefs Specifies whether or not certain display elements are shown.

Restore defaults. Sets parameters for a 4-carrier WCDMA measurement.

Freq & RBW Tab for ACPR and MCPR Displays
The Freq & RBW tab specifies frequency parameters for the Channel Power & ACPR measurements and MCPR measurement.

Setting Description

Meas Freq Specifies the center/measurement frequency.

Step The Step control sets the increment/decrement size for the adjustment of the center frequency. If Auto
is enabled, the analyzer will adjust the Step size as required.

RBW Select Auto or Manual. Adjusts the RBW for the entire measurement. This setting is Independent of
the Spectrum view's RBW setting.

VBW Adjusts the VBW (Video Bandwidth) value. VBW Maximum = 10 times the current RBW value. VBW
Minimum = 1/10,000 RBW setting.

Note: While the center frequency and step settings on this control tab are shared between ACPR, MCPR and Occupied
Bandwidth, the RBW setting is not shared. The RBW setting is unique for each measurement.

VBW
The VBW setting enables/disables the Video Bandwidth filter. VBW is used in traditional swept analyzers to reduce the effect of noise on
the displayed signal. The VBW algorithm in the analyzer emulates the VBW filters of traditional swept analyzers.

The maximum VBW value is 10 times the current RBW setting. The minimum VBW value is 1/10,000 of the RBW setting.

Note: If you are following a procedure that says to "set VBW to three times the RBW value or greater", it means that the test
should be conducted with no VBW effects. In the SignalVu software, this condition is met by disabling the VBW function.

Measurement Params for ACPR and MCPR Displays
The Measurement Params tab is where you set parameters that control the ACPR and MCPR measurements.
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Parameter Description

Average Enables/disables measurement averaging. Averaging can be enabled in either the Frequency
Domain or Time Domain.

Frequency-domain This setting takes the average linear value of the traces (so that rms values are preserved). The
number of averages is user-defined. Frequency domain averaging is available in spans larger
(or smaller) than the maximum real time bandwidth. This is the mode to use unless you need to
extract maximum dynamic range from an ACPR measurement.

Time-domain This setting takes the average linear value of the traces. It is useful if you need to extract
maximum dynamic range from an ACPR measurement. The number of traces is user defined.
But, the signals must be triggered and repeating. That is, the signal needs to be exactly the same
for each acquisition. When this condition is met, each waveform contains the same signal, but the
random noise changes from acquisition to acquisition and the average value of the random noise
is lowered, while the signal value remains constant. Time domain averaging is not available in
spans wider than the maximum real-time bandwidth.

Off This setting turns Average off.

Number Specifies the number of acquisitions to be averaged when Averaging is set to Frequency Domain.
Specifies the number of successive capture records that are averaged when Averaging is set to
Time Domain.

Correct for Noise Floor Enables/disables the Noise Floor Correction function.

Power Reference Specifies power against which the results are compared. Choices available are each of the
existing main channels and “Total (active channels”.

Only present when MCPR is the selected display.

Channel Filter Specify the channel filter used. Select between None (default) and Root-raised Cosine.

Filter Parameter Value entry box for the Root-raised Cosine filter Adjacent Channel Filter.

Present only when the Channel Filter is set to Root-raised Cosine.

Table continued…
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Parameter Description

Chip Rate Value entry box for the Root-raised Cosine chip rate.

Present only when the Channel Filter is set to Root-raised Cosine.

Parameter Description

Average Enables/disables measurement averaging. Averaging can be enabled in either the Frequency
Domain or Time Domain.

Frequency-domain This setting takes the average linear value of the traces (so that rms values are preserved). The
number of averages is user-defined. Frequency domain averaging is available in spans larger
(or smaller) than the maximum real time bandwidth. This is the mode to use unless you need to
extract maximum dynamic range from an ACPR measurement.

Time-domain This setting takes the average linear value of the traces. It is useful if you need to extract
maximum dynamic range from an ACPR measurement. The number of traces is user defined.
But, the signals must be triggered and repeating. That is, the signal needs to be exactly the same
for each acquisition. When this condition is met, each waveform contains the same signal, but the
random noise changes from acquisition to acquisition and the average value of the random noise
is lowered, while the signal value remains constant. Time domain averaging is not available in
spans wider than the maximum real-time bandwidth.

Number Specifies the number of acquisitions to be averaged when Averaging is set to Frequency Domain.
Specifies the number of successive capture records that are averaged when Averaging is set to
Time Domain.

Correct for Noise Floor Enables/disables the Noise Floor Correction function.

Power Reference Specifies power against which the results are compared. Choices available are each of the
existing main channels and “Total (active channels”.

Only present when MCPR is the selected display.

Channel Filter Specify the channel filter used. Select between None (default) and Root-raised Cosine.

Filter Parameter Value entry box for the Root-raised Cosine filter Adjacent Channel Filter.

Present only when the Channel Filter is set to Root-raised Cosine.

Symbol/Chip Rate Value entry box for the Root-raised Cosine chip rate.

Present only when the Channel Filter is set to Root-raised Cosine.

Correct for Noise Floor
When this setting is enabled, the instrument applies a correction to the ACPR or MCPR measurement to reduce the effect of instrument
noise on the results. It generates this correction by taking a preliminary acquisition to measure the instrument noise floor. Once this
is done, the measurement proceeds, applying the correction to each result. When any relevant settings (reference level, attenuator,
frequency, or span) are changed, the instrument performs a new noise measurement and correction.

The noise correction signal is created by switching off the input to the RTSA and performing acquisitions of the instrument internal noise.
A minimum of 100 acquisitions are averaged to create the noise reference signal. It is possible to increase the number of acquisitions
for creation of the noise reference signal. When frequency domain averaging is enabled and the number of averages exceeds 100, the
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number of frequency domain averages becomes the total number of acquisitions to determine the instrument internal noise. Noise is
measured for each channel defined by the measurement. The noise reference from each channel is subtracted from the incoming signal
power for each channel to create the corrected result. All calculations are performed in Watts, and then converted to the desired units.

The amount of noise correction is limited to 12 dB to avoid the possibility of a negative power measurement. This is a rare condition that
could occur if the subtraction of the reference power from the channel power results in a negative value (or ‘infinite’ dBm).   

The measured values differ from the displayed trace in two ways. First, any filtering applied to the channels is not displayed on the
trace. Second, the single value of measured noise for a channel is subtracted from each trace point in the channel, rather than offsetting
the entire channel by a single amount. This produces a smooth trace with no discontinuities at the channel edges.

Channels Tab for MCPR
Main menu bar: Setup > Settings > Channels 

The Channels tab is where you specify the parameters for the channels measured in the MCPR display.

Setting Description

Main Channels

Number Sets the number of Main channels.

BW Sets the bandwidth of the Main channels.

The maximum channel bandwidth is 39.6 MHz for USB instruments.

Spacing Sets the frequency difference between the centers of the Main channels.

Inactive Selected channels are ignored by the measurement routine.

Adj Chans

Add Opens the Edit Channel Parameters dialog, which you use to specify the parameters of a new pair of
adjacent channels. You can add up to 50 adjacent channel pairs.

Edit Opens the Edit Channel Parameters dialog box. (You must first select a channel to enable the Edit
button.)

Delete Deletes the selected main channel or adjacent channel pair.

Channel Definition table A table of the parameters for every channel. Offset is the frequency difference between the Center
Frequency and center of the selected channel. Nothing in the table is editable directly. You can set the
upper and lower limits by clicking on the Add button.

The following figure illustrates the settings controlled from the Channels tab.
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Editing Channel Parameters
To edit the offset or bandwidth of a Main channel:

1. Select the value in the BW or Spacing number entry boxes.
2. Adjust the value as required. All the Main channels share the same BW and Spacing.
3. Select the appropriate check box to make a channel Inactive, as appropriate.
4. Click the Close button when you have finished making changes.

To edit the offset or bandwidth of an Adjacent channel:

1. Select the channel to be edited in the channel definition table.
2. Select Edit. This displays the Edit Channel Parameters dialog box.
3. Adjust the values for the Frequency Offset, Bandwidth, and upper and lower Limits, as required.
4. Click the Close button when you have finished making changes.

Adding Channels
To add a main channel:

1. Select the Number entry box.
2. Use the knob to enter a value for the desired number of Main channels.
3. Click the Close button when you have finished making changes.

To add an adjacent channel pair:

1. Select Add. This displays the Edit Channel Parameters dialog box.
2. Use the knob to enter values for the Frequency Offset, Bandwidth, and upper and lower Limits, as required. The Frequency Offset is

measured from the Meas Frequency of the Main channels.
3. Click the Close button when you have finished making changes.

Deleting Channels
To delete a main channel:

1. Select the Number entry box.
2. Use the knob to reduce the number of channels or enter a new value using the front-panel keypad.
3. Click the Close button when you have finished making changes.

To delete an adjacent channel:

1. Select the channel to be deleted in the channel definition table.
2. Select Delete. This removes the selected channel from the channel table.

RF Measurements

SignalVu™ Vector Signal Analysis Software Printable Help 120



3. Click the Close button when you have finished making changes.

Occupied BW & x dB BW Display
The Occupied BW display shows the bandwidth within which 99% (a user-defined value, the default is 99%) of the power transmitted within
the measurement bandwidth falls.

To show the Occupied BW display:

1. Press the Displays button or select Setup > Displays.
2. In the Select Displays dialog, select RF Measurements in the Measurements box.
3. In the Available displays box, double-click the Occupied Bandwidth icon or select the icon and click Add. The Occupied Bandwidth

icon will appear in the Selected displays box and will no longer appear under Available displays.
4. Click OK to display the Occupied Bandwidth.

Elements of the Display

Item Display element Description

1 Check mark indicator The check mark indicator denotes the display for which the acquisition hardware is
optimized. This indictor appears only when the display is the selected display.

Note: When Best for multiple windows is selected in the Amplitude control
panel's RF & IF Optimization control, none of the measurement displays shows a
checkmark, as there is not a single optimized measurement.

2 Averaging readout Appears when averaging is enabled (Settings > Parameters tab > Average results).
Displays "Avg: n of m" while averaging the results and "Avg: m" once the requested
number of results have been averaged.

3 Autoscale Adjusts the vertical and horizontal settings so that the entire trace fits in the graph.

4 Trace function readout Displays either Normal or MaxHold to indicate trace function.

Table continued…

RF Measurements

SignalVu™ Vector Signal Analysis Software Printable Help 121



Item Display element Description

5 Clear Resets count for Average and MaxHold functions. Enabled only when Averaging or
MaxHold is enabled. Pressing Clear will clear the trace and, if acquisition is running,
restart the averaging or hold process.

6 Graph Displays the input signal. Shaded areas indicate the measurement bandwidth (Settings >
Parameters tab > Measurement BW).

7 Blue lines The blue lines indicate where the selected results (selected in the Main results area) are
being measured on the trace.

8 Grid divider Determines the portion of the display allocated to the graph and detailed results area. You
can move the grid divider all the way to the top or bottom and any position in between.

9 Detailed results area Displays additional measurements results.

10 Position and dB/div

Units (not shown)

Position sets the top of graph value. The dB/div setting is the vertical scale value.

Sets the global amplitude units for all the views in the analysis window. This will change
the amplitude selection in the Units tab of the Amplitude control panel.

11 Main results area Displays results for Occupied Bandwidth (OBW) and x dB bandwidth. Use the two radio
buttons to select which of the two results are illustrated in the graph with the blue lines and
arrows. There are also controls for adjusting OBW % Power, x dB BW, and RBW.

12 VBW Enables the VBW (Video Bandwidth) filter. Displays current VBW filter setting. See Setup
> Settings > Freq & RBW tab.

Detailed Results Readouts

Measurement Description

Freq Error The frequency difference between the measured carrier frequency of the signal and the user-selected
center frequency of the analyzer.

OBW Level left The signal level at the left edge of the occupied bandwidth.

OBW Level right The signal level at the right edge of the occupied bandwidth.

OBW Ref Power The total power measured within the measurement bandwidth.

x dB BW Ref Power The peak power measured within the measurement bandwidth.

Changing the Occupied Bandwidth Settings

Occupied Bandwidth
Bandwidth within which some defined percentage of the power transmitted on a single channel lies.

Occupied BW & x dB BW Settings
Main menu bar: Setup > Settings 
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The control panel tabs for the Occupied Bandwidth display are shown in the following table.

Settings tab Description

Freq & RBW Allows you to specify the Center Frequency, Step size and RBW.

Parameters Allows you to specify the Occupied BW % Power, x dB level, Measurement BW, enable averaging and
the Max Hold function.

Scale Allows you to set the vertical and horizontal scale parameters.

Prefs The Prefs tab enables you to set characteristics of the measurement display.

Parameters Tab
The Parameters tab enables you to specify parameters that control the Occupied BW measurement.

Setting Description

Occupied BW % Power Specifies the proportion of power within the occupied bandwidth (referenced against the total power in
the measurement bandwidth).

x dB level x dB level defines the x dB BW level search threshold.

Measurement BW Specifies the frequency range used by the measurement.

Max Hold spectral data Enables the Max Hold function.

Average results Enables/disables results averaging. Note that this is not an averaging of the trace, but an averaging of
the results.

Count Specifies the number of results averaged to calculate the Occupied BW. Range: 2 to 10,000.

x dB Level
The x dB level determines the x dB BW. The instrument analyzes the spectrum trace to locate the frequencies at which the level is x dB
down from the peak level calculated over the measurement bandwidth. The frequency difference between the upper and lower crossing
thresholds is the x dB BW.

Range: -80.0 to -1.0 dB; Resolution: 0.1%; Inc/dec small: 0.1%, large: 1%; Default: -26 dB

Max Hold Spectral Data
Max Hold displays the maximum value in the acquisition record for each display point. Each new trace display point is compared to the
previous maximum value and the greater value is retained for display and subsequent comparisons.
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Spurious display
To show the Spurious display:

1. Click the Displays button or select Setup > Displays.
2. From the Measurements box, select RF Measurements.
3. Double-click the Spurious icon in the Available displays box. This adds the Spurious icon to the Selected displays box (and

removes it from the Available displays box). Alternatively, you can click the Spurious icon and then click the Add button to select
Spurious for display.

4. Click the OK button.

Elements of the Spurious Display

Item Display element Description

1 Check mark indicator Indicates the display for which the acquisition hardware is optimized.

Note: When Best for multiple windows is selected in the Amplitude control
panel's RF & IF Optimization control, none of the measurement displays shows a
checkmark, as there is not a single optimized measurement.

2 Vert Position Sets the top of graph value. This is only a visual control for panning the graph. The
Reference Level is adjusted in the Toolbar and the Ampl control panel. By default, Vert
Position = Ref Level.

3 Units Sets the global Amplitude units for all the views in the analysis window. This will change
the Amplitude selection in the Units tab of Analysis Control panel.

4 dB/ div Sets the vertical scale value. The maximum value is 20.00 dB/division.

Table continued…
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Item Display element Description

5 Bottom-of-graph readout Indicates the amplitude at the bottom of the graph. This value changes with the dB/div and
Vertical Position settings.

6 Autoscale Adjusts the Vertical and Horizontal scaling to display the entire trace on screen. Selects
Multi-range display mode.

7 Start Adjusts the graph start frequency. This setting affects only visual scaling, not
measurement parameters.

8 Green bar Indicates the range that is selected on the Settings > Ranges and Settings > Limits tabs.

9 Spur table Displays spur measurements. See the following table for details.

10 Stop Adjusts the graph stop frequency. This setting affects only visual scaling, not measurement
parameters.

11 Clear Restarts multi-trace functions (Average, Max Hold).

12 Trace function Indicates the trace processing method. If Average or Max Hold is selected, this readout
displays the number of traces being processed (averaged or compared for the Max Hold
value).

13 Show Controls whether the selected trace is visible or not. When trace is Off, the box is not
checked.

14 Trace Selects a trace. Clicking here pops up a context menu listing the available traces, whether
they are enabled or not. If you select a trace that is not currently enabled, it will be made
enabled.

15 Ref: If enabled, displays the power reference level.

16 Pass / Fail readout Indicates whether one or more spurs have exceeded a limit specified on the Settings >
Limits tab.

Elements of the Spurious Graph Display
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Item Display element Description

1 The green line or shading indicates an Abs (absolute) limit. The absolute limit is enabled
when the mask is set to Abs, Abs & Rel, or Abs OR Rel. Note that absolute and relative
amplitude masks can overlap.

2 The gray-shaded area indicates a portion of the spectrum where no measurements are
being taken.

3 The cyan line or shading indicates a Relative limit. The relative limit is enabled when the
mask is set to Rel, Abs & Rel, or Abs OR Rel. Note that absolute and relative amplitude
masks can overlap.

4 abs rel Reminder that green-shaded areas highlight absolute limits and cyan-shaded areas
highlight relative limits.

5 This indicates the selected spur, when it is in violation of the limits. In Run mode, this is the
peak spur violation. The selected marker is highlighted in the Spur table below the graph
with a blue background.

6 A spur marker. Indicates a spur that does not exceed the mask settings. See the Settings
> Ranges and Limits tab.

7 A violation marker. Indicates a spur that exceeds the mask settings. See the Settings >
Ranges and Limits tab.

- - Indicates the selected spur when it is not in violation of the limits. The selected marker is
highlighted in the Spur table below the graph with a blue background.

8 1, 2, 3... A Spur number. The number indicates the row in the spur table that corresponds to the
spur. The instrument can display up to 999 spurs.

9 A, B, C, D... Identifies the enabled ranges.

10 Green bar Indicates the range selected on the Settings > Ranges and Limits tab tab.

11 Ref Indicates the location of the power reference. See Settings > Reference.

Elements of the Spur Table

Column Description

Spur A number that identifies a spur in the graph area. The instrument can display a maximum of
999 spurs.

Table continued…
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Column Description

Range The letter representing the frequency range where the spur is located.

Freq Abs The absolute frequency at which the spur occurs.

Freq Rel The relative frequency at which the spur occurs. The relative frequency is the difference between the
absolute frequency (absolute) and the carrier frequency.

Ampl Abs The absolute amplitude of the spur.

Ampl Rel The relative amplitude at which the spur occurs. The relative amplitude is the difference between the
absolute amplitude and the carrier amplitude. See the Settings > Limits tab.

Lim Abs The value of the absolute amplitude limit at the spur frequency. This value can vary even with small
spur frequency changes if the start and stop limit values are different. See the Settings > Ranges and
Limits tab.

Lim Rel The relative amplitude limit at which the spur occurs. This value can vary even with small spur
frequency changes if the start and stop relative amplitude limit values are different. See the Settings >
Ranges and Limits tab.

Blue background The cell in the Spur column with a blue background identifies the selected spur.

Red background Cells in the Spur column with a red background identify violations.

Cells in the results area with a red background identify the measurement that exceeded a limit.

Rearranging the Columns in the Spur Table
You can rearrange the order of the columns in the Spur Table. To move a column, click on the column heading and drag it to the desired
position.

Sorting the Rows in the Spur Table
You can sort the rows in the Spur table by clicking on the column heading. For example, if you click on the Freq Abs heading, the results
in the Spur table will be sorted by frequency. If you click on Range, the rows will be sorted by range. Clicking a second time on the same
heading reverses the order.

Changing the Spurious Display Settings

Spurious display settings
Main menu bar: Setup > Settings 

The control panel tabs for the Spurious display are shown in the following table.

Settings tab Description

Parameters Specifies whether the graph displays one range or multiple ranges. Specifies whether all spurs are
shown or only spurs over specified limits.

Table continued…
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Settings tab Description

Reference Specifies the Power Reference level.

Ranges Specifies start and stop frequencies of ranges and which ranges to take measurements in. Sets
parameters that define a spur. Review, save and load the Range table from this tab.

Limits Specifies Pass/Fail limit parameters.

Traces Specifies the trace Function.

Scale Specifies the vertical and horizontal scale settings.

Prefs Specifies the appearance features of the graph area.

Restore defaults. Sets the Spurious parameters to their default values.

Parameters Tab
The Parameters tab enables you to specify settings that control the Spurious measurement.

Setting Description

Frequency Ranges

Multi Enables the instrument to display all enabled ranges in the graph.

Single Limits the graph to the display of only one range. The displayed range is set to the range that contains
the selected spur.

List Spurs

All spurs Displays any spur that exceeds the Threshold and Excursion values set on the Ranges tab.

Over Limit Displays only spurs that exceed both the Threshold and Excursion values set on the Ranges tab and
the limits specified on the Limits tab.

Reference Tab
The Reference tab enables you to specify the Power Reference parameter. The Power reference parameter is used to calculate relative
values in the Spur table and to calculate relative amplitude limits.
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Setting Description

Power Reference Specifies the power reference level used for relative values and limits.

No reference Power level readings are calculated only for absolute values, no relative values are calculated.

Manual level The reference level for relative measurements is specified by the Reference power level setting.

Carrier The reference level for relative measurements is based on the power level calculated at the specified
carrier frequency.

Setting the Power Reference Level to No Reference

To set the power reference to No Reference:

• Select No reference from the Power reference drop-down list.

Setting the Power Reference Level to Manual Level

To set the power reference to manual level:

1. Select Manual level from the Power reference drop-down list. This displays the Reference power level entry box.
2. Specify the desired power level in the Reference power level entry box.
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Setting the Power Reference Level to Carrier

To set the power reference to Carrier:

1. Select Carrier from the Power reference drop-down list.
2. To set the Carrier frequency, specify the necessary values in the Frequency and Channel width entry boxes .
3. Specify the Threshold level.
4. Specify the Integration BW. The Integration BW is the bandwidth over which the carrier is measured.
5. If necessary, specify the Resolution Bandwidth by changing the value in the Res BW entry box. Auto is the recommended setting.
6. Set the Detection method. Select +Peak, Avg (VRMS), or Avg (of logs).

Note: If the power level measured over the Integration BW about the carrier frequency is below the threshold level, the
instrument concludes that no carrier is present and no relative measurements will be taken. Absolute measurements will still
be taken.

Ranges and Limits Tab
Use the Ranges and Limits tab to specify the parameters that control the Spurious measurement. From the Ranges and Limits tab, you
specify the start and stop frequencies for ranges, whether or not a range is enabled, the parameters that specify what constitutes a spur,
measurement filter shape and bandwidth, and the detection method used for processing signals, as well as the pass/fail parameters for
limit testing.

Setting Description

Expand Displays the Ranges and Limits Table in a new, resizeable window.

Reset layout You can reorder columns in the Ranges and Limits Table by dragging the columns to a new position.
Clicking Reset Layout returns the column order to the factory default order.

Load Click to load a saved Ranges and Limits table from a file. The default directory is the last folder to
which you saved an Acq data export (.CSV)” file.

Save Click to save the current Ranges and Limits table to a file. The default directory is the last folder to
which you saved an Acq data export (.CSV)” file.

To specify the ranges and limits for the Spurious measurement:

• Edit the values in the Ranges and Limits table.
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You can edit the Ranges and Limits table in two ways:

• Edit values directly from the Ranges and Limits tab. You will need to scroll the table to access all settings.
• Click the Expand button. This displays the Ranges and Limits Table in a new window that can be sized to the full screen.

The following table describes the parameters that are set in the Ranges and Limits Table.

Table 11: Ranges and Limits Table Settings

Setting Description

On Specifies whether or not measurements are taken in the specified range.

Start (Hz) Readout of the start frequency for the selected range.

Stop (Hz) Readout of the stop frequency for the selected range.

Filter shape Specifies the filter shape used for the Spurious measurement.

BW (Hz) Specifies the bandwidth used for the selected filter shape.

Auto Sets the BW automatically. If CISPR is selected for Filter shape, this control is disabled.

Detector For CISPR detectors, this selection enables calculation as per the methods described in the CISPR
documents. Supported CISPR detectors include CISPR Pk.

For non-CISPR detectors, this selection indicates the processing method used for compressing
excess intermediate data into the desired number of trace points.

VBW (Hz) Adjusts the VBW (Video Bandwidth) value. VBW Maximum: 10 times RBW current value; VBW
Minimum: 1/10,000 RBW setting. Disabled when Filter shape is set to CISPR.

VBW On Specifies whether the VBW filter is applied.

Thrshld (dBm) Threshold specifies the level that must be exceeded for a signal peak to be recognized as a spur. A
signal peak must also exceed the Excursion setting to be considered a spur.

Table continued…
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Setting Description

Excrsn (dB) Excursion specifies the peak to peak magnitude that must be exceeded for a signal peak to be
recognized as a spur. A signal transition must also exceed the Threshold setting to be considered a
spur.

Mask Selects the type of limits used for Pass/Fail testing. Spurs that exceed the mask settings are
considered violations. The available choices are shown below.

Abs Spurs that exceed the Absolute limits settings are identified as violations.

Rel Spurs that exceed the Relative limits settings are identified as violations.

Abs & Rel Spurs that exceed both the Absolute and Relative limits settings are identified as violations.

Abs OR Rel Spurs that exceed either the Absolute or Relative limits settings are identified as violations.

Off Turns off limit testing for the selecting range. Measurements are still taken in the range, but violations
are not flagged. Signal peaks that exceed the Threshold and Excursions values will still be identified
as spurs.

(Abs Start and Abs Stop) Absolute amplitude limits are not based on the measured carrier amplitude or manual reference. Start
and stop values can be different.

Abs Start (dBm) Abs Start specifies the limit at the start frequency of the range.

Abs Stop (dBm) Abs Stop specifies the limit at the stop frequency of the range.

Abs Same Sets the limit at the start and stop frequencies to the value set for the start frequency.

(Rel Start and Rel Stop) Relative amplitude limits are calculated from the Power Reference. If the Power Reference is set to
the Carrier level, the relative amplitude limits will change with the carrier level. Start and stop values
can be different.

Rel Start (dB) Specifies the limit at the start frequency of the range.

Rel Stop (dB) Specifies the limit at the stop frequency of the range.

Rel Same Sets the limit at the stop frequency to the value set for the start frequency.

Save As Click to save the current Ranges and Limits table to a file.

Load Click to load a saved Ranges and Limits table from a file.

Done Save changes and close the Ranges and Limits Table window.

Changing the Range Start and Stop Frequencies
To change the range start and stop frequencies, edit the Start and Stop frequencies in the Ranges and Limits Table:

1. Click the Expand button on the Settings > Range and Limits tab. This displays the Ranges and Limits Table.
2. Click the On box for a range to take measurements in the range.
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3. Click on the Start or Stop frequency setting to change it. Type in a number for the frequency and a letter as a multiplier. You can use k,
m, or g to set the frequency multiplier.

4. Click Done to save your changes.

Specifying Spur Requirements
A spur is a signal peak that exceeds both the Threshold and Excursion settings in the Ranges and Limits table. The Threshold and
Excursion settings are absolute values; they are not calculated relative to a reference. The Threshold and Excursion settings are specific
to the selected range. If you want to use different settings for spurs in different ranges, you have to set the values separately for each
range. The Excursion control is used to avoid interpreting a single spur as multiple narrower spurs by requiring the amplitude to drop by the
Excursion amount between spurs. Raising the Threshold value means that fewer, larger signals will be identified as spurs.

To specify the spur requirements for a range:

1. Click the Expand button on the Range and Limits tab. This displays the Ranges and Limits Table.
2. Select the Range (A–T) for which you want to specify the spur requirements.
3. Set the Thrshld value.
4. Set the Excrsn value.

Setting Limits
Use the Limits settings in the Ranges and Limits Table to specify the pass/fail parameters for the Spurious measurement. When the Mask
setting is set to any value except off, the instrument identifies any signal peak that exceeds the specified limits as a violation and displays
Fail on the screen. If no signal peak exceeds the limits, the instrument displays Pass on the screen.

Performing Pass/Fail Limit Testing
To set limits:

1. Click the Expand button on the Range and Limits tab. This displays the Ranges and Limits Table.
2. Adjust the Start and Stop frequencies as required for each range you want to test.
3. For ranges that you wish to test, verify that the On box is checked.
4. For each range you wish to test, select the desired Mask type from the drop-down list.
5. Set the limits as desired in the Abs Start, Abs Stop, Rel Start, and Rel Stop boxes. The values you can edit depend on the mask

type you select.
6. Verify that the Thrshld and Excrsn values are set as required. These are the values that define a spur.
7. Click Done to save your changes and close the Range and Limits Table window.
8. Click Run to begin testing.

CCDF Display
The CCDF (Complementary Cumulative Distribution Function) is a statistical characterization that plots power level on the x-axis and
probability on the y-axis of a graph. Each point on the CCDF curve shows what percentage of time a signal spends at or above a given
power level. The power level is expressed in dB relative to the average signal power level. The CCDF Display also shows the Average
power level and the Peak/Average ratio.

To show the CCDF display:

1. Recall an appropriate acquisition data file.
2. Press the Displays button or select Setup > Displays. This shows the Select Displays dialog box.
3. From the Measurements box, select RF Measurements.
4. Double-click the CCDF icon in the Available Displays box. This adds the CCDF icon to the Selected displays box.
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5. Click the OK button.
6. Press the Replay button to take measurements on the recalled acquisition data file.

Elements of the CCDF Display

Item Display element Description

1 100% The top of the graph represents the 100% probability that the signal will be at or above the
average signal level.

2 Power level select Adjust to display the value of the CCDF curve at a specific power level. The selected
power level is indicated by a small triangle on the CCDF curve.

3 CCDF value Readout of the value of the CCDF curve at the selected power level.

4 Avg Readout of the Average power level and the CCDF value at the Average power level.

5 Readout Table Readout of the CCDF curve at six points.

6 Pk / Avg Readout of the Peak to Average power ratio.

7 Measurement time Readout of the length of time used for the measurement. Displays --- s when the
Measurement time is set to continuous.

Changing the CCDF Display Settings

CCDF Settings
Main menu bar: Setup > Settings 

The control panel tabs for the CCDF Display are shown in the following table.
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Settings tab Description

Parameters Specifies the time to be measured.

Traces Select the trace to be measured and select reference trace for display.

Scale Specifies the vertical and horizontal scale settings.

Prefs Specifies whether on not certain display elements are shown.

Restore defaults. Sets the CCDF parameters to their default values.

Scale Tab
The Scale tab for the CCDF display allows you to change the start and stop points for the horizontal trace. Changing the scale settings
changes how the trace appears on the display but does not change control settings such as Center Frequency.

Setting Description

Rest Scale Resets all settings to their default values.

Horizontal Controls the span of the trace display and position of the trace.

Start Sets the starting range of the trace.

Stop Sets the end range of the trace.

Parameters Tab
The Parameters tab enables you to specify several parameters that control signal acquisition for the CCDF Display.

RF Measurements

SignalVu™ Vector Signal Analysis Software Printable Help 135



Setting Description

Single When Single is selected, the CCDF measurement is based on the Analysis Time parameters set on
Analysis control panel (Setup > Analysis > Analysis Time), shared by all displays. In Single, CCDF is
time-correlated with the other open displays.

Total Time When Total Time is selected, you can adjust its value. The value set here changes the Analysis
Length (and Acquisition Length, if needed) to 20 msec. If the Total Time value is longer than the
Analysis Length, CCDF uses multiple acquisitions to collect signal data.

Continuous When Continuous is selected, the CCDF measurement combines each new record (Actual Analysis
Length) into the existing result. It does not erase and start over until user presses STOP or CLEAR.

Span Specifies the range of frequencies used for analysis.

Single
To have statistically meaningful results, CCDF works best when calculated on at least 1 ms of data. Depending on the Analysis Time
setting, the CCDF display may present error messages:

• If the Actual Analysis Time is greater than 1 ms, the CCDF Display will calculate the trace without any problems.
• If the Actual Analysis time is less than 1 ms, the CCDF Display will measure the data as best if can, but if it receives fewer than

20 samples, the CCDF display will clear the trace and report "Not enough samples".

Total Time
Setting the Measurement Time to Total Time changes the Analysis Length (and Acquisition Length, if needed) to 20 msec. This can impact
other measurements. For instance, the OBW measurement would change because it would get more analysis length than it normally
needs, so switching in/out of the CCDF Total Time selection noticeably affects OBW results. This happens to a lesser amount when
Measurement Time is set to Single or Continuous. This is because each sets Analysis Length to 1 msec. These different Analysis Lengths
may affect other measurements, too.

Settling Time Measurement Overview
The Settling Time measurement (Option SVT) is used to measure frequency and phase settling time of frequency-agile oscillators
and subsystems. Automated measurements can reduce user-to-user measurement variations, improve repeatability and measurement
confidence, and save time in gathering results.

Measurement Definitions

Settling time. The time measured from a reference point to when the signal of interest settles to within user-defined tolerance.

Settled frequency. The final reference frequency, determined automatically or manually. The tolerance band is centered about this settled
frequency.

Settled phase. The final reference phase, determined automatically or manually. The tolerance band is centered about this settled phase.

Mask Testing
Mask testing is a tool to automatically determine the pass/fail state of the Device-Under-Test. The mask is defined over three or fewer
user-defined time zones, with an independent limit band for each time zone. If the mask is violated, the area of violation is highlighted
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in red on screen, and a Fail message is displayed. The pass/fail status of the mask test can be queried over GPIB for rapid results. To
configure Mask testing, see the Mask tab.

The instrument's Search function can watch the Settling Time measurement for either pass or fail results, and perform actions such as
stopping or saving data when the defined condition occurs. See Mask Test Settings on page 492 for details on configuring Mask Test.

Frequency Settling Time Theory of Operation
The following paragraphs describe how a frequency and phase settling measurement is made.

Figure 2: Frequency settling time flow diagram
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Figure 3: Phase settling time flow diagram

Acquisition hardware collects I and Q samples at the measurement frequency. Sample Rate is based on the measurement bandwidth
setting.

The instantaneous phase is computed as:
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The instantaneous frequency is the derivative of the phase:

Data smoothing is applied (if selected by the user). This filtering method uses ±n adjacent samples to produce an average value that is
used to replace the values of the original 2n samples. An example is shown below.

If averaging is turned on, the smoothed data array is averaged with data arrays of previous acquisitions on a point-by-point basis.
Smoothing has the advantage of reducing noise-like variations in the measurement, but carries the risk of masking real measurement data.
The amount of smoothing applied must be determined by evaluating the waveform you see for artifacts that result from the process.

Next, Settled Frequency is calculated. Settled frequency is the average frequency determined by looking back in time from the point set
by the Measurement Length control over a minimum of 256 samples. This value is used to determine the frequency level about which
to center the Tolerance range. The measurement then searches backward through the data until it finds the first point that exceeds the
tolerance range. A maximum of 20 million acquisition data samples can be processed by the measurement.

Settling Time is measured as the time from the start reference to the point where the frequency remains within the tolerance band. The
start reference can be any of three points:

• The trigger point
• The beginning of the analysis period. This result can only be computed when the instrument can find a previous settled state within the

measurement period
• The point at the end of the previous frequency hop where the frequency first leaves the tolerance band. This result can only be

computed when the instrument can find a previous settled state within the measurement period.
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Figure 4: Settling time start reference points

All measurements are now complete and the numeric settling time values can be sent to the display. However, no result traces have been
produced yet. Detection is used to reduce the measured points (which can number up to 10 million) to a number more easily processed by
the display processor. +/- Peak detection is always used, preserving the maximum positive and negative excursions for display. Reducing
the number of points in the result reduces the time resolution of the markers. If averaging is on, the measurement results are computed on
the average of the undecimated results.

Phase Settling Time Overview
Phase settling time is determined, as described previously, with the addition of tilt correction.

The instrument estimates tilt (or slope of the phase) using linear least square fitting over (at least) 256 samples of the phase vs. time
waveform, looking backwards from the point set by the Measurement Length. The instrument adjusts the phase waveform so that its phase
is of zero value at the point set by the Measurement Length.

Settling Time Displays
The Frequency Settling Time measurement is used to measure the frequency settling time of frequency-agile oscillators and subsystems.
The Phase Settling Time measurement is used to measure the phase settling time of phase-agile oscillators and subsystems. Automated
measurements can reduce user-to-user measurement variations, improving repeatability and measurement confidence and saving time in
gathering results. To measure phase settling, a phase reference is required. This means that the measurement tool must be frequency-
referenced to the device under test, or must act as the frequency reference to the device under test. To lock the reference to an external
source, go to Setup > Configure In/Out > Frequency Reference and choose External. Values from 1 MHz to 25 MHz in 1 MHz steps can
be used as an external reference.

To show a Settling Time display:

1. Recall an appropriate acquisition data file.
2. Click the Displays button or select Setup > Displays.
3. From the Measurements box, select RF Measurements.
4. Double-click the Freq Settling icon or the Phase Settling icon in the Available displays box. This adds the selected display to the

Selected displays box (and removes it from the Available displays box).
5. Click the OK button.
6. Press the Replay button to take measurements on the recalled acquisition data file.
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Figure 5: Frequency settling time display

Figure 6: Phase settling time display

Elements of the Display

Item Display element Description

1 Top of graph Sets the frequency/phase that appears at the top of the graph. However, note that the
top of graph setting, vertical scale setting (Settings > Scale tab), and Vertical Position
settings interact. Adjusting this value changes the frequency/phase at the top of the graph
by adjusting the scale setting.

Phase Settling Time: Sets

2 Vertical Position Sets the frequency/phase value at the vertical center of the graph.

Table continued…
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Item Display element Description

3 Autoscale Adjusts the Vertical and Horizontal scaling to display the entire trace on screen.

4 Horizontal Position Sets the horizontal position of the trace on the graph.

5 Measurement readouts Displays measurement results. See Measurement Readout Text Color below.

6 Signal transition start indicator A blue vertical line that indicates the staring point of the Settling Time measurement that
is based on the signal transition away from the previous settled state, if a previous settled
state is found within the measurement period.

7 Trigger point indicator An orange line and “T” (which appears below the graph) that indicates the location of the
trigger point in time.

8 +/- Tolerance indicators A pair of blue horizontal lines that show the tolerance range.

9 Settled time indicator A blue vertical bar that shows the point on the trace at which the measurement has
determined the signal frequency or phase to be settled.

10 Measurement length indicator A magenta vertical line that specifies the end of the allowed measurement period. This is a
control, not a result.

11 Scale Adjusts the horizontal (time) scale of the graph.

12 Clear Restarts multi-trace functions (Avg, Hold) and erases the trace.

13 Function Displays the Detection and Function selections for the selected trace. (Detection is always
+/-Peak for Settling Time measurements.)

14 Show Controls whether the selected Trace is visible or not. When trace is Off, the box is not
checked.

15 Trace Selects a trace. Touching here displays a menu that shows the available traces and
whether they are enabled or not. If you select a trace that is not currently enabled, it will be
enabled.

Measurement Readout Text Color

The measurement readouts can appear in either black text or red text. Measurement results that appear in black text indicate:

• the signal is settled AND
• the signal is settled longer than the minimum settled duration AND
• the settling time is valid OR the settling time from trigger is valid

If any of the conditions listed are not met, the measurement results text is red.

Elements of the Frequency Settling Time Graph
The following illustration shows the various indicators that appear in the Frequency Settling Time graph.
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Note: The blue vertical bar that indicates the end of the previous settled state may not always appear. For frequency settling time,
this can happen because the starting frequency is outside the measurement bandwidth.

Elements of the Phase Settling Time Graph

The following illustration shows the various indicators that appear in the Phase Settling Time graph. For most phase settling time
measurements, there is not a previous settled state within the measurement period, making it impossible to measure the settling time from
the previous settled value. However, the settling time from trigger is typically available.
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Note: The blue vertical bar indicating the measurement start time may not appear. Zero phase is referenced to the measured hop,
as the phase will not typically have a settled value during the previous hop.

Measuring Settling Time

1. Select the Displays button.
2. Select RF Measurements from the Measurements box.
3. Double-click the Freq Settling icon or Phase Settling icon in the Available displays box. Click OK to complete your selection.
4. Select General Signal Viewing from the Measurements box.
5. Double-click the Time Overview icon in the Available displays box. Click OK to complete your selection.
6. Press the front-panel Freq button and use the front-panel keypad or knob to adjust the frequency to that of the signal you want to

measure.
7. Select the Trig button.
8. In the Trigger control panel, select Triggered. Configure the trigger settings an needed to achieve a triggered signal.

For the next step in measuring settling time, you must set the starting point of the measurement. To do this, you will use the Time
Overview display.

9. Select the Time Overview display.
10. At the left edge of the graph, drag across the graph to adjust the analysis offset. Adjust the Analysis Offset to locate the start of the

settling time measurement just ahead of the signal transition where you want to measure the settling time. Any portion of the signal in
the gray area will be excluded from the settling time measurement.
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Figure 7: Setting the starting point of the settling time measurement

Even if the signal transition is difficult to see on the Time Overview display, you can set the starting point based on the location of the
Trigger indicator below the graph. Or open the Frequency vs. Time graph to see the frequency transition.

11. Click in the Settling Time display to select it.
12. Select the Settings button to display the Settling Time Settings control panel.
13. On the Define tab, adjust the Meas BW to improve the signal-to-noise ratio as appropriate. Make sure the bandwidth covers

the settled frequency, particularly when the instrument Measurement Frequency is not locked to the spectrum Center Frequency
(Analysis control panel > Frequency tab).

14. Set the Target Reference on page 148 to Auto or Meas freq as appropriate. If you select Meas freq, also set Offset to fine-tune the
measurement frequency if necessary.

15. Set the Tolerance as required for your measurement.

If your signal must be settled for a period of time before it is considered settled, you can specify a minimum settled duration for the
settling time measurement.

16. Select the Time Params tab. Adjust the Min Settled Duration on page 149Min Settled Duration on page 149 as required.

To get the measurement made in the correct location on the signal, you must adjust the measurement length. You do this by dragging
the magenta line in the Settling Time graph.

17. Drag the measurement length indicator (magenta line) to the correct location on the signal. Choose a point at which the signal
appears to be well settled. The measurement will then find the exact time at which the signal actually settled to within the specified
tolerance.

Note the difference in the settling time in the two illustrations that follow. In both examples, the Target reference is set to Auto. The only
difference is the measurement length, as shown by the magenta line.
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Figure 8: Frequency settling time display before setting the measurement length

Figure 9: Frequency settling time display after setting the measurement length

Settling Time Settings
Main menu bar: Setup > Settings

The settings for the Frequency and Phase Settling Time displays are shown in the following table.

Settings tab Description

Define Sets the measurement parameters that characterize the settling time measurement.

Time Params Sets measurement end-time and minimum settled duration parameters.

Mask Enable or disables mask testing and sets the parameters that specify the three zones used for mask
testing.

Trace Specifies trace display characteristics and which traces are displayed.

Table continued…
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Settings tab Description

Scale Sets vertical and horizontal scale and position parameters.

Prefs Specifies whether or not to show certain display elements, the maximum number of points in the
exported trace, and the displayed precision of the settling time measurement.

Common Controls Settling Time Displays Shared Measurement Settings
The control panel tabs in this section are shared by the Frequency and Phase Settling Time displays. These control panel tabs are not
shared with other RF Measurement displays. With few exceptions, each display shares values for each of the controls on these tabs. For
example, Vertical Scale values are independent for each of the displays (degrees for Phase Settling Time and Hertz for Frequency Settling
Time).

Table 12: Common controls for settling time measurement displays

Settings tab Description

Define Specifies the parameters that characterize the settling time measurement.

Time Params Specifies the Measurement length and minimum settled duration for the settling time measurement.

Mask Specifies the parameters used for Mask testing.

Trace Specify which traces to show and how they are computed.

Scale Specifies the vertical and horizontal scale settings.

Prefs Specifies display parameters of the Settling Time displays.

Define Tab for Settling Time Displays
The Define tab for the Frequency Settling Time measurement controls several parameters that affect how the measurement is made.

Meas Freq
Select the frequency of the signal to be measured. Measurement Frequency can be selected as the target frequency (see Target
Reference).

Note: If Lock Center Frequency of Spectrum Display to Measurement Frequency is unchecked, then Measurement Frequency is
independent of Center Frequency) Range: Entire input frequency of the instrument
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Meas BW
This control limits the bandwidth of the Settling Time measurement. You use the measurement bandwidth setting to improve the
signal-to-noise ratio of the measurement, resulting in lower measurement uncertainty. However, if the measurement bandwidth is set too
low, resulting in fewer samples per second, it can reduce the number of points within the measurement length below the 256 stable
samples required, thus causing the analysis to fail. The measurement bandwidth depends on the oscilloscope on which the recalled file
was acquired. To see the effect of measurement bandwidth on measurement uncertainty, see the RSA6100B Series Specifications and
Performance Verification Reference, Tektronix part number 077-0647-XX. This manual can be downloaded from www.tek.com/manuals.

Target Reference
The target reference is a calculated or user-specified value of final settled frequency within the measurement period. When set to Auto,
the instrument determines this value by averaging at least the last 256 samples at the end of the measurement period. When set to
Meas freq, the Target Reference is set to the Measurement Frequency of the instrument. You can enter a manual offset from the target
frequency to fine-tune the Target Reference when Meas freq is selected.

Tolerance(+/-)
The Tolerance is the frequency or phase range within which the signal must remain to be considered settled. This is set as a ± value by
the user. In the frequency settling time measurement, the tolerance band is centered about the target value. In the phase settling time
measurement, the tolerance band is centered about the settled phase value.

The target frequency depends on the Target reference value setting:

• If Target Reference is set to AUTO, then the target value is the settled value (the frequency at which the signal is considered settled).
• If Target Reference is set to MeasFreq, then the Target value = Meas Frequency + Offset.

Offset
Offset is used for fine-tuning the Target Reference when Meas freq is selected. The value for Offset is entered manually.

Time Params Tab for Settling Time Displays
The Time Params tab is used to set the Measurement length and minimum settled duration parameters.

Measurement Length
Measurement length locates the end of the measurement period for settling time. This value is set independently of the analysis period for
other measurements in the analyzer. This allows other measurements to display multiple frequency hops during an analysis, while focusing
the settling time analysis on a single hop. You can set the measurement length either by entering a value in the entry box, or by dragging
the magenta bar to the desired location in the graph. Traces and the display to the right of the measurement time are shown in grey to
indicate that this section of the waveform is not being used in the measurement. If your signal does not settle to within your tolerance band,
make sure that the measurement time ends during the settled portion of the waveform. The beginning of the settling time measurement is
set with the analysis offset control, the same as other measurements in the instrument. Use analysis offset to exclude earlier hops from the
measurement. See Analysis Time for setting the analysis offset control.
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If there is more than one phase or frequency hop in the signal to be analyzed, use the Measurement Length control to instruct the analyzer
which hop to measure. First, adjust the main Analysis Offset control to a point in time slightly earlier than the transition you wish to
measure. Do this in the Time Overview display or the Analysis Settings control panel. Then adjust the Measurement Length so the end of
the Settling Time measurement falls within the apparent settled period after the signal transition. The reason it is important for the user to
set this control is that the Settling Time measurements start at this point and look backwards in time (towards the signal transition) to find
the latest trace point that is not inside the tolerance band.

Note: If your signal does not settle to within your tolerance bands, make sure that the measurement time ends during the settled
portion of the waveform.

Min Settled Duration
The minimum settled duration is the amount of time the signal must remain within the tolerance band to be considered settled. Some user
specifications require that the signal be settled for a minimum period. If this is not required in your application, set this value to the default
of 0 seconds.

Mask Tab for Settling Time Displays
The Mask tab is used to specify the parameters used for Mask testing. 

Enable Mask Test
Enables or disables mask testing.

Start 1, 2, 3
Sets the starting point for the time zone of interest. If you don't want to use all three zones, set the Start Time for the unneeded zones to a
time after the end of the Measurement Length.

Stop
Sets the end point for the final time zone of interest.

Limit (+/-)
Sets the mask violation limits for each time zone.

Mask Time Reference
When mask testing is enabled, the Mask time reference selection specifies the starting point of the mask. You can choose to start the mask
test at the trigger point or at the point on the trace where the signal began its transition from its previous settled frequency or phase level to
the level you intend to measure.

This capability is useful because some applications do not have a trigger signal available. For those situations where a trigger signal is
available, the specification for the device-under-test may require that measurements be referenced to that signal.
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Trace Tab for Settling Time Displays
The Traces Tab allows you to set the display characteristics of displayed traces.

Smooth
Smooth is a low-pass filter function that uses n points in the trace to determine the smoothed value. For example, in the case of n=3, 3
consecutive points are averaged to determine the result of the smoothed output. This is very useful for single-shot signals that contain
significant noise where multiple trace averages cannot be used. However, smoothing does have limits, and the user should visually
determine whether smoothing is removing noise from the measurement, or if it is affecting the signal. The following illustration shows the
effect smoothing has on the displayed trace.

The range for the Smooth function is 2–1000. The setting resolution is 1. arrow keys increment it in steps of 1, 2, 5, 10. When smoothing is
enabled, it applies to both traces. Smooth is turned off by default.

Average
This sets the number of acquisitions to be averaged together to produce the result. Averaging reduces random variations but maintains the
correct waveshape for repeating signal aberrations. To use averaging, the signal must be repetitive. For example, the tuning direction must
always be same for each measurement to be averaged. Signals that vary in tuning direction will tend to average positive-going effects with
negative-going effects and the settling time characteristics will cancel out.

The range for the Average function is 2–10000. The setting resolution is 1. arrow keys increment it in steps of 1, 2, 5, 10. When smoothing
is enabled, it applies to both traces. Smooth is turned off by default.

Trace
Selects a trace for display. Choices are Trace 1 and 2. Either trace can be a recalled trace.
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Saving Traces
To save a trace for later analysis:

1. Select the Save Trace As button. This displays the Save As dialog box.
2. Navigate to the desired folder or use the default.
3. Type a name for the saved trace and click Save.

Recalling Traces
You can recall a previously saved trace for analysis or comparison to a live trace.

To select a trace for recall:

1. Select the trace into which the recalled trace will be loaded, from the Trace drop-down list.
2. Check the Show check box.
3. Click the ... button to display the Open dialog box.

4. Navigate to the desired file and click Open.
5. Check the Show Recalled Trace check box.
6. Verify that the trace's Show check box is selected (either on this tab or next to the drop-down list located at the top-left corner of the

graph).

Scale Tab for Settling Time Displays
The Scale tab allows you to change the vertical and horizontal scale settings. Changing the scale settings changes how the trace appears
on the display but does not change control settings such as Measurement Frequency. In effect, these controls operate like pan and zoom
controls.

Setting Description

Vertical

Scale Changes the vertical scale or span of the graph.

Position Sets the frequency (or phase) at the vertical center of the graph.

Relative Freq Sets the vertical (position) display readouts to show frequency values relative to the center frequency
or as absolute values.

Autoscale Resets the Scale and Position to center the trace in the graph.

Horizontal

Table continued…
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Setting Description

Scale Sets the range of time shown in the graph.

Position Allows you to pan the graph left and right.

Autoscale Resets Scale and Position to the automatically determined settings.

Prefs Tab for Settling Time Displays
The Prefs tab allows you to change display parameters of the Settling Time displays. 

The following table explains the controls that can appear on the Prefs tab.

Setting Description

Max trace points Sets the number of trace points used for marker measurements and for results export.

Show graticule Select to display or hide the graticule.

Show Marker readout in graph
(selected marker)

Shows or hides the readout for the selected marker in the graph area.

Settling Time decimal places Specifies the precision of the settling time measurement readout that appears below the graph. This
setting does not affect the precision of internal calculations.

SEM Display
The SEM (Spectrum Emission Mask) display measures out-of-band emissions immediately outside the channel bandwidth that result from
the modulation process and non-linearity in the transmitter. The Spectrum Emission Mask display allows you to define up to six pair of
masks, or offsets, that specify the limits for out-of-band emissions and performs a pass/fail tests of the signal against the defined offsets
and limits.

To show the Spectrum Emission Mask display:

1. Recall an appropriate acquisition data file.
2. Select Displays or select Setup > Displays.
3. In the Select Displays dialog, select RF Measurements or WLAN Analysis in the Measurements box.
4. In the Available displays box, double-click the SEM icon or select the icon and click Add. The SEM icon will appear in the Selected

displays box and will no longer appear under Available displays.
5. Click OK to show the Spectrum Emission Mask display.
6. Press the Replay button to take measurements on the recalled acquisition data file.
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Elements of the Display

Item Display element Description

1 Check mark indicator Indicates the display for which the acquisition hardware is optimized.

Note: When Best for multiple windows is selected in the Amplitude control
panel's RF & IF Optimization control, none of the measurement displays shows a
checkmark, as there is not a single optimized measurement.

2 Top-of-graph setting Sets the level that appears at the top of the graph.

(not
shown)

Units Sets the global amplitude units for all the views in the analysis window. This will change
the amplitude selection in the Units tab of the Amplitude control panel.

3 dB/div Sets the vertical scale value. The maximum value is 20.00 dB/division.

4 Bottom-of-graph readout Indicates the amplitude at the bottom of the graph. This value changes with the dB/div and
Vertical Position settings.

5 Autoscale Properly offsets the peak of the display from the top of the screen.

If the screen has been enlarged through a manual vertical (dB/div) setting entry, the view
is not vertically rescaled when Autoscale is used.

6 CF / Pos Default function is CF - center frequency (equivalent to the Measurement Freq setting).
If Horizontal scaling has been manually adjusted in Setup > Settings > Scale, then Pos
replaces CF as the setting at the bottom-left corner of the screen. Adjusting Pos shifts the
trace left or right in the graph, but does not change the measurement frequency.

7 Span / Scale Default function is Span - frequency difference between the left edge of the display and
the right edge. If Horizontal scaling has been manually adjusted in Settings > Scale, then
Scale will replace Span as the setting at the bottom-right corner of the screen.

8 Clear Erases the current results from the display.

Table continued…
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Item Display element Description

9 Function readout Readout of the Function selection for the Reference channel (Setup > Processing >
Function).

Spurious

10 Detection readout Readout of the Detection selection for the Reference channel (Setup > Processing >
Detection).

11 Pass / Fail readout Readout indicating whether any part of the trace has exceeded the any of the limits
defined in the Offsets & Limits table (Setup > Settings > Offsets & Limits Table).

Pass / Fail Readout
This readout displays either Pass or Fail XX%. When the signal exceeds the mask in any offset, it is considered a mask violation, and
results in Fail XX% being displayed. If there are no mask violations, Pass is displayed.

How the fail percentage is determined. Each offset has two sides, one lower and one upper. For example, Offset A has two sides: AL
(lower side) and AU (upper side). In the SEM display, there is a maximum of six offsets (A-F) and each offset can have a maximum of two
sides (if Both is selected for Side in the Offsets & Limits table). This results in a total of six offsets multiplied by two sides per offset, which
results in 12 offsets. Mask violations can occur in any of these offsets. The failure percentage is calculated as follows:

Fail percentage = Number of offsets with mask violations x 100 / Total number of enabled offsets

For example: Assume there are three enabled offsets: A, B, C, and all these offsets have both lower and upper sides. Thus, the total
number of enabled offsets is equal to six. Suppose there are mask violations in the offsets AL and CU, then the number of offsets having
mask violations is equal to 2. Therefore, Fail percentage = 2 * 100 / 6 = 33%.

Results Display
The Results Display shows the measurement results for the SEM display.

Readout Description

Ref: A two-part readout to the left of the table that displays information about the Reference
Channel. The first part of the readout displays the Measurement Type selected on the
Parameters tab. The second part of the readout displays the measurement result for the
Reference channel.

Row A sequence number for ordering the offsets. Click to organize by row number, resort rows
from high to low or low to high.

Offset The Offset name. A combination of the offset (A-F) and the location (U for upper and L for
Lower).

Start Freq The start frequency of the offset (relative to the Measurement Freq).

Table continued…
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Readout Description

Stop Freq The stop frequency of the offset (relative to the Measurement Freq).

Peak Abs Absolute power peak power at worst case margin of the offset

Margin Abs The worst case difference between the trace and the absolute limit line. Note that an offset
can have different start and stop levels, thus, the margin can vary if the offset start and stop
levels are different.

Peak Rel Relative peak power of worst case margin of the offset. Relative with respect to the
reference power level.

Margin Rel The worst-case difference between the trace and the relative limit line. Because an offset
can have different start and stop levels, the margin can vary if the offset start and stop
levels are different.

@Freq The frequency at which the worst margin occurs.

Integ Abs The absolute integrated power of the offset.

Integ Rel The relative integrated power of the offset (with respect to the reference power).

Reordering results in the results table. You can sort the results in the Results table by clicking the column heading containing the values
you want to sort on. You can sort results for the following columns: Row, Offset, Start Frequency, Stop Frequency, Peak Abs, and Peak
Rel.

Rearranging columns in the results table. You can rearrange the order of the columns and their size. To rearrange columns, select the
column heading you want to move and drag it to the new position; the new location is indicated by a dark blue bar that appears between
column headings.

You can resize the columns by selecting the divider between columns and dragging it to a new position.

Spectrum Emission Mask Settings
Main menu bar: Setup > Settings 

The settings for the Spectrum Emission Mask display are visible when SEM is the selected display. To display the SEM Settings, select
Setup > Settings.

Settings tab Description

Parameters Tab Specifies several characteristics that control how the measurement is made.

Processing Tab Specifies settings for detection on the Reference channel and the offsets. Specifies the function
setting.

Ref Channel Tab Specifies how the measurements on the reference channel are performed.

Offsets & Limits Table Specifies characteristics of offsets and mask limits.

Table continued…
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Settings tab Description

Scale Tab Specifies the vertical and horizontal scale settings.

Prefs Tab Specifies the appearance features of the graph area and the maximum trace points.

Parameters Tab - SEM
The Parameters tab specifies several characteristics that control how the Spectrum Emission Mask measurements are made.

Setting Description

Meas Freq Specify the frequency of the signal to be measured.

Step Sets the increment size when changing the Frequency using the knob or mouse wheel.

Auto When Auto is enabled, the step size is adjusted automatically based on the span setting.

Real-Time When Real-Time mode is enabled, the entire SEM span is measured using a real-time/contiguous
acquisition. Not all described parameters are available in Real-Time mode.

Measurement Type Specifies the type of measurement for the reference channel; used as a reference for the offsets.

Total Power Sets the reference to the integrated power of the reference channel within the reference's integration
bandwidth.

PSD Sets the reference to the mean of the power spectral density (dBm/Hz) of the reference channel. The
trace and the absolute and relative limits line are also in dBm/Hz

Peak Sets the reference to the Peak power of the reference channel.

Offset definition Defines the relative position of the start/stop frequency of an offset. Choose the offset definition based
on the standard.

Ref center to OS center Specifies that the start/stop frequencies are defined from the center frequency of the reference
channel to the center of the filter BW.

Ref center to OS edge Specifies that the start/stop frequencies are defined from the center frequency of the reference
channel to the center of the (inner) edge of the filter BW of the offset.

Ref Edge to OS center Specifies that the start/stop frequencies are defined from the edge of the reference channel to the
center of the filter BW of the offset.

Table continued…
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Setting Description

Ref Edge to OS edge Specifies that the start/stop frequencies are defined from the edge of the reference channel to the
(inner) edge of the filter BW of the offset.

Filter Shape Specifies the shape of the filter determined by the window that is applied to the data record, in the
spectrum analysis, to reduce spectral leakage. 3GPP specifies a Gaussian window shape be applied
to the reference channel measurements.

Gaussian This filter shape provides optimal localization in the frequency domain.

Rectangular This filter shape provides the best frequency, worst magnitude resolution. This is essentially the same
as no window.

Processing Tab - SEM
The Processing tab controls the Detection settings for the Reference Channel and Offsets, as well as selecting the Function.

Settings tab Description

Detection (in each sweep)

Ref Channel Specifies the Detection method used for the Reference Channel. Detection is used to produce the
desired measurement result (peak or average) and to reduce the results of a measurement to the
desired number of trace points.

Avg (VRMS) For each sweep, each point of the trace is the result of determining the RMS voltage value for the
last 'n counts' of the collected traces for the same point. When 'n count' has not been reached, partial
averaging results are displayed.

+Peak Selects the +Peak detection method. With this method, the highest value is selected from the results
to be compressed into a trace point.

Offsets Specifies the detection method used for the offsets.

Avg (VRMS) Selects the Average Vrms detection method. With this method, each point on the trace in each offset
is the result of determining the RMS Voltage value for all of the results values it includes.

+Peak Selects the +Peak detection method. With this method, the highest value in each offset is selected
from the results to be compressed into a trace point.

Function (across multiple sweeps)

Table continued…
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Settings tab Description

Function Selects the trace processing method. Available settings are: Normal, Avg (VRMS), and Hold.

Normal When a new trace has been computed, it replaces the previous trace.

Max Hold With each sweep, each trace point in the new trace is compared to the point’s value in the old trace
and the greater value is retained for display and subsequent comparisons.

Avg (VRMS) For each sweep, each point on the trace is the result of determining the RMS Voltage value for all of
the collected traces' values for the same point.

Ref Channel Tab
The Ref Channel tab controls how the measurement of the Reference channel is performed.

Settings tab Description

Power Reference The value used to calculate relative measurements.

Auto When Auto is unchecked, you can enter a value for the reference power, and the measured reference
power is not used or displayed

RBW Sets the RBW for the Reference Channel.

VBW Enables/disables the Video Bandwidth filter. VBW is used in traditional swept analyzers to reduce the
effect of noise on the displayed signal. The VBW algorithm in the analyzer emulates the VBW filters
of traditional swept analyzers. When the checkbox next to VBW is not checked, the VBW filter is not
applied. SEM standards specify what value of VBW should be applied, if any.

Channel width Specifies the width of the reference channel.

Integration BW Specifies the integration bandwidth used to compute the total power in the reference channel.

Channel Filter Specifies the measurement filter used in the Reference Channel. Choices are None and Root-raised
Cosine.

Filter param Specifies the alpha value (or roll-off factor) of the Root-raised cosine filter. Present only when Channel
Filter is set to Root-raised Cosine.

Chip rate Specifies the chip rate used for the Root-raised Cosine filter. Present only when Channel Filter is set
to Root-raised Cosine.
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Offsets & Limits Table Tab - SEM
The Offsets & Limits Table tab is used to specify parameters that define Offsets and masks.

Figure 10: Expanded display of Offsets & Limits Table

Setting Description

Buttons

Expand Displays the Offsets & Limits Table in a new, resizeable window.

Reset Layout You can reorder columns in the Offsets & Limits Table by dragging the columns to a new position.
Clicking Reset Layout returns the column order to the factory default order.

Load Click to load a saved Offsets & Limits table from a file.

Save As Click to save the current Offsets & Limits table to a file.

Done When the table is expanded, click Done when you have finished editing the table to save your
changes and close the expanded table display.

Table columns

On Specifies whether or not measurements are taken in the specified offset.

Start (Hz) Start Frequency of the selected offset.

Stop (Hz) Stop Frequency of the selected offset.

Side Specifies whether the specified range appears on both side of the carrier frequency or just one side
(left or right).

RBW (Hz) Specifies the RBW for the selected range.

n (RBWS) An integer value that specifies how many times to multiply the RBW to set the Filter bandwidth.

Filter BW (n x RBW) Displays the Filter BW. Filter BW is the equivalent BW of each point in the offset. When n > 1,
an integration technique is used to achieve the Filter BW using narrower RBWs. For most SEM
measurements, this value is set to 1. The 3GPP standard suggests n greater than 1.

VBW (Hz) Adjusts the VBW (Video Bandwidth) value. VBW Maximum: RBW current value; VBW Minimum:
1/10,000 RBW setting.

Table continued…
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Setting Description

VBW On Specifies whether the VBW filter is applied.

Mask Select the type of limits used for Pass/Fail testing. Signal excursions that exceed the mask settings
are considered violations. The available choices are shown below.

Abs Start (dBm) Specifies the mask level at the inner edge of the selected offset.

Abs Stop (dBm) Specifies the mask level at the outer edge of the selected offset.

Abs Same Specifies whether the value for the inner and outer edges of the offset must be the same value. When
enabled, the Abs Stop cell is grayed-out and set to the value of the Abs Start cell.

Rel Start (dBm) Specifies the mask level for the Relative mask at the inner edge of the selected offset.

Rel Stop (dBm) Specifies the mask level for the Relative mask at the outer edge of the selected offset.

Rel Same Specifies whether the inner and outer edges of the offset must be the same value. When enabled, the
Rel Stop cell is grayed-out and its value is set to the value of the Rel Start cell.

Scale Tab - SEM
Use the Scale tab to change the vertical and horizontal scale settings. Changing the scale settings changes how the trace appears on the
display. In effect, these controls operate like pan and zoom controls.

Setting Description

Vertical Controls the vertical position and scale of the trace display.

Scale Changes the vertical scale units.

Position Adjusts the reference level away from top of the graph.

Autoscale Resets the scale of the vertical axis to contain the complete trace.

Horizontal Controls the span of the trace display and position of the trace.

Scale Specifies the frequency range displayed in the graph

Position Specifies the frequency shown at the center of the graph.

Autoscale Resets the scale of the horizontal axis to optimize the display of the trace.

Table continued…
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Setting Description

Reset Scale Resets all settings to their default values.

Prefs Tab - SEM
The Prefs tab enables you to change parameters of the measurement display. The parameters available on the Prefs tab vary depending
on the selected display, but include such items as enabling/disabling Marker Readout and switching the Graticule display on/off. Some
parameters appear with most displays while others appear with only one display.

Setting Description

Show graticule Controls the vertical position and scale of the trace display.

Max Trace points (per range) When the spectrum analysis produces more than the selected maximum number of points, the
method specified in Detection control is used to decimate the result. This setting applies to both the
Reference channel and offsets.

Show Marker readout in graph Adjusts the reference level away from top of the graph.

Show limits Controls the appearance of mask limits in the graph.

Shaded Shows limits using a shaded area. Green shading is used to identify Absolute limits. Blue shading is
used to indicate Relative limits.

Line only Shows limits using only a line. A green line is used to identify Absolute limits. A blue line is used to
indicate Relative limits.

None No lines or shading are used to indicate limits in the graph. Violations of the mask are still identified by
red shading.

Common Controls RF Measurements Shared Measurement Settings
The control panel tabs in this section are shared by multiple displays in the RF Measurement folder (Setup > Displays). With few
exceptions, each display maintains separate values for each of the controls on these tabs. For example, Scale values are independent for
each of the displays.

Table 13: Common controls for RF measurement displays

Settings tab Description

Freq & RBW Allows you to specify the Center Frequency, Step size and RBW.

Table continued…
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Settings tab Description

Traces Specifies trace parameters such as detection method and whether smoothing is enabled. Traces can
also be saved and loaded for reference from this tab.

Scale Specify vertical and horizontal scale settings.

Prefs Specify appearance features of the graph area.

Freq & RBW Tab
The Freq & RBW tab specifies frequency parameters for some of the RF Measurements displays.

Setting Description

Meas Freq Specifies the measurement frequency.

Step The Step control sets the increment/decrement size for the adjustment of the center frequency. If Auto
is enabled, the analyzer will adjust the Step size as required.

RBW Select Auto or Manual. Adjusts the RBW for the entire measurement. This setting is Independent of
the Spectrum view's RBW setting.

VBW Adjusts the VBW (Video Bandwidth) value.

Note: While the measurement frequency and step settings on this control tab are shared between ACPR, MCPR and Occupied
Bandwidth, the RBW setting is not shared. The RBW setting is unique for each measurement.

VBW
The VBW setting enables/disables the Video Bandwidth filter. VBW is used in traditional swept analyzers to reduce the effect of noise on
the displayed signal. The VBW algorithm in the analyzer emulates the VBW filters of traditional swept analyzers.

The maximum VBW value is 10 times the current RBW setting. The minimum VBW value is 1/10,000 of the RBW setting.

Note: If you are following a procedure that says to "set VBW to three times the RBW value or greater", it means that the test
should be conducted with no VBW effects. In the SignalVu software, this condition is met by disabling the VBW function.

Traces Tab
The Traces tab enables you to select traces for display. You can choose to display live traces and/or recalled traces. The Trace tab for
Settling Time displays is described in the Settling Time controls section.

Note: Not all RF Measurements support multiple traces and/or save and recall of traces.
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Setting Description

Trace Selects a trace for display.

CCDF display: Choices are Trace 1, 2, and Gaussian. Trace 1 and 2 can be recalled.

Spurious display: Choices are Trace 1, 2, 3, 4, and Math trace. All traces can be recalled. Math trace
is computed for all ranges.

Show Shows / hides the selected trace.

Freeze Halts updates to the selected trace.

Save Trace As Saves the selected trace to a file for later recall and analysis.

Show recalled trace Used to select a saved trace for display. When a trace is recalled, controls such as show, freeze, and
function will be disabled.

Function Selects the trace processing method (Spurious display only). Possible settings are: Normal, Average
(VRMS), Avg (of logs), and Max Hold.

Smooth: (points)

Average: (count)

Available for Phase and Frequency Settling Time displays only.

Smooth is a low-pass filter function that uses n points in the trace to determine the smoothed value.

Average sets the number of acquisitions to be averaged together to produce the result.

See Trace Tab for Settling Time Displays on page 150 for complete details.

Trace processing (Function)
The trace can be processed to display in different ways. The Function setting controls trace processing.

• Max Hold - Displays the maximum value in the trace record for each display point. Each new trace display point is compared to the
previous maximum value and the greater value is retained for display and subsequent comparisons.

• Normal - Displays the trace record for each display point without additional processing.
• Avg (VRMS) [Average VRMS] – Multiple traces are averaged together to generate the displayed trace, which will contain just one

vertical value for each underlying frequency data point. Once the specified number of traces have been acquired and averaged to
generate the displayed trace, additional traces contribute to the running average, except in Single Sequence run mode. In the case
of Single Sequence, the instrument stops running after the specified number of traces have been averaged together. The Number of
Traces setting specifies how many traces are averaged. The averaging is performed on the linear (Voltage) values, resulting in the
correct RMS average).

• Avg (of logs) – This is a trace function used to emulate legacy spectrum analyzer results and for the specification of displayed
average noise level. In older swept analyzers, a voltage envelope detector is used in the process of measuring signal level, and the
result is then converted to Watts and then to dBm. Averaging is then applied to the resultant traces.
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For CW signals, this method results in an accurate power measurement. However, with random noise and digitally modulated carriers,
errors result from this 'average of logs' method. For random noise, the average of logs methods results in power levels -2.51 dB lower
than that measured with a power meter, or with a spectrum analyzer that measures the rms value of a signal, and performs averaging
on the calculated power in Watts and not dBm or other log-power units.

This detector should be used when following a measurement procedure that specifies it, or when checking the Displayed Averaged
Noise Level (DANL) of the instrument. The 'average of logs' detection and trace function is used for DANL specification to provide
similar results to other spectrum/signal analyzers for comparison purposes. Use of the Average of Logs method of measurement is not
recommended for digitally modulated carriers, as power measurement errors will occur.

Note: The Detection setting does not affect the trace until the spectrum length is longer than the Auto setting.

Saving Traces
To save a trace for later analysis:

1. Select the Save Trace As button. This displays the Save As dialog box.
2. Navigate to the desired folder or use the default.
3. Type a name for the saved trace and click Save.

Recalling Traces
You can recall a previously saved trace for analysis or comparison to a live trace.

To select a trace for recall:

1. Select the trace into which the recalled trace will be loaded, from the Trace drop-down list.
2. Check the Show check box.
3. Click the ... button to display the Open dialog box.

1. Navigate to the desired file and click Open.
2. Check the Show Recalled Trace check box.
3. Verify that the trace's Show check box is selected (either on this tab or next to the drop-down list located at the top-left corner of the

graph).

Gaussian Trace (applies only to CCDF)
The Gaussian trace is a reference trace that you can compare your trace against. Because the Gaussian trace is for reference, there are
no settings for the trace other than whether or not it is shown.
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Scale Tab
The Scale tab allows you to change the vertical and horizontal scale settings. Changing the scale settings changes how the trace appears
on the display but does not change control settings such as Center Frequency. Parameters on this tab may vary depending on the selected
display.

Setting Description

Vertical Controls the vertical position and scale of the trace display.

Scale Changes the vertical scale units. This is only accessible when the vertical units are set to dBm.

Position Adjusts the level shown at the center of the graph.

Autoscale Resets the scale of the vertical axis to contain the complete trace.

Rest Scale Resets all settings to their default values.

Horizontal Controls the span of the trace display and position of the trace.

Scale (Start) Allows you to, in effect, change the span.

Position (Stop) Adjusts the position of the acquisition record shown at the left edge of the graph.

Autoscale Resets the scale of the horizontal axis to contain the complete trace.

Log (Spurious only) Resets the display to show the frequency axis in a logarithmic scale.

Prefs Tab
The Prefs tab enables you to change parameters of the measurement display. The parameters available on the Prefs tab vary depending
on the selected display, but include such items as enabling/disabling Marker Readout and switching the Graticule display on/off. Some
parameters appear with most displays while others appear with only one display.
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Setting Description

Show graticule Shows or hides the graticule.

Show Marker readout in graph
(selected marker)

Shows or hides the readout for the selected marker in the graph area.

Max trace points In general, time-domain traces can include up to 100K points and frequency-domain traces can
include up to 10K points. When the analysis produces a results array longer than the selected trace
length, the trace is decimated (using the method specified with the Detection control) to be equal to or
less than the Max trace points setting (except when Max trace points is set to Never Decimate). This
decimated (or undecimated) trace is what is used for marker measurements and for results export.

Settling Time decimal places
(Frequency and Phase Settling
Time displays only)

Specifies the number of decimal places shown in the results readout below the graph. This setting
does not affect the precision of internal calculations.

Show trace legend (CCDF
(Complementary Cumulative
Distribution Function) display
only)

Displays or hides the trace legend.
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WLAN Measurements
WLAN Measurements Overview
The WLAN Analysis option allows you to evaluate WLAN signals, performing standards based transmitter measurements in the time,
frequency, and modulation domains. WLAN measurements can be made on signals defined by 802.11a/b/g/j/n/p (standard IEEE
802.11-2012) and 802.11ac (draft IEEE P802.11ac-D4.0 or later). User controls allow you to modify signal parameters for analysis
of signals. The analysis results give multiple views of WLAN signal characteristics to allow the diagnosis of signal imperfections and
impairments quickly and easily. Display controls allow you to selectively display the analysis results to help locate trouble-spots in the
signal.

WLAN Standards
The following options support the given standards:

• Option SV23: Supports IEEE 802.11a, g, j, and p OFDM signals and 802.11b DSSS/CCK signals
• Option SV24: Supports IEEE 802.11n signals with bandwidths of 20 MHz and 40 MHz
• Option SV25: Supports IEEE 802.11ac signals with bandwidths of 20, 40, 80, and 160 MHz

WLAN Standards Presets
The Standards Presets button located on the WLAN Settings Control Panel allows you to recall preconfigured displays for the standards
and bandwidths that you select. You can also access these presets from Presets on the display menu bar. You can read more information
about the Standards Presets.

The following table shows the center frequency and displays that are automatically loaded for each of the listed standards and bandwidths.
SEM masks are also loaded and are explained here.
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Table 14: WLAN presets standards, bandwidths, center frequencies, and displays

Standard Bandwidth (MHz)
Center frequency
(GHz) Displays loaded

802.11a 20 5.18 SEM, Time Overview, WLAN Constellation, WLAN Summary

802.11g 20 2.412

802.11j 10 5.18

20

802.11p 5 5.8

10

20

802.11n 20 2.412

40

802.11ac 20 5.18

40 5.19

80 5.21

160 5.25

802.11b 2.412

SEM mask parameters. The SEM wireless standard masks that are applied to the WLAN signal depend on the standard you select when
you configure the preset. Once you select a standard and bandwidth, the application will automatically load the mask that best fits the
signal for which the standard applies. All mask parameters are derived from IEEE standards and loaded for you. This provides you the
assurance that you are evaluating the signal with the most appropriate mask.

WLAN Displays
The displays in WLAN Analysis (Setup > Displays > Measurements) are:

• SEM
• WLAN Channel Response
• WLAN Constellation
• WLAN EVM
• WLAN Magnitude Error
• WLAN Phase Error
• WLAN Power versus Time
• WLAN Spectral Flatness
• WLAN Summary
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WLAN Channel Response Display
The WLAN Channel Response display plots the channel response (magnitude and phase) versus the subcarrier or frequency. Here, the
channel refers to all sources of signal frequency response impairment up to the analyzer input, including the transmitter itself, as well as
any transmission medium through which the signal travels between the transmitter and the analyzer.

Note: WLAN Channel Response is only available for OFDM (non-802.11b) signals.

To show the WLAN Channel Response display:

1. If you are analyzing a stored data file, recall the data file now. Otherwise, go to the next step.
2. Press the Displays button or select Setup > Displays.
3. In the Select Displays dialog, select WLAN Analysis in the Measurements box.
4. In the Available displays box, double-click the WLAN Chan Response icon or select the icon and click Add. The WLAN Chan

Response icon will appear in the Selected displays box and will no longer appear under Available displays.
5. Click OK to show the WLAN Chan Response display.
6. Set the Frequency appropriate for the signal.
7. Select Setup > Settings to display the control panel.
8. Select the Modulation Params tab. Set the Standard, Guard Interval, Subcarrier Spacing, and Bandwidth controls as appropriate for

the input signal.
9. If you are analyzing a data file, press the Replay button to take measurements on the recalled acquisition data file.

Elements of the Display

Item Display element Description

1 Magnitude graph (top graph)

1a Top of graph Sets the level that appears at the top of the magnitude graph. This is only a visual
control for panning the graph. The Reference Level is adjusted in the Toolbar and the
Ampl control panel. By default, Vert Position = Ref Level.

Table continued…
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Item Display element Description

1b Position (dB) Sets the vertical position value. The maximum value is 20.00 dB. The readout
indicates the subcarrier (for non-b standards only) or frequency shown at the bottom
of the display.

1c Bottom of graph readout Indicates the magnitude at the bottom of the top graph. This value changes with the
dB and vertical Position settings.

2 Phase graph (bottom graph)

2a Top of graph Sets the phase value indicated at the top of the graph. Since the Position value at the
vertical center of this graph remains constant as the Top of Graph value is adjusted,
the Vertical Scale increases as the Top of Graph value increases, which also affects
the bottom of graph readout.

2b Position (°) Specifies the phase shown at the center of the graph display. Changing this value
moves the trace up and down in the graph, which affects the Top of Graph and Bottom
of Graph values as well.

2c Bottom of bottom graph readout Indicates the phase at the bottom of the bottom graph. This value changes with the
Position setting.

3 Autoscale Adjusts the Vertical and Horizontal scaling to optimize the trace display on screen.

4 Start (Position) Shifts the trace left or right in the graph. The readout indicates the subcarrier (for
non-b standards only) or frequency shown at the left edge of the display.

5 Stop (Scale) Specifies the number of subcarriers (for non-b standards only) shown in the graph.

WLAN Channel Response Settings
The WLAN Channel Response Settings control panel provides access to settings that control parameters of the Channel Response
Display.

Settings tab Description

Modulation Params Specifies the input signal standard and additional user-settable signal parameters.

Analysis Params Specifies parameters used by the instrument to analyze the input signal.

Data Range Tab Specifies which symbols and subcarriers of the signal to display.

Analysis Time Tab Specifies parameters that define the portion of the acquisition record that is used for analysis. Also
allows you to specify the time units (Symbols or Seconds) for WLAN Analysis displays.

Traces Tab Enables you to select from magnitude or phase trace, save a trace, and recall an trace

Scale Tab Specifies the Zoom scale, and vertical and horizontal positions of the display.

Prefs Tab Specifies the units of the display and whether elements of the graphs are displayed.
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WLAN Constellation Display
The WLAN Constellation Display shows the WLAN signal modulation amplitude and phase in I (horizontal) versus Q (vertical) form.
For multicarrier WLAN OFDM signals, the points show all data symbol subcarriers' modulation. For single-carrier 802.11b, each point
corresponds to a single modulated chip.

To show the WLAN Constellation display:

1. If you are analyzing a stored data file, recall the data file now. Otherwise, go to the next step.
2. Press the Displays button or select Setup > Displays.
3. In the Select Displays dialog, select WLAN Constellation in the Measurements box.
4. In the Available displays box, double-click the WLAN Constellation icon or select the icon and click Add. The WLAN Constellation

icon will appear in the Selected displays box and will no longer appear under Available displays.
5. Click OK to show the WLAN Constellation display.
6. Set the Frequency appropriate for the signal.
7. Select Setup > Settings to display the control panel.
8. Select the Modulation Params tab. Set the Standard, Guard Interval, Channel Bandwidth, and Subcarrier Spacing controls as

appropriate for the input signal.
9. If you are analyzing a data file, press the Replay button to take measurements on the recalled acquisition data file.

Elements of the Display

Item Display element Description

1 Plot Constellation graph.

2 Marker readout If markers are enabled, the marker readout shows the selected Marker, Symbol,
Subcarrier, Type, Value, Magnitude, and Phase for the symbol at the marker location.
Located to the left of the constellation plot or below it, depending on the size of the
window.

Table continued…
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Item Display element Description

3 Marker controls Define and position markers.

WLAN Constellation Settings
Main menu bar: Setup > Settings

The WLAN Constellation Settings control panel provides access to settings that control parameters of the Constellation Display. 

Settings tab Description

Modulation Params Specifies the input signal standard and additional user-settable signal parameters.

Analysis Params Specifies parameters used by the instrument to analyze the input signal.

Data Range Specifies which symbols and subcarriers of the signal to display.

Analysis Time Tab Specifies parameters that define the portion of the acquisition record that is used for analysis. Also
allows you to specify the Units (Symbols or Seconds) for WLAN Analysis displays.

Trace Tab Enables you to freeze the display or hide the measurement or average trace.

Scale Tab Specifies the Zoom scale, and vertical and horizontal positions of the display.

Prefs Tab Specifies the units of the display and whether elements of the graphs are displayed.

WLAN EVM Display
The WLAN EVM display shows the data symbols' individual subcarrier Error Vector Magnitude values versus symbol interval (time) and
subcarrier (frequency).

Note: For 802.11b analysis, the subcarrier graph is not displayed.

To show the WLAN EVM display:

1. If you are analyzing a stored data file, recall the data file now. Otherwise, go to the next step.
2. Press the Displays button or select Setup > Displays.
3. In the Select Displays dialog, select WLAN EVM in the Measurements box.
4. In the Available displays box, double-click the WLAN EVM icon or select the icon and click Add. The WLAN EVM icon will appear in

the Selected displays box and will no longer appear under Available displays.
5. Click OK to show the WLAN EVM display.
6. Set the Frequency appropriate for the signal.
7. Select Setup > Settings to display the control panel.
8. Select the Modulation Params tab. Set the Standard as appropriate. Set the Standard, Guard Interval, Channel Bandwidth, and

Subcarrier Spacing controls as appropriate for the input signal.
9. If you are analyzing a data file, press the Replay button to take measurements on the recalled acquisition data file.
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Elements of the Display

Item Display element Description

1 Top of graph Sets the EVM value that appears at the top of the graph. This is only a visual control for
panning the graph.

2 Bottom of graph Sets the EVM value that appears at the bottom of the graph. This is only a visual control
for panning the graph.

3 Autoscale Adjusts the vertical and horizontal settings to provide the best display.

4 Start (Position) Specifies the horizontal position of the trace on the graph display.

5 Stop (Scale) Adjusts the horizontal range of the graph. By decreasing the scale, the graph essentially
becomes a window that you can move over the analysis results by adjusting the position.

WLAN EVM Settings
Main menu bar: Setup > Settings 

The settings for the WLAN EVM display are shown in the following table.

Settings tab Description

Modulation Params Specifies the type of modulation used for the input signal and other parameters.

Table continued…
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Settings tab Description

Analysis Params Specifies parameters used by the instrument to analyze the input signal.

Data Range Specifies which symbols and subcarriers of the signal to display.

Analysis Time Specifies parameters that define the portion of the acquisition record that is used for analysis. Also
allows you to specify the Units (Symbols or Seconds) for WLAN Analysis displays.

Trace Enables you to freeze the display or hide the measurement or average trace.

Scale Specifies the vertical, subcarrier (for non-b standards only) and symbols scale and position settings.

Prefs Specifies the units of the display and whether elements of the graphs are displayed.

WLAN Magnitude Error Display
The WLAN Magnitude Error display shows the data symbols' individual subcarrier Magnitude Error values versus symbol interval (time)
and subcarrier (frequency).

Note: For 802.11b analysis, the subcarrier graph is not displayed.

To show the WLAN Magnitude Error display:

1. If you are analyzing a stored data file, recall the data file now. Otherwise, go to the next step.
2. Press the Displays button or select Setup > Displays.
3. In the Select Displays dialog, select WLAN Analysis in the Measurements box.
4. In the Available displays box, double-click the WLAN Mag Error icon or select the icon and click Add. The WLAN Mag Error icon will

appear in the Selected displays box and will no longer appear under Available displays.
5. Click OK to show the WLAN Mag Error display.
6. Set the Frequency appropriate for the signal.
7. Select Setup > Settings to display the control panel.
8. Select the Modulation Params tab. Set the Standard, Guard Interval and Spacing and Bandwidth controls as appropriate for the input

signal.
9. If you are analyzing a data file, press the Replay button to take measurements on the recalled acquisition data file.
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Elements of the Display

Item Display element Description

1 Top of graph Sets the Magnitude Error value that appears at the top of the graph. This is only a visual
control for panning the graph.

2 Bottom of graph Sets the Magnitude Error value that appears at the bottom of the graph. This is only a
visual control for panning the graph.

3 Autoscale Adjusts the vertical and horizontal settings to provide the best display.

4 Pos Specifies the horizontal position of the trace on the graph display.

5 Scale Adjusts the horizontal range of the graph. By decreasing the scale, the graph essentially
becomes a window that you can move over the analysis results by adjusting the position.

WLAN Magnitude Error Settings
Main menu bar: Setup > Settings

The settings for the WLAN Mag Error display are shown in the following table.

Settings tab Description

Modulation Params Specifies the type of modulation used for the input signal and other parameters.

Table continued…
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Settings tab Description

Analysis Params Specifies parameters used by the instrument to analyze the input signal.

Data Range Specifies which symbols and subcarriers of the signal to display.

Analysis Time Tab Specifies parameters that define the portion of the acquisition record that is used for analysis. Also
allows you to specify the Units (Symbols or Seconds) for WLAN Analysis displays.

Trace Enables you to display or hide the measurement or average trace.

Scale Tab Specifies the vertical, subcarrier (for non-b standards only), and symbols scale and position settings.

Prefs Tab Specifies the units of the display and whether elements of the graphs are displayed.

WLAN Phase Error Display
The WLAN Phase Error display shows the data symbols' individual subcarrier Phase Error values versus symbol interval (time) and
subcarrier (frequency).

Note: For 802.11b analysis, the subcarrier graph is not displayed.

To show the WLAN Phase Error display:

1. If you are analyzing a stored data file, recall the data file now. Otherwise, go to the next step.
2. Press the Displays button or select Setup > Displays.
3. In the Select Displays dialog, select WLAN Analysis in the Measurements box.
4. In the Available displays box, double-click the WLAN Phase Error icon or select the icon and click Add. The WLAN Phase Error icon

will appear in the Selected displays box and will no longer appear under Available displays.
5. Click OK to show the WLAN Phase Error display.
6. Set the Frequency appropriate for the signal.
7. Select Setup > Settings to display the control panel.
8. Select the Modulation Params tab. Set the Standard, Guard Interval and Spacing and Bandwidth controls as appropriate for the input

signal.
9. If you are analyzing a data file, press the Replay button to take measurements on the recalled acquisition data file.
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Elements of the Display

Item Display element Description

1 Top of graph Sets the Phase Error value that appears at the top of the graph. This is only a visual
control for panning the graph.

2 Bottom of graph Sets the Phase Error value that appears at the bottom of the graph. This is only a visual
control for panning the graph.

3 Autoscale Adjusts the vertical and horizontal settings to provide the best display.

4 Pos Specifies the horizontal position of the trace on the graph display.

5 Scale Adjusts the horizontal range of the graph. By decreasing the scale, the graph essentially
becomes a window that you can move over the analysis results by adjusting the position.

WLAN Phase Error Settings
Main menu bar: Setup > Settings 

The settings for the WLAN Phase Error display are shown in the following table.

Settings tab Description

Modulation Params Specifies the type of modulation used for the input signal and other parameters.

Table continued…

WLAN Measurements

SignalVu™ Vector Signal Analysis Software Printable Help 177



Settings tab Description

Analysis Params Specifies parameters used by the instrument to analyze the input signal.

Data Range Specifies which symbols and subcarriers of the signal to display.

Analysis Time Tab Specifies parameters that define the portion of the acquisition record that is used for analysis. Also
allows you to specify the Units (Symbols or Seconds) for WLAN Analysis displays.

Trace Enables you to display or hide the measurement or average trace.

Scale Tab Specifies the vertical, subcarrier (for non-b standards only), and symbols scale and position settings.

Prefs Tab Specifies the units of the display and whether elements of the graphs are displayed.

WLAN Power vs Time Display
The WLAN Power vs Time display shows the signal power amplitude versus time. For 802.11b signals, the packet Power-On and
Power-Down ramp times are also measured.

To show the WLAN Power vs Time display:

1. If you are analyzing a stored data file, recall the data file now. Otherwise, go to the next step.
2. Press the Displays button or select Setup > Displays.
3. In the Select Displays dialog, select WLAN Analysis in the Measurements box.
4. In the Available displays box, double-click the WLAN Power vs Time icon or select the icon and click Add. The WLAN Power vs Time

icon will appear in the Selected displays box and will no longer appear under Available displays.
5. Click OK to show the WLAN Power vs Time display.
6. Set the Frequency appropriate for the signal.
7. Select Setup > Settings to display the control panel.
8. Select the Modulation Params tab. Set the Standard, Guard Interval and Spacing and Bandwidth controls as appropriate for the input

signal.
9. If you are analyzing a data file, press the Replay button to take measurements on the recalled acquisition data file.

Elements of the Display
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Item Display element Description

1 Top of graph, first setting Sets the Power level that appears at the top of the graph, in dBm. This is only a visual
control for panning the graph.

(not
shown)

Units Sets the global amplitude units for all the views in the analysis window. This will change
the amplitude selection in the Units tab of the Amplitude control panel.

2 Top of graph, second setting Sets the vertical Scale of the graphs, in dB/div. This is only a visual control for panning the
graph.

3 View Selects the specific view of the packet burst within the display:

- Full Burst displays the entire packet, with vertical lines indicating length of the packet

- Rising Edge zooms the display into the interval around the packet rising edge, with
vertical lines indicating the 10% to 90% Power-On Ramp time

- Falling Edge zooms the display into the interval around the packet falling edge, with
vertical lines indicating the 90% to 10% Power-Down Ramp time

4 Bottom of graph readout Shows the Power level at the bottom of the graph in dBm.

5 Autoscale Adjusts the vertical and horizontal settings to provide the best display.

6 Bottom of graph, left side Sets the starting time of the graph in seconds

7 Bottom of graph, right side Sets the scale (width) of the graph in seconds

8 Table below graph - Burst Power: Average power of the burst packet, in dBm

- Burst Width: Measured time width of the burst packet from Power-On to Power-Down (or
end of waveform, if that occurs before Power-Down), in seconds

Note: Power-On Ramp Time and Power-Down Ramp Time values are only
available for 802.11b analysis.

- Power-On Ramp Time: Time interval for signal level to increase from 10% to 90% of
maximum packet power, in seconds

- Power-Down Ramp Time: Time interval for signal level to decrease from 90% to 10% of
maximum packet power, in seconds. This value is not available is the analysis record does
not include the packet power-down portion.

WLAN Power vs Time Settings
Main menu bar: Setup > Settings 

The settings for the WLAN Power vs Time display are shown in the following table.
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Settings tab Description

Modulation Params Specifies the type of modulation used for the input signal and other parameters.

Analysis Params Specifies parameters used by the instrument to analyze the input signal.

Data Range Specifies which symbols and subcarriers of the signal to display.

Analysis Time Specifies parameters that define the portion of the acquisition record that is used for analysis. Also
allows you to specify the Units (Symbols or Seconds) for WLAN Analysis displays.

Scale Specifies the vertical, subcarrier (for non-b standards only), and symbols scale and position settings.

Prefs Specifies the units of the display and whether elements of the graphs are displayed.

WLAN Spectral Flatness Display
The WLAN Spectral Flatness display shows the average power levels of subcarriers across the signal bandwidth and indicates if they
remain within the limits defined for a particular standard.

The averaged subcarrier level is shown as a line on the display, while the individual subcarrier levels are shown as points. The Pass or Fail
result indicates whether the average line remains between the upper and lower limit mask boundaries.

Note: WLAN Spectral Flatness is only available for OFDM (non-802.11b) signals.

To show the WLAN Spectral Flatness display:

1. If you are analyzing a stored data file, recall the data file now. Otherwise, go to the next step.
2. Press the Displays button or select Setup > Displays.
3. In the Select Displays dialog, select WLAN Analysis in the Measurements box.
4. In the Available displays box, double-click the WLAN Flatness icon or select the icon and click Add. The WLAN Flatness icon will

appear in the Selected displays box and will no longer appear under Available displays.
5. Click OK to show the WLAN Flatness display.
6. Set the Frequency appropriate for the signal.
7. Select Setup > Settings to display the control panel.
8. Select the Modulation Params tab. Set the Standard, Guard Interval, Subcarrier Spacing, and Channel Bandwidth controls as

appropriate for the input signal.
9. If you are analyzing a data file, press the Replay button to take measurements on the recalled acquisition data file.
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Elements of the Display

Item Display element Description

1 Top of graph, first setting Sets the Flatness value that appears at the top of the graph in dB. This is only a visual
control for panning the graph.

2 Top of graph, second setting Sets the lower range of the Flatness value that appears at the top of the graph in dB/div.
This is only a visual control for panning the graph.

3 Bottom of graph Shows the Flatness value set at the bottom of the graph.

4 Autoscale Adjusts the vertical and horizontal settings to provide the best display.

5 Posn Specifies the horizontal position of the trace on the graph display.

6 Scale Adjusts the horizontal range of the graph. By decreasing the scale, the graph essentially
becomes a window that you can move over the analysis results by adjusting the position.

WLAN Spectral Flatness Settings
Main menu bar: Setup > Settings

Favorites toolbar:

The settings for the WLAN Spectral Flatness display are shown in the following table.

Settings tab Description

Modulation Params Specifies the type of modulation used for the input signal and other parameters.

Table continued…
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Settings tab Description

Analysis Params Specifies parameters used by the instrument to analyze the input signal.

Data Range Specifies which symbols and subcarriers of the signal to display.

Analysis Time Tab Specifies parameters that define the portion of the acquisition record that is used for analysis.

Note: The Units control on this tab only affects the Analysis Length (AFAIK). Use the Units
control in the Prefs tab to affect the displays.

Trace Enables you to display or hide the measurement or average trace.

Scale Tab Specifies the vertical, subcarrier (for non-b standards only), and symbols scale and position settings.

Prefs Tab Specifies the units of the display and whether elements of the graphs are displayed.

WLAN Summary Display
The WLAN Summary display shows several measurements of WLAN signal quality. The summary display and it’s contents will vary by
standard selected. Not all of the display contents are provided in this section.

To show the WLAN Summary display:

1. If you are analyzing a stored data file, recall the data file now. Otherwise, go to the next step.
2. Press the Displays button or select Setup > Displays.
3. In the Select Displays dialog, select WLAN Analysis in the Measurements box.
4. In the Available displays box, double-click the WLAN Summary icon or select the icon and click Add. The WLAN Summary icon will

appear in the Selected displays box and will no longer appear under Available displays.
5. Click OK to show the WLAN Summary display.
6. Set the Frequency appropriate for the signal.
7. Select Setup > Settings to display the control panel.
8. Select the Modulation Params tab. Set the Standard, Guard Interval and Spacing and Bandwidth controls as appropriate for the input

signal.
9. If you are analyzing a data file, press the Replay button to take measurements on the recalled acquisition data file.
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WLAN Summary Display for 802.11a/g/j/p/n/ac Signals

Elements of the Display for 802.11a/g/j/p/n/ac Signals
Table 15:

Measurement Description

Standard Display of the standard selected on the Setup > Settings > Modulation Params tab.

Bandwidth Display of the channel bandwidth selected on Setup > Settings > Modulation Parameters tab.

Burst Power The average power of all symbols in the packet, including Preamble and Data segments.

Peak-to-Average The ratio of the highest instantaneous signal power level to the average signal power.

Burst Index The index of the analyzed packet within the analysis record.

IQ Origin Offset The average magnitude of the DC subcarrier level relative to total signal power. It indicates the level
of carrier feedthrough detected at the center (DC) subcarrier.

Frequency Error The frequency difference between the measured carrier frequency of the signal and the measurement
frequency setting.

Common Pilot Error The RMS magnitude error of the pilots over all data symbols.

Symbol Clk Error The symbol clock error in parts per million.

Table continued…
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Measurement Description

EVM The RMS and Peak values of the normalized subcarrier Error Vector Magnitude values. The
normalized subcarrier EVM values are calculated as the difference between the detected received
signal subcarrier constellation points and ideal reference points estimated by the instrument from the
received signal. Values are reported in units of percent or dB. Peak values include the symbol and
subcarrier location.

RMS and Peak values are displayed for groupings of all subcarriers, Pilots only and Data only.
Results are calculated over all Data symbols in the packet.

Average RMS and Peak RMS values are accumulated over multiple packet analysis cycles. The Clear
button on the display resets these values by clearing the result memory.

Packet Format Displays the packet format: AG, HT_MF, HT_GF, VHT.

Data Modulation Displays the modulation used in the Data symbols: BPSK, QPSK, 16QAM, 64QAM, 256QAM.

Guard Interval Displays the Guard Interval used by the Data symbols: 1/4, 1/8.

Symbols, EVM, Avg Power Displays the type and number of symbols, EVM-RMS and average power of the Preamble and Data
portions of the packet.

SIG Data

L-SIG Data

HT-SIG Data

VHT-SIG Data

Displays he decimal values of the received packet SIGNAL, HT-SIGNAL and VHT-SIGNAL symbols'
fields. The Pass/Fail result in each heading line indicates whether the calculated Parity or CRC value
matches the received Parity or CRC value of the corresponding SIGNAL symbol grouping.

WLAN Summary Display for 802.11b Signals
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Elements of the Display for 802.11b Signals
Table 16:

Measurement Description

Standard Display of the standard selected on the Setup > Settings > Modulation Parameters tab.

Burst Power The average power of the entire packet.

Peak-to-Average The ratio of the highest instantaneous packet signal power level to the average signal power.

Burst Index The index of the analyzed packet within the analysis record.

IQ Origin Offset The amount of power at the signal carrier frequency relative to the total power of the signal.

Frequency Error The frequency difference between the measured carrier frequency of the signal and the measurement
frequency setting.

EVM The RMS and Peak values of the normalized Error Vector Magnitudes taken at signal chip intervals.
The normalized EVM values are calculated as the difference between the detected received signal
constellation points and ideal reference points estimated by the instrument from the received signal.
Values are reported in units of percent or dB. Peak values indicate the associated chip locations.

RMS and Peak values are displayed for groupings of All chips, and the first 1000 (1k) chips.

Average RMS and Peak RMS values are accumulated over multiple packet analysis cycles. The Clear
button on the display resets these values by clearing the result memory.

Packet Format Displays the packet format: DSSS 1M, DSSS 2M, CCK 5.5M or CCK 11M.

Data Modulation Displays the modulation used in the PSDU/Data packet segment.

Chips, EVM, Avg Power Displays the number of chips, EVM-RMS and average power of the Preamble, Header and Data
portions of the packet.

Header Data Displays he decimal values of the received packet Header's Signal, Service, Length, and CRC fields.
The CRC Pass/Fail result indicates if the received CRC value is equal to the CRC value computed
from the received Signal, Service and Length values.

WLAN Summary Settings
Main menu bar: Setup > Settings 

The settings for the WLAN Summary display are shown in the following table.

Settings tab Description

Modulation Params Specifies the type of modulation used for the input signal and other parameters.

Table continued…
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Settings tab Description

Analysis Params Specifies parameters used by the instrument to analyze the input signal.

Data Range Specifies which symbols and subcarriers of the signal to display.

Analysis Time Specifies parameters that define the portion of the acquisition record that is used for analysis. Also
allows you to specify the Units (Symbols or Seconds) for WLAN Analysis displays.

EVM Specifies the EVM units (dB or %) and Max Bursts to Avg. The EVM is generally measured on symbol
or chip instants and is usually measured after best-fit estimates of the frequency error and a fixed
phase offset have been removed.

Prefs Specifies the units of the display and whether elements of the graphs are displayed.

WLAN Symbol Table Display
The WLAN Symbol Table display shows decoded data values for each data symbol in the analyzed signal packet. For OFDM signals
(all standards except 802.11b), results are presented with subcarrier (frequency) indices in the horizontal dimension and symbol (time)
intervals in the vertical dimension. For 802.11b signals, the Preamble, Header, and Data (PSDU) symbol values are presented sequentially,
with symbol indices in the left column.

To show the WLAN Symbol Table display:

1. If you are analyzing a stored data file, recall the data file now. Otherwise, go to the next step.
2. Press the Displays button or select Setup > Displays.
3. In the Select Displays dialog, select WLAN Analysis in the Measurements box.
4. In the Available displays box, double-click the WLAN Symb Table icon or select the icon and click Add. The WLAN Symbol icon will

appear in the Selected displays box and will no longer appear under Available displays.
5. Click OK to show the WLAN Symbol Table display.
6. Set the Frequency appropriate for the signal.
7. Select Setup > Settings to display the control panel.
8. Select the Modulation Params tab. Set the Standard, Guard Interval and Spacing and Bandwidth controls as appropriate for the input

signal.
9. If you are analyzing a data file, press the Replay button to take measurements on the recalled acquisition data file.
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WLAN Symbol Table for OFDM signals

Item Description
1 Subcarrier identifiers (OFDM only). Yellow column indicates Pilot

subcarrier locations.
2 Symbol identifiers
3 Subcarrier data values.
4 Marker readout when markers are enabled.
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WLAN Symbol Table for 802.11b signals

Item Description
1 Symbol number index (from beginning of packet or segment) of first

Symbol data value on the line.
2 Symbol values, with the value in column 2 of each row

corresponding to the symbol number index in column 1, and then
the symbol value in column 3 corresponding to the next symbol
number index, etc., to the end of each row.

For example: The symbol number index 130 = 0 in column 2. The
symbol number index for column 3 is 131, which equals 0. The
symbol number index for column 4 is 132, which equals 1. This
pattern continues to the end of the row.

WLAN Symbol Table Settings
Main menu bar: Setup > Settings

Favorites toolbar:

The settings for the WLAN Symbol Table display are shown in the following table.

Settings tab Description
Modulation Params Specifies the type of modulation used for the input signal and other parameters.
Analysis Params Specifies parameters used by the instrument to analyze the input signal.
Data Range Specifies which symbols and subcarriers of the signal to display.
Analysis Time Specifies parameters that define the portion of the acquisition record that is used for analysis. Also

allows you to specify the Units (Symbols or Seconds) for WLAN Analysis displays.
Prefs Specifies the units of the display and whether elements of the graphs are displayed.

WLAN Analysis Shared Measurement Settings
Main menu bar: Setup > Settings
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Favorites toolbar:

The control panel tabs in this section are shared between the displays in the WLAN Analysis folder (Setup > Displays). Some tabs are
shared by all the displays, some tabs are shared by only a subset of displays. The settings available on some tabs change depending on
the selected display.

Table 17: Common controls for WLAN analysis displays

Settings tab Description
Modulation Params Specifies the type of modulation used for the input signal and other parameters.
Analysis Params Specifies parameters used by the instrument to analyze the input signal.
Data Range Specifies which symbols and subcarriers of the signal to display.
Analysis Time Specifies parameters that define the portion of the acquisition record that is used for analysis. Also

allows you to specify the Units (Symbols or Seconds) for WLAN Analysis displays.
Trace Enables you to display or hide the measurement or average trace.
Scale Specifies the vertical, subcarrier (for non-b standards only), and symbols scale and position settings.
EVM Specifies the EVM units and max burst averages.
Prefs Specifies the units of the display and whether elements of the graphs are displayed.

Modulation Params Tab - WLAN
The Modulation Params tab specifies the type of modulation used by the input signal and other parameters that define the signal format.

Settings Description

Standard Specifies the standard used for the input signal. Choices are 802.11a/b/g/j/n/p/ac.

Guard Interval Specifies the guard interval used in the input signal. You can select the following:

– Auto from SIG uses the Guard Interval value extracted from the signal

– 1/8 allows setting the value manually

– 1/4 allows setting the value manually

Channel Bandwidth Specifies the nominal channel bandwidth. This setting affects the Subcarrier Spacing value
when the Subcarrier Spacing Auto box is checked.

Subcarrier Spacing Specifies the spacing between subcarriers. When Auto is selected, this setting is
automatically calculated according to the Channel Bandwidth value. If Auto is unchecked, a
custom subcarrier spacing value can be entered for nonstandard signal definition.

FFT Sample Rate Indicates the FFT sample rate, based on the bandwidth or subcarrier setting.

Table continued…

WLAN Measurements

SignalVu™ Vector Signal Analysis Software Printable Help 189



Settings Description

FFT Length Indicates the fixed FFT length.

Analysis Params Tab - WLAN
The Analysis Params tab contains parameters that control the analysis of the input signal.

Settings Description

Burst Selection Index Allows specifying the burst you want to measure when multiple bursts are present in an
acquisition. Index number of the first burst is 1, second burst is 2, etc.

Frequency Error When the Auto box is checked, the analysis determines the Frequency Error and the
measured Frequency Error is displayed. When the Auto box is unchecked, the entered value
is used by the analysis as a fixed frequency offset. This is useful when the exact frequency
offset of the signal is known.

Symbol Analysis Offset Specifies the analysis offset in the symbol interval. This value is a percentage of the Guard
Interval. The allowable range is -100% to 0%. -100% positions the FFT to start at the
beginning of the Guard Interval, 0% positions it to start at the end of the Guard Interval.
Default value is -50% which usually gives the best measurement results.

Swap I & Q Select the checkbox to swap the I and Q components of a signal. This compensates the
input signal for spectral inversion.

Equalizer Training Specifies the method used to estimate channel frequency response and equalization. This
control can be used to diagnose changes in frequency response over the signal packet.

Preamble The instrument uses only the Preamble to estimate channel frequency response. This
response is then used to equalize the entire signal packet.

Preamble + Data The instrument makes an initial channel frequency response estimate from the Preamble.
It then estimates the channel response for each data symbol using the decoded data
content to derive equalization for each symbol individually. This allows compensation for
time-varying channel response over the packet.

Table continued…

WLAN Measurements

SignalVu™ Vector Signal Analysis Software Printable Help 190



Settings Description

Data Modulation Allows choice of automatic or manual method of data symbol modulation identification, as
follows:

– Auto Detect estimates the modulation from the data symbol IQ content.

– Auto from SIG sets the modulation as indicated by the embedded SIG preamble symbol
format data.

– Manual allows specifying the modulation type regardless of the signal content.

Enable 1024QAM detection Check box to enable auto-detection of 1024QAM.

Pilot tracking Specifies if pilot subcarriers should be used to correct amplitude, phase, and symbol timing
variations over the packet. The choices available are Phase, Amplitude, and Timing. The
default setting is Phase correction enabled, Amplitude and Timing correction disabled..

Subcarrier derotation Allows some displays to show subcarriers with or without Gamma subcarrier phase rotation
removed. Gamma phase rotation is applied to 802.11n and 802.11ac subcarriers in defined
subranges depending on the selected Channel Bandwidth >40 MHz. Only Constellation and
Symbol Table results are affected by this control.

When the box is unchecked, the rotation is not removed, which provides a direct view of the
physical modulation on the channel.

When the box is checked, the rotation is removed, allowing easier decoding of the
underlying data content.

Data Range Tab - WLAN
The Data Range tab enables you to control how much signal is analyzed, as well as specify the range of results that are displayed for the
WLAN Constellation, EVM, Flatness, Magnitude Error, Phase Error, and Symbol Table graphs. The tab contents vary by standard.

Data Range tab for non-b standards.

Settings Description

Symbols Specifies which symbols are displayed in the graphs.

All Select All to display all symbols.

Range Select Range to specify a subset of symbols for display.

Start Specifies the first symbol to include in the display.

Stop Specifies the last symbol to include in the display.

Single Select Single to display a single symbol.

Index Use Index to specify the symbol you want to display.

Subcarriers Specifies which subcarriers are displayed.

Table continued…
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Settings Description

All Select All to display all subcarriers in the signal.

Pilots Select Pilot to display only pilot subcarriers.

Data Select Data to display only data subcarriers.

Single Specifies a specific subcarrier for display.

Index Specifies the specific subcarrier to be displayed.

Range Specifies a range of subcarriers to be displayed.

Start Specifies the start value of the range to be displayed.

Stop Specifies the ending value of the range to be displayed.

Max symbols to analyze Specifies how many symbols are analyzed. You can use this setting to speed analysis by
limiting the number of symbols being analyzed.

Data Range tab for 802.11b standards.

Settings Description

Chips Specifies which symbols are displayed in the graphs.

All Select All to display all chips.

Preamble Only Select to include only the Preamble in the display.

Header Only Select to include only the Header in the display.

Data Only Select to include only the Data in the display.

Max number of chips to analyze Specifies how many chips are analyzed. You can use this setting to speed analysis by
limiting the number of chips being analyzed. Check this box and then enter the maximum
number of chips to analyze.

Analysis Time Tab - WLAN
The Analysis Time tab contains parameters that define how the signal is analyzed in the WLAN Analysis displays.
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Settings Description

Analysis Length Specifies the length of the analysis period to use in measurements. Length is specified in either
symbols or seconds, depending on the Units setting.

Use this to specify how long a period of time is analyzed.

– Range: minimum value depends on modulation type

– Resolution: 1 symbol

Auto When enabled, causes the instrument to set the Analysis Length value based on the requirements of
the selected display.

Units Specifies the units of the Analysis Length in either Symbols or Seconds.

Trace Tab - WLAN
The Trace tab allows you to set the trace display characteristics of the selected display. This tab is not available for all WLAN displays.

Settings Description

Trace Use this drop-down list to select whether or not the Average trace or the measurement trace is
displayed. The measurement trace depends on the selected display.

Show Symbols Select or deselect this checkbox to show or hide symbols.

Freeze Selecting Freeze halts updates to the symbols.

Traces Tab - WLAN Channel Response
The Traces tab allows you to set the trace display characteristics of the WLAN Channel Reponse display.
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Settings Description

Trace Selects the Magnitude or Phase trace for saving or recalling.

Save Trace As . . . Select to save a trace.

Recall Trace . . . Select to recall a trace.

Scale Tab - WLAN
The Scale tab allows you to change the scale settings that control how the trace appears on the display but does not change control
settings such as Measurement Frequency. There are four versions of the Scale tab for WLAN displays. One version is used for the
Constellation display, one for the Spectral Flatness display, one for the Power vs Time display, and one for the EVM, Magnitude Error,
Phase Error, and Channel Response displays.

Figure 11: Scale tab for the WLAN Power vs Time display

Figure 12: Scale tab for WLAN EVM, Magnitude Error, Phase Error, and Channel Response displays

Figure 13: Scale tab for WLAN Constellation display
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Figure 14: Scale tab for WLAN Spectral Flatness display

Settings Description

Vertical Controls the vertical position and scale of the trace display.

Scale Changes the vertical scale of the graph.

Position Adjusts the reference level away from top of the graph.

Autoscale Resets the scale of the vertical axis to contain the complete trace.

Subcarrier Controls the scale of the subcarrier graph and position of the trace.

Scale Specifies how many subcarriers are displayed horizontally.

Position Specifies the subcarrier that appears at the left edge of the subcarrier graph.

Autoscale Resets the scale of the horizontal axis to contain the complete trace.

Symbols Controls the scale of the Symbols graph.

Scale Specifies the number of symbols that appear in the symbols graph.

Position Specifies the symbol that appears at the left edge of the Symbols graph.

Autoscale Resets the scale and position settings to optimize the display.

Auto When Auto is checked, the scale and position values for the Symbols graph are automatically
adjusted to maintain the optimal display.

Zoom Sets the Constellation display size and position.

Scale Sets the magnification value for the Constellation display.

Vertical Position Sets the vertical location of the Constellation display within the graph. Range is -3.7 to +3.7.

Horizontal Position Sets the horizontal location of the Constellation display within the graph. Range is -3.7 to +3.7.

EVM Tab - WLAN
The EVM Tab enables you to chose between dB and percent for the EVM units and to select to set the maximum bursts to average. The
EVM Tab is only available for the WLAN Summary display.

WLAN Measurements

SignalVu™ Vector Signal Analysis Software Printable Help 195



Settings Description

EVM units Specifies whether the displayed EVM units are dB or percent.

Max Bursts to Avg Specifies the maximum number of bursts to average when Count is selected.

Count Enables the Max Bursts to Avg function.

Prefs Tab - WLAN
The Prefs tab enables you to change appearance characteristics of the WLAN Analysis displays. Not all settings on the Prefs tab shown
below appear for every WLAN display.

Settings Description

Time units Specifies whether the displayed time units are seconds or symbols.

Freq units Specifies whether the displayed frequency units are frequency (Hz) or subcarrier channel.

Radix Specifies whether symbol values are displayed in binary or hex format (for example, in the Symbol
Table or markers readouts).

Show graphs Specifies which graphs are displayed. Select from Symbols, Subcarriers or Both, Magnitude, Phase,
or Both. Disabled (no masks), Shaded Region, or Line Only. These selections are only available for
OFDM signals.

Show graticule Specifies to show the graticule on the display when checked.

Show marker readout Specifies to show the marker readout when checked.
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802.11ad and 802.11ay Analysis
Overview of 802.11ad and 802.11ay
The optional Tektronix 802.11ad and 802.11ay solution provides repeatable signal quality measurements (such as EVM) for the 802.11ad
single carrier PHY, 802.11ad control PHY, and 802.11ay single carrier at RF (up to 70 GHz).

The IEEE 802.11ad standard was approved in December 2012 and amended in December 2016. The IEEE 802.11ay is an eveloving
standard that is in draft stage and planned for approval in March 2020. These standards allow wireless communication of devices at
multi-gigabit speeds and enable high performance wireless data, display, and audio applications that supplement the capabilities of
previous wireless LAN devices. They operate in the 60 GHz band and deliver data transfer rates up to 20 Gbit/s, while maintaining
compatibility with existing Wi-Fi devices. The 60 GHz signal cannot typically penetrate walls, but can propagate off reflections from walls,
ceilings, floors, and objects using beamforming built into an 802.11ad system. When roaming away from the main room, the protocol can
switch to make use of the other 802.11 lower bands at a much lower rate, but which can propagate through walls.

ITU-T mandates the use of the following four channels at the 60 GHz band for 802.11ad.

Channel Center (GHz) Min (GHz) Max (GHz) BW (GHz)

1 58.32 57.24 59.4 2.16

2 60.48 59.4 61.56 2.16

3 62.64 61.56 63.72 2.16

4 64.8 63.72 65.88 2.16

ITU-T mandates the use of the following channels at the 60 GHz band for 802.11ay.

2.16 GHz BW channels

Channel Center (GHz) Min (GHz) Max (GHz)

1 58.32 57.24 59.40

2 60.48 59.4 61.56

3 62.64 61.56 63.72

4 64.80 63.72 65.88

5 66.96 65.88 68.04

6 69.12 68.04 70.2

4.32 GHz BW channels

Channel Center (GHz) Min (GHz) Max (GHz)

7/8 59.40 57.24 61.56

Table continued…
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Channel Center (GHz) Min (GHz) Max (GHz)

9/10 61.56 59.4 63.72

11/12 63.72 61.56 65.88

13/14 65.88 63.72 68.04

15/16 68.04 65.88 70.2

802.11ay 4.32 GHz BW Packet Measurements
For a 802.11ay 4.32 GHz BW packet, the results of analysis are shown for 3 regions separately: EDMG, PreEDMG1, and PreEDMG2.
This is because of the different chip rate of these regions and to allow you to perform detailed analysis of any specific region with
marker support. The region can be selected from the Modulation Params drop-down list. A replay or run will be required to see
the updated results after changing the selection in drop-down. Also, when a non-EDMG duplicate mode is detected, the lower band
(2GUID-A88BD14F-0A29-4276-A887-CB84AB2B2A94U) or upper band (2GUID-A88BD14F-0A29-4276-A887-CB84AB2B2A94L) can be
selected from the drop-down.

802.11ad/11ay Standards Preset

Select Presets > Standards in the menu to open the 802.11ad/11ay preset. You can then select to recall preconfigured displays for Single
Carrier or Control PHY standards with an EVM or SEM test setup. The preset displays are Spectrum, Time Overview, 802.11ad/11ay
Summary, 802.11ad/11ay Constellation for EVM test setup, and SEM and Time Overview for SEM test setup. The preset sets the
measurement filter EVM test setup, and SEM and Time Overview for SEM test setup. The preset sets the measurement filter to Root
Raised Cosine, the filter parameter to 0.25, and the default data length to Analyze as 1000 for Single Carrier and 512 for Control PHY.
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Note: The default resolution bandwidth for the SEM display is 1 MHz.

Settings Description

Standard Allows you to choose between Single Carrier and Control PHY.

Test Setup Allows you to choose between EVM and SEM.

RF Source Allows you to choose between Channel 1 or Channel 2. If you choose Channel 1, the center
frequency is set to 10 GHz (IF). If you choose Channel 2, then the center frequency is set to
60.48 GHz (RF). However, if the Retain Current Center Frequency setting is enabled, the previously
selected center frequency is retained. In case of a DX series oscilloscope, if you decide to connect
the signal to Channel 3 or Channel 4, then you have to select this manually in the Acquisition Control
Pane > Vertical tab > RF Source

Channel BW Allows you to select the channel bandwidth.

Retain current center frequency
setting

Allows you to retain the previous center frequency. It is disabled by default. To enable or disable this
setting, select the checkbox.

Retain current reference level
setting

Allows you to retain the previous reference level. It is enabled by default. To enable or disable this
setting, select the checkbox.
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802.11ad/11ay topics in this Help
The following information about the 802.11ad/11ay Analysis option is available:

• 802.11ad/11ay measurements on page 201
• 802.11ad/11ay displays on page 202
• 802.11ad/11ay Control Panel Settings on page 212

802.11ad/11ay measurements

The 802.11ad/11ay option supports analysis of 802.11ad Control PHY, 802.11ad Single Carrier PHY, and 802.11ay Single Carrier PHY
standards. Information about the 802.11ad packet is given in Section 20 of the 802.11ad-2016 standard. Information about the 802.11ay
packet is given in the draft versions of the 802.11ay standard.

These measurements are only supported for Windows oscilloscopes of bandwidth > 3 GHz. ATI oscilloscopes support real time data
analysis at RF, without any downconverters. The 802.11ad/11ay option allows you to do the following:

• Automatically detect the packet start, if it is included in the analysis region
• Synchronize to preamble start using the Golay codes in STF (Short training field) region
• Demodulate Preamble, Header, and Payload regions separately and measure EVM in each of these sections.

The input data is filtered with a RRC filter, corrected for frequency, phase and symbol timing errors, IQ DC offset errors and
Equalization is done based on Channel estimated using the Channel Estimation Field (CEF) data.

• Decode packet information in header (like MCS, length etc.)
• Measure the following:

• EVM
• RF power and Received Power Indicator (RCPI)
• Estimated SNR
• Frequency error
• IQ DC origin offset
• IQ Gain imbalance is calculated with the equation

Gain Error in dB = 20 log [( 1+eA)/( 1-eA)]

Where, 2εA is the amplitude difference between the signal paths.
• IQ phase imbalance or quadrature error
• Signal quality

• Perform Transmit Mask measurement with the set up file given under Example Files. The Mask (Offset frequencies and Start and Stop
limits) is developed as per standard recommendations. After loading set up file, you can set the Center Frequency manually to that of
the signal.

The following features are also available:

• Analyze EVM result with and without equalization.
• Analyze EVM result with and without IQ DC offset correction.
• View the constellation color coded for the preamble, header, guard, and payload regions. You can also view the pi/2 rotated

constellation against the final de-rotated constellation.
• View the demodulated symbols in tabular form with different color codes and with an option to traverse to the start of each region.
• View the EVM spread across the analyzed packet with color codes differentiating regions.
• View of scalar results in the Summary display.
• EVM numbers can be seen in percentage or in dB.
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• EVM and Frequency Error limits for the transmitter can be set in the Limits tab of the Settings control panel. If the measured EVM
is greater than the limits, or if the measured Frequency Error is greater than the limit, then a FAIL status will appear against the
respective measurement.

• Save the Channel Impulse response coefficients as a .txt or .csv file.

802.11ad/11ay displays

The displays in 802.11ad/11ay Analysis (Setup > Displays > Measurements) are:

• 802.11ad/11ay Constellation Display on page 202
• 802.11ad/11ay EVM vs Time display
• 802.11ad/11ay Symbol Table Display on page 207
• 802.11ad/11ay Summary Display on page 209

802.11ad/11ay Constellation Display
This display shows a digitally-modulated signal in constellation form.

To show the 802.11ad/11ay Constellation display:

1. Recall the data file.
2. Press the Displays button or select Setup > Displays.
3. In the Select Displays dialog, select 802.11ad/11ay Analysis in the Measurements box.
4. In the Available displays box, double-click the 802.11ad/11ay Constellation icon or select the icon and click Add. The 802.11ad/11ay

Constellation icon will appear in the Selected displays box and will no longer appear under Available displays.
5. Click OK to show the 802.11ad/11ay Constellation display.
6. Press the Replay button to take measurements on the recalled acquisition data file.

Elements of the display
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Item Display element Description

A Scalar results Gives results of Data EVM (Average EVM over the data region and the Peak Error in the
data region), Freq Error, and IQ Origin Offset.

B Marker readout Specifies the Marker readout values.

C Graph Displays the input signal.

Figure 15: The above image shows an 802.11ad signal with QPSK data region
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Figure 16: The above image shows an 802.11ad signal with 16QAM data region

Figure 17: The above image shows an 802.11ad signal with 64QAM data region

Constellation display settings

Settings tab Description

Modulation Params Specifies the input signal standard, measurement filters and filter parameters.

Analysis Params Specifies parameters used by the instrument and software to analyze the input signal.

Table continued…

802.11ad and 802.11ay Analysis

SignalVu™ Vector Signal Analysis Software Printable Help 204



Settings tab Description

Advanced Params Specifies additional parameters used by the instrument and software to analyze the input signal.

Analysis Time Specifies parameters that define the portion of the acquisition record that is used for analysis.
Also allows you to specify the Units (Symbols or Seconds) and Time Zero Reference (Trigger or
Acquisition Start) for 802.11ad/11ay Analysis displays.

EVM Specifies the EVM units, start and length of data symbols to be analyzed for EVM, and the number of
acquisitions used for averaging. For Control PHY, the Start and Length of data symbols is specified in
terms of de-spread symbols and also the number of Bursts to Avg by enabling the count.

Traces Specifies the trace type and the result content. Select either rotated or de-rotated constellation.
De-rotated constellation is shown by default.

Prefs Specifies the radix of the data symbols and the option to see the marker readout.

Scale Defines the vertical and horizontal axes.

802.11ad/11ay EVM vs Time
This display shows the EVM plotted against time in seconds or symbols. The analysis region in which EVM measurement done is indicated
by a purple line in the Time Overview to indicate the region of analysis.

To show the 802.11ad/11ay EVM vs Time Display:

1. Recall the data file.
2. Press the Displays button or select Setup > Displays.
3. In the Select Displays dialog, select 802.11ad/11ay Analysis in the Measurements box.
4. In the Available displays box, double-click the 802.11ad/11ay EVM vs Time icon or select the icon and click Add. The 802.11ad/11ay

EVM vs Time icon will appear in the Selected displays box and will no longer appear under Available displays.
5. Click OK to show the 802.11ad/11ay EVM vs Time display.
6. Press the Replay button to take measurements on the recalled acquisition data file.

Elements of the display
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Item Display element Description

1 Freq error Displays the frequency error which has been corrected after which the EVM is calculated.
The displayed frequency error is followed by either Auto or Manual. This indicates the
error calculation mode which is set under Settings >Analysis Params.

2 Graph Displays the input signal. Different color codes are used in the 802.11ad EVM vs Time to
indicate different regions of the packet. Check legend at the bottom of the symbol table for
color codes

3 Scale Adjusts the span of the graph in seconds or symbols.

4 Position Displays the horizontal position of the trace on the graph display.

5 Autoscale Adjusts the vertical and horizontal settings to provide the best display.

6 Position The error at the bottom of the graph in dB or percent.

7 Top of graph The error at the top of the graph in dB or percent.

Figure 18: The above image shows a 802.11ay 4.32 GHz pre-EDMG region. The initial empty portion is for the pre-EDMG region.

Figure 19: The above image shows a 802.11ay 4.32 GHz EDMG1 region. The trailing empty portion is for the EDMG region.
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EVM vs Time display settings

Settings tab Description

Modulation Params Specifies the input signal standard, measurement filters, and filter parameters.

Analysis Params Specifies parameters used by the instrument to analyze the input signal.

Advanced Params Specifies parameters used by the instrument to analyze the input signal, with options to enable the
Equalizer and IQ DC Offset correction.

Analysis Time Specifies parameters that define the portion of the acquisition record that is used for analysis.
Also allows you to specify the Units (Symbols or Seconds) and Time Zero Reference (Trigger or
Acquisition Start) for 802.11ad/11ay Analysis displays.

EVM Specifies the number of data symbols to be analyzed for EVM. For Control PHY, the Start and Length
of data symbols is specified in terms of de-spread symbols.

Prefs Specifies the radix of the marker readout and whether elements of the graphs are displayed.

Scale Defines the vertical and horizontal axes.

802.11ad/11ay Symbol Table Display
This display shows a digitally-modulated signal. It is similar to the Constellation display except that a text table is used to display data bits
as symbols rather than a graph.

1. Recall the data file.
2. Press the Displays button or select Setup > Displays.
3. In the Select Displays dialog, select 802.11ad/11ay Analysis in the Measurements box.
4. In the Available displays box, double-click the 802.11ad/11ay Symbol Table icon or select the icon and click Add. The 802.11ad/11ay

Symbol Table icon will appear in the Selected displays box and will no longer appear under Available displays.
5. Click OK to show the 802.11ad/11ay Symbol Table display.
6. Press the Replay button to take measurements on the recalled acquisition data file.
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Elements of the display

Different Color codes are used in the table to indicate different regions of the packet. The legend at the bottom of the table indicates which
color represents which packet component. The bit colors in the table match the packet colors. The packet will have the following regions:

• Preamble (pi/2-BPSK)
• Header (pi/2-BPSK)
• Data (pi/2 BPSK, pi/2 QPSK, pi/2 16QAM, or pi/2 64QAM)
• Guard (pi/2-BPSK)

Using markers
Markers are indicators in the display that you can position on a trace to measure values such as frequency, power, and time. A Marker
always displays its position and, if the Delta readout is enabled, will display the difference between its position and that of the Marker
Reference. Within the Symbol Table, colored cells indicate the location of markers. The selected Marker is highlighted with a light green
background. All other markers are highlighted with a light gray background. In the Symbol Table, the marker readout below the table shows
the marker location in time, symbol numbers and symbol value.

Symbol Table display settings

Settings tab Description

Modulation Params Specifies the type of modulation used for the input signal and other parameters.

Analysis Params Specifies parameters used by the instrument to analyze the input signal.

Table continued…

802.11ad and 802.11ay Analysis

SignalVu™ Vector Signal Analysis Software Printable Help 208



Settings tab Description

Advanced Params Specifies additional parameters used by the instrument to analyze the input signal.

Analysis Time Specifies parameters that define the portion of the acquisition record that is used for analysis.
Also allows you to specify the Units (Symbols or Seconds) and Time Zero Reference (Trigger or
Acquisition Start) for 802.11ad/11ay Analysis displays.

Prefs Specifies the radix of the symbols and the option to see the marker readout.

802.11ad/11ay Summary Display
The 802.11ad/11ay Summary display shows a summary of all scalar measurements done on the acquired test pattern. Pass/Fail
information is also provided in this display for all enabled scalar measurements. You can set limits and choose which measurement
to compare for Pass/Fail from the Limits tab in the 802.11ad/11ay Summary Settings control panel. The default limits come from the
performance recommendation limits given by the Standards document. The default limits can be reloaded by selecting the 802.11ad/11ay
as the preset in the Standards Preset window.

1. Recall the data file.
2. Press the Displays button or select Setup > Displays.
3. In the Select Displays dialog, select 802.11ad/11ay Analysis in the Measurements box.
4. In the Available displays box, double-click the 802.11ad/11ay Summary icon or select the icon and click Add. The 802.11ad/11ay

Summary icon will appear in the Selected displays box and will no longer appear under Available displays.
5. Click OK to show the 802.11ad/11ay Summary display.
6. Press the Replay button to take measurements on the recalled acquisition data file.

Elements of the display
The results presented in the display include scalar results of modulation characteristics, shown in the following areas of the display: EVM -
Packet, Average results over multiple Acquisitions (One Bust per Acquisition), and Packet Information. These scalar results are averaged
over the previously acquired packets. The packet number to be analyzed is set in the EVM tab of the Settings control panel.

802.11ad and 802.11ay Analysis

SignalVu™ Vector Signal Analysis Software Printable Help 209



Figure 20: The above image shows an 802.11ad Single Carrier signal with pi/2 16QAM data modulation

Display element Description

Standard Display of the standard selected on the Setup > Settings > Standard Params tab.

Data Modulation Indicates data modulation. Data modulation types are as follows:

Single Carrier: pi/2 BPSK, pi/2 QPSK, pi/2 16QAM, pi/2 64QAM

Control PHY: pi/2 DBPSK

Clear Click to reset the scale measurements.

RF Power Measures the RF power in the signal.

RCPI Calculates the Received Channel Power Indicator from RF power.

Frequency error The frequency difference between the measured carrier frequency of the signal and the measurement
frequency setting in ppm and Hz.

Estimated SNR Measures the estimated SNR in the measurement setup.

Table continued…
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Display element Description

IQ Origin Offset The average magnitude of the DC subcarrier level relative to total signal power. It indicates the level of
carrier feedthrough detected at the center (DC) carrier.

IQ Gain Imbalance Measures the Gain mismatch of the signal (sinusoid) in dB. It indicates the mismatch between I and Q
signal paths.

IQ Quadrature Error Measures the phase part of the imbalance in degrees. It indicates the mismatch between I and Q
signal paths.

Signal Quality Measure the signal quality of the packet based on the preamble region.

EVM – Packet Gives EVM results for each packet region. The number of symbols analyzed in each region is given
alongside the packet region labels.

802.11ad Single Carrier: STF, CEF, Header, Guard, and Data

802.11ad Control PHY: STF, CEF and Data + Header in despread symbols

802.11ay Single Carrier 2.16 GHz BW: LSTF, LCEF, L Header, EDMG Header-A, EDMG STF, EDMG
CEF Guard and Data

802.11ay Single Carrier 4.32 GHz BW: LSTF, LCEF, L Header, EDMG Header-A, EDMG STF, EDMG
CEF Guard and Data

EVM Gives Average EVM in the region of the packet.

Peak EVM Gives the Peak error/EVM in the corresponding region of the packet.

@ Symbol Gives the symbol index at which the peak error occurred out of the entire set of symbols in the packet
(it is not an index just within the region). The symbol index shown here can be used to place a marker
in the Symbol Table or EVM vs Time displays to observe the exact symbol position at which the peak
error occurred.

Average results over multiple
acquisitions (one burst per
acquisition)

Avg Data EVM

Max Data EVM

1-sigma Data EVM

Avg Frequency Error

Max Frequency Error

Gives data EVM and Frequency error results over multiple acquisitions. Gives both the Average and
Max over multiple acquisitions. Also shows how many acquisitions have been used for these results
below. For Data EVM, the 1-sigma variation is shown in addition to average. When the EVM unit is in
%, this value is equivalent to the standard deviation statistic. When the EVM unit is in dB, this value
is the standard deviation after converting EVM values to dB scale. The number of acquisitions to be
used for these measurements can be selected from the EVM tab of the Settings Control panel using
the Max Bursts to Avg selection.

Packet Information The packet header information includes the Scrambler initialization, MCS, Length, Packet type,
Training Length, Turnaround and HCS. MCS, Length and Training length are shown in decimal.

PDDU, Aggregation, Beam Tracking Request, and Last RSSI are shown only for 802.11ad Single
Carrier.

For 802.11ay Single Carrier, EDMG MCS, BW Bitmap, Channel Aggregation, PSDU Length are
shown. The Guard Length type info can be derived from the Last RSSI bits. The 2 MSB bits of Last
RSSI bit convey the Guard type information (00 – Short, 01 – Normal, 10 – Long).
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Summary Table display settings

Settings tab Description

Modulation Params Specifies the input signal standard and other signal parameters.

Analysis Params Specifies parameters used by the instrument to analyze the input signal.

Advanced Params Specifies additional parameters used by the instrument to analyze the input signal.

Analysis Time Specifies parameters that define the portion of the acquisition record that is used for analysis.
Also allows you to specify the Units (Symbols or Seconds) and Time Zero Reference (Trigger or
Acquisition Start) for 802.11ad/11ay Analysis displays.

EVM Specifies the EVM units and number of data symbols to be analyzed for EVM. For Control PHY, the
Start and Length of data symbols is specified in terms of de-spread symbols and also the number of
Bursts to Avg by enabling the count.

Limits Load and define 802.11ad measurement limits for Pass/Fail comparison. You can save defined limits
as a .csv file and also load previously saved .csv files.

802.11ad/11ay Control Panel Settings

The control panel tabs in this section are shared between the displays in the 802.11ad/11ay Analysis folder (Setup > Displays). Some tabs
are shared by all the displays, some tabs are shared by only a couple of displays. The settings available on some tabs change depending
on the selected display.

Settings tab Description

Modulation Params Specifies the type of modulation used for the input signal and other parameters.

Analysis Params Specifies parameters used by the instrument to analyze the input signal.

Advanced Params Specifies parameters used by the instrument to analyze the input signal.

Analysis Time Specifies parameters that define the portion of the acquisition record that is used for analysis.
Also allows you to specify the Units (Symbols or Seconds) and Time Zero Reference (Trigger or
Acquisition Start) for 802.11ad/11ay Analysis displays.

EVM Specifies the EVM units and number of data symbols to be analyzed for EVM.

Limits Load and define 802.11ad/11ay measurement limits for Pass/Fail comparison. You can save defined
limits as a .csv file and also load previously saved .csv files.

Traces Specifies the trace type and the result content. Select either rotated or de-rotated constellation.
De-rotated constellation is shown by default.

Prefs Specifies the radix of the symbols, the option to see the marker readout, and whether elements of the
graphs are displayed.

Table continued…
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Settings tab Description

Scale Defines the vertical and horizontal axes.

Modulation Params tab – 802.11ad/11ay
The Modulation Params tab specifies the type of modulation used by the input signal and other parameters that define the signal format.
This tab is available for the 802.11ad/11ay EVM vs Time, Constellation, Symbol Table, and Summary displays.

Settings Description

Standard Specifies the standard used for the input signal. Choices are 802.11ad Control PHY, 802.11ad Single
Carrier, and 802.11ay Single Carrier.

Measurement filter Specify whether a filter is used to limit the bandwidth of the input signal. Options are None and Root
Raised Cosine.

Filter parameter Enter a value used for defining the alpha parameter for Root Raised Cosine filter. (Not present when
Measurement filter is None.)

Channel BW Specifies whether channel bandwidth configuration for 802.11ay is 2.16 GHz or 4.32 GHz. Option
visible only for 802.11ay Single Carrier modulation.

Region Specifies the region to show in the Constellation, EVM and Symbol Table Displays when 11ay Single
Carrier 4.32GHz Channel BW is chosen. Options are preEDMG1, preEDMG2 and EDMG. Replay is
required if this option is changed.

Band When a non EDMG duplicate mode is detected, a lower band (2GUID-A88BD14F-0A29-4276-A887-
CB84AB2B2A94L) or upper band (2GUID-A88BD14F-0A29-4276-A887-CB84AB2B2A94U) can be
selected using the drop-down list.

Analysis Params tab – 802.11ad/11ay
This tab contains parameters to control the analysis of the input signal. This tab is available for the 802.11ad/11ay EVM vs Time,
Constellation, Symbol Table, and Summary displays.
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Settings Description

Frequency Error When Auto is checked, the analysis determines the Frequency Error and the measured Frequency
Error is displayed. When unchecked, the entered value is used by the analysis as fixed frequency
offset. This is useful when the exact frequency offset of the signal is known.

Measurement BW Specifies the bandwidth about the center frequency at which measurements are made. Select
Manual, Auto, or Link to Span.

Advanced Params tab – 802.11ad/11ay
This tab specifies additional parameters that control the demodulation of the signal. This tab is available for the 802.11ad/11ay EVM vs
Time, Constellation, Symbol Table, and Summary displays. Not all settings appear for every display.

Settings Description

Enable DC Offset Correction Enables DC offset correction before EVM results are calculated.

Blockwise Correction Enables impairments correction in a blockwise approach. This selection allows you to see if
impairments like frequency error vary within the packet. Disabled by default.

SFO Tracker Enables tracking and correction of Symbol Timing (Tc) errors and offsets. When disabled, the symbol
timing offset is computed based on STF region (EDMG STF region in 802.11ay 4.23 GHz) and
corrected for the entire packet. When enabled, it estimates and corrects for Symbol Timing errors for
each data block and preamble/header regions. This option should be enabled when the reference
clock of the oscilloscope is not synchronized to the transmitter.

Tracking Equalizer In addition to the Preamble based equalizer, the Tracking Equalizer helps to correct for residual
channel errors across each data block in the packet. The Tracking Equalizer coefficients are updated
for each data block based on the initial set of data symbols, and applied for the full data/guard block.
The coefficients are updated according to a Least Mean Square algorithm.

Table continued…
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Settings Description

Save Chan Imp Resp As... Opens a file dialogue box that allows you to save the Estimated Channel Impulse response (128
coefficients). You can save it as a .txt or .csv file.

The saved file will have two columns. The first and the second columns give the 128 real and
imaginary coefficients, respectively.

The generated coefficients are that of the last analyzed acquisition.

The impulse response will show an early and a late multipath propagation.

When channel response coefficients are plotted, the horizontal axis represents symbols.

OFF The EVM measurement is done with the equalizer switched off.

Non Adaptive (CEF) The EVM measurement is done with an equalizer that is non-adaptive and the equalization is done
based on the data in Channel Estimation Field (CEF).

Adaptive (STF and CEF) The EVM measurement is done with the equalizer that adapts its coefficients from acquisition to
acquisition. Equalization in this case is done based on the data in the Short Training Field (STF) and
Channel Estimation Field (CEF) regions.

Mode Specifies whether the equalizer is in learning (Train) mode or analysis (Hold) mode.

Convergence Specifies the update rate.

Taps/Symbol The number of filter coefficients per symbol used by the filter

Taps The number of filter coefficients. Range: 3 to 100 (you can set a higher number, but 100 is the
practical limit).

Length Specifies the number of symbols analyzed (or filter length).

Reset Equalization Resets the equalizer.

You can read more about how to use the equalizer in the topic here.

Swap I & Q Enables swapping of I & Q when there are multiple up converter stages.

Analysis Time tab – 802.11ad/11ay
This tab contains parameters that define how the signal is analyzed in the 802.11ad/11ay EVM vs Time, Constellation, Symbol Table, and
Summary displays.
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Settings Description

Analysis Offset Specifies the location of the first time sample to use in measurements.

Auto When enabled, causes the instrument to set the Analysis Offset value based on the requirements of
the selected display.

Analysis Length Specifies the length of the analysis period to use in measurements. Length is specified in either
symbols or seconds, depending on the Units.

Auto When enabled, causes the instrument to set the Analysis Length value based on the requirements of
the selected display.

Actual This readout displays the analysis length (time or symbols) used by the analyzer. This value may not
match the Analysis Length requested in manual mode.

Time Zero Reference Specifies the zero point for the analysis time.

Units Specifies the units of the analysis length to either Symbols or Seconds.

Analysis offset
Use analysis offset to specify where measurements begin. Be aware that you cannot set the Analysis Offset outside the range of time
covered by the current acquisition data (all time values are relative to the Time Zero Reference).

You can set the Analysis Length so that the requested analysis period falls partly or entirely outside the current range of acquisition
data settings. When the next acquisition is taken, its Acquisition Length will be increased to cover the new Analysis Length, as long as
the Sampling controls are set to Auto. If the Sampling parameters are set to manual, or if the instrument is analyzing saved data, the
actual analysis length will be constrained by the available data length, but in most cases, measurements are able to be made anyway.
The instrument will display a notification when measurement results are computed from less data than requested. Range: 0 to [(end of
acquisition) - Analysis Length)]. Resolution: 1 effective sample (or symbol).

Analysis length
Use the analysis length to specify how long a period of time is analyzed. As you adjust this value, the actual amount of time for Analysis
Length, in Symbol or Seconds units, is shown below the control in the "Actual" readout. This setting is not available when Auto is checked.
Range: minimum value depends on modulation type. Resolution: 1 symbol.

Time zero reference
All time values are measured from this point (such as marker position or horizontal position (in Y vs Time displays). Choices are:
Acquisition Start or Trigger.

Acquisition Start sets the analyzer to measure the offset from the starting point of the acquisition.

Trigger sets the analyzer to measure the offset from the trigger point of the acquisition.

EVM tab – 802.11ad/11ay
This tab enables you to set the EVM Units, Data Start, and Data Length. Not all settings appear for every display.
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Figure 21: The above image is the EVM tab for the 802.11ad/11ay EVM vs Time and Constellation displays for 802.11ad Single Carrier and 802.11ay Single Carrier

Figure 22: The above image is the EVM tab for the 802.11ad/11ay EVM vs Time and Constellation displays for 802.11ad Control PHY

Figure 23: The above image is the EVM tab for the 802.11ad/11ay Summary display for 802.11ad Single Carrier

Settings Description

EVM Units Specifies whether the displayed EVM units are dB or percent.

Max Bursts to Avg Specifies the maximum number of acquisitions to average when Count is selected.

Count Enables the Avg function. Multiple acquisitions are averaged when this is enabled.

Data Symbols (for Single Carrier)

De-spread Data Symbols (for Control PHY)

Start Specified the EVM measurement start data symbol.

Length Specifies the length in terms of Data Symbols to analyze the EVM in data region starting from Start.

Table continued…
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Settings Description

Analyze all Check to analyze all data symbols in the packet. When checked, Start and Length options will be
disabled. However, Length will be automatically updated to the number of data symbols analyzed
when this option is selected.

Scale tab – 802.11ad/11ay
This tab allows you to change the scale settings that control how the trace appears on the display but does not change control
settings such as Measurement Frequency. There are two versions of the Scale tab for 802.11ad/11ay displays. One version is used for
Constellation display, and one for EVM vs Time. Not all settings appear for every display.

Figure 24: The above image is the Scale tab for the 802.11ad/11ay Constellation display

Figure 25: The above image is the Scale tab for the 802.11ad/11ay EVM vs Time display

Settings Description

Vertical

Scale Changes the vertical scale.

Position Adjusts the reference level away from top of the graph.

Autoscale Resets the scale of the vertical axis to contain the complete trace.

Horizontal

Scale Changes the horizontal scale.

Position Adjusts the reference level away from top of the graph.

Table continued…
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Settings Description

Autoscale Resets the scale of the vertical axis to contain the complete trace.

Zoom

Scale Sets the magnification value for the Constellation display.

Vertical position Sets the vertical location of the Constellation display within the graph.

Horizontal position Sets the horizontal location of the Constellation display within the graph.

Prefs tab – 802.11ad/11ay
This tab enables you to change appearance characteristics of the 802.11ad/11ay Analysis displays. Not all settings appear for every
display.

Figure 26: The above mage is the Prefs tab for the 802.11ad/11ay Constellation display

Figure 27: The above mage is the Prefs tab for the 802.11ad/11ay Symbol Table display

Figure 28: The above mage is the Prefs tab for the 802.11ad/11ay EVM vs Time display

802.11ad and 802.11ay Analysis

SignalVu™ Vector Signal Analysis Software Printable Help 219



Settings Description

Data radix Specifies whether symbol values are displayed in binary or decimal format (for example, in the
Symbol Table or markers readouts).

Show graticule Specifies to show the graticule on the display when checked.

Show Marker readout in graph
(selected marker)

Specifies to show the marker readout when checked.

Traces tab – 802.11ad/11ay
This tab allows you to set the trace display characteristics of the selected display.

Settings Description

Trace Type Specifies the trace type is regular or pi/2 rotated.

Result Contents Selects which regions of the packet to show in constellation display. You can choose from Preamble,
Header, Guard, and Data for Single Carrier. You can choose from Preamble, Header, and Data for
Control PHY.

Limits tab – 802.11ad/11ay
This tab allows you to load an existing limits table, save a limits table, or edit limits values. By default, FreqErrorLimit is turned on and
EVMLimit is turned off. This tab is available for the 802.11ad/11ay Summary display only.
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Settings Description

On Click on a cell in the On column next to the measurement name to specify whether or not
measurements are selected for limit comparison to indicate Pass or Fail. EVMLimit is off by default
and FreqErrorLimit is on by default.

Measurement Name Specifies the name of the measurement related to the limit (not editable).

Limit Specifies the value of the limit to the related measurement. When the cell is selected, the value is
shown along with the units. This is editable.

Load Click to load a saved Limits table from a .csv file.

Save Click to save the current Limits table to a .csv file.

Edit Limits
To directly edit measurement limits in the table, click on the value in the Limit column that you want to change.
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OFDM Analysis
OFDM Analysis Overview
The OFDM Analysis option provides measurements for OFDM signals specified by 802.11a/g/j (Wifi) and 802.16 (2004) (commonly known
as Fixed WiMAX) standards. User controls allow you to modify signal parameters for analysis of non-standard signals. The analysis results
give multiple views of OFDM signal characteristics to allow diagnosing signal imperfections and impairments quickly and easily. Display
controls provide the ability to selectively display the analysis results to help locate trouble-spots in the signal.

The displays in OFDM Measurements (Displays > Measurements > OFDM Measurements) are:

• OFDM Channel Response
• OFDM Constellation
• OFDM EVM
• OFDM Spectral Flatness
• OFDM Mag Error
• OFDM Phase Error
• OFDM Power
• OFDM Summary
• OFDM Symbol Table

OFDM Channel Response Display
The OFDM Channel Response display plots the channel response (magnitude or phase) versus the subcarrier or frequency. Here, the
channel refers to all sources of signal frequency response impairment up to the analyzer input, including the transmitter itself, as well as
any transmission medium through which the signal travels between the transmitter and the analyzer.

To show the OFDM Channel Response display:

1. Recall an appropriate acquisition data file.
2. Press the Displays button or select Setup > Displays.
3. In the Select Displays dialog, select OFDM Analysis in the Measurements box.
4. In the Available displays box, double-click the OFDM Chan Response icon or select the icon and click Add. The OFDM Chan

Response icon will appear in the Selected displays box and will no longer appear under Available displays.
5. Click OK to show the OFDM Chan Response display.
6. Set the Frequency appropriate for the signal.
7. Select Setup > Settings to display the control panel.
8. Select the Modulation Params tab. Set the Standard, Guard Interval and Spacing and Bandwidth controls as appropriate for the input

signal.
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Elements of the Display

Item Display element Description

1 Top-of-graph (magnitude) Sets the level that appears at the top of the magnitude graph. This is only a visual control
for panning the graph. The Reference Level is adjusted in the Toolbar and the Ampl control
panel. By default, Vert Position = Ref Level.

2 dB/div (magnitude) Sets the vertical scale value. The maximum value is 20.00 dB/division.

3 Display selector Selects the display type. Channel Response Magnitude or Phase can be displayed as a
Magnitude or Phase graph.

4 Bottom-of-graph readout
(magnitude)

Indicates the amplitude at the bottom of the graph. This value changes with the dB/div and
Vertical Position settings.

5 Autoscale Adjusts the Vertical and Horizontal scaling to display the optimize the trace display on
screen.

Table continued…
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Item Display element Description

6 Pos Shifts the trace left or right in the graph. The readout indicates the subcarrier or frequency
shown at the left edge of the display.

7 Scale Specifies the number of subcarriers shown in the graph.

8 Top-of-graph (phase) Sets the phase value indicated at the top of the graph. Since the Position value at the
vertical center of this graph remains constant as the Top of Graph value is adjusted,
the Vertical Scale increases as the Top of Graph value increases, which also affects the
bottom of graph readout.

9 Position (phase) Specifies the phase shown at the center of the graph display. Changing this value moves
the trace up and down in the graph, which affects the Top of Graph and Bottom of Graph
values as well.

10 Bottom-of-graph (phase) Indicates the phase at the bottom of the graph. This value changes with the Position
setting.

OFDM Channel Response Settings
The OFDM Channel Response Settings control panel provides access to settings that control parameters of the Channel Response
Display.

Settings tab Description

Modulation Params Specifies the input signal standard and additional user-settable signal parameters.

Advanced Params Specifies parameters used by the instrument to analyze the input signal.

Data Range Tab Specifies which symbols and subcarriers of the signal to display.

Analysis Time Tab Specifies parameters that define the portion of the acquisition record that is used for analysis. Also
allows you to specify the time units (Symbols or Seconds) for OFDM Analysis displays.

Prefs Tab Specifies the units of the display and whether elements of the graphs are displayed.

OFDM Constellation Display
Display shows the OFDM signal subcarriers' amplitude and phase in IQ constellation form.

To show the OFDM Constellation display:

1. Recall an appropriate acquisition data file.
2. Press the Displays button or select Setup > Displays.
3. In the Select Displays dialog, select OFDM Constellation in the Measurements box.
4. In the Available displays box, double-click the OFDM Constellation icon or select the icon and click Add. The OFDM Constellation

icon will appear in the Selected displays box and will no longer appear under Available displays.
5. Click OK to show the OFDM Constellation display.
6. Set the Frequency appropriate for the signal.
7. Select Setup > Settings to display the control panel.
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8. Select the Modulation Params tab. Set the Standard, Guard Interval and Spacing and Bandwidth controls as appropriate for the input
signal.

9. Press the Replay/Run button to take measurements on the acquired data.

Elements of the Display

Item Display element Description

1 Plot Constellation graph.

2 Marker Readout If markers are enabled, the marker readout shows the selected Marker, Symbol,
Subcarrier, Type, Value, Magnitude, and Phase for the symbol at the marker location.
Located to the left of the constellation plot or below it, depending on the size of the
window.

OFDM Constellation Settings
Main menu bar: Setup > Settings

The OFDM Constellation Settings control panel provides access to settings that control parameters of the Constellation Display. 

Settings tab Description

Modulation Params Specifies the input signal standard and additional user-settable signal parameters.

Advanced Params Specifies parameters used by the instrument to analyze the input signal.

Data Range Specifies which symbols and subcarriers of the signal to display.

Analysis Time Tab Specifies parameters that define the portion of the acquisition record that is used for analysis. Also
allows you to specify the Units (Symbols or Seconds) for OFDM Analysis displays.

Trace Enables you to freeze the display or hide the measurement or average trace.

Scale Tab Specifies the Zoom scale, and vertical and horizontal positions of the display.

Table continued…
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Settings tab Description

Prefs Tab Specifies the units of the display and whether elements of the graphs are displayed.

OFDM EVM Display
The OFDM EVM display shows the data symbols' individual subcarrier Error Vector Magnitude values versus symbol interval (time) and
subcarrier (frequency).

To show the OFDM EVM display:

1. Recall an appropriate acquisition data file.
2. Press the Displays button or select Setup > Displays.
3. In the Select Displays dialog, select OFDM EVM in the Measurements box.
4. In the Available displays box, double-click the OFDM EVM icon or select the icon and click Add. The OFDM EVM icon will appear in

the Selected displays box and will no longer appear under Available displays.
5. Click OK to show the OFDM EVM display.
6. Set the Frequency appropriate for the signal.
7. Select Setup > Settings to display the control panel.
8. Select the Modulation Params tab. Set the Standard as appropriate. Set the Standard, Guard Interval and Spacing and Bandwidth

controls as appropriate for the input signal.

Elements of the Display

Note: There is no carrier assigned to DC.

Item Display element Description

1 Top of graph Sets the EVM value that appears at the top of the graph. This is only a visual control for
panning the graph.

2 Bottom of graph Sets the EVM value that appears at the bottom of the graph. This is only a visual control
for panning the graph.

Table continued…
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Item Display element Description

3 Autoscale Adjusts the vertical and horizontal settings to provide the best display.

4 Pos Specifies the horizontal position of the trace on the graph display.

5 Scale Adjusts the horizontal range of the graph. By decreasing the scale, the graph essentially
becomes a window that you can move over the analysis results by adjusting the position.

OFDM EVM Settings
Main menu bar: Setup > Settings 

The settings for the OFDM EVM display are shown in the following table.

Settings tab Description

Modulation Params Specifies the type of modulation used for the input signal and other parameters.

Advanced Params Specifies parameters used by the instrument to analyze the input signal.

Data Range Specifies which symbols and subcarriers of the signal to display.

Analysis Time Specifies parameters that define the portion of the acquisition record that is used for analysis. Also
allows you to specify the Units (Symbols or Seconds) for OFDM Analysis displays.

Trace Enables you to freeze the display or hide the measurement or average trace.

Scale Specifies the vertical, subcarrier, and symbols scale and position settings.

Prefs Specifies the units of the display and whether elements of the graphs are displayed.

OFDM Spectral Flatness Display
The OFDM Spectral Flatness display shows the average power levels of subcarriers across the signal bandwidth and indicates if they
remain within the limits defined for a particular standard.

The averaged subcarrier level is shown as a line on the display, while the individual subcarrier levels are shown as points. The Pass or Fail
result indicates whether the average line remains between the upper and lower limit mask boundaries.

To show the OFDM Spectral Flatness display:

1. Recall an appropriate acquisition data file.
2. Press the Displays button or select Setup > Displays.
3. In the Select Displays dialog, select OFDM Analysis in the Measurements box.
4. In the Available displays box, double-click the OFDM Flatness icon or select the icon and click Add. The OFDM Flatness icon will

appear in the Selected displays box and will no longer appear under Available displays.
5. Click OK to show the OFDM Flatness display.
6. Set the Frequency appropriate for the signal.
7. Select Setup > Settings to display the control panel.
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8. Select the Modulation Params tab. Set the Standard, Guard Interval, Subcarrier Spacing and Channel Bandwidth controls as
appropriate for the input signal.

Elements of the Display

Item Display element Description

1 Top of graph Sets the Flatness value that appears at the bottom of the graph in dB. This is only a visual
control for panning the graph.

2 Bottom of graph Shows the Flatness value set at the top of the graph.

3 Autoscale Adjusts the vertical and horizontal settings to provide the best display.

4 Pos Specifies the horizontal position of the trace on the graph display.

5 Scale Adjusts the horizontal range of the graph. By decreasing the scale, the graph essentially
becomes a window that you can move over the analysis results by adjusting the position.

OFDM Spectral Flatness Settings
Main menu bar: Setup > Settings

The settings for the OFDM Spectral Flatness display are shown in the following table.

Settings tab Description

Modulation Params Specifies the type of modulation used for the input signal and other parameters.

Advanced Params Specifies parameters used by the instrument to analyze the input signal.

Data Range Specifies which symbols and subcarriers of the signal to display.

Table continued…
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Settings tab Description

Analysis Time Specifies parameters that define the portion of the acquisition record that is used for analysis. Also
allows you to specify the Units (Symbols or Seconds) for WLAN Analysis displays.

Trace Enables you to display or hide the measurement or average trace.

Scale Tab Specifies the vertical, subcarrier, and symbols scale and position settings.

Prefs Tab Specifies the units of the display and whether elements of the graphs are displayed.

OFDM Magnitude Error Display
The OFDM Mag Error display shows the data symbols' individual subcarrier Magnitude Error values versus symbol interval (time) and
subcarrier (frequency).

To show the OFDM Magnitude Error display:

1. Recall an appropriate acquisition data file.
2. Press the Displays button or select Setup > Displays.
3. In the Select Displays dialog, select OFDM Analysis in the Measurements box.
4. In the Available displays box, double-click the OFDM Mag Error icon or select the icon and click Add. The OFDM Mag Error icon will

appear in the Selected displays box and will no longer appear under Available displays.
5. Click OK to show the OFDM Mag Error display.
6. Set the Frequency appropriate for the signal.
7. Select Setup > Settings to display the control panel.
8. Select the Modulation Params tab. Set the Standard, Guard Interval and Spacing and Bandwidth controls as appropriate for the input

signal.

Elements of the Display

Item Display element Description

1 Top of graph Sets the Magnitude Error value that appears at the top of the graph. This is only a visual
control for panning the graph.

Table continued…
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Item Display element Description

2 Bottom of graph Sets the Magnitude Error value that appears at the bottom of the graph. This is only a
visual control for panning the graph.

3 Autoscale Adjusts the vertical and horizontal settings to provide the best display.

4 Pos Specifies the horizontal position of the trace on the graph display.

5 Scale Adjusts the horizontal range of the graph. By decreasing the scale, the graph essentially
becomes a window that you can move over the analysis results by adjusting the position.

OFDM Magnitude Error Settings
Main menu bar: Setup > Settings

The settings for the OFDM Mag Error display are shown in the following table.

Settings tab Description

Modulation Params Specifies the type of modulation used for the input signal and other parameters.

Advanced Params Specifies parameters used by the instrument to analyze the input signal.

Data Range Specifies which symbols and subcarriers of the signal to display.

Analysis Time Tab Specifies parameters that define the portion of the acquisition record that is used for analysis. Also
allows you to specify the Units (Symbols or Seconds) for OFDM Analysis displays.

Trace Enables you to display or hide the measurement or average trace.

Scale Tab Specifies the vertical, subcarrier, and symbols scale and position settings.

Prefs Tab Specifies the units of the display and whether elements of the graphs are displayed.

OFDM Phase Error Display
The OFDM Phase Error display shows the data symbols' individual subcarrier Phase Error values versus symbol interval (time) and
subcarrier (frequency).

To show the OFDM Phase Error display:

1. Recall an appropriate acquisition data file.
2. Press the Displays button or select Setup > Displays.
3. In the Select Displays dialog, select OFDM Analysis in the Measurements box.
4. In the Available displays box, double-click the OFDM Phase Error icon or select the icon and click Add. The OFDM Phase Error icon

will appear in the Selected displays box and will no longer appear under Available displays.
5. Click OK to show the OFDM Phase Error display.
6. Set the Frequency appropriate for the signal.
7. Select Setup > Settings to display the control panel.
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8. Select the Modulation Params tab. Set the Standard, Guard Interval and Spacing and Bandwidth controls as appropriate for the input
signal.

Elements of the Display

Item Display element Description

1 Top of graph Sets the Phase Error value that appears at the top of the graph. This is only a visual
control for panning the graph.

2 Bottom of graph Sets the Phase Error value that appears at the bottom of the graph. This is only a visual
control for panning the graph.

3 Autoscale Adjusts the vertical and horizontal settings to provide the best display.

4 Pos Specifies the horizontal position of the trace on the graph display.

5 Scale Adjusts the horizontal range of the graph. By decreasing the scale, the graph essentially
becomes a window that you can move over the analysis results by adjusting the position.

OFDM Phase Error Settings
Main menu bar: Setup > Settings 

The settings for the OFDM Phase Error display are shown in the following table.

Settings tab Description

Modulation Params Specifies the type of modulation used for the input signal and other parameters.

Advanced Params Specifies parameters used by the instrument to analyze the input signal.

Data Range Specifies which symbols and subcarriers of the signal to display.

Table continued…
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Settings tab Description

Analysis Time Tab Specifies parameters that define the portion of the acquisition record that is used for analysis. Also
allows you to specify the Units (Symbols or Seconds) for OFDM Analysis displays.

Trace Enables you to display or hide the measurement or average trace.

Scale Tab Specifies the vertical, subcarrier, and symbols scale and position settings.

Prefs Tab - OFDM on page 242 Specifies the units of the display and whether elements of the graphs are displayed.

OFDM Power Display
The OFDM Power display shows the data symbols' individual subcarrier Power values versus symbol interval (time) and subcarrier
(frequency).

To show the OFDM Power display:

1. Recall an appropriate acquisition data file.
2. Press the Displays button or select Setup > Displays.
3. In the Select Displays dialog, select OFDM Analysis in the Measurements box.
4. In the Available displays box, double-click the OFDM Power icon or select the icon and click Add. The OFDM Power icon will appear

in the Selected displays box and will no longer appear under Available displays.
5. Click OK to show the OFDM Power display.
6. Set the Frequency appropriate for the signal.
7. Select Setup > Settings to display the control panel.
8. Select the Modulation Params tab. Set the Standard, Guard Interval and Spacing and Bandwidth controls as appropriate for the input

signal.

Elements of the Display
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Item Display element Description

1 Vertical Position Sets the top of graph value. This is only a visual control for panning the graph. The
Reference Level is adjusted in the Toolbar and the Ampl control panel. By default, Vert
Position = Ref Level.

2 dB/div Sets the vertical scale value. The maximum value is 20.00 dB/division.

(not
shown)

Units Sets the global amplitude units for all the views in the analysis window. This will change
the amplitude selection in the Units tab of the Amplitude control panel.

2 Bottom of graph readout Indicates the amplitude at the bottom of the graph. This value changes with the dB/div and
Vertical Position settings.

3 Autoscale Adjusts the vertical and horizontal settings to provide the best display.

4 Pos Specifies the horizontal position of the trace on the graph display.

5 Scale Adjusts the horizontal range of the graph. By decreasing the scale, the graph essentially
becomes a window that you can move over the analysis results by adjusting the position.

OFDM Power Settings
Main menu bar: Setup > Settings 

The settings for the OFDM Power display are shown in the following table.

Settings tab Description

Modulation Params Specifies the type of modulation used for the input signal and other parameters.

Advanced Params Specifies parameters used by the instrument to analyze the input signal.

Data Range Specifies which symbols and subcarriers of the signal to display.

Analysis Time Specifies parameters that define the portion of the acquisition record that is used for analysis. Also
allows you to specify the Units (Symbols or Seconds) for OFDM Analysis displays.

Trace Enables you to display or hide the measurement or average trace.

Scale Specifies the vertical, subcarrier, and symbols scale and position settings.

Prefs Specifies the units of the display and whether elements of the graphs are displayed.

OFDM Summary Display
The OFDM Summary display shows several measurements of OFDM signal quality.

To show the OFDM Summary display:
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1. Recall an appropriate acquisition data file.
2. Press the Displays button or select Setup > Displays.
3. In the Select Displays dialog, select OFDM Analysis in the Measurements box.
4. In the Available displays box, double-click the OFDM Summary icon or select the icon and click Add. The OFDM Summary icon will

appear in the Selected displays box and will no longer appear under Available displays.
5. Click OK to show the OFDM Summary display.
6. Set the Frequency appropriate for the signal.
7. Select Setup > Settings to display the control panel.
8. Select the Modulation Params tab. Set the Standard, Guard Interval and Spacing and Bandwidth controls as appropriate for the input

signal.

Elements of the Display

Measurement Description

Standard Display of the standard selected on the Setup > Settings > Modulation Params tab.

Frequency Error The frequency difference between the measured carrier frequency of the signal and the measurement
frequency setting.

IQ Origin Offset The average magnitude of the DC subcarrier level relative to total signal power. It indicates the level
of carrier feedthrough detected at the center (DC) subcarrier.

Average Power The average power of all symbols in the analysis. Calculated over only the data symbols in the
packet.

Symbols How many symbols were analyzed.

Symbol Clk Error The symbol clock error in parts per million.

CPE CPE, Common Pilot Error, is the RMS magnitude error of the pilots over all analyzed symbols.

Peak-to-Average The ratio of the highest instantaneous signal power level to the average signal power. Calculated over
only the data symbols in the packet.

Table continued…
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Measurement Description

EVM The RMS and Peak values of the normalized subcarrier Error Vector Magnitude values. The
normalized subcarrier EVM values are calculated as the difference between the detected received
signal subcarrier constellation points and ideal reference points estimated by the instrument from the
received signal. Values are reported in units of percent and dB. Peak values include the symbol and
subcarrier location.

RMS and Peak values are displayed for groupings of all subcarriers, Pilots only and Data only.
Results are calculated over the entire signal packet analyzed, covering the number of Symbols
indicated in the Summary display.

OFDM Summary Settings
Main menu bar: Setup > Settings 

The settings for the OFDM Summary display are shown in the following table.

Settings tab Description

Modulation Params Specifies the type of modulation used for the input signal and other parameters.

Advanced Params Specifies parameters used by the instrument to analyze the input signal.

Data Range Specifies which symbols and subcarriers of the signal to display.

Analysis Time Specifies parameters that define the portion of the acquisition record that is used for analysis. Also
allows you to specify the Units (Symbols or Seconds) for OFDM Analysis displays.

Prefs Specifies the units of the display and whether elements of the graphs are displayed.

OFDM Symbol Table Display
The OFDM Symbol Table display shows decoded data bits for each subcarrier in each symbol in the analyzed signal packet. Results are
presented with subcarrier (frequency) indices in the horizontal dimension and symbol (time) intervals in the vertical dimension.

To show the OFDM Symbol Table display:

1. Recall an appropriate acquisition data file.
2. Press the Displays button or select Setup > Displays.
3. In the Select Displays dialog, select OFDM Analysis in the Measurements box.
4. In the Available displays box, double-click the OFDM Symb Table icon or select the icon and click Add. The OFDM Symbol icon will

appear in the Selected displays box and will no longer appear under Available displays.
5. Click OK to show the OFDM Symbol Table display.
6. Set the Frequency appropriate for the signal.
7. Select Setup > Settings to display the control panel.
8. Select the Modulation Params tab. Set the Standard, Guard Interval and Spacing and Bandwidth controls as appropriate for the input

signal.
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Table 18:

Item Description

1 Subcarrier identifiers.

2 Symbol identifiers.

3 Subcarrier data values.

4 Marker readout when markers are enabled.

OFDM Symbol Table Settings
Main menu bar: Setup > Settings 

The settings for the OFDM Symbol Table display are shown in the following table.

Settings tab Description

Modulation Params Specifies the type of modulation used for the input signal and other parameters.

Advanced Params Specifies parameters used by the instrument to analyze the input signal.

Data Range Specifies which symbols and subcarriers of the signal to display.

Analysis Time Specifies parameters that define the portion of the acquisition record that is used for analysis. Also
allows you to specify the Units (Symbols or Seconds) for OFDM Analysis displays.

Prefs Specifies the units of the display and whether elements of the graphs are displayed.

Common Controls OFDM Analysis Shared Measurement Settings
Main menu bar: Setup > Settings
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The control panel tabs in this section are shared between the displays in the OFDM Analysis folder (Setup > Displays). Some tabs are
shared by all the displays, some tabs are shared by only a couple of displays. The settings available on some tabs change depending on
the selected display.

Table 19: Common controls for OFDM analysis displays

Settings tab Description

Modulation Params Specifies the type of modulation used for the input signal and other parameters.

Advanced Params Specifies parameters used by the instrument to analyze the input signal.

Data Range Specifies which symbols and subcarriers of the signal to display.

Analysis Time Specifies parameters that define the portion of the acquisition record that is used for analysis. Also
allows you to specify the Units (Symbols or Seconds) for OFDM Analysis displays.

Trace Enables you to display or hide the measurement or average trace.

Scale Specifies the vertical, subcarrier, and symbols scale and position settings.

Prefs Specifies the units of the display and whether elements of the graphs are displayed.

Modulation Params Tab - OFDM
The Modulation Params tab specifies the type of modulation used by the input signal and other parameters that control the demodulation
of the input signal.

Settings Description

Standard Specifies the standard used for the input signal. Choices are 802.11a/g/j and 802.16 (2004).

Guard Interval Specifies the guard interval used in the input signal. Choices are 1/4, 1/8, 1/16/, 1/32, and
User. When you select User, you can enter a percentage value to specify the size of the
guard interval as a percentage of the useful symbol interval. The Guard Interval range is
0–100%.

Spacing and Bandwidth Specifies the spacing between subcarriers and the nominal channel bandwidth. Only one of
these settings can be set at a time, the other setting is automatically calculated.

Sample Rate Indicates the FFT sample rate, based on the bandwidth or subcarrier setting.
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Advanced Params Tab - OFDM
The Advanced Params tab contains parameters that control the analysis of the input signal.

Settings Description

Constellation determination Specifies the method used to detect the constellation. Auto Detect analyzes the signal to
determine the appropriate constellation, Manual allows you to specify the constellation type.
Manual choices are: BPSK, QPSK, 16QAM, and 64QAM.

Symbol analysis offset Specifies the analysis offset in the symbol interval. This value is a percentage of the Guard
Interval. The allowable range is -100% to 0%. -100% positions the FFT to start at the
beginning of the Guard Interval, 0% positions it to start at the end of the Guard Interval.
Default value is -50% which usually gives the best measurement results.

Channel Estimation Specifies the method used to estimate channel frequency response and equalization. This
control can be used to diagnose changes in frequency response over the signal packet.

Preamble When you select Preamble, the instrument uses only the Preamble to estimate channel
frequency response. This response is then used to equalize the entire signal packet.

Preamble + Data When you select Preamble + Data, the instrument makes an initial channel frequency
response estimate from the Preamble. Then estimates the channel response for each data
symbol using the decoded data content to derive equalization for each symbol individually.
This allows compensation for time-varying channel response over the packet.

Pilot tracking Specifies if pilot subcarriers should be used to correct amplitude, phase, and symbol timing
variations over the packet. The choices available are Phase, Amplitude, and Timing. The
default setting is Phase.

Swap I & Q Select the checkbox to swap the I and Q components of a signal. This compensates the
input signal for spectral inversion.

Data Range Tab - OFDM
The Data Range tab enables you to control how much signal is analyzed, as well as specify the range of results that are displayed in the
Constellation, EVM, Magnitude Error, Phase Error, Power and Symbol Table graphs.
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Settings Description

Symbols Specifies which symbols are displayed in the graphs.

All Select All to display all symbols.

Range Select Range to specify a subset of symbols for display.

Start Specifies the first symbol to include in the display.

Number Specifies how many symbols to display in the graphs.

Single Select Single to display a single symbol.

Index Use Index to specify the symbol you want to display.

Subcarriers Specifies which subcarriers are displayed.

All Select All to display all subcarriers in the signal.

Pilots Only Select Pilot to display only pilot subcarriers.

Data Only Select Data to display only data subcarriers.

Single Specifies a specific subcarrier for display.

Index Specifies the specific subcarrier to be displayed.

Range Specifies a range to subcarriers to be displayed.

Start Specifies the start value of the range to be displayed.

Stop Specifies the ending value of the range to be displayed.

Max symbols to analyze Specifies how many symbols are analyzed. You can use this setting to speed analysis by
limiting the number of symbols being analyzed.

Analysis Time Tab - OFDM
The Analysis Time tab contains parameters that define how the signal is analyzed in the OFDM Analysis displays.
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Settings Description

Analysis Offset Specifies the location of the first time sample to use in measurements.

Auto When enabled, causes the instrument to set the Analysis Offset value based on the requirements of
the selected display.

Analysis Length Specifies the length of the analysis period to use in measurements. Length is specified in either
symbols or seconds, depending on the Units setting.

Auto When enabled, causes the instrument to set the Analysis Length value based on the requirements of
the selected display.

Actual This is a displayed value, not a setting. It is the Analysis Length (time or symbols) being used by the
analyzer, this value may not match the Analysis Length requested (in manual mode).

Time Zero Reference Specifies the zero point for the analysis time.

Units Specifies the units of the Analysis Length to either Symbols or Seconds.

Analysis Offset
Use analysis offset to specify where measurements begin. Be aware that you cannot set the Analysis Offset outside the range of time
covered by the current acquisition data. (all time values are relative to the Time Zero Reference).

You can set the Analysis Length so that the requested analysis period falls partly or entirely outside the current range of acquisition
data settings. When the next acquisition is taken, its Acquisition Length will be increased to cover the new Analysis Length, as long as
the Sampling controls are set to Auto. If the Sampling parameters are set to manual, or if the instrument is analyzing saved data, the
actual analysis length will be constrained by the available data length, but in most cases, measurements are able to be made anyway.
The instrument will display a notification when measurement results are computed from less data than requested. Range: 0 to [(end of
acquisition) - Analysis Length)]. Resolution: 1 effective sample (or symbol).

Analysis Length
Use the analysis length to specify how long a period of time is analyzed. As you adjust this value, the actual amount of time for Analysis
Length, in Symbol or Seconds units, is shown below the control in the "Actual" readout. This setting is not available when Auto is checked.
Range: minimum value depends on modulation type. Resolution: 1 symbol.

Time Zero Reference
All time values are measured from this point (such as marker position or horizontal position (in Y vs Time displays). Choices are:
Acquisition Start or Trigger.

Parameter Description

Acquisition Start Offset is measured from the point at which acquisition begins.

Trigger Offset is measured from the trigger point.

Trace Tab - OFDM
The Trace tab allows you to set the trace display characteristics of the selected display. This tab is not available for all OFDM displays.
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Settings Description

Trace Use this drop-down list to select whether or not the Average trace or the measurement trace is
displayed. The measurement trace depends on the selected display.

Show Select or deselect this checkbox to show or hide the trace selected in the Trace drop-down list.

Freeze Selecting Freeze halts updates to the trace.

Scale Tab - OFDM
The Scale tab allows you to change the scale settings that control how the trace appears on the display but does not change control
settings such as Measurement Frequency. There are two versions of the Scale tab for OFDM displays. One version is used only for the
Constellation display and the other version is used for the OFDM EVM, OFDM Magnitude Error, OFDM Phase Error, and OFDM Power
displays.

Figure 29: Scale tab for OFDM EVM, OFDM Mag Error, OFDM Phase Error, and OFDM Power displays

Figure 30: Scale tab for OFDM Constellation display

Settings Description

Vertical Controls the vertical position and scale of the trace display.

Scale Changes the vertical scale of the graph.

Position Adjusts the reference level away from top of the graph.

Autoscale Resets the scale of the vertical axis to contain the complete trace.

Table continued…
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Settings Description

Subcarrier Controls the scale of the subcarrier graph and position of the trace.

Scale Specifies how many subcarriers are displayed horizontally.

Position Specifies the subcarrier that appears at the left edge of the subcarrier graph.

Autoscale Resets the scale of the horizontal axis to contain the complete trace.

Symbols Controls the scale of the Symbols graph.

Scale Specifies the number of symbols that appear in the symbols graph.

Position Specifies the symbol that appears at the left edge of the Symbols graph.

Autoscale Resets the scale and position settings to optimize the display.

Auto When Auto is checked, the scale and position values for the Symbols graph are automatically
adjusted to maintain the optimal display.

Zoom Sets the Constellation display size and position.

Scale Sets the magnification value for the Constellation display.

Vertical Position Sets the vertical location of the Constellation display within the graph. Range is -3.7 to +3.7.

Horizontal Position Sets the horizontal location of the Constellation display within the graph. Range is -3.7 to +3.7.

Prefs Tab - OFDM
The Prefs tab enables you to change appearance characteristics of the OFDM Analysis displays. Not all settings on the Prefs tab shown
below appear for every OFDM display.

Settings Description

Time units Specifies whether the displayed time units are seconds or symbols.

Freq units Specifies whether the displayed frequency units are frequency (Hz) or subcarrier channel.

Radix Specifies whether symbol values are displayed in binary or hex format (for example, in the Symbol
Table or markers readouts).

Table continued…
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Settings Description

Show graphs Specifies which graph types are displayed.

Both Displays both the Subcarrier and Symbol graphs.

Subcarriers Displays only the subcarrier graph.

Symbols Displays only the symbol graph.

Show graticule Displays or hides the graticule in the graphs.

Show marker readout Displays or hides the marker readouts in the graphs.
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Pulsed RF
Pulsed RF Overview
The Pulsed RF option (SVP) allows you to take measurements that provide deep insight into pulse train behavior. You can define and
analyze unique pulse characteristics in the time and frequency domains and gain additional insight into the performance of Radar or EW
subsystems. The Pulse Cumulative Histogram and Pulse Cumulative Statistics Table accumulate results over multiple acquisitions. The
remaining Pulse displays show results for the current acquisition. You can use cross-correlated markers to pinpoint events in one display
and debug in other displays.

The displays in Pulsed RF (Setup > Displays > Pulsed RF) are:

• Cumulative Histogram
• Cumulative Statistics
• Pulse-Ogram™
• Pulse Statistics
• Pulse Table
• Pulse Trace

Pulse Measurements
The analyzer takes the following pulse measurements.

Measurement Description

Average ON Power The average power transmitted during pulse on.

Peak Power Maximum power during pulse on.

Average Transmitted Power The average power transmitted, including both the time the pulse is on and the time it is off, and all
transition times.

Pulse Width The time from the rising edge to the falling edge at the –3 dB / –6 dB level (50%) of the user selected
100% level. Level is user selectable for Volts or Watts.

Rise Time The time required for a signal to rise from 10% to 90% (or 20% to 80%) of the user selected 100%
level.

Fall Time The time required for a signal to fall from 90% to 10% (or 80% to 20%) of the user selected 100%
level.

Repetition Interval The time from a pulse rising edge to the next pulse rising edge.

Repetition Rate The inverse of repetition interval.

Duty Factor (%) The ratio of the width to the pulse period, expressed as a percentage.

Duty Factor (Ratio) The ratio of the pulse width to the pulse period.

Table continued…
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Measurement Description

Ripple Ripple is the peak-to-peak ripple on the pulse top. It does not include any preshoot, overshoot,
or undershoot. By default, the first 25% and the last 25% of the pulse top is excluded from this
measurement to eliminate distortions caused by these portions of the pulse. 

If the Amplitude units selected in the Amplitude panel (affects all amplitude measurements for the
analyzer) are linear, the Ripple results will be in %Volts. For log units, the Ripple results will be in
%Watts. The default for the general Units control is dBm, so the Ripple results default is %Watts.

See also Ripple on page 570.

Ripple dB The Ripple measurement expressed in dB.

Droop Droop is the power difference between the beginning and the end of the pulse on time. A straight-line
best fit is used to represent the top of the pulse. The result is a percentage referenced to the Average
ON Power.

Droop dB The Droop measurement expressed in dB.

Overshoot The amount by which the signal exceeds the 100% level on the pulse rising edge. Units are %Watts
or %Volts.

Overshoot dB The Overshoot measurement expressed in dB.

Pulse-ref-Phase Difference The phase difference between the current pulse and the first pulse in the analysis window. The
instantaneous phase is measured at a user-adjustable time following the rising edge of each pulse.

Phase Difference The time interval by which one wave leads of lags another.

Pulse-ref Freq Difference The difference between the frequency of the current pulse and frequency of the previous pulse. The
instantaneous frequency is measured at a user-adjustable time following the rising edge of each
pulse.

RMS Freq Error The RMS Frequency Error measurement is the RMS average of the Freq Error vs. Time trace,
computed over the Measurement Time.

Max Freq Error The maximum frequency error is the difference between the measured carrier frequency of the signal
and the user-selected center frequency of the analyzer.

RMS Phase Error The RMS Phase Error measurement is the RMS average of the Phase vs Time trace, computed over
the Measurement Time.

Max Phase Error The phase is measured at each point during the pulse on time. The phase error for each point is the
difference between the measured phase value and the calculated ideal phase value. After the phase
error is calculated for all points in the acquisition record, the largest error in the positive direction and
the largest in the negative direction are determined. Whichever of these two values has the greater
absolute value is designated the Max Phase Error.

Freq Deviation The Frequency Deviation measurement is the difference between the maximum and minimum
measured values of the signal frequency during the Measurement Time.

Table continued…
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Measurement Description

Phase Deviation The Phase Deviation is the difference between the maximum and minimum Phase values measured
during the on time of a pulse.

Impulse Response Amplitude The difference in dB between the levels of the main lobe and highest side lobe.

Impulse Response Time The difference in time between the main lobe and highest side lobe.

Time This is the time in seconds relative to the time reference point in the first acquisition record in the data
set.

Absolute Frequency The absolute pulse frequency measured at a point specified by the user. The measurement includes
carrier frequency as well. The measurement point should be within the pulse width, starting from the
50% point.

Pulse-Pulse Frequency Difference The difference between the frequency of the current pulse and frequency of the previous pulse. The
instantaneous frequency is measured at a user-adjustable time following the rising edge of each
pulse.

Pulse-Pulse Phase Difference The phase difference between the selected pulse and the first pulse in the analysis window. The
instantaneous phase is measured at a user-adjustable time following the rising edge of each pulse.

Delta Frequency (Non-chirped
pulse)

The Delta Frequency measurement is the difference from the measurement frequency to each pulse
frequency. Pulse frequency is calculated across the time defined by the Frequency Domain Linearity
setting in the Define tab.

The measurement is available for modulation types CW (Constant Phase), CW (Changing phase).
and Other (manual) setting in the Freq Estimation tab.

The measurement is not specified for chirp or other signals and no answer is returned when
frequency estimation is set to Chirp.

If frequency estimation is set to Other, then Frequency Offset must be set to 0 Hz and the Range can
be set to ±40% of the acquisition bandwidth.

A least-square fit of slope of phase vs. time over the measurement period is used for the
measurement of the individual pulse frequency. Frequency difference is calculated as the difference
between the reference frequency and the calculated frequency of the pulse.

Cumulative Histogram Display
This histogram display shows the numerical distribution of the various pulse measurement results accumulated over multiple frames (in
Fast Frame mode) and acquisitions. You can see the pulse count in a chosen bin by choosing the bin number or the X value (of the chosen
result). Pulses that do not lie within the chosen Min/Max are shown as outliers.

To show the Cumulative Histogram display:

1. Recall an appropriate acquisition data file.
2. Press the Displays button or select Setup > Displays.
3. In the Select Displays dialog, select Pulse Analysis in the Measurements box.
4. In the Available displays box, double-click the Cumulative Histogram icon or select the icon and click Add. The icon will appear in the

Selected displays box and will no longer appear under Available displays.
5. Click OK to show the Cumulative Histogram display.
6. If you are analyzing a stored data file, press the Replay button to take measurements on the acquisition data file.
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Elements of the display

Item Display element Description

1 Result Drop down list of measurements. The results of the selected measurement in this
Cumulative Histogram display will also show in the Pulse Statistics display and be
highlighted in the Pulse Table display. All results will be available for view when Auto
mode is enabled in the Cumulative Histogram display settings on page 248 window. Only
selected results will be available for view when Manual mode is enabled in the Histogram
Settings window.

2 X A value of the selected result where the pulse indicator is positioned. Changing X will
automatically change the bin number to the one that contains the X value.

3 Bin Bin number where the indicator is positioned. Changing this number will change the value
of X to the middle of the selected bin.

4 Pulses in Bin Number of pulses in the selected bin.

5 Total Pulses Total number of pulses analyzed in the current acquisition.

6 Vertical Sets the vertical range.

7 Autoscale Sets the axes to values for clear visibility of trace points.

8 Horizontal offset and scale Controls that specify the offset and scale on the horizontal axis.

9 Clear button Clears results from the display and starts a new measurement.

10 Outliers Number of pulses that have measurement values outside of the maximum and minimum
values indicates the outliers below the lower limit and those exceeding the upper limit.

Table continued…
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Item Display element Description

11 Histogram Table button Contains the Bin number, Bin Range, and Pulses in bin for the chosen measurement.

Cumulative Histogram display settings
Main menu: Setup > Settings 

The Settings control panel tabs for the Cumulative Histogram display are shown in the following table.

Settings tab Description

Params Specifies several parameters that control how pulses are counted and defined.

Define Specifies parameters that control where measurements are taken on a pulse.

Levels Specifies parameters that control the method and levels used to calculate some pulse values.

Freq Estimation Specifies the reference used for computing frequency error.

Scale Specifies the vertical and horizontal scale settings.

Prefs Specifies whether or not certain display elements are shown.

Histogram Settings button
This button is located on the Pulse Cumulative Histogram Settings control panel. Click this button to open a window where you can select
which measurement results will be available in the Result drop down menu. You can select to use Auto or Manual mode.

Manual mode for histogram settings. In Manual mode, the histogram computation is done for the selected measurement results. You
set the maximum and minimum values. The Bin field represents the total number of bins used in the histogram.
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Auto mode for histogram settings. In Auto mode, the histogram computation is done for all measurement results. Minimum and
maximum limits are chosen automatically based on the first 10,000 pulses. The Bin field represents the total number of bins used in the
histogram.

Restore Defaults button
This button is located on the Pulse Cumulative Histogram Settings control panel. Click this button to set the Cumulative Histogram
parameters to their default values.

Cumulative Statistics Table display
This display is a statistics table that provides information on Pulse Count, Max, Max TimeStamp, Min, Min TimeStamp, Peak to Peak,
Average, and Standard Deviation over different acquisitions.

1. Recall an appropriate acquisition data file.
2. Press the Displays button or select Setup > Displays.
3. In the Select Displays dialog, select Pulsed RF in the Measurements box.
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4. In the Available displays box, double-click the Cumulative Statistics icon or select the icon and click Add. The icon will appear in the
Selected displays box and will no longer appear under Available displays.

5. Click OK to show the Cumulative Statistics display.
6. Press the Replay/Run button to take measurements on the acquired data.

Elements of the display
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Display element Description

Measurement The row across the top of the table shows the selected measurement.

You can right click on this row to access this menu to edit the table:

Select Add Measurements to open this window to select measurements:

Maximum Maximum value of the measurement across acquisitions with a time stamp.

Maximum TimeStamp This time stamp denotes the time the maximum value of the measurement occurred across
acquisitions.

Minimum Minimum value of the measurement across acquisitions with a time stamp.

Minimum TimeStamp This time stamp denotes the time the minimum value of the measurement occurred across
acquisitions.

Average Average value of the measurement values accumulated over multiple acquisitions until the current
acquisition.

Peak to peak This is the difference between Maximum and Minimum value of the measurement

Table continued…
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Display element Description

Standard deviation Standard deviation of the measurement that has a population equal to the Pulse Count value.

Clear button Clear the results and starts a new measurement.

Note: When analysis is done on only one pulse, the Standard Deviation is zero. Log10 (0) is not defined and thus is reperesented
by a “–” when the unit is dB.

Cumulative Statistics Table display settings
Main menu: Setup > Settings 

The Settings control panel tabs for the Cumulative Statistics Table display are shown in the following table.

Settings tab Description

Measurements Specifies which measurements to show in the table. Click the box(es) next to the measurement(s) you
want to show. You can also click the Select All and Clear All buttons.

Params Specifies how pulses are counted and defined.

Define Specifies parameters that control where measurements are taken on a pulse.

Levels Specifies parameters that control the method and levels used to calculate some pulse values.

Freq Estimation Specifies the reference used for computing frequency error.

Prefs Specifies whether on not certain display elements are shown.

Restore defaults button
This button is located on the Cumulative Statistics Table Settings control panel. Sets the Cumulative Statistics Table parameters to their
default values.

Pulse-Ogram display
The Pulse-Ogram™ display shows a stacked view of radar pulses when the analyzer is using fast-frame mode. The fast-frame captures IQ
samples around a pulse when triggered. Each fast frame is configured to capture few IQ samples before rise-time, and after fall-time of a
single pulse, and a timestamp associated with that pulse. With this information, the different fast-frame captures are stacked one after the
other and displayed as Time v/s Time, and the corresponding spectrum information as Frequency v/s Time. The stacking allows for overlap
of adjacent frames. The user can also select the range of frames for viewing in the display. This enables the user to study various aspects
of pulse such as pulse width, reflections, rise-time, fall-time, etc.

Marker correlation in Pulse-Ogram
At the end of an acquisition, the TOV and Spectrum show the last frame acquired. When we place a marker in Pulse-Ogram, the marker
would not move in TOV and Spectrum unless you bring the marker to the last frame in Pulse-Ogram. Similarly, if marker is moved in TOV
and Spectrum, then the marker in Pulse-Ogram will move to the last frame automatically.
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If you want the marker movement in Pulse-Ogram to change the pulse indicator in the Pulse Table or Pulse Trace display, then you must
add the Pulse Statistics display in Time trend mode. Movement of the marker now in the Pulse Statistics display or Pulse-Ogram display
will change the pulse indicator position too, and therefore the appropriate pulse will be shown in the Pulse Trace display.

1. Recall an appropriate acquisition data file.
2. Press the Displays button or select Setup > Displays.
3. In the Select Displays dialog, select Pulsed RF in the Measurements box.
4. In the Available displays box, double-click the Pulse-O-gram icon or select the icon and click Add. The icon will appear in the

Selected displays box and will no longer appear under Available displays.
5. Click OK to show the Pulse-O-gram display.
6. Press the Replay/Run button to take measurements on the acquired data.

Elements of the display

Display element Description

Time vs Time This view has the IQ data captured in the fast frames in a stacked view (with overlap).

Frequency vs Time This view has the corresponding spectrum of the signal captured.

Frame offset Controls the number of frames that are offset in the display. The starting frame will be frame offset + 1.

Frame scale Controls the number of frames that can be seen in the display.

Frame count Total number of fast frames in the acquisition.

Frame # Indicates the frame number in which the marker is present. This option will only appear when the
marker is added.

Plot type Shows Stacked and is not selectable.

Display Select to view Time vs Time or Frequency vs Time or Both.

RBW Shows the resolution bandwidth for the Frequency vs Time view.

Pulse-Ogram display settings
Main menu: Setup > Settings 
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The Settings control panel tabs for the Pulse-Ogram display are shown in the following table.

Settings tab Description

Analysis Specifies settings related to analysis of the signal.

Traces Specifies the display characteristics of displayed traces.

Scale Specifies the parameters related to fast frame.

Prefs Specifies marker readout options.

Pulse Table display
The Pulse Table lists selected measurements in a spreadsheet format, showing the pulse numbers and all the results for each
measurement on all the detected pulses. Pulses are numbered from one. 

Displaying the Pulse Table
1. Press the Displays button or select Setup > Displays.
2. Select Pulsed RF in the Measurements box.
3. Double-click Pulse Table in the Available displays box to add the display to the Selected displays box.
4. Click OK.

Selecting the Measurements to Show
1. With the Pulse Table selected, press the Settings button.
2. In the Pulse Table Settings control panel, select the Measurements tab.
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3. Select the measurements you wish to take from the list of measurements or click Select all to choose all measurements.
4. Click the close box ( ) to remove the Settings control panel.

Changing the Pulse Table Display Settings

Pulse Table display settings
Main menu bar: Setup > Settings 

The Settings control panel tabs for the Pulse Table Display are shown in the following table.

Settings tab Description

Measurements Selects the measurements to be show in the Pulse Table.

Params Specifies several parameters that control how pulses are counted and defined.

Define Specifies parameters that control where measurements are taken on a pulse.

Levels Specifies parameters that control the method and levels used to calculate some pulse values.

Freq Estimation Specifies the reference used for computing frequency errors.

Restore defaults button
This button is located on the Pulse Table Settings control panel. Sets the Pulse Table parameters to their default values.

Clearing results
If you want to clear the Pulse Table results for a new acquisition, open the Time Overview window and select Autoscale. This causes the
Pulse Table to refresh.

Pulse Trace display
The Pulse Trace display shows one measurement result and a trace graph illustrating that measurement for a selected pulse number. You
can also choose to display arrows and lines in the graph that illustrate where on the pulse the measurement is being taken.
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Elements of the Pulse Trace Display

Item Display element Description

1 Check mark indicator The check mark indicator in the upper, left-hand corner of the display shows when the
Pulse Trace display is the optimized display.

Note: When Best for multiple windows is selected in the Amplitude control
panel's RF & IF Optimization control, none of the measurement displays shows a
checkmark, as there is not a single optimized measurement.

2 Result Use this list to select the measurement to show. The measurement chosen here selects
the same result to be displayed in the Statistics view and highlighted in the Table view.
Selecting a result in any of these views causes the same result to be selected in all of
them.

3 Pulse Selects which pulse result is shown. Like the Result, this selection is shared with the
Statistics and Table views. The maximum number of pulses that can be measured is
limited to 10000.

4 Pulse threshold indicator This green triangle indicates the power threshold used to detect pulses. See Settings >
Params > Power threshold to detect pulses.

5 Autoscale Set the axes to values that show all trace points.

6 Horizontal offset and scale Located along the bottom edge of the trace display, these controls specify the offset and
scale on the horizontal axis.

7 Top of graph adjustment Sets the power level shown at the top of the graph. If the number is greater than the Ref
Level, a white line will appear in the graph to indicate the Ref Level.

(not
shown)

Units Sets the global amplitude units for all the views in the analysis window. This will change
the amplitude selection in the Units tab of the Amplitude control panel.

8 Vertical scale Sets the vertical scale value.
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Changing the Pulse Trace Display Settings

Pulse Trace display settings
Main menu: Setup > Settings 

The Setup settings for the Pulse Trace display are shown in the following table.

Settings tab Description

Params Specifies several parameters that control how pulses are counted and defined.

Define Specifies parameters that control where measurements are taken on a pulse.

Levels Specifies parameters that control the method and levels used to calculate some pulse values.

Freq Estimation Specifies the reference used for computing frequency error.

Scale Specifies the vertical and horizontal scale settings.

Prefs Specifies whether on not certain display elements are shown.

Restore defaults button
This button is located on the Pulse Trace Settings control panel. Sets the Pulse Trace display parameters to their default values.

Pulse Statistics display
The Pulse Statistics view displays a plot of a pulse measurement's values for every pulse in the analysis period. For example, the Pulse
Statistics display will show the Rise Time measurement for each of 30 pulses, with rise time on the Y axis and pulse number on the X
axis. Alternatively, the Statistics Display can show an FFT trace for the values of a measurement over all the pulses analyzed. Numeric
readouts of Pulse Count, Max, Min, Peak to Peak, Average, and Standard Deviation in this display summarize results for the selected
pulse measurement.

Elements of the Pulse Statistics Display
The following images show the display when different plot types are selected. The table following these images explains the elements of
these displays.
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Figure 31: The above image shows an FFT plot.

Figure 32: The above image shows a Trend plot.

Figure 33: The above image shows a Time Trend plot.
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Figure 34: The above image shows a Histogram plot.

Item Display element Description

1 Result Use this list to select which measurement statistics to display. The measurement chosen
here selects the same result to be displayed in the Pulse Trace display and the Pulse
Table display. Selecting a result in any of these views causes the same result to be
selected in all of them.

2 Results indicators

(The indicators shown depend on the plot type selection. The values shown are plot indicator (Item 9) values.)

Pulse Pulse indicator for Trend or Time Trend plots that indicates the pulse selected by the Pulse
setting.

Freq Pulse indicator for FFT plots that marks the trace point at the selected frequency.

X For Histogram plots: A value of the selected result where the pulse indicator is positioned.
Changing X will automatically change the bin number to the one that contains the X value.

Bin For Histogram plots: Bin number where the indicator is positioned. Changing this number
will change the value of X to the middle of the selected bin.

Pulses in Bin For Histogram plots: Number of pulses in the selected bin.

Total Pulses For Histogram plots: Total number of pulses analyzed in the current acquisition.

3 Vertical Sets the vertical range.

4 Autoscale Sets the axes to values for clear visibility of trace points.

Table continued…
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Item Display element Description

5 Histogram Table button Contains the Bin number, Bin range, and Pulses in bin for the chosen measurement.

6 Plot type selector Select Trend, Time Trend, FFT, or Histogram as plot type.

7 Horizontal offset Adjusts the horizontal offset.

8 Statistics summary Display of measurement statistics for the selected result.

9 Pulse indicator For Trend and Time Trend plot types, this indicates the pulse selected by the Pulse
setting. For the FFT plot type, this indicator marks the trace point at the selected
frequency. For Histogram plot types, this indicator marks the selected results bin.

10 Scale Adjusts the horizontal scale.

Changing the Pulse Statistics Display Settings

Pulse Statistics settings
Main menu bar: Setup > Settings 

The settings for the Pulse Statistics display are shown in the following table.

Settings tab Description

Params Specifies several parameters that control how pulses are counted and defined.

Define Specifies parameters that control where measurements are taken on a pulse.

Levels Specifies parameters that control the method and levels used to calculate some pulse values.

Freq Estimation Specifies the reference used for computing frequency errors.

Scale Specifies the vertical and horizontal scale settings.

Table continued…
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Settings tab Description

Prefs Specifies whether or not certain elements of the display are shown.

Restore defaults button
This button is located on the Pulse Statistics Settings control panel. Sets the Pulse Statistics display parameters to their default values.

Pulsed RF Measurement Settings
Some of the control panel tabs are shared by the Pulsed RF displays (Setup > Displays). Changing a setting in a shared tab changes that
setting for all the Pulsed RF displays. The other control panel tabs are unique for each display. The following information explains both
types.

Table 20: Common controls for pulsed RF displays

Settings tab Description

Measurements Specifies which measurement results appear in the Cumulative Statistics Table and Pulse Table
displays.

Params Specifies several parameters that control how pulses are counted and defined.

Define Specifies parameters that control where measurements are taken on a pulse.

Analysis

(Only Available for the Pulse-
Ogram display)

Specifies parameters related to analysis of the signal.

Levels Specifies parameters that control the method and levels used to calculate some pulse values.

Freq Estimation Specifies the reference used for computing frequency errors.

Traces

(Only available for the Pulse-
Ogram display)

Specifies the smooth points for the Time vs Time view and the detection method for the Frequency vs
Time view.

Scale Specifies the vertical and horizontal scale settings.

Prefs Specifies whether or not certain elements of the display are shown.

Measurements Tab
The Measurements tab is used to specify the measurements that appear in the Cumulative Statistics Table display and the Pulse Table
display.
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Show in Cumulative Statistics Table
Checked measurements appear in the table.

Select all
Click Select all to choose all measurements for display in the table.

Clear all
Click Clear all to remove all measurements from the table display.

Params Tab
The Params tab enables you to adjust several measurement parameters for Pulsed RF displays. Not all parameters show for all displays. 

Setting Description

Measurement Filter Specify whether a filter is used to limit the bandwidth of the input signal.

Bandwidth Sets the bandwidth of the measurement filter.

Power threshold to detect pulses Specifies the level used for locating pulses in the data.

Minimum OFF time between
pulses

Specifies the time the signal must fall below the power threshold for two pulses to be considered
separate pulses.

Max number of pulses Specifies the number of pulses to measure within the analysis time.

(Only available for the Pulse Statistics, Pulse Trace, and Pulse Table displays.)

Measurement Filter
Three choices are available for the measurement filter:

• No Filter - Max BW: The widest acquisition bandwidth available is used. The Bandwidth setting is disabled, but shows the value in
use.

• No Filter: - This is the default. The Bandwidth control is enabled to specify an acquisition bandwidth.
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• Gaussian - The Bandwidth control is enabled for you to specify a value. The instrument uses an acquisition bandwidth two times wider
than the entered value.

Power Threshold to Detect Pulses
Specifies the minimum power level the trace must exceed to be detected as a pulse. The range for this setting is: -3 to -70 dBc. The setting
resolution is 1 dB. The default value is -10 dB.

Minimum OFF time between pulses
Specifies the time the signal must fall below the power threshold for two pulses to be considered separate pulses. The minimum value for
this setting is 1.000 ns.

Max Number of Pulses
Only available for the Pulse Statistics, Pulse Trace, and Pulse Table displays.

If the Analysis Time contains fewer pulses than specified, the analyzer will measure all the pulse within the analysis time. If there are more
pulses in the Analysis Time, than the specified number, the analyzer measures the specified number of pulses and ignores the rest. The
setting resolution is: 1. If this setting is not checked, the analyzer will measure all pulses within the Analysis Time.

To determine the maximum number of pulses that can be analyzed, use the following equation:

Maxnumberofpulses thatcan analyzed= PulseRate× capacity

where:

• Pulse rate is the number of pulses per second (frequency).
• Capacity is a length of time which is displayed on the Acquire > Sampling Parameters tab.

Note that the maximum number of pulses is affected by several parameters. For example, measurement bandwidth affects the sample
rate. The measurement algorithm also can reduce the maximum number of pulses that can be analyzed (by increasing the sample rate)
based on the characteristics of the signal.

Additionally, when FastFrame is enabled, determining the maximum number of pulses is even more challenging. In FastFrame mode, the
signal analyzer samples the signal around events of interest and ignores the signal between events of interest. Thus, if the instrument
is only looking at pulses and ignoring the signal between pulses, the number of pulses that can be analyzed depends strongly on the
characteristics of the pulse itself (for example, fewer wide pulses can be analyzed than narrow pulses, all other things being equal).

The Pulse Cumulative Statistics display provides statistics of pulses like Average, Standard Deviation, and Peak to Peak. Pulse Count
does not have an upper limit for Pulse Cumulative Statistics. The Pulse Cumulative Histogram display provides information about the trend
of the Pulse characteristics and outliers. This display does not support any upper limit or lower limit.

Note: In Fast Save mode, Pulse /Frame Count can go up to 200,000. This count also depends on the hard disk drive (HDD)
capacity to store acquisitions.

The asterik (*) around a pulse number indicates that it is a Fast Frame.

All Pulse Analysis displays except the Pulse-Ogram update results only after analysis of all fast frames.

Define Tab
The Define tab enables you to specify parameters that control where measurements are made on a pulse. The settings available depend
on the measurement selected. This tab is not available for the Pulse-Ogram display.
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The settings that appear on the Define tab are described below. They may vary according to the Measurement(s) selection.

Freq-Domain Linearity

Setting Description

Time method Specifies how the measurement's duration is determined. The choices are Absolute and
Relative.

Absolute time method

Ref (R) Ref specifies the level along the pulse rising edge that is defined as the point from which Start
time is counted. Choices: 50%, 60%, 70%, 80%, 90% 100%; Default: 100%

Start (S) Start specifies the time the instrument waits after the rising-edge reference before starting to
measure the pulse. The Start time is measured from the point along the pulse rising edge
specified by the Ref setting. Start Range: ±100 ms; Resolution: 3 digits; inc/dec small: 1 ns,
large: 1,2,5,10...; Default: 0

Length (L) Length specifies the period of time that is used for pulse measurements The measurement time
begins at the Start point and continues for the amount of time specified by Length.

Relative time method

Length In the Relative time method, Length specifies the percentage of the top of the pulse that is used
for measurements. The instrument automatically determines the pulse top. The measurement
length is centered within the pulse ON time.

Impulse Response
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Setting Description

Apply ampl corrections Enable/disable corrections that remove errors due to the window function and to the time offset
of the side lobe.

Keep-out time (+/-) The Keep-out time specifies a region that is ignored when the trace is analyzed for side lobes.
The setting defines a region to the left and to the right of the center of the main lobe. Lobes that
fall within this time region are not eligible to be the “highest side lobe”.

Time method Specifies how measurement parameters are determined. The choices are Absolute and
Relative.

Absolute time method

Ref (R) Ref specifies the level along the pulse rising edge that is defined as the point from which Start
time is counted. Choices: 50%, 60%, 70%, 80%, 90% 100%; Default: 100%

Start (S) Start specifies the time the instrument waits after the rising-edge reference before starting to
measure the pulse. The Start time is measured from the point along the pulse rising edge
specified by the Ref setting. Start Range: ±100 ms; Resolution: 3 digits; inc/dec small: 1 ns,
large: 1,2,5,10...; Default: 0

Length (L) Amount of time that should be included in the measurement. The measurement time begins at
the Start point and continues for the amount of time specified by Length.

Relative time method In the Absolute time method, Length specifies the period of time that is used for pulse
measurements.

Length In the Relative time method, Length specifies the percentage of the top of the pulse that is used
for measurements. The instrument automatically determines the pulse top. The measurement
length is centered within the pulse ON time.

P-R F Diff, P-P F Diff, F Abs, P-R ø Diff, P-P ø Diff
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Setting Description

Measurement point Specifies the period in time after the 50% rising edge at which frequency and phase difference
measurements are made.

Ripple

Setting Description

Length Length specifies the percentage of the top of the pulse that is used for measurements. The
instrument automatically determines the pulse top. The measurement length is centered within
the pulse ON time. Only the Relative Time method is available for Ripple.

Overshoot

Setting Description

Time method Specifies how measurement parameters are determined. The choices are Absolute and
Relative.

Absolute time method

Ref (R) Ref specifies the level along the pulse rising edge that is defined as the point from which Start
time is counted. Choices: 50%, 60%, 70%, 80%, 90% 100%; Default: 100%

Start (S) Start specifies the time the instrument waits after the rising-edge reference before starting to
measure the pulse. The Start time is measured from the point along the pulse rising edge
specified by the Ref setting. Start Range: ±100 ms; Resolution: 3 digits; inc/dec small: 1 ns,
large: 1,2,5,10...; Default: 0

Length (L) Amount of time that should be included in the measurement. The measurement time begins at
the Start point and continues for the amount of time specified by Length.

Table continued…
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Setting Description

Relative time method

Ref Ref specifies the level along the pulse rising edge that is defined as the point from which Start
time is counted. Choices: 50%, 60%, 70%, 80%, 90% 100%; Default: 100%

Start Start specifies the time the instrument waits after the rising-edge reference before starting to
measure the pulse. The Start time is measured from the point along the pulse rising edge
specified by the Ref setting. Start Range: ±100 ms; Resolution: 3 digits; inc/dec small: 1 ns,
large: 1,2,5,10...; Default: 0

Length In the Relative time method, Length specifies the percentage of the top of the pulse that is used
for measurements. The instrument automatically determines the pulse top. The measurement
length is centered within the pulse ON time.

Levels Tab
Use the Levels tab to set parameters that control the method and levels used to calculate some pulse values.

Setting Description

100% Level Specifies the method used to determine the 100% level(s).

50% Level Specifies the method used to determine the 50% level on the pulse.

Rise/Fall Levels Select whether to use the 10% to 90% or 20% to 80% points (based on voltage level) to define the
rise and fall times.

100% Level
Use the 100% Level settings to select the method used to determine the 100% level(s) used for calculating pulse parameters, for example,
Rise, Fall, and Width.

The Pulse Average Amplitude defines the pulse top as the average of the values of all the points along the pulse top. This average is used
as the 100% level, from which the 10, 20, 50, 80 and 90% levels are calculated. Pulse measurements are referenced against these various
levels. For example, Rise is the time between the 10 and 90% (or 20 and 80%) levels on the rising edge of the pulse. When the Pulse
Average Amplitude method is selected, the same 100% level is used for both rising and falling edges.

Because some RF pulse types have droop (a height difference between the beginning and ending points of the pulse top), the 100%
percent level on the rising edge may not be equal to the 100% level on the falling edge. The Independent method of pulse point location is
designed for pulses with different 100% levels at their rising and falling edges. The Independent method calculates the 100% level for the
rising edge separately from the 100% level of the falling edge. As a result, the 10, 20, 50, 80 and 90% levels are also different for the rising
and falling edges, allowing for more accurate measurements on pulses with droop.
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50% Level
Select Voltage to use -6 dB as the 50% point. Select Power to use -3 dB as the 50% level.

Freq Estimation Tab
Use the Freq Estimation tab to specify parameters used for determining frequency offset. This tab is not available for the Pulse-Ogram
display.

Setting Description

Modulation type Specifies which algorithm to use for estimating frequency error.

Pulse Frequency Reference Specifies the method used to determine the pulse frequency error and if applicable, the chirp slope.

Auto Selecting Auto causes the instrument to calculate the frequency offset and if applicable, the chirp
slope.

Freq Offset If Auto is not enabled, specify the value for frequency offset here. If Auto is enabled, the offset is set
to zero and this readout displays the calculated frequency error.

Chirp BW If Auto is not enabled, specify the value for Chirp Slope here. If Auto is enabled, this readout displays
the calculated Chirp slope. This setting is used only when the modulation type is set to Linear Chirp.

Modulation Type
Frequency estimation is performed by the instrument using selectable methods, depending on signal type. The selections for modulation
type are CW (constant phase), CW (changing phase), Linear Chirp and Other. Select the method of frequency method based upon a best
match to your signal based on the following descriptions:

• CW (constant phase): The signal is not designed to change in either frequency or phase during the measured pulse train.
• CW (changing phase): The signal does not change the carrier phase within each pulse, although it could change the phase from one

pulse to another pulse. The signal is not designed to make frequency changes.
• Linear Chirp: The signal changes frequency in a linear manner during each pulse. The signal has the same carrier phase at the same

time offset from the rising edge of the pulse.
• Other: The signal is not one of the listed types. You must manually enter the Frequency Offset value.

The following table maps the appropriate signal type selection with the signal characteristics.

Signature Phase offset from one pulse to another

Zero Any (unknown)

CW CW Constant Phase CW Changing Phase

LFM Linear Chirp N/A
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Analysis Tab
The Analysis tab is only available for the Pulse-Ogram display. It allows you to set parameters related to analysis of the signal. The settings
vary depending on which spectrum analysis region you select.

Setting Description

Measurement bandwidth Specifies the frequency range used by the measurement. This control is linked to the Bandwidth
control of other Pulsed RF Displays. If No Filter – Max BW is selected in other displays, the
control setting is disabled, but shows the maximum value possible. If No Filter or Gaussian is
selected in other displays, then the Bandwidth control is also enabled in the Pulse-Ogram display.

Filter shape Spectrum of the signal is windowed by the desired filter shape.

Use analysis time settings Provides the complete analysis length as displayed in Time Overview.

Pulse on time Analysis is done in the ON period of the data.

Length Specifies the analysis length.

Power threshold to detect pulses Specifies the level used for locating pulses in the data.

Independent In Manual option, you can choose the analysis length of the desired type for the Freq vs Time
view in the display.

Start Specify the analysis offset. The default value is the offset in Time Overview.

Length Specify the analysis length. The default value is the length in Time Overview.
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Traces Tab
The Traces tab is only available for the Pulse-Ogram display. It allows you to set the trace characteristics for the display.

Setting Description

Smooth points Shows the number of filter coefficients used for smoothening the noisy region for visual clarity.

Detection Trace Detection is used to reduce the results of a measurement to the desired number of trace points.

Detection
Trace Detection is used to reduce the results of a measurement to the desired number of trace points. For example, if the maximum
number of trace points is 100,000 and a measurement over the selected analysis length yields 200,000 points, the measurement must
decimate these 200,000 trace points by 2 to prevent exceeding the 100,000 trace point limit. Since only one value can be represented for
each trace point, an algorithm must be used to select (detect) the appropriate value to use.

The results array from an analysis can be detected (or “decimated”) in a variety of ways. The number of results points produced for each
trace point varies with both analysis length and trace length. For example, the frequency transform used for the Spectrum display produces
just one output value for each desired trace point. In this case, the detection method chosen has no effect, as no decimation is required.

Increasing the Analysis Length (or for the Spectrum display, the Spectrum Length), causes the available detection method's output traces
to differ from each other because they have a larger set of samples for the various detection methods to process.

The available detection methods are:

• +Peak: The highest value is selected from the results to be compressed into a trace point.
• –Peak: The lowest value is selected from the results to be compressed into a trace point.
• Avg (VRMS): Each point on the trace is the result of determining the RMS Voltage value for all of the results values it includes. When

displayed in either linear (Volts, Watts) or Log (dB,dBm), the correct RMS value results.
• Sample: The first value is selected from the set of results to be compressed into a trace point.

Scale Tab
The Scale tab is only available for trace displays. It allows you to change the vertical and horizontal scale settings. Changing the scale
settings changes how the trace appears on the display but does not change control settings such as Measurement Frequency. In effect,
these controls operate like pan and zoom controls. Each display has different settings, as shown below.

Figure 35: The above image shows the Scale tab for the Pulse Statistics display.
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Figure 36: The above image shows the Scale tab for the Pulse Trace display.

Figure 37: The above image shows the Scale tab for the Pulse Cumulative Statistics display.

Setting Description

Vertical Controls the vertical position and scale of the trace display.

Scale Changes the vertical scale. The units for this setting depend on the statistic selected from the Result
drop-down list in the Pulse Statistics display.

Position Adjusts the Reference Level away from the top of the trace display. The units for this setting depend
on the statistic selected from the Result drop-down list in the Pulse Statistics display.

Autoscale Resets the scale of the vertical axis to contain the complete trace.

Horizontal Controls the span of the trace display and position of the trace.

Scale Allows you to change the span.

Position Allows you to pan a zoomed trace.

Full Scale (Pulse Trace display
only)

Specifies the Horizontal scale default.

Selected Sets the horizontal scale default to be based on the result value for the currently-select pulse.

Max Pulse Sets the horizontal scale default to be based on the largest value for the selected pulse measurement.

Autoscale Resets the scale of the horizontal axis to contain the complete trace.

Plot (Pulse Statistics display only) Specifies the FFT, Trend, Time Trend, or Histogram plot.

Reset Scale Restores all settings to their default values.
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Figure 38: The above image shows the Scale tab for the Pulse-Ogram display.

Setting Description

Vertical Controls the vertical position and scale of the trace display.

Frame Offset Display will start after the indicated frame number.

Frame Scale Shows how many frames are displayed in both Time vs Time and Frequency vs Time views.

Horizontal

(Time vs Time view)

Controls the span of the Time vs Time trace display and position of the trace.

Position Allows you to pan a zoomed trace. The default value matches the offset of the acquisition.

Scale Allows you to change the span. The default value matches the length of the acquisition.

Reset Scale Restores the position and scale settings to default value.

Horizontal

(Frequency vs Time view)

Controls the span of the Frequency vs Time trace display and position of the trace.

Start Freq Allows you to set the starting frequency shown in the graph without changing analysis. The default
value matches the highest frequency of the span.

Stop Freq Allows you to set the stop frequency shown in the graph without changing analysis. The default value
matches the highest frequency of the span.

Reset Scale Restores the start frequency and stop frequency to default values.

Prefs Tab
The Prefs tab is only available for Pulsed RF trace displays. It is not available for the table displays. It enables you to change parameters
of the measurement display. Available parameters vary depending on the selected display.
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Figure 39: The above image shows the Prefs tab for the Pulse Cumulative Histogram display.

Figure 40: The above image shows the Prefs tab for the Pulse-Ogram display.

Figure 41: The above image shows the Prefs tab for the Pulse Cumulative Statistics display.

Figure 42: The above image shows the Prefs tab for the Pulse Statistics display when Time Trend is the selected plot type. Trend and FFT plot types do not show the Show
Marker readout selection.

Figure 43: The above image shows the Prefs tab for the Pulse Statistics display when Histogram is the selected plot type.
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Figure 44: The above image shows the Prefs tab for the Pulse Trace display.

Setting Description

Show graticule Displays or hides the graticule in the trace display.

Show Marker readout in graph

(Only available for Pulse Trace and
Pulse-Ogram displays.)

When a marker is enabled, this setting displays or hides the maker readout, but not the maker
itself, on Time Trend plots.

Histogram readout

(Only available for Cumulative
Histogram display and the Pulse
Statistics display when Histogram is
the plot type.)

Controls the parameters Histogram readout and Bins. Histogram readout can be set to either
Count or %. Count indicates the number of hits that fell into each bin. % indicates percentage of
the total count (for the acquisition) that fell into each bin.

Calculate statistics in linear scale (for
results in log)

(Only available for Pulse Statistics
display.)

Checking this box allows for calculation of statistics in the linear domain (for example, the Power
values in dB are converted to Watts (linear scale) and statistics are computed in Watts and then
converted back to dB scale). This measurement will be observed only when this box is selected.

This selection only appears in the Pulse Statistics display for these measurements: Average
ON Power, Average Transmitted Power, Peak Power, Impulse Response Amplitude, Droop dB,
Overshoot dB, and Ripple dB.

Bins

(Only available for Pulse Statistics
display when Histogram is the plot
type.)

Specifies how many "bins" or histogram bars the results are distributed into.

Auto

(Only available for Pulse Statistics
display when Histogram is the plot
type.)

Sets the bin number to automatic default, which is 10.

Outlier readout

(Only available for Cumulative
Histogram display)

Controls the parameters Outlier readout and Bins. Outlier readout can be set to either Count or %.
Count indicates the number of hits that fell into each bin. % indicates percentage of the total count
(for the acquisition) that fell into each bin.

Trace points

(Only available for the Pulse-Ogram
display.)

Sets the number of trace points used for marker measurements and for results export.

Table continued…
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Setting Description

Frame Info

(Only available for the Pulse-Ogram
display.)

Displays or hides the frame information in the display.

The statistics can be calculated in the linear domain as well the log

Average ON Power, Average Transmitted Power, Peak Power, Impulse Response Amplitude, Droop dB, Overshoot dB, Ripple dB, the
statistics can be calculated in linear domain as well, i.e. the Power values in dB are converted to watts (linear scale) and statistics are
computed in watts and then converted back to dB scale. This measurement will be observed only when the Calculate statistics in linear
scale (for results in log) is selected.
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APCO P25 Analysis
P25 Overview
P25 Overview
The Association of Public Safety Communication Officials (APCO) P25 Compliance Testing and Analysis option allows you to evaluate
radio signals to ensure they meet the standards set for the public safety communications community for interoperable LMR equipment.
This complete set of push-button Telecommunication Industry Association TIA-102 standard-based transmitter measurements includes
modulation measurements, power measurements, and timing measurements. These measurements are also compared with the limits that
best fit the signal for which the standard applies to provide pass/fail results.

The P25 measurements available with this option can be made on signals defined by the Phase 1 (C4FM) and Phase 2 (HCPM, HDQPSK)
P25 standards. With this test suite, test engineers can simplify the execution of a number of transmitter tests while still allowing for controls
to modify signal parameters for signal analysis. The analysis results give multiple views of P25 signal characteristics to allow the diagnosis
of signal imperfections and impairments quickly and easily. Display controls allow you to selectively display the analysis results to help
locate trouble-spots in the signal.

P25 Topics
The following information about the P25 Analysis option is available:

• Reference Table of Supported P25 Measurements
• P25 Standards Presets on page 277
• P25 Displays on page 278
• P25 Settings
• P25 Measurements on page 278
• P25 Test Patterns on page 284

Reference Table of Supported P25 Measurements

TIA-102 transmitter measurement
Tektronix measurement display(s) (value name if different
from TIA-102 measurement name) Phase 1 Phase 2

RF output power P25 Summary

P25 Power vs Time

Yes Yes

Operating frequency accuracy P25 Summary (Operating Freq Accuracy) Yes Yes

Modulation emission spectrum SEM (The SEM display can be found in Select Displays > RF
Measurements)

Yes Yes

Unwanted emissions: Non
spurious adjacent channel power
ratio

MCPR (The MCPR display can be found in Select Displays >
P25 Analysis)

Yes Yes

Frequency deviation P25 Summary (Freq Dev) Yes HCPM

Modulation fidelity P25 Summary

P25 Constellation

Yes Yes

Table continued…
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TIA-102 transmitter measurement
Tektronix measurement display(s) (value name if different
from TIA-102 measurement name) Phase 1 Phase 2

Symbol rate accuracy P25 Summary Yes Yes

Transmitter power and encoder
attack time

P25 Summary (Phase1 Tx Attack Time)

P25 Power vs Time (Power Attack Time and Encoder Attack
Time)

Yes N/A

Transmitter power and encoder
attack time with busy/idle
operations

P25 Summary (Phase1 Tx Attack Time (Busy/Idle))

P25 Power vs Time (Power Attack Time Busy Idle and
Encoder Attack Time Busy Idle)

Yes N/A

Transmitter throughput delay P25 Summary (Phase1 Tx Throughput Delay) Yes N/A

Transient frequency behavior P25 Freq Dev vs.Time Yes N/A

HCPM transmitter logical channel
peak adjacent channel power ratio

P25 Summary (HCPM Tx Logic Ch Pk ACPR) N/A HCPM

HCPM Transmitter logical channel
off slot power

P25 Power vs Time (Off Slot Power)

P25 Summary (HCPM Tx Logic Ch Off Slot)

N/A HCPM

HCPM Transmitter logical channel
power envelope

P25 Power vs Time (Power Info)

P25 Summary (HCPM Tx Logic Ch Pwr Env Limits)

N/A HCPM

HCPM Transmitter logical channel
time alignment

P25 Summary (HCPM Tx Logic Ch Time Alignt) N/A HCPM

P25 Standards Presets
The P25 standards preset allows you to access displays preconfigured for the P25 standards you select. You can read more about how
Presets work here.

The following table shows the bandwidth, modulation type, and displays that are automatically loaded for each of the listed standards.
MCPR masks are also loaded and are explained here.

Table 21: P25 standards, modulation type, bandwidth, and displays

Standard Modulation type Bandwidth (kHz) Displays loaded with preset

Phase 1 C4FM 12.5 MCPR, Time Overview, P25 Constellation, P25 Summary

Phase 2 HCPM (inbound) 12.5 MCPR, Time Overview, P25 Constellation, P25 Summary

HDQPSK (outbound) 12.5

Retain Current Center Frequency
This setting becomes available when P25 is the selected preset in the Standards Preset window. You can access this window by selecting
Presets > Standards and then selecting P25 from the Preset drop down menu. To activate the Retain current Center Frequency
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Setting, check the box. This setting allows you to retain the previously used center frequency. By default, the box is unchecked and
therefore the four P25 preset displays will load with a center frequency of 850 MHz.

The default adjacent channels table for MCPR is different for RF frequencies in the range of 769 to 806 MHz (called 700 MHz band) and
for frequency ranges outside it. The option of retaining center frequency in Standards Preset is therefore useful if you want to load the
default table for center frequencies in the 700 MHz band.

MCPR channel and limit parameters. The MCPR (ACPR) standard channel and limit parameters that are applied to the P25 signal
depend on the standard you select when you configure the preset. Once you select a standard and center frequency, the application
will automatically load the parameters and default limits recommended for best performance comparison by the Standard document. All
channel and limit parameters are derived from the TIA-102 standard and loaded for you. This provides you the assurance that you are
evaluating the signal with the most appropriate parameters.

Note: Changing analysis and display parameters recalculates the measurement results, but does not affect acquisitions.

P25 Displays
The displays in P25 Analysis (Setup > Displays > Measurements: P25 Analysis) are:

• MCPR
• P25 Constellation
• P25 Power vs Time
• P25 Eye Diagram Display
• P25 Frequency Dev Vs Time
• P25 Symbol Table
• P25 Summary
• Time Overview

P25 Measurements
The following topics contain important information you should know about specific P25 measurements.

RF Output Power (Phase 1 and Phase 2)
This is a measure of RF output power when the transmitter is connected to the standard load during defined duty cycle. This measurement
is presented as a scalar result in the P25 Summary display. Power variation is shown in the P25 Power vs Time display.
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Information of note about this measurement:

• For bursty HCPM (Phase 2 Inbound) signals, the RF Output Power is measured only during the on slot regions centered at the middle
of the on slot.

• The result shown in the P25 Summary Display is the average RF Output Power of all the bursts selected in the analysis window.
• If only one on slot region is chosen in the analysis window, then the RF Output Power of only the chosen on slot is reported.
• For non-bursty data, the entire duration of analysis window is considered to obtain RF Output Power.
• The result shown in the P25 Summary display does not account for any attenuation introduced by a user. Ensure that this attenuation

is accounted for when you enter limits for comparison.
• Enter external attenuation introduced by the user by entering the attenuation in the Amplitude control panel (Setup > Amplitude >

External Gain/Loss Correction tab, and External Gain Value (dB)). Select All acquired data (filter method).
• The Limits tab in the P25 Summary Settings control panel allows you to compare the results against limits set for Pass/Fail.
• This measurement result is not shown in the P25 Summary display when Trigger Measurements are selected.

Note: Read about important information related to HCPM bursty data measurements here.

Operating Frequency Accuracy (Phase 1 and Phase 2)
The Operating Frequency Accuracy is the ability of the transmitter to operate on its assigned frequency. This measurement is presented as
a scalar result in the P25 Summary display.

• For bursty HCPM (Phase 2 Inbound) signals, the operating frequency accuracy is measured only during the on slot regions centered at
the middle of the on slot.

• The result shown in the P25 Summary display is the average of all the bursts selected in the analysis window.
• If only one on slot region is chosen in the analysis window, then the operating frequency accuracy of only the chosen on slot is

reported.
• For non-bursty data, the entire duration of the analysis window is considered to obtain the operating frequency accuracy.
• The Limits tab in the P25 Summary Settings control panel allows you to compare the results against limits set for Pass/Fail.

In Operating Frequency Error, double sided operating frequency error is converted to one sided error and compared against the
Absolute Limit.

• This measurement result is not shown in the P25 Summary display when Trigger Measurements are selected.

Unwanted Emissions (ACPR) (Phase 1 and Phase 2)
This measurement is the ratio of the total power of a transmitter under prescribed conditions and modulation to that of the output power
that falls within a prescribed bandwidth centered on the nominal frequency of adjacent channels. This measurement is shown in the MCPR
display.

• For HCPM signals, Adjacent Channel Power Ratio analysis is only done on the first on slot region. When the Modulation Type is set
to HCPM from any P25 display or from Standards Presets, there will be a search for bursts before ACPR analysis is done. If a burst
is found, then analysis is done only on first burst. If a burst is not found, it will show the results of the entire analysis length. The Main
Preset will remove the HCPM modulation Type setting, allowing MCPR to work in its regular mode.

• The MCPR display will only have one Main channel for P25 signals in addition to relevant adjacent channels.
• The default adjacent channels table for Unwanted Emissions (ACPR) as suggested by the standard can be loaded by using the P25

Standards Preset option (for which MCPR is one of the four displays).
• The default adjacent channels table for MCPR is different for RF frequencies in the range of 769 to 806 MHz (called 700 MHz band)

and for frequency ranges outside it.
• To load the default adjacent channels table of a 700 MHz band, first set the center frequency. Next, select Presets > Standards to

view the Standards Preset window. Lastly, check the Retain current Center Frequency Setting box.
• By default, the Retain Center Frequency box is unchecked and therefore the four P25 preset displays will load with a center frequency

of 850 MHz and load the adjacent channels table for non-700 MHz band.
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• By default, only six adjacent channels (on either side) will be shown when 700 MHz band is analyzed in P25 (for visual clarity).
However, analysis is done for all the ten channels and results will be available in the table just under the display. You can zoom out to
see the remaining bands.

Frequency Deviation (Phase 1 (C4FM) and Phase 2 (HCPM))
This measurement shows the amount of frequency deviation that results for a Low Deviation and High Deviation test pattern. This
measurement is shown in the P25 Summary display.

• This measurement only applies to HCPM and C4FM signals and High Deviation or Low Deviation test patterns. If this measurement is
run for any other test patterns or for HDQPSK signals, comparisons for limits (set in the Limits tab of the control panel) will result in N/A
being shown, as the measurement will not be valid.

• This measurement is done using a FM demodulator without any filter. As a result, it will not be exactly the same as the result given in
the P25 Frequency Deviation vs Time display. That display shows the frequency deviation after complete demodulation and might use
relevant shaping filters.

• The Low pass filter cut off frequency can be set from the Analysis Params tab of the Settings Control panel. The default value of the
cut off frequency is 5 kHz.

• Measurement results are only available when High Deviation, Low Deviation, or Symbol Rate test pattern is selected.
• The scalar result in the P25 Summary display will be shown as f1 (Positive Peak) and f2 (Negative Peak) when analyzing the High

Deviation test pattern (or the Symbol Rate test pattern for C4FM signals).
• The scalar result in the P25 Summary display will be shown as f3 (Positive Peak) and f4 (Negative Peak) when analyzing the Low

Deviation test pattern.
• The scalar results in the P25 Summary display do not have a corresponding graphical view. A closely representative display would be

the FM display (Setup > Displays > Analog Modulation).
• The Limits tab in the P25 Summary Settings control panel allows you to compare the results against limits set for Pass/Fail.

Modulation Fidelity (Phase 1 and Phase 2)
This measures the degree of closeness to which the modulation follows the ideal theoretical modulation determined by the rms difference
between the actual deviation and the expected deviation for the transmitted symbols. This measurement is shown in the P25 Summary
and P25 Constellation displays.

• This measurement is done on the first on slot region in the analysis window for bursty HCPM data. The analysis is done on 160
symbols centered at the burst.

• This measurement is done on all of the data chosen in the analysis window for non-bursty modulation types. A warning message
is issued if the data is less than 164 symbols (the standard recommends at least 164 symbols be present for the measurement of
non-bursty signals).

• This measurement is done by performing the frequency demodulation after taking the signal through relevant shaping filters and
comparing it with expected frequency deviation points.

• The Limits tab in the P25 Summary Settings control panel allows you to compare the results against limits set for Pass/Fail.
• This measurement result is not shown in the P25 Summary display when Trigger measurements are selected.
• HDQPSK-P25 filter attempts to remove the Inter Symbol Interference before symbol detection.

Note: Read about important information related to HCPM bursty data measurements here.

Symbol Rate Accuracy (Phase 1 and Phase 2)
Symbol Rate Accuracy measures the ability of the transmitter to operate at the assigned symbol rate (4.8 kHz for Phase 1, 6 kHz for Phase
2). It is a scalar result shown in the P25 Summary display.

• This measurement result appears in the P25 Summary display and only applies to High Deviation or Low Deviation test patterns. Test
patterns are selected in the Test Patterns tab in the Settings control panel.

• The Limits tab in the P25 Summary Settings control panel allows you to compare the results against limits set for Pass/Fail.
• This measurement only applies to High Deviation or Low Deviation test patterns. If this measurement is run for any other test patterns,

comparisons for limits will result in N/A being shown, as the measurement will not be valid.
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Common Trigger Related Measurements
The measurements covered in this subsection have some common information. These measurements are:

• Transmitter Power and Encoder Attack Time (Phase 1): This measurement is the time required for a transmitter to prepare
and transmit information on the radio channel after changing state from standby to transmit (applies to conventional mode). This
measurement result can be seen in the P25 Summary display. A graphical representation of these results can be seen in the P25
Power vs Time display.

• Transmitter Power and Encoder Attack Time with Busy/Idle Operations (Phase 1): This measures the time required for a
transmitter to prepare and transmit information on the radio channel after the receiving channel changes state from busy to idle.
Transmission is inhibited until a status symbol indicates an idle channel. This measurement result can be seen in the P25 Summary
display. A graphical representation of these results can be seen in the P25 Power vs Time display.

• Transmitter Throughput Delay (Phase 1): This measures the time it requires for audio changes in the microphone to be encoded
and transmitted over the air. A calibrated receiver with a known receiver throughput delay is used to monitor the transmitted signal.
The aggregate delay of the transmitter under test and calibrated receiver is measured and the desired transmitter throughput delay is
then the aggregate delay less the delay of the calibrated receiver. A calibrated Receiver throughput delay from the UI is needed. This
measurement result can be seen in the P25 Summary display.

• Transient Frequency Behavior (Phase 1): This is a measure of difference of the actual transmitter frequency and assigned
transmitter frequency as a function of time when the RF output power is switched on or off. This measurement appears in the P25 Freq
Dev vs Time display.

• HCPM Tx Logical Channel Time Alignment (Phase 2 HCPM): This measures the ratio of total transmitter power under prescribed
conditions and modulation to the peak power that falls in a prescribed bandwidth centred on the nominal frequency of the adjacent
channel during the transmitter power ramping interval. This applies only to inbound signals. This measurement result appears in the
P25 Summary display.

Common information. The following information applies to all of the measurements in the previous list.

• Select the relevant Trigger measurement from the Trig Meas tab of the control panel.
• When this measurement is chosen from the Trig Meas tab of the control panel, only this result will be populated in the P25 Summary

display and everything else will have no result.
• The Time Zero Reference under the Analysis Time tab in the control panel is forced to Trigger.
• You can select to do the same experiment multiple times and this measurement will produce an average result of the last 10 single

acquisitions. Clicking the Clear button on the P25 Summary display will clear the results and start a new measurement.

Transmitter Power and Encoder Attack Time and Transmitter Power and Encoder Attack Time with Busy/Idle Operations (Phase
1). The following information is specific to these two measurements.

• The Transmitter Power Attack Time analysis is done by measuring the time taken from the trigger point to the point where the
transmitter output power will reach 50% of its maximum value.

• For Encoder Attack Time, the initial frame synchronization word is searched in the demodulated output and the time taken from trigger
to the start of the synchronization word is reported as the result.

• When a clear power ramp up is not available, the analysis will report the following error, indicating that no power ramp was received as
expected: Input data too short. When the synchronization word is not found, the analysis will report the following error: IQ Processing
error.

• The Limits tab in the P25 Summary Settings control panel allows you to compare the results against limits set for Pass/Fail.
• The P25 Power vs Time display shows marking from trigger point to 50% ramp point and also up to the Synchronization word for

Transmitter Power and Encoder Attack Time. Frequency Dev vs Time can also be used to check for the synchronization word. The
following image shows this measurement.
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Transmitter Throughput Delay (Phase 1). The following information is specific to this measurement.

• Select Tx Throughput Delay from the Trig Meas tab of the Settings control panel to get this measurement.
•
• The actual input to the RSA comes after the noise signal from the source has passed through the DUT and calibrated receiver as

shown in the setup for this measurement in the measurement methods standard document.
• The calibrated receiver throughput delay entered by the user in the Trig Meas tab in the Settings control panel (this option appears

when Throughput Delay is selected) is subtracted from the calculated time difference and reported as Throughput Delay.
• A limit comparison can be performed by selecting the appropriate limits from the Limits tab in the Settings control panel.

Transient Frequency Behavior (Phase 1). The following information is specific to this measurement.

• Select Transmitter Frequency Behavior from the Trig Meas tab of the Settings control panel to get this measurement.
• This measurement can be done for On to Off and Off to On behaviors. Select which behavior to measure by selecting the desired

behavior from the Transient Frequency drop down list that appears when the Transient Frequency Behavior measurement is selected
in the Trig Meas tab of the Settings control panel.

• Select enough acquisition length (from the Acquisition control panel) to ensure that sufficient data is available when the acquisition is
triggered. For a transient frequency behavior, there is a need for t1+t2 amount of time after ton as defined in the measurement methods
standard document. Approximately 100 ms of data after trigger should ensure that all cases are taken care of as suggested by the
standard. t1, t2, and t3 durations are fetched based on the RF frequency range.

• The identification of ton is done by looking for a significant frequency deviation after a certain power level has been achieved. A
manual override for the ton is also provided in the Trigger Meas tab of the Settings control panel when a Transient Frequency Behavior
measurement is chosen. This allows you to manually override the ton that is calculated (by releasing the Auto Option) and place it
appropriately based on the P25 Freq Dev vs Time display. The same is true for toff when the measurement is being done for the On to
Off behavior.

• t1 and t2 regions are identified after ton and t3 before toff (for the On to Off behavior).
• The mean and max frequency deviation is reported in the regions identified.
• A Pass or Fail is also reported by comparing the Mean frequency deviation with the recommended values given in the standard.

A red band is shown if a particular region’s result is less than the performance recommendation. The following image shows this
measurement.
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HCPM Tx Logical Channel Time Alignment (Phase 2 HCPM). The following information is specific to this measurement. This result can
be viewed in P25 Summary and P25 Power vs Time displays.

• This measurement is done in two steps: First by calculating tOB_sync using HDQPSK data (the ISCH pattern is looked for) and then
by using the result to calculate tIB_sync using HCPM data (the SACCH pattern is looked for).

The first step is done by choosing Time Alignment (tOB_sync measurement) in the Trig Meas tab in the Settings control panel.

When the second step, Time Alignment (t_error_0 calculation) or (t_error_1 calculation) is selected in the Trig Meas tab of the control
panel, there is an option to override the tOB_sync value calculated in the first step.

• When this measurement is chosen, only this result is provided in the P25 Summary display.
• You must provide the ultraframe boundary to the trigger of the analyzer.
• An autocorrelation of the input RF signal with the reference patterns is performed to get the peak that will determine tOB_sync

(measured) and t_error_0 or t_error_1 from the trigger point.

HCPM Tx Logical Channel Peak ACPR (Phase 2 HCPM)
This measures the ratio of total transmitter power under prescribed conditions and modulation to the peak power that falls in a prescribed
bandwidth centred on the nominal frequency of the adjacent channel during the transmitter power ramping interval. This applies only to
inbound signals. This measurement result appears in the P25 Summary display.

• This measurement is done by calculating power in the adjacent channels for the entire duration of data chosen by the user, including
the power ramp up and ramp down portions. The standard recommends 360 ms of data for this measurement, unlike the other ACPR
measurements for which the analysis is done only for the on slot region.

• The higher and lower adjacent channel power is reported in the P25 Summary display under Power Measurements.
• The two results are then subtracted from the calculated RF output power and the minimum of the two results is presented as the Min

Pk ACPR in the P25 Summary display.
• This measurement is only done for bursty HCPM data and not for High Deviation or Low Deviation test patterns.
• The Limits tab in the P25 Summary Settings control panel allows you to compare the results against limits set for Pass/Fail.
• This measurement result is not shown in the P25 Summary display when trigger measurements are chosen.

Note: Read about important information related to HCPM bursty data measurements here.

HCPM Transmitter Logical Channel Off Slot power (Phase 2 HCPM)
This measures the power of a TDMA transmitter during the off portion of the TDMA pulse. This measurement only applies to inbound
signals. This result can be viewed in P25 Summary and P25 Power vs Time displays.
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• The measurement is done as suggested by the standard to calculate PONREL and POFFREL. PONREL is the maximum level observed in
the interval 1 ms to 29 ms and POFFREL is the maximum level observed in 30.2 ms to 59.8 ms.

• PTX is the rated carrier power and can be set by the user from the Analysis Params tab in the Settings control panel.
• The absolute level of the off slot power is then calculated as POFF = PTX – (PONREL – POFFREL) dBm
• This measurement is only done for bursty HCPM data and not for High Deviation or Low Deviation test patterns.
• The Limits tab in the P25 Summary Settings control panel allows you to compare the results against limits set for Pass/Fail.
• This measurement result is not shown in the P25 Summary display when trigger measurements are chosen.

Note: Read about important information related to HCPM bursty data measurements here.

HCPM Transmitter Logical Channel Power Envelope (Phase 2 HCPM)
This is a measure of how well a portable radio controls the transmitter power as it inserts an inbound HCPM TDMA burst into a frame on a
voice channel. This measurement applies to inbound signals only.

• All scalar results relevant to this measurement are shown both in P25 Power vs Time display and the P25 Summary display.
• The measurement results and the duration in which the measurements are made are shown graphically in P25 Power vs Time display.

The results are grouped under Power Info and Time Info in the table at the bottom of the display.
• This measurement is only done for bursty HCPM data and not for High Deviation or Low Deviation test patterns.
• The Limits tab in the P25 Summary Settings control panel allows you to compare the results against limits set for Pass/Fail.
• This measurement result is not shown in the P25 Summary display when trigger measurements are chosen.

Note: Read about important information related to HCPM bursty data measurements here.

P25 Test Patterns
A variety of test patterns are specified in the TIA-102 documents for use in performance testing of transmitters. These test patterns allow
the software to compare the measurement result to the standards limit. Test engineers can select from the test patterns described in the
following tables.

Note: Although this table gives the test patterns for measurements as recommended by the Standard, other measurement results
are also be provided as additional information for a given test pattern. For example, Modulation Fidelity results can also be
provided for High Deviation and Low Deviation test patterns.

Table 22: P25 test patterns, Phase 1 C4FM

TIA-102 Phase 1 C4FM test pattern Phase 1 (C4FM) measurement
Standard transmitter RF Output Power

Operating Frequency Accuracy
Modulation Emission Spectrum
Unwanted Emissions (Adjacent Channel Power Ratio)
Modulation Fidelity
Transmitter Power and Encoder Attack Time
Transmitter Power and Encoder Attack Time (With Busy/Idle Operations)

Low Deviation Operating Frequency Accuracy
Transient Frequency Behavior
Frequency Deviation

Standard Idle Transmitter Power and Encoder Attack Time (With Busy/Idle Operations)
Table continued…
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TIA-102 Phase 1 C4FM test pattern Phase 1 (C4FM) measurement

Standard Transmitter Symbol Rate

(Same as High Deviation test pattern

Symbol Rate Accuracy

Frequency Deviation

C4FM Modulation Fidelity Modulation Fidelity

Standard Tone Can be used for measurements such as RF Output Power, Operating Frequency Accuracy,
Modulation Fidelity, and ACPR

Other

(User created test pattern)

Can be used for measurements such as RF Output Power, Operating Frequency Accuracy,
Modulation Fidelity, and ACPR

Table 23: P25 test patterns, Phase 2 Inbound and Outbound

TIA-102 Phase 2 test pattern Phase 2 measurement

Standard Transmitter (Inbound and
Outbound)

RF Output Power

Operating Frequency Accuracy

Modulation Emission Spectrum

Unwanted Emissions (Adjacent Channel Power Ratio)

Modulation Fidelity

Inbound Standard Tone Ch0 Can be used for measurements such as RF Output Power, Operating Frequency Accuracy,
Modulation Fidelity, and ACPR

Inbound Standard Tone Ch1 Can be used for measurements such as RF Output Power, Operating Frequency Accuracy,
Modulation Fidelity, and ACPR

Outbound Standard Tone Operational Frequency Accuracy

Inbound Symmetrical Time Slot RF Output Power

Modulation Emission Spectrum

Modulation Fidelity

HCPM (Peak ACPR)

HCPM (Off slot power)

HCPM (Power envelope)

Unwanted Emissions (Adjacent Channel Power Ratio)

Table continued…
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TIA-102 Phase 2 test pattern Phase 2 measurement

Low Deviation (Inbound) Frequency deviation for HCPM

Symbol Rate Accuracy

Low Deviation (Outbound) Symbol Rate Accuracy

High Deviation (Inbound and Outbound) Symbol Rate Accuracy

Other

(User created test pattern)

Can be used for measurements such as RF Output Power, Operating Frequency Accuracy,
Modulation Fidelity, and ACPR

Analysis of HCPM Bursty Data
It important to take into account the following information when analyzing HCPM bursty data.

• It is mandatory that at least one complete on slot and off slot region (including the ramp up and ramp down portion) have to be included
in the analysis window for HCPM measurement results to be analyzed.

• If HCPM is the chosen standard in Standards Presets, then a minimum length of 94 ms is set for the analysis window. This is to ensure
that a full on slot and off slot region is available irrespective of the selected analysis offset.

• Do not use the High Deviation or Low Deviation test patterns for bursty signals. Test patterns are selected in the P25 Settings control
panel on the Test Patterns tab. If selected, analysis would look for a bursty pattern. High Deviation and Low Deviation test patterns are
not bursty and therefore do not have the above analysis length restriction.

If you try to set the analysis length to less than 94 ms, the following status message will display: P25:HCPM:Minimum Analysis Length
should be ≥ 94 ms.

• Most measurements that are required to be done on on slot regions are done centered at the on slot region of HCPM bursty data.

HCPM Pilot symbols are not displayed in the P25 Symbol Table.

It is mandatory that at least one complete on slot and off slot region (including the ramp up and ramp down portion) have to be included
in the analysis window for HCPM measurement results to be analyzed.

The analysis module does not analyze two active adjacent slots (28 ms each) if they do not have the off slot (power off) region between
them.

When HCPM bursty data is analyzed, the following status message will appear on all relevant displays: P25:HCPM modulation
analysis is done only on on slot regions.

Note: The test patterns, except for High Deviation and Low Deviation, do not impact the HCPM pattern analysis for other selected
test patterns, such as Standard Transmitter Test Pattern, Inbound Standard Tone Test Pattern Ch0, Inbound Standard Tone Test
Pattern Ch1, Inbound Symmetrical Time Bound Test Pattern, and Others.

P25 Constellation Display
The P25 Constellation Display shows the P25 signal modulation amplitude. For the HCPM and HDQPSK standards, you can view this
display as frequency deviation or as I and Q. For the C4FM standard, only the frequency deviation applies.

To show the P25 Constellation display you can select Presets > Standards > P25 or do the following:

1. Recall an appropriate acquisition data file.
2. Press the Displays button or select Setup > Displays.
3. In the Select Displays dialog, select P25 Analysis in the Measurements box.
4. In the Available displays box, double-click the P25 Constellation icon or select the icon and click Add. The P25 Constellation icon

will appear in the Selected displays box and will no longer appear under Available displays.
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5. Click OK to show the P25 Constellation display.
6. Select Setup > Settings to display the control panel.
7. Select the Modulation Params tab. Set the Standard, Modulation Type, and Measurement and Reference filters as appropriate for

the input signal.
8. For Phase 2 signals, select the Trace tab and set the Trace Type to Freq Dev or IQ.
9. Select the Test Patterns tab and select the desired test pattern as appropriate for the input signal.
10. Press the Replay/Run button to take measurements on the acquired data.

Elements of the Display
The following image shows the P25 Constellation display set to IQ for a HDQPSK signal.

The following image shows the same signal as the previous image, but with the display set to Frequency Deviation.
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Item Display element Description

1 Marker Readout Located to the left of the constellation plot or below it, depending on the size of the
window. If markers are enabled, the marker readout will show frequency deviation results
or IQ results (time, mag, phase, symbol marker and symbol value) of the point with the
selected marker.

2 Measurement results readout These readouts are located to the left or below of the Constellation plot, depending on the
window size. The readout shows Modulation Fidelity (%) and Frequency Error (Hz).

The second readout can either be Freq Error where the result is followed by Auto or it
could be Freq Offset where the result is followed by Manual. This choice between Freq
Error and Freq Offset is made from the Analysis Params tab in the Settings control panel.

3 Plot Shown as either I vs Q or as Frequency Deviation. The trace type is controlled from the
Settings > Trace tab.

P25 Constellation Settings
Main menu bar: Setup > Settings

The P25 Constellation Settings control panel provides access to settings that control parameters of the Constellation Display. 

Settings tab Description

Modulation Params Specifies the input signal standard and additional user-settable signal parameters.

Table continued…
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Settings tab Description

Analysis Params Specifies parameters used by the instrument to analyze the input signal.

Analysis Time Specifies parameters that define the portion of the acquisition record that is used for analysis.
Also allows you to specify the Units (Symbols or Seconds) and Time Zero Reference (Trigger or
Acquisition Start) for P25 Analysis displays.

Test Patterns Specifies the type of test pattern being used. Some analysis differs based on the selected test pattern.
Available test patterns vary depending on the selected standard and modulation type.

Trace Specifies the trace type (Vectors, Points, and Lines), the number of points per symbol when chosen to
view as Vectors or Lines, and to control the view as Freq Dev or IQ.

Prefs Specifies the radix of the marker readout and whether elements of the graphs are displayed.

Trig Meas Enables you to select from several different trigger measurements.

P25 Eye Diagram Display
The P25 Eye Diagram display shows a digitally modulated signal overlapped on itself to reveal variations in the signal.

To show the P25 Eye Diagram display:

1. Recall an appropriate acquisition data file.
2. Press the Displays button or select Setup > Displays.
3. From the Measurements box, select P25 Analysis.
4. Double-click the P25 Eye Diagram icon in the Available Displays box. This adds the P25 Eye Diagram icon to the Selected

displays box.
5. Click OK button. This displays the P25 Eye Diagram view.
6. Select Setup > Settings to display the control panel.
7. Select the Modulation Params tab. Set the Standard, Modulation Type, and Measurement and Reference filters as appropriate for

the input signal.
8. For Phase 2 signals, select the Trace tab and set the Trace Type to Freq Dev or IQ.
9. Select the Test Patterns tab and choose a test pattern appropriate for the input signal.
10. Press the Replay/Run button to take measurements on the acquired data.

Elements of the Display
The following image shows the P25 Eye display with Trace Type set to IQ.
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The following image shows the P25 Eye display with Trace Type set to Freq Dev.

Item Display element Description

1 Top of graph The vertical scale is normalized with no units (for IQ) and with Hz (for Freq dev).

2 Position Specifies the value shown at the center of the graph display.

3 Bottom Readout Displays the value indicated by the bottom of graph.

Table continued…
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Item Display element Description

4 Autoscale Adjusts the vertical and horizontal settings to provide the best display.

5 Position Displays the horizontal position of the trace on the graph display.

6 Scale Adjusts the span of the graph in symbols.

7 Freq Error Displays the difference between the maximum and minimum measured values of the
signal frequency during the Measurement Time. The readout can either be Freq Error
where the result is followed by Auto or it could be Freq Offset where the result is followed
by Manual. This choice between Freq Error and Freq Offset is made from the Analysis
Params tab in the Settings control panel.

P25 Eye Diagram Settings
Main menu bar: Setup > Settings 

The settings for the P25 Eye Diagram display are shown in the following table.

Settings tab Description

Modulation Params Specifies the input signal standard and additional user-settable signal parameters.

Analysis Params Specifies parameters used by the instrument to analyze the input signal.

Analysis Time Specifies parameters that define the portion of the acquisition record that is used for analysis. Also
allows you to specify the Units (Symbols or Seconds) for P25 Analysis displays.

Trig Meas Enables you to select from various trigger measurements. The trigger selections vary by signal type.

Test Patterns Specifies the type of test pattern being used. Some analysis differs based on the selected test pattern.
Available test patterns vary depending on the selected standard and modulation type.

Trace Specifies the trace type (Vectors, Points, and Lines), the number of points per symbol when chosen to
view as Vectors or Lines, and to control the view as Freq Dev or IQ.

Scale Defines the vertical and horizontal axes.

Prefs Specifies the radix of the marker readout and whether elements of the graphs are displayed.

P25 Power vs Time Display
The P25 Power vs Time display shows the signal power amplitude versus time. In HCPM bursty data, the Regions A, B and C are shown
based on the middle of the burst and not based on the pilots.

To show the P25 Power vs Time display:

1. Recall an appropriate acquisition data file.
2. Press the Displays button or select Setup > Displays.
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3. In the Select Displays dialog, select P25 Analysis in the Measurements box.
4. In the Available displays box, double-click the P25 Power vs Time icon or select the icon and click Add. The P25 Power vs Time icon

will appear in the Selected displays box and will no longer appear under Available displays.
5. Click OK to show the P25 Power vs Time display.
6. Select Setup > Settings to display the control panel.
7. Select the Modulation Params tab. Set the Standard, Modulation Type, and Measurement and Reference filters as appropriate for the

input signal.
8. Select the Test Patterns tab and choose a test pattern appropriate for the input signal.
9. Press the Replay/Run button to take measurements on the acquired data.

Elements of the Display

Item Display element Description

1 Top of graph, first setting Sets the Power level that appears at the top of the graph, in dBm. This is only a visual
control for panning the graph.

2 Units Sets the global amplitude units for all the views in the analysis window. This will change
the amplitude selection in the Units tab of the Amplitude control panel.

3 Top of graph, second setting Sets the vertical Scale of the graphs, in dB/div. This is only a visual control for panning the
graph.

4 View

(Only available for bursty HCPM
data.)

Selects the specific view of the packet burst within the display:

Full Burst displays the entire packet, with vertical lines indicating Power ramp up, On Slot,
Power ramp down, and Off slot regions.

Ramp Up zooms the display into the interval around the packet rising edge.

Ramp Down zooms the display into the interval around the packet falling edge.

5 Bottom of graph readout Shows the Power level at the bottom of the graph in dBm.

6 Autoscale Adjusts the vertical and horizontal settings to provide the best display.

Table continued…
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Item Display element Description

7 Bottom of graph, left side Sets the starting time of the graph in seconds

8 Bottom of graph, right side Sets the scale (width) of the graph in seconds

9 Table below graph This table shows the following results.

For non-bursty signals: RF output power

For bursty signals: Power Info (Offslot Power and Power Envelope results) and Time Info.

P25 Power vs Time Settings
Main menu bar: Setup > Settings 

The settings for the P25 Power vs Time display are shown in the following table.

Settings tab Description

Modulation Params Specifies the input signal standard and additional user-settable signal parameters.

Analysis Params Specifies parameters used by the instrument to analyze the input signal.

Analysis Time Specifies parameters that define the portion of the acquisition record that is used for analysis. Also
allows you to specify the Units (Symbols or Seconds) for P25 Analysis displays.

Trig Meas Enables you to select from various trigger measurements. The trigger selections vary by signal type.

Test Patterns Specifies the type of test pattern being used. Some analysis differs based on the selected test pattern.
Available test patterns vary depending on the selected standard and modulation type.

Scale Defines the vertical and horizontal axes.

Prefs Specifies the radix of the marker readout and whether elements of the graphs are displayed.

P25 Summary Display
The P25 Summary display shows a summary of all the scalar measurements done on the acquired test pattern. The summary display and
contents will vary according to the selected standard.

Pass/Fail information is also provided in this display for all enabled scalar measurements. You can set limits and choose which
measurement to compare for Pass/Fail from the Limits tab in the P25 Summary Settings control panel. The default limits come from the
performance recommendation limits given by the Standard document. The default limits can be reloaded by selecting the P25 Standards
Preset option or by loading the default limits table.

To show the P25 Summary display you can select Presets > Standards >P25 or do the following:

1. Recall an appropriate acquisition data file.
2. Press the Displays button or select Setup > Displays.
3. In the Select Displays dialog, select P25 Analysis in the Measurements box.
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4. In the Available displays box, double-click the P25 Summary icon or select the icon and click Add. The P25 Summary icon will appear
in the Selected displays box and will no longer appear under Available displays.

5. Click OK to show the P25 Summary display.
6. Select Setup > Settings to display the control panel.
7. Select the Modulation Params tab. Set the Standard, Modulation Type, and Measurement and Reference filters as appropriate for the

input signal.
8. Select the Test Patterns tab and select a test pattern. The available test patterns in the drop down list depend of the standard and

modulation type you have selected.
9. Press the Replay/Run button to take measurements on the acquired data.

P25 Summary Display
The Modulation Measurements, Power Measurements, and Trigger Measurements components of this display vary depending on which
modulation type is selected.

The following image shows an example of the display for a Phase 1 C4FM signal.

The following image shows an example of the display for a Phase 1 C4FM High Deviation signal.

The following image shows an example of the display for a Phase 2 HCPM (Inbound) signal.
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The following image shows an example of the display for a Phase 2 HDQPSK (Outbound) signal.

For more information about specific measurement results, see the P25 Measurements section here.

Elements of the Display

Element Description

Standard Display of the standard selected on the Setup > Settings > Modulation Params tab.

Bandwidth Display of the channel bandwidth which is set based on the standard and modulation type.

Modulation Type Display of the modulation type selected on Setup > Settings > Modulation Parameters tab.

Clear Click button to reset measurement. Clears all values.

Table continued…
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Element Description

Modulation Measurements Shows the modulation measurements associated with the signal.

Power Measurements Shows the power measurements associated with the signal.

Trigger Measurements Shows the trigger measurements associated with the signal.

P25 Summary Settings
Main menu bar: Setup > Settings 

The settings for the P25 Summary display are shown in the following table.

Settings tab Description

Modulation Params Specifies the input signal standard and additional user-settable signal parameters.

Analysis Params Specifies parameters used by the instrument to analyze the input signal.

Analysis Time Specifies parameters that define the portion of the acquisition record that is used for analysis. Also
allows you to specify the Units (Symbols or Seconds) for P25 Analysis displays.

Trig Meas Enables you to select from various trigger measurements. The trigger selections vary by signal type.

Test Patterns Specifies the type of test pattern being used. Some analysis differs based on the selected test pattern.
Available test patterns vary depending on the selected standard and modulation type.

Limits Load and define P25 measurement limits for Pass/Fail comparison. You can save defined limits as
a .csv file and also load previously saved .csv files.

P25 Symbol Table Display
The P25 Symbol Table display shows decoded data values for each data symbol in the analyzed signal packet.

To show the P25 Symbol Table display:

1. Recall an appropriate acquisition data file.
2. Press the Displays button or select Setup > Displays.
3. In the Select Displays dialog, select P25 Analysis in the Measurements box.
4. In the Available displays box, double-click the P25 Symbol Table icon or select the icon and click Add. The P25 Symbol icon will

appear in the Selected displays box and will no longer appear under Available displays.
5. Click OK to show the P25 Symbol Table display.
6. Select Setup > Settings to display the control panel.
7. Select the Modulation Params tab. Set the Standard, Modulation Type, and Measurement and Reference filters as appropriate for the

input signal.
8. Select the Test Patterns tab and select a test pattern. The available test patterns in the drop down list depend on the standard and

modulation type you have selected.
9. Press the Replay/Run button to take measurements on the acquired data.
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P25 Symbol Table
The following image shows the P25 Symbol Table for HCPM (bursty) signals. For this signal type, the symbols are arranged as Bursts vs
Symbols. The analysis is done only on the on slot regions of the bursty HCPM data and 160 symbols (centered at the middle of the burst)
are reported on the symbol table for every on slot region. You can read more about specific measurements here.

The following image shows the P25 Symbol Table for C4FM (non-bursty) signals. For this signal type and for HDQPSK, there is no
grouping into bursts and all symbols that are analyzed are shown.

APCO P25 Analysis

SignalVu™ Vector Signal Analysis Software Printable Help 297



Elements of the Display

Element Description

Marker Displays the selected marker label.

Time Displays the time in ms or in Symbols based on the Units chosen in the Analysis Time tab of the
Settings Control panel.

Symbol The value shown here reflects the symbol you have selected (highlighted) in the display.

Value Displays the value of the selected symbol.

P25 Symbol Table Settings
Main menu bar: Setup > Settings 

The settings for the P25 Symbol Table display are shown in the following table.

Settings tab Description

Modulation Params Specifies the input signal standard and additional user-settable signal parameters.

Analysis Params Specifies parameters used by the instrument to analyze the input signal.

Table continued…
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Settings tab Description

Analysis Time Specifies parameters that define the portion of the acquisition record that is used for analysis. Also
allows you to specify the Units (Symbols or Seconds) for P25 Analysis displays.

Trig Meas Enables you to select from various trigger measurements. The trigger selections vary by signal type.

Test Patterns Specifies the type of test pattern being used. Some analysis differs based on the selected test pattern.
Available test patterns vary depending on the selected standard and modulation type.

Prefs Specifies the radix of the marker readout.

P25 Frequency Dev vs Time Display
The P25 Frequency Deviation vs. Time Display shows how the signal frequency varies with time.

To display the P25 Frequency Dev vs. Time Display:

1. Recall an appropriate acquisition data file.
2. Select the Displays button or Setup > Displays.
3. In the Select Displays dialog, select P25 Analysis in the Measurements box.
4. In the Available displays box, double-click the P25 Frequency Dev vs. Time icon or select the icon and click Add. The P25

Frequency Dev vs. Time icon will appear in the Selected displays box and will no longer appear under Available displays.
5. Click OK to display the Freq Dev vs. Time display.
6. Select the Modulation Params tab. Set the Standard, Modulation Type, and Measurement and Reference filters as appropriate for the

input signal.
7. Select the Test Patterns tab and select a test pattern. The available test patterns in the drop down list depend of the standard and

modulation type you have selected.
8. Press the Replay/Run button to take measurements on the acquired data.

Elements of the Display
The following image shows the P25 Freq Dev vs Time display for Phase 1 C4FM (non-bursty) High Deviation signals.
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The following image shows the P25 Freq Dev vs Time display for Phase 2 HCPM (bursty) signals.

Note: For bursty HCPM signals, frequency deviation analysis is done only on 160 symbols centered at every on slot region in the
chosen analysis window and not on off slot regions. That is why there is no information shown during off slot regions. You can
read more specific information about P25 measurements here.
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Elements of the Display

Item Display element Description

1 Top of graph adjustment Adjust the frequency range displayed on the vertical axis.

2 Position (center) Adjust the frequency shown at the center of the display.

3 Autoscale button Adjusts the offset and range for both vertical and horizontal to provide the best display.

4 Position Displays the horizontal position of the trace on the graph display.

5 Scale Adjust the horizontal scale (time).

Changing Frequency vs Time Display Settings

P25 Frequency Dev Vs Time Settings
Main menu bar: Setup > Settings 

The Setup settings for P25 Frequency Dev vs. Time are shown in the following table.

Settings tab Description

Modulation Params Specifies the input signal standard and additional user-settable signal parameters.

Analysis Params Specifies parameters used by the instrument to analyze the input signal.

Analysis Time Specifies parameters that define the portion of the acquisition record that is used for analysis. Also
allows you to specify the Units (Symbols or Seconds) for P25 Analysis displays.

Trig Meas Enables you to select from various trigger measurements. The trigger selections vary by signal type.

Test Patterns Specifies the type of test pattern being used. Some analysis differs based on the selected test pattern.
Available test patterns vary depending on the selected standard and modulation type.

Trace Specifies the trace type (Vectors, Points, and Lines), the number of points per symbol when chosen to
view as Vectors or Lines, and to control the view as Freq Dev or IQ.

Scale Defines the vertical and horizontal axes.

Prefs Specifies the radix of the marker readout and whether elements of the graphs are displayed.

P25 Analysis Shared Measurement Settings
Main menu bar: Setup > Settings
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The control panel tabs in this section are shared between the displays in P25 Analysis (Setup > Displays). Some tabs are shared by all
the displays, some tabs are shared by only a subset of displays. The settings available on some tabs change depending on the selected
display.

Table 24: Common controls for P25 analysis displays

Settings tab Description

Modulation Params Specifies the input signal standard and additional user-settable signal parameters.

Analysis Params Specifies parameters used by the application to analyze the input signal.

Analysis Time Specifies parameters that define the portion of the acquisition record that is used for analysis. Also
allows you to specify the Units (Symbols or Seconds) for P25 Analysis displays.

Trace Specifies the trace type (Vectors, Points, and Lines), the number of points per symbol when chosen to
view as Vectors or Lines, and to control the view as Freq Dev or IQ.

Scale Defines the vertical and horizontal axes.

Test Patterns Enables you to select from eight different test patterns.

Trig Meas Enables you to select from various trigger measurements. The trigger selections vary by signal type.

Prefs Specifies the radix of the marker readout and whether elements of the graphs are displayed.

Modulation Params Tab - P25
The Modulation Params tab specifies the type of modulation used by the input signal and other parameters that define the signal format.

Settings Description

Standard Specifies the standard used for the input signal: Phase 1, Phase 2.

Channel Bandwidth This readout shows the nominal channel bandwidth based on the standard.

Modulation Type Specifies the modulation type of the input signal. Choices vary depending on the selected
standard. Modulation types for Phase 2 are HCPM (Inbound) and HDQPSK (Outbound).
Phase 1 has only C4FM as the modulation type selection.

Measurement Filter Specifies the filter used as a measurement.

Reference Filter Specifies the filter used as a reference.

Filter Parameter Enter a value used for defining the Reference Filter. (Not present for some filter types)

Table continued…
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Settings Description

Symbol Rate This is a readout that shows the symbol rate for demodulating digitally modulated signals
based on the standard. This rate is always 4.8 kHz for Phase 1 signals and 6 kHz for Phase
2 signals.

Symbol Rate
Specifies the symbol rate for demodulating digitally modulated signals based on the standard. The symbol rate and the bit rate are related
as follows:

(Symbol rate) = (Bit rate)/(Number of bits per symbol)

The bit rate used for Phase 1 (C4FM) is 9600 bps. For Phase 2 (HCPM and HDQPSK) it is 12000 bps. There are two bits per symbol for
all above mentioned modulation types. Therefore, the symbol rate is 4800 Hz for Phase 1 and 6000 Hz for Phase 2.

Measurement and Reference Filters
The available measurement and reference filters depend on the selected modulation type. The following table shows the recommended
filters for the specified modulation types.

CAUTION: Although there are other filter types listed in the drop down menu, if you select any filter other than that which is
recommended, the measurement results may not be accurate.

Modulation type Measurement filters Reference filters

HDQPSK HDQPSK-P25 None

HPCM None None

C4FM C4FM-P25 RaisedCosine (Filter parameter 0.2)

The measurement filter is applied before the demodulation bit is detected and the ideal reference is calculated.

The reference filter is applied to the internally generated ideal reference signal before the modulation fidelity is calculated.

How to Select Filters
In a signal transmitter/receiver system, the baseband signal might be filtered for bandwidth limiting or for another kind of necessary
shaping that needs to be applied. Normally, a filter in the transmitter (Ft) and a filter in the receiver (Fr) are applied.

The Measurement Filter setting in the analyzer corresponds to the baseband filter in the receiver (Fr): This setting tells the analyzer what
filter your receiver uses. When the analyzer is set to the same filter used by the receiver, the analyzer sees the signal as your receiver
would. The Measurement Filter setting should be the same as the filter used in the receiver under normal operation (as opposed to
testing).

The Reference Filter setting in the analyzer corresponds to the baseband filter in the transmitter-receiver combination (Fr * Ft). The
baseband filter for the transmitter-receiver combination is often referred to as the System Filter. This filter is called the reference filter
because it is used to recreate a reference signal that is compared to the received signal. This recreated reference signal is the ideal signal
with Fr * Ft applied; differences between this ideal signal and the received signal enables the determination of signal quality, such as
modulation fidelity measurements.

Filter Parameter (C4FM only)
The filter parameter specifies the alpha for the Raised Cosine filter when selected as the Reference filter. Some filter types have a fixed
parameter value that is specified by industry standard, while other filter types by definition have no filter parameter. For filter types with no
filter parameter, there is no filter parameter control present in the control panel. The recommended Reference filter for C4FM is Raised
Cosine and the corresponding filter parameter for C4FM is 0.2.
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Analysis Params Tab - P25
The Analysis Params tab contains parameters that control the analysis of the input signal.

Settings Description

Frequency Error When the Auto box is checked, the analysis determines the Frequency Error and the
measured Frequency Error is displayed. When the Auto box is unchecked, the entered value
is used by the analysis as a fixed frequency offset. This is useful when the exact frequency
offset of the signal is known.

Measurement BW Specifies the bandwidth about the center frequency at which measurements are made.
Select Manual, Auto, or Link to Span.

PTX Specifies the RF Output Power as recommended for transmitters. This is only used in the
computation of off slot power in HCPM modulated signals.

Low Pass cut off frequency

(only for frequency deviation)

Specifies the filter cut off frequency for Frequency deviation measurement. This setting will
only affect the scalar results Frequency Deviation (Positive and Negative Peak f1,f2,f3, and
f4) in the Summary display.

This selection is only visible when High or Low Deviation or Standard Transmitter Symbol
Rate Pattern is chosen from the Test Patterns tab of the Settings Control panel.

Analysis Time Tab - P25
The Analysis Time tab contains parameters that define how the signal is analyzed in the P25 Analysis displays.

Settings Description

Analysis Offset Specifies the location of the first time sample to use in measurements.

Auto When enabled, causes the instrument to set the Analysis Offset value based on the requirements of
the selected display.

Table continued…
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Settings Description

Analysis Length Specifies the length of the analysis period to use in measurements. Length is specified in either
symbols or seconds, depending on the Units setting.

Auto When enabled, causes the instrument to set the Analysis Length value based on the requirements of
the selected display.

Actual This is a displayed value, not a setting. It is the Analysis Length (time or symbols) being used by the
analyzer, this value may not match the Analysis Length requested (in manual mode).

Time Zero Reference Specifies the zero point for the analysis time.

Units Specifies the units of the Analysis Length to either Symbols or Seconds.

Analysis Offset
Use analysis offset to specify where measurements begin. Be aware that you cannot set the Analysis Offset outside the range of time
covered by the current acquisition data. (all time values are relative to the Time Zero Reference).

You can set the Analysis Length so that the requested analysis period falls partly or entirely outside the current range of acquisition
data settings. When the next acquisition is taken, its Acquisition Length will be increased to cover the new Analysis Length, as long as
the Sampling controls are set to Auto. If the Sampling parameters are set to manual, or if the instrument is analyzing saved data, the
actual analysis length will be constrained by the available data length, but in most cases, measurements are able to be made anyway.
The instrument will display a notification when measurement results are computed from less data than requested. Range: 0 to [(end of
acquisition) - Analysis Length)]. Resolution: 1 effective sample (or symbol).

Analysis Length
Use the analysis length to specify how long a period of time is analyzed. As you adjust this value, the actual amount of time for Analysis
Length, in Symbol or Seconds units, is shown below the control in the "Actual" readout. This setting is not available when Auto is checked.
Range: minimum value depends on modulation type. Resolution: 1 symbol.

Time Zero Reference
All time values are measured from this point (such as marker position or horizontal position (in Y vs Time displays). Choices are:
Acquisition Start or Trigger. When a trigger measurement is chosen from the Trig Meas tab of the Settings control panel, Time Zero
Reference is forced to Trigger.

Parameter Description

Acquisition Start Time zero starts from the point at which acquisition begins.

Trigger Time zero starts from the trigger point.

Test Patterns Tab - P25
Test patterns allow the software to compare the measurement result to the standards limit. The list of available test patterns varies
depending on which standard and modulation type is selected.
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Settings Description

Test Patterns Use this drop-down list to select an appropriate test pattern. The list varies depending on which
standard and modulation type is selected.

You can read more about test patterns here.

Trace Tab - P25
The Trace tab allows you to set the trace display characteristics of the P25 trace display. The selections vary depending on the selected
display.

The following image shows the tab for the Constellation and Eye Diagram displays. For the other trace displays, the Trace Type setting is
not available.

Setting Description

Trace

(P25 Constellation and P25 Eye
Diagram displays only)

Select the trace to display.

P25 Constellation display only: Select the trace that is hidden or displayed based on whether or not
Show is selected.

Show

(P25 Constellation and P25 Eye
Diagram displays only)

Specifies whether the trace selected by Trace is displayed or hidden.

Freeze

(P25 Constellation display only)

Halts updates to the trace selected by the Trace setting. Present for the Constellation display only.

Points/Symbol Select how many points to use between symbols when connecting the dots. Values: 1, 2, 4, 8.

Content

(P25 Constellation and P25 Freq
Dev & Time displays only)

Select whether to display the trace as vectors (points connected by lines), points (symbols only
without lines), or lines (lines drawn between symbols, but no symbols are displayed). The choices
available depend on the display.

Table continued…

APCO P25 Analysis

SignalVu™ Vector Signal Analysis Software Printable Help 306



Setting Description

Trace Type

(P25 Constellation and P25 Eye
Digram displays only)

Select to specify whether the plots in the Constellation and Eye Diagram displays are shown as I vs Q
or as Frequency Deviation.

Scale Tab - P25
The Scale tab allows you to change the scale settings that control how the trace appears on the display but does not change control
settings such as Measurement Frequency. There are three versions of the Scale tab for P25 displays.

Figure 45: Scale tab for the P25 Eye Diagram display

Figure 46: Scale tab for the P25 Power vs Time display

Figure 47: Scale tab for the P25 Freq Dev vs Time display

Settings Description

Vertical Controls the vertical position and scale of the trace display.

Scale Changes the vertical scale of the graph.

Position Adjusts the reference level away from top of the graph.

Autoscale Resets the scale of the vertical axis to contain the complete trace.

Horizontal

Horizontal Full Burst

Controls the span of the trace display and position of the trace.

Table continued…
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Settings Description

Scale Allows you to, in effect, change the span.

Position Allows you to pan a zoomed trace without changing the Measurement Frequency. Position is only
enabled when the span, as specified by Freq/div, is less than the acquisition bandwidth.

Autoscale Resets the scale of the horizontal axis to contain the complete trace.

Auto When Auto is checked, the scale and position values for the Symbols graph are automatically
adjusted to maintain the optimal display.

Reset Resets the vertical and horizontal settings.

Note: The Units used for the horizontal scale can be either Seconds or Symbols. To set the units for the horizontal scale, display
the Analysis Time tab. On the tab, select the appropriate units from the Units drop-down list.

Trig MeasTab - P25
The Trig Meas tab enables you to chose a trigger measurement. The available measurements in the drop-down menu depend on the
standard and modulation type selected in the Modulation Params tab. The Trig Meas tab is not available for Phase 2 HDQPSK (Outbound)
signals. You can read more about P25 trigger related measurements here.

The following image shows the tab for Phase 1 (C4FM) signals.

The following image shows the tab for Phase 1 (HCPM Inbound) signals.

Settings Description

Trigger Measurements Select the trigger measurement test.

Prefs Tab - P25
The Prefs tab enables you to change appearance characteristics of the P25 Analysis displays. Not all settings on the Prefs tab shown
below appear for every P25 display. The Summary display does not have a Prefs tab.
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Setting Description

Show graticule Shows or hides the graticule.

Show Marker readout in graph
(selected marker)

Shows or hides the readout for the selected marker in the graph area.

Radix Specifies how symbols are displayed in the Symbol Table display and in the Marker readout in the
display. There are three choices for Radix: Binary (00,01,10,11), Quaternary (0,1,2,3), and Modulation
Symbols (+1,+3,-1,-3).

Limits Tab - P25
The Limits tab is only available for the P25 Summary display. It enables you to load an existing limits table, save a limits table, or edit limits
values.

Setting Description

Load Click to load a saved Limits table from a .csv file.

Save Click to save the current Limits table to a .csv file.

Edit Limits
To directly edit measurement limits in the table, click on the value in the Limit column that you want to change.

The following table describes the parameters that are set in the Limits Table.

Table 25: Limits Table Settings

Setting Description

On Click on the cell in the On column next to the measurement to specify whether ofrnot measurements
are selected for limit comparison to indicate Pass or Fail.. A check mark means the measurement will
be taken. An empty box means it will not be taken.

Measurement Name Specifies the name of the measurement related to the limit. (Not editable.)

Table continued…
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Setting Description

Limit Specifies the value of the limit to the related measurement. When the cell is selected, the value is
shown along with the units.
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LTE Analysis
LTE Overview
The Long Term Evolution (LTE) Downlink RF Measurements Analysis option allows you to evaluate RF signals to ensure that they meet
3GPP measurements. These are described in the TS 36.104 Base Station (BS) radio transmission and reception and test specifications
TS36.141 Base Station (BS) conformance testing documents version 12.5. This analysis option supports both LTE TDD and LTE FDD
frame structures. This analysis option supports the following measurements.

• Channel Power
• Occupied Bandwidth
• Adjacent Channel Leakage Ratio (ACLR)
• Spectral Emission Mask (Operating Band Unwanted Emission)
• Cell ID
• For TDD LTE Transmitter Off Power
• Reference Signal Power

These measurements are also compared with the limits provided by the standard to give pass/fail results (except for Channel Power and
OBW).

More detailed information about these measurements is available in the LTE measurements on page 319 section and the supported
measurements table.

You can also select these measurements from four LTE preset test setups. The test setups load pre-configured displays and control setting
as suggested by the standard to accelerate the test setup of the analyzer. The following four test setups are available for this analysis
option.

• Cell ID
• ACLR
• Channel Power and TDD Toff Power
• SEM

More detailed information about these test setups is available here.

With the LTE downlink RF Measurement Analysis test suite, test engineers can simplify the execution of a number of transmitter tests while
still enabled to modify signal parameters for in-depth signal analysis. The analysis results give multiple views of LTE signal characteristics
to allow the diagnosis of signal imperfections and impairments quickly and easily. Display controls allow you to selectively display the
analysis results to help locate trouble spots in the signal.

LTE topics in this Help
The following information about the LTE Analysis option is available:

• Reference table of supported LTE measurements
• LTE measurements
• LTE Standards preset test setups on page 312
• LTE displays on page 318
• LTE measurement control settings

Supported LTE measurements
The following table gives a brief description of the available LTE measurements. More detailed information can be found here. LTE
measurements on page 319

LTE Analysis

SignalVu™ Vector Signal Analysis Software Printable Help 311



LTE measurement LTE standard(s) Description

Cell ID detection TDD

FDD

The Cell ID is detected from the input LTE signal.

Adjacent Channel Leakage Ratio (ACLR) TDD

FDD

The Adjacent Channel integrated power is
calculated and shown. The relative power
compared to the reference signal is also
computed. The computed power is compared
against limits suggested by the selected standard
and pass/fail is reported. The appropriate settings
for this measurement are loaded with the ACLR
test setup (Presets > Standards > LTE).

Channel Power TDD

FDD

The channel power is calculated in the channel
bandwidth.

Occupied Bandwidth TDD

FDD

The Occupied bandwidth is calculated as
bandwidth containing 99% of the total integrated
power in the selected span around the selected
center frequency.

Operating Band Unwanted Emission TDD

FDD

The power in the offset regions is calculated and
presented and compared against limits set in the
offset and limits table and pass/fail is reported.
The appropriate settings for this measurement
are loaded with the SEM test setup (Presets >
Standards > LTE).

Toff TDD The power in off-slot region is computed and
compared against selected limits.

Reference Signal Power TDD

FDD

Measures the power of cell specific reference
signals.

LTE Standards preset test setups
Presets > Standards

The LTE Standards preset allows you to access displays preconfigured for the test setup you select. The test setups load the displays and
control setting options suggested by the LTE standard to perform the measurements. You can read more about how Presets work here.

There are four test setups for LTE:

• Cell ID
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• ACLR

• Channel Power and TDD Toff Power
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• SEM

The following table shows what automatically loads with each test setup.
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Table 26: LTE preset test setups

Test setup Displays loaded with preset

Cell ID Frame structure:

- Downlink FDD

- Downlink TDD

(Default is Downlink FDD.)

Spectrum, Time Overview, LTE Constellation

Channel bandwidth: 1.4, 3, 5, 10, 15, 20 MHz

(Default is 1.4 MHz.)

Table continued…
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Test setup Displays loaded with preset

ACLR Frame structure:

- Downlink FDD

- Downlink TDD

(Default is Downlink FDD.)

LTE ACLR

Channel bandwidth: 1.4, 3, 5, 10, 15, 20 MHz

(Default is 1.4 MHz.)

Base station category:

- Wide Area Cat A

- Wide Area Cat B — Option 1

- Home Area (P-rated ≤ 20 dBm)

- Local Area (P-rated ≤ 24 dBm))

- Medium Area (P-rated ≤ 38 dBm))

(Default is Wide Area Cat A.)

Adjacent channel type:

- UTRA

- E-UTRA

(Default is UTRA.)

UTRA chip rate.

1.28 Mcps

3.84 Mcps

7.68 Mcps

Chip rate is only displayed under the following conditions:

TDD is frame structure

Adjacent channel type selected is UTRA

Channel bandwidth is >3 MHz

(Default chip rate is 3.84 Mpcs.)

Table continued…
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Test setup Displays loaded with preset

Channel Power and
TDD Toff Power

Frame structure:

- Downlink FDD

- Downlink TDD

(Default is Downlink FDD.)

Time Overview (TDD only), LTE Channel Spectrum,
LTE Power vs Time (TDD only)

Channel bandwidth: 1.4, 3, 5, 10, 15, 20 MHz

(Default is 1.4 MHz.)

SEM Frame structure:

- Downlink FDD

- Downlink TDD

(Default is Downlink FDD.)

SEM

Channel bandwidth: 1.4, 3, 5, 10, 15, 20 MHz

(Default is 1.4 MHz.)

Base station category:

- Wide Area Cat A

- Wide Area Cat B — Option 1

- Home Area (2 dBm ≤ P ≤ 20 dBm)

- Local Area

- Medium Area (P ≤ 31 dBm)

(Default is Wide Area Cat A.)

Retain current center frequency and reference level settings
The Retain current Center Frequency setting appears when the LTE Standards Preset is chosen. This setting allows you to retain the
previously used center frequency. By default, the Center Frequency setting box is unchecked and the LTE preset displays will load with
1.96 GHz for FDD and 1.9 GHz for TDD.

The Retain current Ref Level setting appears when the LTE Standards Preset is chosen. This setting allows you to retain the previously
used reference level. By default, the Ref Level setting box is checked.

To activate these settings, check the box next to the desired setting. The following image shows the Retain current Ref Level setting box
checked.
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LTE displays
The displays in LTE Analysis (Setup > Displays > Measurements: LTE Analysis) are:

• LTE Channel Spectrum
• LTE ACLR
• LTE Constellation
• LTE Power vs Time
• SEM (This display is not an LTE specific display, but is available when RF Measurements is selected from the Select Displays dialog

(Setup > Displays) (see the following image).)
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LTE measurements
LTE Analysis enables RF measurements and detection of Cell ID in the transmitted signal for both TDD and FDD frame structure LTE
signals. For TDD signals, the analysis will also do the TOFF measurement. The following topics contain important information you should
know about specific LTE measurements. You can view a table with all of the available measurements here.

Channel Power and Occupied Bandwidth (TDD and FDD)
The Channel Power measurement is done by calculating the power in the LTE signal based on the selected channel bandwidth option. The
Occupied Bandwidth measurement calculates the frequency range over which 99% of the power is contained in the acquired signal. This
measurement is done for the selected channel bandwidth option.

More information about this measurement:

• Select the Channel Power and TDD Toff Power test setup from Presets > Standards > LTE to perform the measurement. This will load
the displays found in the LTE preset test setups table.

• This test setup allows you to choose the frame structure and the channel bandwidth.
• The Channel Spectrum display will contain the results of Channel Power and Occupied Bandwidth. The result gives the power in the

LTE signal (calculated over the channel bandwidth).
• Results are presented as scalar and are located below the display.
• For TDD signals, the channel power and the occupied bandwidth measurement are done on the on-slot region. If the valid on-slot

region is not found, the measurement is done in the selected analysis length.

ACLR (FDD and TDD)
The Adjacent Channel specification and limits for comparison are set based on selected frame structure, adjacent channel and base
station types from Standards Presets. It calculates the integrated power in the different adjacent regions and also indicates pass/fail based
on comparison with absolute and relative limits in LTE ACLR display.

More information about this measurement:

• Select the ACLR test setup from Presets > Standards > LTE to perform the measurement. This will load the displays found in the LTE
preset test setups table.

• This test setup allows you to select the frame structure, channel bandwidth, base station type, and adjacent channel type with the
following restrictions:

• Frame Structure can be TDD or FDD
• Channel Bandwidth can be 1.4, 3, 5, 10, 15, or 20 MHz
• Base station type can be Wide Area Cat A, Wide Area Cat B- Option 1, Home Area (P-rated ≤ 20 dBm), Local Area (P-rated ≤ 24

dBm), Medium Area (P-rated ≤ 38 dBm)
• Adjacent Channel type can E-UTRA or UTRA
• UTRA chip rate can be 1.28, 3.84, or 7.68 Mcps

Default rate is 3.84 Mcps for all UTRA adjacent channels of FDD and when channel bandwidth is 1.4 or 3 MHz.

However, you can choose other rates when the frame structure is TDD and when the bandwidth is more than 3 MHz. Otherwise,
the standard recommends use of 3.84 Mcps.

• Based on the settings you select from Standards Preset, the offset and bandwidth of the adjacent channels are set in the Offset and
Limits tab of the control panel. The settings are different for paired and unpaired spectrum.

• The settings also include the absolute power limit for comparison based on the base station type. The standard recommends the
settings in dBm/MHz for each base station type. The power limits are appropriately scaled with the integration bandwidth and
presented in dBm in the Offset and Limits table of the display. The integrated power in each adjacent band is compared with the
absolute and relative limits as recommended by the standard. The absolute limits are dependent on this choice of base station type
because they apply to different power levels (as the P-rated levels in the drop down menu indicate). The relative limit is also set.

• The results are presented in both tabular and display format. In the tabular display, the reference channel power and the offset,
bandwidth, integrated power, and relative power of the adjacent channels are presented. An expanded view format is also available.

• The integrated power in the display is shaded blue in each adjacent channel region.
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• Each adjacent channel is clearly shown. Interadjacent channel gaps are shown in gray.
• The limit lines are shown in different colors. Based on the Mask option chosen in the Offset & Limits table, failures in the different

bands are shown in red on violation. By default for LTE Standards Presets, the Mask option is Abs & Rel, so the failure is shown only
when the calculated power violates both relative and absolute power limits.

• The respective rows that violate both absolute and relative limits are also shown in red. Pass/fail information appears in the top left
corner of the display.

• This measurement can be performed in Real Time or Non-Real Time mode. In Real Time mode, a single acquisition required for the
entire span needed for this measurement is taken and the measurement is done. In the Non-Real Time mode, a separate acquisition
for each adjacent channel region is taken and analyzed.

Non-real time mode is also useful when the bandwidth offered by the instrument does not support the span requirement for this
measurement. The span requirement comes from the choice of adjacent channel type and channel bandwidth. In such cases,
Non-Real Time mode can be used.

• For UTRA adjacent channels, filtering of the adjacent channels with an RRC filter of the same bandwidth is employed, as suggested
by the standard. The chip rate is set to 3.84 Mcps for FDD and when the channel bandwidth is 1.4 or 3 MHz. For TDD, when the
channel bandwidth is more than 3 MHz, you can choose the UTRA chip rate from the ACLR test setup (Presets > Standards > LTE).
The options are 1.28, 3.84, and 7.68 Mcps.

• The standard recommends this measurement be done on the transmitter ON period when the signal being analyzed is TDD. An on slot
detection module in the analysis helps you to do the measurement in the transmitter ON period.

• If you are doing the measurement in Real Time, you can also load the Time Overview display, which will indicate to you the region
in which the measurement is done (a purple line at the bottom). You can see the measurement is done only on the valid transmitter
ON period. However, when a bursty data is not available, the measurement is done on the available analysis length.

Note: Real-Time mode can be set from the Parameters tab of the Settings control panel of the LTE ACLR display.
Disabling Real-Time mode is the non-Real-Time setting.

• When the measurement is done in non-Real Time mode, separate acquisitions are obtained for each adjacent channel band.
In such cases, it cannot be ensured that all the adjacent channel acquisitions are done on the transmitter ON period. It is
recommended that you use either Real time mode or an external trigger from the source (when used with non-Real-Time mode) to
do the measurement. An external trigger from the source can ensure that all the acquisitions are done just after the rising edge of
the burst. A status message in the display indicates when to use Real-Time mode or external trigger for TDD signals. The status
message that is displayed in the LTE ACLR display is "Signal must be triggered or measurement in Real-Time". This message
is displayed when TDD is chosen from Standard Presets, when Real-Time is not enabled from the Parameters tab of the control
panel, and when the instrument is in Free Run mode.

Operating Band Unwanted Emission (FDD and TDD)
This measurement finds the power in the offset regions recommended by the standard. The offset channel specification and limits for
comparison are set based on the selected channel bandwidth, frame structure, and base station types in Standards Preset. It calculates
the integrated power in the different offset regions and also indicates pass/fail information based on comparison with absolute and relative
limits in the SEM display.

More information about this measurement:

• Select the SEM test setup from Presets . Standards . LTE to perform the measurement. This will load the displays found in the LTE
preset test setups table.

• This test setup allows you to select the frame structure, channel bandwidth, and base station type with the following restrictions:

• Frame Structure can be TDD or FDD
• Channel Bandwidth can be 1.4, 3, 5, 10, 15, or 20 MHz
• Base station type can be Wide Area Cat A, Wide Area Cat B - Option 1, Home Area (2 dBm ≤ P ≤ 20 dBm), Local Area, Medium

Area (P ≤ 31 dBm)
• Based on the settings chosen by the user from Standards Presets the offset and bandwidth of the offset channels are set in the Offset

and Limits tab of the control panel of SEM display.
• The settings also include the absolute power limit for comparison based on the base station type. The standard recommends the

settings in dBm/MHz for each base station type. The power limits are appropriately scaled with the integration bandwidth and
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presented in dBm in the Offset and Limits table of the display. The integrated power in each adjacent band is compared with the
absolute and relative limits as suggested by the standard. The absolute limits are dependent on this choice of base station type as they
apply to different power levels (as the P-rated levels in the drop down menu indicate). The relative limit is also set.

• The results are presented both in tabular and display form.
• The Pass/ Fail information is also shown in the top left corner of the display.
• For TDD signals, a detection module in the analysis helps you to do the measurement in the transmitter ON period.

• If you are doing the measurement in Real Time, you can also load the Time Overview display, which will indicate to you the region
in which the measurement is done (a purple line at the bottom). You can see the measurement is done only on the valid transmitter
ON period. However, when a bursty data is not available, the measurement is done on the available analysis length.

Note: Real-Time mode can be set from the Parameters tab of the Settings control panel of the SEM display. Disabling
Real-Time mode is the non-Real-Time setting.

• When the measurement is done in non-Real Time mode, separate acquisitions are obtained for each adjacent channel band.
In such cases, it cannot be ensured that all the adjacent channel acquisitions are done on the transmitter ON period. It is
recommended that you use either Real-Time mode or an external trigger from the source (when used with non-Real Time mode) to
do the measurement. An external trigger from the source can ensure that all the acquisitions are done just after the rising edge of
the burst. A status message in the display indicates when to use Real Time mode or external trigger for TDD signals. The status
message that is displayed in the LTE SEM display is "Signal must be triggered or measurement in Real-Time". This message is
displayed when TDD is chosen from Standard Presets, when Real-Time is not enabled from the Parameters tab of the control
panel, and when the instrument is in Free Run mode.

• Settings for all tables provided in the base station conformance testing document (3GPP TS 36.141 v12.5 – for Release 12) has been
incorporated from Standards Presets.

• Wide Area and Local area settings from standard presets are provided as per the standard document.
• Home Area base station settings loaded from standard presets correspond to Reference power levels between 2 to 20 dBm.
• Medium Area base station settings loaded from standard presets correspond to reference power levels less than 31 dBm.

• The following settings are provided in a *.csv file that you can load. These files will be available in the installed directory (Example
Files\LTE).

• Wide Area category B Option 2 (for specific bands specified by the standard). There are three csv files based on operating band
and channel bandwidth for Wide Area.

• LTE_SEM_1.4MHz_CatB_optn2_bands_3_8.csv
• LTE_SEM_3MHz_CatB_optn2_bands_3_8.csv
• LTE_SEM_5to20Hz_CatB_optn2_bands_1_3_8_32_33_34.csv

• Home Area base station for power level less than 2 dBm. There are six csv files based on operating band and channel bandwidth
for Home Area.

• LTE_SEM_1_4MHz_above3GHz_Home2P.csv
• LTE_SEM_1_4MHz_below3GHz_Home2P.csv
• LTE_SEM_3MHz_above3GHz_Home2P.csv
• LTE_SEM_3MHz_below3GHz_Home2P.csv
• LTE_SEM_5to20MHz_above3GHz_Home2P.csv
• LTE_SEM_5to20MHz_below3GHz_Home2P.csv

• Medium Area base station for reference power level between 31 to 38 dBm. There are six csv files based on operating band and
channel bandwidth for Medium Area.

• LTE_SEM_1_4MHz_above3GHz_Medium31P38P.csv
• LTE_SEM_1_4MHz_below3GHz_Medium31P38.csv
• LTE_SEM_3MHz_above3GHz_Medium31P38.csv
• LTE_SEM_3MHz_below3GHz_Medium31P38.csv
• LTE_SEM_5to20MHz_above3GHz_Medium31P38.csv
• LTE_SEM_5to20MHz_below3GHz_Medium31P38.csv
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• Additional requirements given in Section 6.6.3.5.3 in 3GPP TS 36.141 v12.5 standard document. There are 14 csv files based on
the requirements in the standard document. The files are named based on the table numbers of Section 6.6.3.5.3 of the standard
document (3GPP TS 36.141 V12.5.0 (2014-09).

Cell ID (TDD and FDD)
The dominant Cell ID in the transmitted LTE signal is detected and presented in the Constellation display. Along with the Cell ID scalar
results, the group and sector ID are also presented. The constellation of the Primary and Second Synchronization signals are presented
too.

More information about this measurement:

• Select the Cell ID test setup from Presets > Standards > LTE to perform the measurement. This will load the displays found in the LTE
preset test setups table.

• This test setup allows you to select the frame structure and channel bandwidth with the following restrictions:

• Frame Structure can be TDD or FDD
• Channel Bandwidth can be 1.4, 3, 5, 10, 15, or 20 MHz

• Analysis of the LTE signals is done based on the settings you choose in the Standards Presets.
• The constellation for PSS and SSS (Primary and Secondary Synchronization Signals) are shown. You can optionally select to view

only the PSS or SSS constellation (selection is made in the Trace tab).
• Equalization based on PSS (Primary Synchronization Signal) data can be enabled using the "Enable Equalization" option (available

in the Analysis Params tab of the Settings Control panel.) This Equalization is based on PSS data and applied on other parts of the
OFDM symbol.

Reference Signal Power (TDD and FDD)
Reference Signal Power measures the power of cell specific reference signals. Reference signals are spread across time and frequency.
Reference signal position is dependent on the Cell ID, bandwidth, and antenna ports. For Downlink TDD (frame structure type 2), the
position of reference signals is also dependent on uplink-downlink and special subframe configurations.

Toff (TDD)
The Toff measurement is done only for the TDD signal. It is a measure of the off slot power in a LTE TDD signal.

More information about this measurement:

• Select the Channel Power and TDD Toff Power test setup from Presets > Standards > LTE to perform the measurement. This will load
the displays found in the LTE preset test setups table.

• This test setup allows you to select the frame structure and channel bandwidth with the following restrictions:

• Frame Structure can be TDD or FDD
• Channel Bandwidth can be 1.4, 3, 5, 10, 15, or 20 MHz

• Analysis of the LTE signals is done based on the settings you choose in the Standards Presets.
• By default, the Toff measurement is the average of several non-overlapping and adjoining 70 μs windows in the off slot region. This

measurement is done only on the 70 μs window in the center of the off slot region, when the Average over entire offslot region
option is disabled.

• The scalar result is presented in dBm/MHz.
• The result is compared against limits that can be defined using the Limits tab of the control panel. By default, these limits are set based

on the Base Station conformance testing document (3GPP TS 36.141 v12.5 – for Release 12). Pass/fail is shown in the top left corner
of the LTE Power vs Time display.

LTE Status Messages
The following status messages may appear. Each message indicates the related condition (Description) shown in the following table.
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Status message Description

LTE Analysis: Signal must be triggered or measured in
Real Time

Shown in the display and status bar when the user attempts to make the ACLR
measurement and SEM measurement for TDD signals in non-Real-Time mode
and when the instrument is in free run.

Since the standard recommends the ACLR measurement to be done in
transmitter ON periods only, either the measurement has to be done in Real-
Time mode (in which a detection module ensures the measurement is done on
the transmitter ON period) or has to be externally triggered if in non-Real-Time
mode.

LTE Analysis: Recovery done on PSS/SSS on the center
62 carriers

Shown in the status bar to indicate that the constellation of PSS and SSS
shown in the LTE constellation is done based on analysis of PSS and SSS
signals in the center 62 carriers of the corresponding OFDM symbols.

Therefore, you may see the correct constellation and Cell ID even when a
different channel bandwidth is chosen from the control panel because the
analysis for PSS and SSS is done only on the center carriers.

LTE Analysis: Analysis Failure - Synchronization
Sequence not found

Shown in the status bar to indicate that a valid Cell ID (from PSS and SSS) is
not detected.

LTE ACLR display
The LTE Adjacent Channel Leakage Ratio (ACLR) display shows the ratio of the mean power centered on the assigned channel frequency
to the mean power centered on an adjacent channel frequency. In the 3GPP specification, both the main channel and adjacent channels
are required to be filtered with RRC (Root Raised Cosine) filters.

To show the LTE ACLR display you can select Presets > Standards > LTE.

Note: Loading the LTE ACLR display from the Presets > Standards > LTE menu is recommended. This loads the control settings
based on the selected options.

You can also load the LTE ACLR display as follows:

1. Recall an appropriate acquisition data file.
2. Press the Displays button or select Setup > Displays.
3. In the Select Displays window, select LTE Analysis in the Measurements box.
4. In the Available displays box, double-click the LTE ACLR icon or select the icon and click Add. The LTE ACLR icon will appear in the

Selected displays box and will no longer appear under Available displays.
5. Click the OK button to show the display.
6. Select Setup > Settings to display the control panel.
7. Select Replay/Run to take measurements on the acquired data.
8. Press the Replay/Run button to take measurements on the acquired data.

Elements of the Display
The following image shows the LTE ACLR display.
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Item Display element Description

A Pass/Fail Indicates Pass or Fail based on Absolute and Relative limits set by the user. The failure
condition is set by Mask in the Offset and Limits Table tab of the Settings control panel. By
default, the mask is set to Abs & Rel, meaning failure is reported only when both absolute
and relative results fail against the respective limits.

B Ref Detection Set to Avg (VRMS) or +Peak based on the choice made in Processing tab of the Settings
control panel.

C Normal Indicates how the result is presented over multiple sweeps. This selection is made in the
Processing tab of the control panel. Displays Average Count if Avg (VRMS) is checked in
the Processing tab in the Settings control panel.

D Clear Resets measurement. Clears all values.

E Plot Shows the reference channel and adjacent channels and the regions in between them.
The Absolute and Relative limit lines are also shown. The integrated power is shown as a
band. Scalar results are also shown.

F Span Adjust the span of the graph in symbols.

Table continued…
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Item Display element Description

G Results Table Tabulates the results in each adjacent band. Table shows the offset, bandwidth, Integrated
Absolute and Relative power in the upper and lower adjacent channel regions.

H CF Center Frequency at which the measurement is performed.

I Ref Total Power Gives the power in the Reference channel.

J Autoscale Adjusts the vertical and horizontal settings so that the entire trace fits in the graph.

K Bottom readout Displays the value indicated by the bottom of graph.

L dB / div Shows the dB per each division in the Y axis of the plot.

(not
shown)

Units Sets the global Amplitude units for all the views in the analysis window. This will change
the amplitude selection in the Units tab of the Amplitude control panel.

M Top of graph The vertical scale is normalized with appropriate power units.

N Expand button Shows the results table in its own window with larger font size.

Clicking on the Expand button allows you to view the results table in a separate window, as shown in the following image.

LTE ACLR Settings
Main menu bar: Setup > Settings

The LTE ACLR Settings control panel provides access to settings that control parameters of the LTE ACLR display. 

Settings tab Description

Channels Allows you to control how the measurement is performed. When in Real Time, the RBW and VBW
settings apply for all channels (including offset regions) and the other parameters apply only for the
reference channel. When Non-Real Time mode is selected, all information in this tab, including RBW
and VBW, only applies to the reference channel.

Parameters Specifies several characteristics that control how the measurement is made. These parameters are
used by the instrument to analyze the input signal.

Table continued…
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Settings tab Description

Processing Specifies settings for detection on the reference channel and the offsets. Specifies the function setting
on how calculations are done across multiple sweeps.

Offsets & Limits Table Allows you to select the characteristics of offsets and mask limits.

Scale Specifies the vertical and horizontal scale settings.

Prefs Allows you to select to show or hide the graticule, power level, limits, and marker readouts.

LTE Channel Spectrum display
The LTE Channel Spectrum display shows the spectrum of the input signal across one channel. Channel power measures the average
power within the selected bandwidth and is expressed in dBm. Other units can be selected from the Units tab of the Analysis control panel.
The measured occupied bandwidth is calculated as the bandwidth containing 99% of the total integrated power within the selected span
around the selected center frequency.

To show the LTE Channel Spectrum display:

1. Recall an appropriate acquisition data file.
2. Press the Displays button or select Setup > Displays.
3. From the Measurements box, select LTE Analysis.
4. Double-click the LTE Channel Spectrum icon in the Available Displays box. This moves the LTE Channel Spectrum icon to the

Selected displays box.
5. Click OK button to view the display.
6. Select Setup > Settings to display the control panel.
7. Select Replay/Run to take measurements on the acquired data.
8. Press the Replay/Run button to take measurements on the acquired data.

Elements of the Display
The following image shows the LTE Channel Spectrum display.
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Item Display element Description

A Normal Displays Average Count if Average is turned on (set to Time Domain or Frequency
Domain) from the Measurement Params tab in the Settings control panel.

B Clear Resets measurement. Clears all values.

C Plot Specifies the value shown at the center of the graph display.

D Scale Adjust the span of the graph.

E Position Displays the horizontal position of the trace on the graph display.

F Scalar results Shows the Channel Power and Occupied Bandwidth measurement results.

G Autoscale Adjusts the vertical and horizontal settings so that the entire trace fits in the graph.

H Bottom readout Displays the value indicated by the bottom of graph.

I dB / div Shows the dB per each division in the Y axis of the plot.

(not
shown)

Units Sets the global Amplitude units for all the views in the analysis window. This will change
the amplitude selection in the Units tab of the Amplitude control panel.

J Top of graph The vertical scale is normalized with appropriate power units.
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LTE Channel Spectrum Settings
Main menu bar: Setup > Settings 

The settings for the LTE Channel Spectrum display are shown in the following table.

Settings tab Description

Freq & RBW Allows you to specify the frequency and resolution bandwidth used for the measurement.

Measurement Params Allows you to set averaging (Time Domain, Off, or Frequency Domain) and to set the number value
associated with the Average setting.

Channels Allows you to set the Channel BW for the Channel Power measurement.

Scale Allows you to specify the horizontal and vertical scale settings.

Prefs Allows you to select to show or hide certain display elements.

LTE Constellation display
The LTE Constellation display shows the constellation of Primary (PSS) and Secondary (SSS) Synchronization Signals. Scalar results
include Cell ID, Group ID, Sector ID, and frequency error.

1. Recall an appropriate acquisition data file.
2. Press the Displays button or select Setup > Displays.
3. In the Select Displays dialog, select LTE Analysis in the Measurements box.
4. In the Available displays box, double-click the LTE Constellation icon or select the icon and click Add. The LTE Constellation icon will

be added to the Selected displays box and will no longer appear under Available displays.
5. Click OK to show the display.
6. Select Replay/Run to take measurements on the acquired data.
7. Press the Replay/Run button to take measurements on the acquired data.

Elements of the Display
The following image shows the LTE Constellation display.
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Item Display element Description

1 Scalar results Gives results of Cell ID, Group and Sector ID information along with Frequency error.

2 Marker readout Shows marker type, magnitude, phase and subcarrier number.

3 Status message Shows relevant status messages.

(You can read about status messages here.)

4 Plot Displays PSS and SSS (Primary and Second Synchronization Signal) constellation.

LTE Constellation Settings
Main menu bar: Setup > Settings 

The settings for the LTE Constellation display are shown in the following table.

Settings tab Description

Modulation Params Specifies the frame structure and channel bandwidth.

Analysis Params Allows you to enable Equalization based on PSS (Primary Synchronization Signal).

Analysis Time Specifies parameters that define the portion of the acquisition record that is used for analysis.
Also allows you to specify the Units (Symbols or Seconds) and Time Zero Reference (Trigger or
Acquisition Start) for LTE Analysis displays.

Trace Allows you to set the display characteristics of the traces.

Scale Specifies the vertical and horizontal scale settings.
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LTE Power vs Time display
The LTE Power vs Time display shows the filtered power of the data and marks where the TOFF measurement is done. The TOFF scalar
results are also shown.

You can select Presets > Standards > LTE to view the display.

Note: Loading the LTE Power vs Time display from the Presets > Standards > LTE menu is recommended. This loads the
control settings based on the selected options.

You can also load the LTE Power vs Time display as follows:

1. Recall an appropriate acquisition data file.
2. Press the Displays button or select Setup > Displays.
3. In the Select Displays dialog, select LTE Analysis in the Measurements box.
4. In the Available displays box, double-click the LTE Power vs Time icon or select the icon and click Add. The LTE Power vs Time icon

will be added to the Selected displays box and will no longer appear under Available displays.
5. Click OK to show the display.
6. Select Replay/Run to take measurements on the acquired data.
7. Press the Replay/Run button to take measurements on the acquired data.

Elements of the Display
The following image shows the LTE Power vs Time display.
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Item Display element Description

A Pass / Fail Shows Pass or Fail based on whether the TOFF measurement (off slot power) is below the
recommended limit set in the Limit tab of the Settings control panel or not. The Pass/Fail
information is displayed only when the chosen frame structure if TDD and if a valid off slot
is found.

B Plot Displays the filtered signal in case of TDD and the region in which the off slot power is
measured is graphically shown. When the frame structure is chosen as FDD, the power in
the input signal is displayed.

C Scale Adjust the span of the graph in symbols.

D Analysis Start Gives the start of analysis region.

E Toff The TOFF (off slot power) is measured and displayed here when a valid off slot is found for
a TDD signal.

F Autoscale Adjusts the vertical and horizontal settings so that the entire trace fits in the graph.

G Bottom readout Displays the value indicated by the bottom of graph.

H dB / div Shows the dB per each division in the Y axis of the plot.

(not
shown)

Units Sets the global Amplitude units for all the views in the analysis window. This will change
the amplitude selection in the Units tab of the Amplitude control panel.

I Top of graph The vertical scale is normalized with appropriate power units.

LTE Power vs Time Settings
Main menu bar: Setup > Settings 

The settings for the LTE Power vs Time display are shown in the following table.

Settings tab Description

Modulation Params Specifies the frame structure and channel bandwidth.

Analysis Time Specifies parameters that define the portion of the acquisition record that is used for analysis.
Also allows you to specify the Units (Symbols or Seconds) and Time Zero Reference (Trigger or
Acquisition Start) for LTE Analysis displays.

Prefs Allows you to select to show or hide the graticule and marker readouts.

Scale Specifies the vertical and horizontal scale settings.

Limit Specifies the mask limits.
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LTE Analysis Measurement Settings
Main menu bar: Setup > Settings

The control panel tabs in this section are shared between the displays in LTE Analysis (Setup > Displays). Some tabs are shared by all the
displays and some tabs are shared by only a subset of displays. The settings available on some tabs change depending on the selected
display.

Table 27: Controls for LTE Analysis displays

Settings tab Description

Modulation Params Allows you to set the frame structure and channel bandwidth.

Available for these displays: LTE Power vs Time, LTE Constellation.

Analysis Params Allows you to enable Equalization based on PSS (Primary Synchronization Signal).

Analysis Time Specifies parameters that define the portion of the acquisition record that is used for analysis. Also
allows you to specify the Units (Symbols or Seconds) for LTE Analysis displays.

Available for these displays: LTE Power vs Time, LTE Constellation.

Trace Specifies the trace type (Vectors, Points, and Lines), the number of points per symbol when chosen to
view as Vectors or Lines, and to control the view as Freq Dev or IQ.

Available for the LTE Constellation display only.

Prefs Allows preferences with Radix display and marker readouts.

Available for these displays: LTE Power vs Time, LTE ACLR, LTE Channel Spectrum, SEM.

Scale Defines the vertical and horizontal axes.

Available for all LTE displays.

Offsets & Limits Table Note: Available for the LTE ACLR display only.

Freq & RBW Specifies the frequency and resolution bandwidth used for the measurement.

Note: Available for the LTE Channel Spectrum display only.

Parameters Specifies several characteristics that control how the measurement is made.

Processing Specifies settings for detection on the reference channel and the offsets. Specifies the function setting
on how calculations are done across multiple sweeps.

Limit Allows you to define limits for pass/fail comparison with calculated values. The default values are as
recommended in the test specification.

Table continued…
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Settings tab Description

Channels Specifies the Channel BW for the Channel Power measurement. Allows you to set RBW, VBW, power
reference, as well.

Available for these displays: LTE ACLR, LTE Channel Spectrum.

Measurement Params Allows you to set averaging (Time Domain, Off, or Frequency Domain) and to set the number value
associated with the Average setting.

Channels tab - LTE
The Channels tab allows you to control how the measurement is performed.

The following image shows the Channels tab for the LTE ACLR display. When in Real Time, the RBW and VBW settings apply for all
channels (including offset regions) and the other parameters such as Power Reference, Channel Width, and Integrated bandwidth apply
only to the reference channel. When Non-Real Time mode is selected, all information in this tab, including RBW and VBW, only applies to
the reference channel.

Settings Description

Reference

Power Reference The value used to calculate relative measurements. When Auto is selected, the calculated
reference channel power is displayed. When Auto is unchecked, you can enter a value for
the reference power, and the measured reference power is not used or displayed.

Channel Width Specifies the width of the reference channel.

Integration BW Specifies the integration bandwidth used to compute the total power in the reference
channel.

All Channels (displayed for Real-Time mode)

Reference Channel (displayed for Non-Real Time mode)

RBW Sets the RBW

Table continued…
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Settings Description

VBW Enables/disables the Video Bandwidth filter. VBW is used in traditional swept analyzers
to reduce the effect of noise on the displayed signal. The VBW algorithm in the analyzer
emulates the VBW filters of traditional swept analyzers. When the check box next to VBW is
not checked, the VBW filter is not applied.

The maximum VBW value is 10 times the current RBW setting. The minimum VBW value is
1/10,000 of the RBW setting.

The following image shows the Channels tab for the LTE Channel Spectrum display. This tab allows you to set the channel bandwidth,
which in turn sets the span for LTE Channel Spectrum.

Settings Description

Channel Bandwidth Specifies the Channel Bandwidth, which in turn sets the span of the LTE Channel Spectrum.

Parameters tab - LTE
The Parameters tab enables you to specify several parameters that control the LTE ACLR measurements are made.

Setting Description

Meas Freq Specify the frequency of the signal to be measured.

Step Sets the increment size when changing the Frequency using the knob or mouse wheel. Auto: When
Auto is enabled, the step size is adjusted automatically based on the span setting.

Real-Time When Real-Time mode is enabled, the entire LTE ACLR span is measured using a real-time/
contiguous acquisition. Not all described parameters are available in Real-Time mode.

When Real-Time is disabled (non-Real-Time mode), a separate acquisition for each region is taken
and analyzed. Non-Real-Time mode is also useful when the bandwidth offered by the instrument
does not support the span requirement for this measurement. The span requirement is guided by the
choice of adjacent channel type and channel bandwidth selected in LTE Standards Presets.

Table continued…
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Setting Description

Measure Noise Floor Takes preliminary acquisitions to measures the instrument noise floor. This initiates a noise correction.
A noise correction signal is created by switching off the RF input and performing acquisitions of the
instrument’s internal noise. Fifty acquisitions are averaged to create the noise reference signal. The
noise reference signal is measured for the Reference channel and each Offset is defined by the
measurement settings.

Apply noise correction This item is enabled and the check box automatically checked after the noise reference signal is taken
when the Measure Noise floor button is clicked. This initiates noise reference subtraction from the
incoming signal power for each region to create the corrected result. All calculations are performed in
Watts and then converted to the desired units.

The amount of noise correction is limited to 20 dB to avoid the possibility of a negative power
measurement. This is a rare condition that could occur if the subtraction of the reference power from
the channel power results in a negative value (or “infinite” dBm). The noise reference for a region is
subtracted from each trace point in the channel, rather than offsetting the entire region by a single
amount. This produces a smooth trace with no discontinuities at the region edges.

Note: If any relevant settings (such as reference level, frequency, span, RBW) are changed
once the noise reference is measured, the following warning message will be displayed
to notify you that Noise Correction was not applied: Noise correction not applied - select
Measure Noise Floor for new noise correction.

Filter shape Specifies the shape of the filter determined by the window that is applied to the data record, in the
spectrum analysis, to reduce spectral leakage. 3GPP specifies a Gaussian window shape be applied
to the reference channel measurements.

Gaussian: This filter shape provides optimal localization in the frequency domain.

Rectangular: This filter shape provides the best frequency, worst magnitude resolution. This is
essentially the same as no window.

Processing tab - LTE
The Processing tab controls the detection settings for the Reference Channel and Offsets, as well as selecting the function for the LTE
ACLR display.

Setting Description

Detection (in each sweep)

Reference Channel Specifies the Detection method used for the Reference Channel. Detection is used to produce the
desired measurement result (peak or average) and to reduce the results of a measurement to the
desired number of trace points.

Table continued…
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Setting Description

Avg (VRMS) For each sweep, each point of the trace is the result of determining the RMS voltage value for the
last 'n counts' of the collected traces for the same point. When 'n count' has not been reached, partial
averaging results are displayed.

+Peak Selects the +Peak detection method. With this method, the highest value is selected from the results
to be compressed into a trace point.

Offsets Specifies the detection method used for the offsets.

Avg (VRMS) Selects the Average Vrms detection method. With this method, each point on the trace in each offset
is the result of determining the RMS Voltage value for all of the results values it includes.

+Peak Selects the +Peak detection method. With this method, the highest value is selected from the results
to be compressed into a trace point.

Function (across multiple sweeps)

Normal When a new trace has been computed, it replaces the previous trace.

Max Hold With each sweep, each trace point in the new trace is compared to the point’s value in the old trace
and the greater value is retained for display and subsequent comparisons.

Avg (VRMS) For each sweep, each point on the trace is the result of determining the RMS Voltage value for all of
the collected traces' values for the same point.

Count Enter the Avg (VRMS) value. Displayed only when Avg (VRMS) is selected.

Offsets and Limits Table tab - LTE
The Offsets and Limits Table tab is used to specify parameters that define Offsets and masks for the LTE ACLR display. The following
images show the tab and expanded view of the tab, respectively.

The following image shows the Offsets and Limits Table tab when Real-Time is selected in the Parameters tab.

The following image shows the Offsets and Limits Table tab when Real-Time is not selected in the Parameters tab (referred to as
non-Real-Time mode).

The following image shows the expanded view of the Offsets and Limits Table (click the Expand button to view).
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Setting Description

Buttons

Expand (button) Displays the Offsets and Limits Table in a new, resizable window.

Reset Layout Allows you to reorder columns in the Offsets & Limits Table by dragging the columns to a new
position. Clicking Reset Layout returns the column order to the factory default order.

Load Click to load a saved Offsets & Limits table from a file.

Save As Click to save the current Offsets & Limits table to a file.

Done When the table is expanded, click Done when you have finished editing the table to save your
changes and close the expanded table display.

Table columns

On Specifies whether or not measurements are taken in the specified offset.

Freq Offset (Hz) Specifies the frequency offset for the offset region (adjacent channel region) from the Center
frequency of the Reference Channel. This offset is always specified from the center frequency of
the Reference Channel to the center frequency of the Offset region.

Start (Hz) Start Frequency of the selected offset.

Stop (Hz) Stop Frequency of the selected offset.

Bandwidth (Hz) Specifies the bandwidth of the Offset region.

Side Specifies whether the specified range appears on both side of the carrier frequency or just one side
(left or right).

RBW (Hz) Specifies the RBW for the selected range.

n(RBWS) An integer value that specifies how many times to multiply the RBW to set the Filter bandwidth.

Filter BW (n x RBW) Displays the Filter BW. Filter BW is the equivalent BW of each point in the offset. When n > 1, an
integration technique is used to achieve the Filter BW using narrower RBWs.

VBW (Hz) Adjusts the VBW (Video Bandwidth) value. VBW Maximum: RBW current value; VBW Minimum:
1/10,000 RBW setting.

Table continued…
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Setting Description

Buttons

VBW (On) Specifies whether the VBW filter is applied.

Mask Select the type of limits used for Pass/Fail testing. Signal excursions that exceed the mask settings
are considered violations. The available choices are Abs, Rel and Abs & Rel.

Abs Limit (dBm) The offset region integrated power is compared against the Abs Limit value mentioned here.

Rel Limit (dB) The offset region integrated power relative to the reference channel integrated power is compared
with this limit.

Scale tab - LTE
The Scale tab allows you to change the scale settings that control how the trace appears on the display but does not change control
settings. In effect, these controls operate like pan and zoom controls. The Scale tab values are unique to each display. Also, note that each
display uses horizontal and vertical units that are appropriate for that display. There are three versions of the Scale tab for LTE displays.

The following image shows the Scale tab for the LTE Power vs Time display.

Settings Description

Vertical Controls the vertical position and scale of the trace display.

Scale Changes the vertical scale units.

Position Adjusts the reference level away from top of the graph.

Reset Resets the scale of the vertical axis to default values.

Horizontal Full Burst Controls the horizontal span.

Start Specifies the horizontal axis start point.

Stop Specifies the horizontal axis end point.

Reset Resets the scale of the horizontal axis to default values.

The following image shows the Scale tab for the LTE Channel Spectrum and LTE ACLR displays.
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Settings Description

Vertical Controls the vertical position and scale of the trace display.

Scale Changes the vertical scale units.

Position Adjusts the reference level away from top of the graph.

Autoscale Resets the scale of the vertical axis to contain the complete trace.

Horizontal Controls the horizontal span of the trace display and position of the trace.

Scale Specifies the frequency range displayed in the graph

Position Specifies the frequency shown at the center of the graph.

Autoscale Resets the scale of the horizontal axis to optimize the display of the trace.

Reset Scale Resets all settings to their default values.

The following image shows the Scale tab for the LTE Constellation display.

Settings Description

Zoom

Scale Zooms in and out of the constellation. As the scale is increased, it will zoom out.

Vertical Position Adjusts the vertical position.

Horizontal Position Adjusts the horizontal position.

Prefs tab - LTE
The Prefs tab enables you to change parameters of the measurement display. The parameters available on the Prefs tab vary depending
on the selected display, but include such items as enabling/disabling Marker Readout and switching the graticule display on/off. Some
parameters appear with most displays, while others appear with only one display.
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The following image shows the Prefs tab for the LTE ACLR display.

The following image shows the Prefs tab for the LTE Channel Spectrum display.

The following image shows the Prefs tab for the LTE Power vs Time display.

Setting Description

Show graticule Shows or hides the graticule.

Trace / Max Trace points When the spectrum analysis produces more than the selected maximum number of points, the
method specified in Detection control is used to decimate the result. This setting applies to both the
reference channel and offsets.

Show Marker readout in graph
(selected marker)

Shows or hides the readout for the selected marker in the graph area.

Show Power Levels In Graph This display the power level (calculated integrated power in the offset region) in the graph.

Show limits

Shaded Shows limits using a shaded area. Absolute limit and Relative limit shading colors can be set under
Presets > Options.

Line only Shows limits using only a line. Absolute limit and Relative limit line colors can be set under Presets >
Options.

Table continued…
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Setting Description

None No lines or shading are used to indicate limits in the graph. Violations of the mask are still identified by
red shading.

Average Over Offslot Enables for averaging of offslot power in non-overlapping 70 μs windows in the entire offslot region.
If this option is disabled, the off slot power is measured only in the center 70 μs window of the offslot
region.

Freq and RBW tab - LTE
The Freq and RBW tab specifies frequency parameters for the Channel Power and ACPR measurements and the MCPR measurement. It
is available for the LTE Channel Spectrum display. 

Settings Description

Meas Freq Specifies the center/measurement frequency

RBW Select Auto or Manual. Adjusts the RBW for the entire measurement. This setting is
Independent of the Spectrum view's RBW setting.

Auto: When Auto is enabled, the step size is adjusted automatically based on the span
setting.

Step The Step control sets the increment/decrement size for the adjustment of the center
frequency. If Auto is enabled, the analyzer will adjust the Step size as required.

Auto: When Auto is enabled, the step size is adjusted automatically based on the span
setting.

VBW Adjusts the Video Bandwidth value.

The maximum VBW value is 10 times the current RBW setting. The minimum VBW value is
1/10,000 of the RBW setting.

Measurement Params tab - LTE
The Measurement Params tab allows you to set parameters that control the ACPR and MCPR measurements. This is available for the LTE
Channel Spectrum display.
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Settings Description

Average

Off

Frequency-domain This setting takes the average linear value of the traces (so that RMS values are preserved).
The number of averages is user-defined. Frequency domain averaging is available in spans
larger (or smaller) than the maximum real time bandwidth. This is the mode to use unless
you need to extract maximum dynamic range from an ACPR measurement.

Time-domain This setting takes the average linear value of the traces. It is useful if you need to extract
maximum dynamic range from an ACPR measurement. The number of traces is user
defined, however, the signals must be triggered and repeating (meaning the signal needs
to be exactly the same for each acquisition). When this condition is met, each waveform
contains the same signal, but the random noise changes from acquisition to acquisition
and the average value of the random noise is lowered, while the signal value remains
constant. Time domain averaging is not available in spans wider than the maximum real-time
bandwidth.

Modulation Params tab - LTE
The Modulation Params tab specifies the type of modulation used by the input signal and other parameters that define the signal format.
This tab is available for the LTE Constellation and Power vs Time displays.

Settings Description

Frame Structure Select the frame structure to set how the demodulation is done.

Downlink FDD Downlink Frequency Division Duplexing

Downlink TDD Downlink Time Division Duplexing

Table continued…
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Settings Description

Auto Detect If checked, Channel Bandwidth and Cyclic Prefix are automatically detected. It will also
detect the TDD Configuration when Downlink TDD is the selected frame structure.

Channel Bandwidth Select from 6 bandwidths: 1.4, 3, 5, 10, 15, 20 MHz

(If Auto Detect is checked, the channel bandwidth is automatically calculated.)

Cyclic Prefix Select Normal or Extended.

TDD Configuration

Uplink-Downlink Select from 0 to 6. The configuration determines the appropriate downlink to uplink
switch periodicity.

Special Subframe Select from 0 to 9. This configuration determines the number of downlink pilots, guard
period, and uplink pilots between uplink to downlink switch.

Antenna Ports

Total Antenna Ports Select from 1 to 4. This is the total number of antenna ports.

Chosen Port Select the antenna port from which the signal is captured.

Analysis Params tab - LTE
The Analysis Params tab allows you to enable equalization on the demodulated LTE packet. The equalization is based on PSS (Primary
Synchronization Signal). This tab is only available for the LTE Constellation display.

Settings Description

Enable Equalization Allows you to enable Equalization based on PSS (Primary Synchronization Signal).

Analysis Time tab - LTE
The Analysis Time tab contains parameters that define how the signal is analyzed in the LTE Analysis displays. This tab is available for the
LTE Constellation and Power vs Time displays.
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Settings Description

Analysis Offset Specifies the location of the first time sample to use in measurements.

Auto When enabled, causes the instrument to set the Analysis Offset value based on the requirements of
the selected display.

Analysis Length Specifies the length of the analysis period to use in measurements. Length is specified in either
symbols or seconds, depending on the Units setting.

Auto When enabled, causes the instrument to set the Analysis Length value based on the requirements of
the selected display.

Actual This is a displayed value, not a setting. It is the Analysis Length (time or symbols) being used by the
analyzer. This value may not match the Analysis Length requested (in manual mode).

Time Zero Reference Specifies the zero point for the analysis time.

Units Specifies the units of the Analysis Length to either Symbols or Seconds.

Analysis Offset
Use analysis offset to specify where measurements begin. Be aware that you cannot set the Analysis Offset outside the range of time
covered by the current acquisition data. (All time values are relative to the Time Zero Reference.)

You can set the Analysis Length so that the requested analysis period falls partly or entirely outside the current range of acquisition
data settings. When the next acquisition is taken, its Acquisition Length will be increased to cover the new Analysis Length, as long as
the Sampling controls are set to Auto. If the Sampling parameters are set to manual, or if the instrument is analyzing saved data, the
actual analysis length will be constrained by the available data length, but in most cases, measurements are able to be made anyway.
The instrument will display a notification when measurement results are computed from less data than requested. Range: 0 to [(end of
acquisition) - Analysis Length)]. Resolution: 1 effective sample (or symbol).

Analysis Length
Use the analysis length to specify how long a period of time is analyzed. As you adjust this value, the actual amount of time for Analysis
Length, in Symbol or Seconds units, is shown below the control in the "Available" readout. This setting is not available when Auto is
checked. Range: minimum value depends on the standard. Resolution: 1 symbol.

Time Zero Reference
All time values are measured from this point (such as marker position or horizontal position (in Y vs Time displays). Choices are:
Acquisition Start or Trigger.

Parameter Description

Acquisition Start Time zero starts from the point at which the acquisition begins.

Table continued…
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Parameter Description

Trigger Time zero starts from the trigger point.

Trace tab - LTE
The Trace tab allows you to set the trace display characteristics of the LTE Constellation display.

Setting Description

> The arrow indicates which measurement name is active so that you can check it (on) or uncheck it
(off).

On Check the box next the measurement name you want to turn on.

Measurement Name Selections are PSS (Primary Synchronization Signal) or SSS (Secondary Synchronization Signal)

Limit tab - LTE
The Limit tab is only available for the LTE Power vs Time display. It enables you to specify the limit used for comparison against measured
values of Toff measurement.

Setting Description

Toff psd Specifies the limit that is used for comparison against measured values of Toff measurement. Pass/
Fail is determined with this limit.
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5GNR Analysis
Overview
The 5GNR RF Measurement Analysis option allows you to evaluate RF signals to ensure that they meet 3GPP measurement
specifications. These are described in the Base Station (BS) radio transmission and reception and test specifications Base Station
(BS) conformance testing documents version 15. This analysis option supports both Uplink and Downlink frame structures. This analysis
option supports the following measurements:

Modulation Accuracy (ModACC) - It measures the deviation of the received symbol relative to the ideal transmitted symbol. The IQ data
is processed to identify the OFDM Symbol boundaries and FFT is performed using the various settings under the Modulation Accuracy
tab. The subcarrier data is equalized and then Data and DMRS are extracted to perform various EVM measurements as per the 3GPP
specifications and then used for display in Constellation Display. The Estimation tab provides advanced settings related to IQ Impairments
and Frequency Offset estimation and corrections.

Channel Power (CHP) - This measurement is used to verify the maximum carrier output power across the frequency range. It includes
the measurement of individual carrier power under carrier aggregation mode. The Integrated Bandwidth type can be selected between
Channel and Signal Bandwidth to include or remove the Guard Bands between the carriers respectively.

Adjacent Channel Power (ACP) - It measures the power leakage from the carrier channels into the neighboring frequency channels,
commonly referred to as offset channels. The RBW, Sweep time, and Spectral Window can be selected from the measurement options tab.
By default, 2 offset channels are enabled for the measurement.

Spectral Emission Mask (SEM) – It measures the spurious emissions of a transmitter in the immediate frequency bands and compares
against the limit chosen in the settings. The RBW settings and the width of the bands can be selected from the measurement options tab.
The predefined band settings as per 3GPP are also provided in the options.

You can also select these measurements from four 5GNR preset test setups. The test setups load pre-configured displays and control
setting as suggested by the standard to accelerate the test setup of the analyzer. The following four test setups are available for this
analysis option.

1. Modulation Accuracy
2. ACP
3. CHP
4. SEM

For more detailed information about these test setups, clickhere.

With the 5GNR RF Measurement Analysis test suite, test engineers can simplify the execution of several transmitter tests while still
enabled to modify signal parameters for in-depth signal analysis.

The analysis results give multiple views of 5GNR signal characteristics to allow the diagnosis of signal imperfections and impairments
quickly and easily. Display controls allow you to selectively display the analysis results to help locate trouble spots in the signal.

5GNR Analysis topics in this Help
The following information about the 5GNR Analysis option is available:

Supported 5GNR measurements

5GNR measurements

5GNR standard preset test setups

5GNR displays

5GNR measurement analysis settings
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Supported 5GNR measurements
The following table gives a brief description of the available 5GNR measurements. More detailed information can be found here.

Table 28: 5GNR Measurements

5GNR Measurement 5GNR Standard(s) Description
Modulation accuracy Sec 6.5.2 for BS and Sec

6.4.2 for UE.
It measures the deviation of the received symbol relative to the ideal transmitted
symbol.

ACP Sec 6.6.3 for BS and Sec
6.5.2.4 for UE

It measures the power leakage from the carrier channels into the neighboring
frequency channels.

CHP Sec 6.2 for BS and Sec
6.3 for UE

It measures the RMS power within the carrier channel bandwidth.

SEM Sec 6.6.5 for BS and Sec
6.5 for UE

It measures spurious out-of-band emissions in the immediate neighboring bands
of the carrier.

5GNR Standards preset test setups
Presets > Standards

The 5GNR Standards preset allows you to access displays preconfigured for the selected test setup. The test setups load the displays and
control setting options suggested by the 5GNR standard to perform the measurements.

There are four test setups for 5GNR:

1. Modulation Accuracy

2. ACP
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3. CHP

4. SEM
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The following table lists the default configurations loaded with each test setup.

Table 29: 5GNR Preset Test Setups

Test setup Displays loaded with preset
Modulation accuracy Link Direction-

• Uplink
• Downlink

(Default is Uplink)

• Spectrum
• Time Overview
• NR Constellation
• NR Summary

Number of Component Carrier:1, 2,3, 4, 5, 6, 7, and 8

(Default is 1)

Channel Bandwidth: 5, 10, 15, 20, 25, 30, 40, 50, 60,
70, 80, 90, 100, 200, and 400 MHz

(Default is 100 MHz)

Sub Carrier Spacing: 15, 30, 60, and 120 kHz

(Default is 30 kHz)

ACP Link Direction-

• Uplink
• Downlink

(Default is Uplink)

• Spectrum
• Time Overview
• NR Summary
• NR Adjacent Channel Power

Number of Component Carrier: 1, 2, 3, 4, 5, 6, 7, and
8

(Default is 1)

Channel Bandwidth: 5, 10, 15, 20, 25, 30, 40, 50, 60,
70, 80, 90, 100, 200, and 400 MHz

(Default is 100 MHz)

CHP Link Direction-

• Uplink
• Downlink

(Default is Uplink)

• Spectrum
• Time Overview
• NR Summary
• NR Channel Power

Number of Component Carrier:1, 2, 3, 4, 5, 6, 7, and 8

(Default is 1)

Channel Bandwidth: 5, 10, 15, 20, 25, 30, 40, 50, 60,
70, 80, 90, 100, 200, and 400 MHz

(Default is 100 MHz)

Table continued…

5GNR Analysis

SignalVu™ Vector Signal Analysis Software Printable Help 350



Test setup Displays loaded with preset
SEM Link Direction-

• Uplink
• Downlink

(Default is Uplink)

• Spectrum
• Time Overview
• NR Summary
• NR Spectral Emission Task

Number of Component Carrier: 1, 2,3, 4, 5, 6, 7, and 8

(Default is 1)

Channel Bandwidth: 5, 10, 15, 20, 25, 30, 40, 50, 60,
70, 80, 90, 100, 200, and 400 MHz

(Default is 100 MHz)

Retain current center frequency and reference level settings
The Retain current Center Frequency setting appears when the 5GNR Standards Preset is selected. Select the check box to retain the
previously used center frequency. By default, the Center Frequency settings box is unchecked.

The Retain current Ref Level setting appears when the 5GNR Standards Preset is selected. Select the check box to retain the
previously used reference level. By default, the Ref Level settings box is checked.

To activate these settings, select the check box next to the desired setting. The following image shows the Retain current Ref Level
setting box is selected.

5GNR displays
The displays in 5GNR Analysis (Setup > Displays > Measurements: 5GNR Analysis) are:

1. NR Adjacent Channel Power
2. NR Channel Power
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3. NR Constellation
4. NR Spectral Emission Mask
5. NR Summary

5GNR Measurements
The 5GNR RF Measurements Analysis option allows you to evaluate the RF signals and ensure that they meet 3GPP measurement
specifications.

Modulation Accuracy (ModACC) - It measures the deviation of the received symbol relative to the ideal transmitted symbol. The IQ data
is processed to identify the OFDM Symbol boundaries and FFT is performed using the various settings under the Modulation Accuracy tab.
The subcarrier data is equalized and then data and DMRS are extracted to perform various EVM measurements as per the 3GPP Spec
and then used for display in Constellation Display. The Estimation tab provides advanced settings related to IQ Impairments, Frequency
Offset estimation, and corrections.

Channel Power (CHP) - This measurement is used to verify the maximum carrier output power across the frequency range. It includes
the measurement of individual carrier power under carrier aggregation mode. The Integrated Bandwidth type can be selected between
Channel and Signal Bandwidth to include or remove the Guard Bands between carriers respectively.

Adjacent Channel Power (ACP) - It measures the power leakage from the carrier channels into the neighboring frequency channels,
commonly referred to as offset channels. The RBW, sweep time, and Spectral Window can be selected from the measurement options tab.
By default, 2 offset channels are enabled for measurement.

Spectral Emission Mask (SEM) – It measures the spurious emissions of a transmitter in the immediate frequency bands and compares
against the limit chosen in the settings. The RBW settings and the width of the bands can be selected from the measurement options tab.
Predefined band settings as per 3GPP are also provided in the options.

5GNR Status messages
The following status messages may appear. Each message indicates the related condition (Description) shown in the following table.

Status message Description
Analysis failure Signal analysis has failed.
Analyzing Signal analysis is in progress.
Stopped Acquisition/Analysis stopped.
Acquiring Signal acquisition is in progress.
Transfer IQ data is being transferred.
Setup error Configuration settings error
Acq BW too small for the current setup Bandwidth/Span lower than expected
Analysis length too small for the current setup Insufficient Data
Trigger position is before the analysis window The analysis window in the "Time Overview" display does not

include the trigger position
Insufficient Span or Incorrect Data for Analysis ACP display expects additional span or the data is incorrect

Cell ID Detected Cell ID detected for the Downlink 5GNR waveform in the
"Constellation" display

Not enough samples for the current setup The current configuration expects more samples
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NR Adjacent Channel Power display
The NR Adjacent Channel Power (ACP) display shows the power leakage from the carrier channels into the neighboring frequency
channels, known as offset channels.

To view the NR ACP display:

1. Select File > Recall to analyze a stored data file or go to the next step.
2. Select Setup > Displays.
3. In the Select Displays window, select 5GNR Analysis in the Measurements box.

4. In the Available displays box, double-click . This moves the NR Adjacent Channel Power icon to the selected displays
box.

5. Click OK to view the display.
6. Select Setup > Settings to display the control panel.
7. Select Replay/Run to take measurements on the acquired data.
8. If you are analyzing a data file, click Replay to take measurements on the recalled acquisition data file.

Elements of the display
The following image shows the NR ACP display.
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Item Display element Description
1 Clear Resets the measurement and clears all the values.
2 Plot Displays the reference channel(s) and adjacent channel(s) and the regions in between

them. The Absolute and Relative limit lines are also shown. The integrated power is
shown as a band. Scalar results are also shown.

3 Span Adjust the span of the graph in symbols.
4 Results table Tabulates the results in each adjacent band. The table shows the offset, bandwidth,

Integrated Absolute and Relative power in the upper and lower adjacent channel
regions.

5 CF Center Frequency at which the measurement is performed.
6 rel Opens relative adjacent channel power color palette.
7 Total Agg Power Displays the total aggregated power of all subblocks.
8 Autoscale Adjusts the adjacent channel power magnitude and frequency scale settings so that

the entire trace fits in the graph.
9 Lower limit in the display graph Displays the lower limit of the channel power in the graph.
10 dB/div Shows the dB per each division in the vertical axis of the plot.
11 Units of adjacent channel power Sets the global Amplitude units for all the views in the analysis window. This will

change the amplitude selection in the Units tab of the Amplitude control panel.
12 Upper limit of the display graph Displays the upper limit of the channel power in the graph.

NR Adjacent Channel Power display settings
Main menu bar: Setup > Settings

Favorites toolbar: 

The NR Adjacent Channel Power display settings control panel allows you to configure the settings of the NR adjacent channel power
display.

Settings tab Description
ACP Allows you to configure the ACP-specific properties.
Signal Configuration Allows you to configure the signal properties.
Subblock Configuration Allows you to configure the properties needed to analyze a subblock in 5G NR signal.
Carrier Configuration Allows you to configure the carrier properties.
Averaging Allows you to configure the averaging parameters.

NR Channel Power display
The NR Channel Power display shows the spectrum of the input signal across one channel. The channel power measures the RMS power
in the carrier channel in dBm. Other units can be selected from the Units tab of the Analysis control panel. 

To view the NR Channel Power display:

1. Select File > Recall to analyze a stored data file or go to the next step.
2. Select Setup > Displays.
3. In the Select Displays window, select 5GNR Analysis in the Measurements box.
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4. In the Available displays box, double-click . This moves the NR Channel Power icon to the selected displays box.
5. Click OK to view the display.
6. Select Setup > Settings to display the control panel.
7. Select Replay/Run to take measurements on the acquired data.
8. If you are analyzing a data file, click Replay to take measurements on the recalled acquisition data file.
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Elements of the display
The following image shows the NR Channel power display.

Item Display element Description
1 Clear Resets the measurement and clears all the values.
2 Span Adjust the frequency span of the graph in symbols.
3 Results table Displays each component carrier’s absolute and relative channel power.
4 CF Center Frequency at which the measurement is performed.
5 rel Opens relative channel power color palette
6 abs Opens absolute channel power color palette
7 Total Agg Power Displays total aggregated power of all the subblocks.
8 Autoscale Adjusts the channel power magnitude and frequency scale settings so that the entire trace

fits in the graph.
9 Lower Limit in the display

graph
Displays the lower limit of the channel power in the graph

10 dB / div Shows the channel power per division in the vertical axis of the plot.
11 Units for Channel Power Sets the global Amplitude units for all the views in the analysis window. This will change the

amplitude selection in the Units tab of the Amplitude control panel.
12 Upper Limit in the display

graph
Displays the upper limit of the channel power in the graph

13 Rel power level Displays the relative power level as a horizontal line in the user-selected color from the
palette

14 Abs power level Displays the absolute power level as a horizontal line in the user-selected color from the
palette
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NR Channel Power display settings
Main menu bar: Setup > Settings

Favorites toolbar: 

The NR Channel Power display control panel allows you to configure the settings of the NR Channel power display.

Settings tab Description
CHP Allows you to configure the CHP specific properties.
Signal Configuration Allows you to configure the signal properties.
Subblock Configuration Allows you to configure properties needed to analyze a subblock in 5G NR signal.
Carrier Configuration Allows you to configure the carrier properties.
Averaging Allows you to configure the averaging parameters.

NR Constellation display
Displays the demodulated and equalized OFDM subcarrier symbols. The same display area is shared for plotting Data (PUSCH/PDSCH)
and DMRS. The plot at a single instance shows a constellation graph for a single component carrier. You can select between different
component carriers.

To view the NR Constellation display:

1. Select File > Recall to analyze a stored data file or go to the next step.
2. Select Setup > Displays.
3. In the Select Displays window, select 5GNR Analysis in the Measurements box.

4. In the Available displays box, double-click . This moves the NR Constellation icon to the selected displays box.
5. Click OK to view the display.
6. Select Setup > Settings to display the control panel.
7. Select Replay/Run to take measurements on the acquired data.
8. If you are analyzing a data file, click Replay to take measurements on the recalled acquisition data file.

Elements of the Display
The following image shows the NR Constellation display.
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Item Display element Description
1 Scalar results Displays the selected component carriers Cell ID, Frequency Error, and EVM.
2 Plot Displays data (PUSCH / PDSCH) and DMRS.

NR Constellation settings
Main menu bar: Setup > Settings

Favorites toolbar: 

The NR Constellation display control panel allows you to configure the settings of the NR Constellation display.

Settings tab Description
Modulation Accuracy Allows you to configure the modulation accuracy-specific properties.
Estimation Allows you to configure the modulation accuracy Estimation properties.
Signal Configuration Allows you to configure the signal properties.
Subblock Configuration Allows you to configure properties needed to analyze a subblock in 5G NR signal.
Carrier Configuration Allows you to configure the carrier properties.
Averaging Allows you to configure the averaging parameters.
Traces Allows you to set the display characteristics of the traces.

NR Spectral Emission Mask display
The NR Spectral Emission Mask (SEM) display shows the margin of the emission level from the limit and reports the measurement status.
Spectral emission mask measurements measure out-of-band emissions in the neighboring bands of the carrier.

To view the NR SEM display:

1. Select File > Recall to analyze a stored data file or go to the next step.
2. Select Setup > Displays.
3. In the Select Displays window, select 5GNR Analysis in the Measurements box.

4. In the Available displays box, double-click  . This moves the NR Spectral Emission Mask icon to the selected displays
box.

5. Click OK to view the display.
6. Select Setup > Settings to display the control panel.
7. Select Replay/Run to take measurements on the acquired data.
8. If you are analyzing a data file, click Replay to take measurements on the recalled acquisition data file.
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Elements of the display
The following image shows the NR SEM display.

Item Display element Description
1 Clear Resets the measurement and clears all the values.
2 Scale Adjust the span of the graph.
3 Results table Displays the spectral emission mask results.
4 rel Displays the relative SEM color palette
5 abs Displays the absolute SEM color palette
6 Total Agg Power Displays the total aggregated power of all subblocks
7 Autoscale Adjusts the channel power magnitude and frequency scale settings so that the entire trace

fits in the graph.
Table continued…
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Item Display element Description
8 Lower limit in the display

graph
Displays the lower limit in the graph.

9 dB/div Displays the channel power per division in the vertical axis of the plot.
10 Units Sets the global amplitude units for all the views in the analysis window. This will change the

amplitude selection in the units tab of the amplitude control panel.
11 Upper limit in the display

graph
Displays the upper limit in the graph.

12 Pass/Fail Indicates Pass or Fail based on absolute and relative limits set by the user. The failure
condition is set by mask in the settings control panel.

13 Pass/Fail % Gives Pass/Fail offset regions to total offset regions in terms of percentage
14 Plot Shows the spectral emission offsets, masks, and the power in the offset region. The

absolute limit lines are also shown.
15 Pos Position in the frequency domain at which the measurement is performed.
16 Limit line (Blue in the plot) Displays the mask limit lines for the SEM measurement.

NR Spectral Emission Mask settings
Main menu bar: Setup > Settings

Favorites toolbar: 

The NR Spectral Emission Mask display control panel allows you to configure the settings of the NR Spectral Emission Mask display.

Settings tab Description
SEM Allows you to configure SEM specific properties.
Signal Configuration Allows you to configure Signal properties.
Subblock Configuration Allows you to configure properties needed to analyze a subblock in 5G NR signal.
Carrier Configuration Allows you to configure carrier properties.
Averaging Allows you to configure averaging parameters.

NR Summary display
Consolidated display of all the results from multiple selected measurements like Modulation Accuracy, CHP, SEM, and ACP. It provides an
option to save all the results to a “.csv” file. Additional results related to the Modulation Accuracy measurement are available here.

To show the NR Summary display:

1. Select File > Recall to analyze a stored data file or go to the next step.
2. Select Setup > Displays.
3. In the Select Displays window, select 5GNR Analysis in the Measurements box.

4. In the Available displays box, double-click . This moves the NR Summary icon to the selected displays box.
5. Click OK to view the display.
6. Select Setup > Settings to display the control panel.
7. Select Replay/Run to take measurements on the acquired data.
8. If you are analyzing a data file, click Replay to take measurements on the recalled acquisition data file.
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Elements of the display
The following images show the NR Summary display.

Summary view for Modulation Accuracy:

Item Display element Description
1 Number of component

carriers
Displays the number of component carriers.

2 Link direction Displays the link direction.
3 Results table Displays the modulation accuracy results.

Summary view for CHP:

Item Display element Description
1 Total Agg Power Displays the total aggregated power.
2 Results table Displays the CHP results.

Summary view for ACP:
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Item Display element Description
1 Number of NR Offsets Displays the number of NR Offsets.
2 Total Agg Power Displays the total aggregated power.
3 Results table Displays the ACP results.

Summary view for SEM:

Item Display element Description
1 Pass/Fail Displays Pass/Fail result based on absolute and relative limits set by the user.
2 Total Agg Power Displays the total aggregated power.
3 Results table Displays the SEM results.
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NR Summary settings
Main menu bar: Setup > Settings

Favorites toolbar: 

The NR Summary display control panel allows you to configure the settings of the NR Summary display.

Settings tab Description
Modulation Accuracy Allows you to configure modulation accuracy-specific properties.
ACP Allows you to configure ACP specific properties.
CHP Allows you to configure CHP specific properties.
SEM Allows you to configure SEM specific properties.
Signal Configuration Allows you to configure signal properties.
Subblock Configuration Allows you to configure properties needed to analyze a subblock in 5G NR signal
Carrier Configuration Allows you to configure carrier properties.
Averaging Allows you to configure averaging parameters.

NR Analysis measurement settings
Main menu bar: Setup > Settings

Favorites toolbar: 

The control panel tabs in this section are shared between the displays in 5GNR Analysis (Setup > Displays). Some tabs are shared by
all the displays and some tabs are shared by only a subset of displays. The settings available on some tabs change depending on the
selected display.

Controls for 5GNR Analysis displays

Settings tab Description
Modulation Accuracy Allows you to configure ModAcc measurement properties.
ACP Allows you to configure ACP measurement properties.
CHP Allows you to configure CHP measurement properties.
SEM Allows you to configure SEM measurement properties.
Signal Configuration Allows you to configure properties related to overall 5GNR signal.
Subblock Configuration Allows you to configure properties needed to analyze a subBlock in 5G NR signal.
Carrier Configuration Allows you to configure properties needed to configure each carrier.
Averaging Allows you to configure properties related to averaging of signal.
Traces Specifies the trace type (Vectors, Points, and Lines), the number of points per symbol when

chosen to view as Vectors or Lines, and to control the view as Freq Dev or IQ.

Available for the NR Constellation display only.

ACP tab
The ACP tab allows you to configure the settings required for the adjacent channel power measurement.
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The following image is of the ACP tab for the NR adjacent channel power display.

Setting Available options Description
Sweep Time 1zs to 20 ms Specifies the sweep time or the total analysis time for the ACP measurement.

To manually specify the sweep time, uncheck Auto.

Default value: 1.000 ms

FFT Window Specifies the Fast Fourier Transform (FFT) window method.

Default value: Flat Top

None No FFT window.

• Flat Top
• Hanning
• Hamming
• Gaussian
• Blackman
• Blackman-Harris
• Kaiser-Bessel

Select reduce spectral leakage.

NR Offset 0, 1, 2, 3, 4, 5, 6 Specifies the number of offsets to be displayed and ACP measurement to be run.

Default value: 2

Resolution Bandwidth
RBW Displays the Resolution Bandwidth (RBW) for NR measurements.

To manually specify the RBW, uncheck Auto.

Default value: 30 kHz

RBW Filter Specifies the RBW filter method used for the transform.

Default value: Flat

Flat Specifies the RBW filter with a flat response.
FFT Based No RBW filtering is performed.
Gaussian Specifies the RBW filter with a gaussian response.

Signal Configuration tab
The Signal Configuration tab allows you to configure the signal settings like link direction and transmitter architecture required for the
5GNR measurements. In downlink mode, it allows you to select the mode and the gNodeB category.

The following image is of the Signal Configuration tab available for the NR adjacent channel power, NR channel power, NR constellation,
NR spectral emission mask, and NR summary displays.
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Setting Available options Description
Link Direction Specifies the Link Direction of the signal. You can set to Uplink or Downlink

depending on the signal type.

Default value: Uplink

Uplink Unidirectional radio link for the transmission of signals from the user equipment to
a base station, from a mobile station to a mobile base station, or from a mobile
base station to a base station.

Downlink Unidirectional radio link for the transmission of signals from a base station to user
equipment. Also, in general, the direction from network to user equipment.

Downlink
Mode Specifies downlink channel configuration mode.

Default value: Test Model

Test Model A test model needs to be selected that will configure all the signals and channels
automatically according to the specifications.

User Defined Select to manually configure the signals, subblocks, and channels.
gNodeB Category A - Wide Area BS Specifies the Downlink gNodeB category

Default value: A - Wide Area BS

B (Option 1) - Wide Area
BS

The gNodeB type is Wide Area Base Station - Category B Option1.

B (Option 2) - Wide Area
BS

The gNodeB type is Wide Area Base Station - Category B Option2.

Local Area BS The gNodeB type is Local Area Base Station.
Medium Range BS The gNodeB type is Medium Range Base Station.

Transmitter Architecture Specifies the RF architecture at the transmitter in case of multi-carrier. Each
carrier can have a separate Local Oscillator (LO) or one common for the entire
subblock.

Default value: Lo Per Component Carrier

Lo Per Component Carrier Local oscillator per component carrier.
Lo Per SubBlock Local oscillator per subblock.

Subblock Configuration tab
The Subblock Configuration tab allows you to analyze a subblock in 5GNR signal.

The following image is of the Subblock Configuration tab available for the NR adjacent channel power, NR channel power, NR
constellation, NR spectral emission mask, and NR summary displays.

5GNR Analysis

SignalVu™ Vector Signal Analysis Software Printable Help 365



Setting Available options Description
Frequency Range Specifies whether to use band, channel bandwidth, and subcarrier spacing

configuration supported in the frequency range 1 or the frequency range 2.

Default value: Range 1

Range 1 The measurement uses the band, channel bandwidth, and the subcarrier spacing
configuration supported in frequency range 1.

Range2 The measurement uses the band, channel bandwidth, and the subcarrier spacing
configuration supported in frequency range 2.

Band Specifies the E-UTRA or NR operating frequency of a subblock. The band
determines the spectral flatness mask and spectral emission mask.

Default value: 78

1, 2, 3, 5, 7, 8, 12, 20, 25,
28, 34, 38, 39, 40, 41, 50,
51, 66, 70, 71, 74, 75, 76,
77, 78, 79, 80, 81, 82, 83,
84, and 86

Bands supported for frequency range 1

257, 258, 260, and 261 Bands supported for frequency range 2
Number of Component
Carriers

Specifies the number of component carriers in a subblock.

Default value: 1

1 Set to 1 for a single carrier.
2 to 8 Number of component carriers in a subblock (greater than 2 for multiple

component carriers in a subblock)
Channel Raster 15 kHz, 60 kHz, 100 kHz Specifies the subblock channel raster which is used for computing nominal

spacing between aggregated carriers. The value is expressed in Hz. The channel
raster defines a subset of RF reference frequencies that can be used to identify
the RF channel position in the uplink and downlink. The RF reference frequency
for an RF channel maps to a resource element on the carrier.

Default value: 15 kHz

Detect All Cell ID’s Select to detect all carrier's cell id.

This is enabled when Link direction is set as Downlink and Downlink configuration
mode is set to User Defined.

Carrier Configuration tab
The Carrier Configuration tab allows you to configure the component carrier settings of the 5GNR signal. Each component carrier is
represented by its row in the table. The corresponding PDSCH/PUSCH configurations are available through a button click at the right side
of the table.
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The following image is of the Carrier Configuration tab available for the NR adjacent channel power, NR channel power, NR constellation,
NR spectral emission mask, and NR summary displays.

Setting Available options Description
Select Allows to select the component carrier, which helps to :

• Configure all component carriers with the selected component carrier configurations.
• Detect selected component carrier Cell ID.
• Configure parameters related to PUSCH/PDSCH for selected component carriers.

Component carrier Specifies which component carrier is being configured.
Bandwidth Specifies component carrier’s channel bandwidth.

Default value: 100MHz

Available values in MHz for Range 1: 5, 10, 15, 20, 25, 30, 40, 50, 60, 70, 80, 90, 100

Available values in MHz for Range 2: 50, 100, 200, 400

Frequency Offset Specifies the offset of the component carrier from the subblock center frequency.

Default value: 0

Test Model Specifies the NR downlink test models.

This can be configured when the Link direction is Downlink and Downlink configuration
mode is set to Test model.

Default value: TM1.1

Available values: TM1.1, TM1.2, TM2, TM2a, TM3.1, TM3.1a, TM3.2, TM3.3

Duplex scheme Downlink FDD,
Downlink TDD

Specifies the duplexing technique of the signal being measured.

FDD refers to Frequency-Division duplexing.

TDD refers to Time-Division duplexing.

This can be configured when the Link direction is Downlink and Downlink configuration
mode is Test model.

Default value: Downlink FDD

Cell ID 0 to 1007 Specifies the physical layer cell identity.

This can be configured when Auto calculation cell ID is deselected.

Default value: 0

Reference grid Subcarrier spacing Specifies the subcarrier spacing of the reference resource grid. This should be the largest
subcarrier spacing used in the component carrier.

Default value: 30 kHz

Available values for Range 1: 15 kHz, 30 kHz, 60 kHz

Table continued…
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Setting Available options Description

Available values for Range 2: 60 kHz and 120 kHz

Start Default value: 0

Available values: 0 to 275

Bandwidth part Subcarrier spacing Default value: 30kHz

Available values for Range1: 15 kHz, 30 kHz, 60 kHz

Available values for Range 2: 60 kHz and 120 kHz

cyclic prefix Specifies the cyclic prefix (CP) duration and the number of symbols in a slot for the signal
being measured.

Default value: Normal

Available values: Normal

Bandwidth part Grid
start

Specifies the resource grid starts relative to reference point A in terms of resource block
offset.

Default value: 0

RB offset Specifies the resource block offset of a bandwidth part relative to the resource grid start the
property.

Default value: 0

RBs Specifies the number of consecutive resource blocks in a bandwidth part.

Default value: 0

Auto Calculation Deselection of any of these parameters enables manual mode which allows to configure
them manually.

Cell ID Deselect to configure the cell ID manually.
Frequency Deselect to configure the Frequency manually.
Reference Grid Deselect to manually configure the Reference Grid Subcarrier spacing and Reference Grid

Start values.
Resource Block Deselect to manually configure the RB offset and RBs values.

Expand Click to view the table in a separate window. You can also configure the table.
PDSCH Click to configure the PDSCH parameters.

PDSCH button is enabled when link direction is selected as Downlink.

PUSCH Click to configure the PUSCH parameters.

PUSCH button is enabled when link direction is selected as Uplink.

Detect All Cell ID’s Select to manually identify the Cell ID of the signal.

This button is enabled when link direction is configured as Downlink and Downlink.

Apply for All CC Click to apply all the selected component carrier to all component carriers, except the Cell
ID.
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Physical uplink shared channel for component carrier 1 window
The Physical Uplink Shared Channel for Component Carrier 1 Window allows you to configure the PUSCH settings for the selected
component carrier. The DMRS settings related to the corresponding PUSCH are also configurable through this window.

The following image is of the Physical Uplink Shared Channel for Component Carrier 1 Window available in the carrier configuration
tab.

Setting Available options Description
Modulation Type Specifies the modulation scheme used in the physical uplink shared channel

(PUSCH) of the signal being measured.

Default value: QAM256

PI/2 BPSK,

QPSK,

QAM16,

QAM64,

QAM256,

QAM1024

Specifies a PI/2 BPSK modulation scheme.

Specifies a QPSK modulation scheme.

Specifies a 16 QAM modulation scheme.

Specifies a 64 QAM modulation scheme.

Specifies a 256 QAM modulation scheme.

Specifies a 1024 QAM modulation scheme.

Table continued…
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Setting Available options Description

Symbol Allocation 1:14 Specifies the symbol allocation of each slot.

Valid values are from 1 to 14, inclusive.

The format is defined by range format specifiers. The range format specifier is a
comma separated list of entries.

Note: If incorrent value is entered in symbol allocation, the value will be
highlighed in red color

Examples:

2,4 will expand to {2,4}

1:3,7 will expand to {1,2,3,7}.

To manually specify the symbol allocation, uncheck All.

Slot Allocation 1:20 Specifies the slot allocation in NR Frame. This defines the indices of the allocated
slots.

Valid values are from 1 to maximum number of slots in the frame max number of
slots is dependent on numerology within the specifications

The format is defined by range format specifiers. The range format specifier is a
comma-separated list of entries.

Note: If incorrent value is entered in slot allocation, the value will be
highlighed in red color

Examples:

2,4 will expand to {2,4}

1:3,7 will expand to {1,2,3,7}.

To manually specify the slot allocation, uncheck All.

DMRS (Release 16)
Power Mode Specifies whether the value of PUSCH DMRS Pwr property is calculated based

on the PUSCH DMRS number of CDM Groups value or specified by the user
(user-defined).

Select to calculate the PUSH DRMS Pwr value based on PUSCH DMRS number
of CDM Groups value or by user-defined method.

Default value: CDM

User Defined Specifies the DMRS power manually.
Antenna Ports Specifies the antenna ports used for DMRS transmission.
Power Specifies the factor which boosts the PUSCH DMRS REs. This value is

expressed in dB. This property is ignored if you set the “Power Mode” value
to CDM Groups.

Number of CDM Groups Specifies the number of CDM groups, when you set the PUSCH “Transform
Precoding” value to False, otherwise, it is set to 2.

Mapping
Table continued…
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Setting Available options Description
Configuration Type Specifies the DMRS configuration type.

Default value: Type 1

• Type 1
• Type 2

• One DMRS subcarrier alternates with one data subcarrier.
• Two consecutive DMRS subcarriers alternate with four consecutive data

subcarriers.

Duration Specifies whether the DMRS is single-symbol or double-symbol..

Default value: Single Symbol

Single Symbol There are one or more non-consecutive DMRS symbols in a slot.
Double Symbol There are one or more sets of two consecutive DMRS symbols in the slot.

Type A Position 2,3 Specifies the position of the first DMRS symbol in a slot when you set the PUSCH
"Mapping Type" value to Type A.

2: The first DMRS symbol index in a slot is 2.

3: The first DMRS symbol index in a slot is 3.

Additional Positions Specifies the number of additional sets of consecutive DMRS symbols in a slot.

Default value: 0

0,1,2,3 0: No additional DMRS symbol set is present in the slot.

1: One additional DMRS symbol set is present in the slot.

2: Two additional DMRS symbol sets are present in the slot.

3: Three additional DMRS symbol sets are present in the slot.

Mapping Type Specifies the mapping type of DMRS.

Default value: Type A

Type A The first DMRS symbol index in a slot is either 2 or 3 based on PUSCH DMRS
"Type A Position" value.

Type B The first DMRS symbol index in a slot is the first active PUSCH symbol.
Scrambling
Mode Specifies whether the configured Scrambling ID is honored or the Cell ID is used

for reference signal generation.

Default value: Cell ID

Cell ID The value of the PUSCH DMRS Scrambling ID is based on the Cell ID property.
User Defined Select this to configure the Scrambling ID manually.

Identity 0 to 65535 Specifies the value of scrambling ID. This property is valid only when you set the
PUSCH "Transform Precoding" value to False.

Initialization Specifies the DMRS nSCID used for reference signal generation.
Transform Precoding Enable or disable Transform precoding configurations.
Table continued…

5GNR Analysis

SignalVu™ Vector Signal Analysis Software Printable Help 371



Setting Available options Description
Group Hopping Specifies whether the group hopping is enabled. This parameter is valid only

when you set the PUSCH "Transform Precoding" value is set to True.
Sequence Hopping Enable or disable Sequence hopping.
PUSCH ID Mode Specifies whether PUSCH DMRS PUSCH ID is based on Cell ID or user-defined.

This parameter is valid only when you set the PUSCH "Transform Precoding"
value is set to True.

Default value: Cell ID

Cell Id The value of PUSCH DMRS PUSCH ID is based on the Cell ID property.
User Defined The value of the PUSCH DMRS PUSCH ID is specified by the user.

User Defined ID 0 to 1007 Specifies the value of PUSCH DMRS PUSCH ID used for reference signal
generation. This property is valid only when you set the PUSCH "Transform
Precoding" value to True and PUSCH DMRS "PUSCH ID Mode" value to User
Defined.

Physical downlink shared channel for component carrier 1 window
The Physical Downlink Shared Channel for Component Carrier 1 Window allows you to configure the PDSCH settings for the selected
component carrier. The DMRS settings related to the corresponding PDSCH are also configurable through this window.

The following image is of the Physical Downlink Shared Channel for Component Carrier 1 Window available in the carrier
configuration tab.
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Setting Available options Description
Modulation Type Specifies the modulation type used in the physical downlink shared channel

(PDSCH) channel of the signal being measured.

Default value: QAM256

QPSK,

QAM16,

QAM64,

QAM256,

QAM1024

Specifies a QPSK modulation scheme.

Specifies a 16 QAM modulation scheme.

Specifies a 64 QAM modulation scheme.

Specifies a 256 QAM modulation scheme.

Specifies a 1024 QAM modulation scheme.

Symbol Allocation 1:14 Specifies the symbol allocation of each slot.

To manually specify the symbol allocation, uncheck All.

Slot Allocation 1:20 Specifies the number of PDSCH slot configurations.

To manually specify the slot allocation , uncheck All.

DMRS (Release 16)
Power Mode CDM Specifies whether the DMRS power is calculated based on several CDM groups

or manually entered by a user

Default value: CDM

User Defined Specifies the DMRS power manually.
Antenna Ports Specifies the Antenna ports used for DMRS transmission.

Default value: 1000

Power Specifies the DMRS power.

Default value: 0

Number of CDM Groups Specifies the number of CDM groups.

Default value: 1

Mapping
Configuration Type Specifies the DMRS configuration type.

Default value: Type 1

• Type 1
• Type 2

• One DMRS subcarrier alternates with one data subcarrier.
• Two consecutive DMRS subcarriers alternate with four consecutive data

subcarriers.

Duration Specifies whether the DMRS is a single symbol or double symbol.

Default value: Single Symbol

Single Symbol There are one or more non-consecutive DMRS symbols in a slot.
Double Symbol There are one or more sets of two consecutive DMRS symbols in the slot.

Table continued…
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Setting Available options Description
Type A Position Specifies the position of the first DMRS symbol in a slot for Type A configurations.

Default value: 2

Additional Positions 0 Specifies the number of additional sets of consecutive DMRS symbols in a slot.

Default value: 0

1,2,3 Different additional DMRS symbols are set in the slot.
Mapping Type Specifies the mapping type of DMRS.

Default value: Type A

Type A The first DMRS symbol index in a slot is either 2 or 3
Type B The first DMRS symbol index in a slot is 0.

Scrambling
Mode Cell ID Specifies the configured Scrambling ID is based on Cell ID or specified by the

user.

Default value: Cell ID

User Defined Select this to configure Scrambling ID manually.
Identity Specifies the scrambling ID used for reference signal generation.

Default value: 0

Initialization Specifies the DMRS nSCID used for reference signal generation.

Default value: 0

Averaging tab
The Averaging tab allows you to configure the settings for averaging 5GNR measurements. The number of acquisitions and the averaging
type for different measurements (modulation accuracy is always mean) is configurable in this tab.

The following image is of the Averaging tab available for the NR adjacent channel power, NR channel power, NR constellation, NR spectral
emission mask, and NR summary displays.

Setting Available options Description
Averaging Specifies whether the averaging parameters are available to configure.
Table continued…
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Setting Available options Description
ACP Averaging Type Specifies the averaging type for averaging spectral acquisitions.

Default value: RMS

RMS Spectral acquisitions are averaged linearly.
Log Spectral acquisitions are averaged on a logarithmic scale.
Scalar Square root of spectral acquisitions is averaged.
Max The maximum power in the spectrum at each frequency bin is retained from one

acquisition to the next.
Min The lowest power in the spectrum at each frequency bin is retained from one

acquisition to the next.
CHP Averaging Type RMS,

Log,

Scalar,

Max,

Min

Specifies the averaging type for averaging spectral acquisitions.

Default value: RMS

SEM Averaging Type RMS,

Log,

Scalar,

Max,

Min

Specifies the averaging type for averaging spectral acquisitions.

Default value: RMS

ModACC Averaging Type Specifies the averaging type for averaging spectral acquisitions.

Default value: Mean

CHP tab
The CHP tab allows you to configure the settings required for the channel power measurement.

The following image shows the CHP tab for the NR channel power display.

Setting Available options Description
Sweep Time Specifies the sweep time or the total analysis time for the CHP measurement.

To manually specify the sweep time, uncheck Auto.

Default value: 1.000 ms

Table continued…
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Setting Available options Description
Integration BW Specifies the type of integration bandwidth to measure the power of the acquired

signal.

Default value: Signal Bandwidth

Signal Bandwidth Excludes the guard bands at the edges of the carrier or subblock.
Channel bandwidth Includes the guard bands at the edges of the carrier or subblock.

FFT Window Fast Fourier Transform (FFT) window. Specifies the FFT window type.

Default value: Flat Top

None No FFT window.
Flat Top, Hanning,
Hamming, Gaussian,
Blackman, Blackman-
Harris, Kaiser-Bessel

Select to reduce spectral leakage.

Resolution Bandwidth
RBW Displays the Resolution Bandwidth (RBW) for NR measurements.

To manually specify the RBW, uncheck Auto.

Default value: 30 kHz

Filter Specifies the RBW filter method used for the transform.

Default value: Flat

Flat Specifies the RBW filter with a flat response.
FFT Based No RBW filtering is being performed.
Gaussian Specifies the RBW filter with a gaussian response.

SEM tab
The SEM tab allows you to configure the settings required for the spectral emission mask measurement.

The following image is of the SEM tab for the NR spectrum emission mask display.

Setting Available options Description
Sweep Time Specifies the sweep time or the total analysis time for the SEM measurement.

To manually specify the sweep time, uncheck Auto.

Default value: 1.000 ms

Table continued…
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Setting Available options Description
FFT Window Fast Fourier Transform (FFT) window. Specifies the FFT window type.

Default value: Flat Top

None No FFT window.
Flat Top, Hanning,
Hamming, Gaussian,
Blackman, Blackman-
Harris, Kaiser-Bessel

Select to reduce spectral leakage.

Resolution Bandwidth
RBW Displays the Resolution Bandwidth (RBW) for SEM measurements.

To manually specify the RBW, uncheck Auto.

Default value: 30 kHz

Filter Specifies the RBW filter method used for the transform.

Default value: Flat

Flat Specifies the RBW filter with a flat response.
FFT Based No RBW filtering is being performed.
Gaussian Specifies the RBW filter with a gaussian response.

Mask Type
Uplink Specifies the spectrum emission mask used in the measurement when the link

direction is uplink.

Default value: General

NS_35,

NS_03,

NS_04,

NS_06,

NS_21

Selection of the different SEM masks as defined in specifications for uplink.

Custom Define a custom SEM mask for uplink.
Downlink Standard Specifies the spectrum emission mask used in the measurement when the link

direction is downlink.

Default value: Standard

Custom Define a custom SEM mask for downlink.
Maximum frequency
Deviation

Specifies the maximum frequency deviation of the offsets when the link direction
is downlink and downlink mask type is set to standard.

Default value: 15 MHz

Modulation Accuracy tab
The Modulation Accuracy tab allows you to configure the settings needed to measure modulation accuracy. The tab contains important
parameters related to OFDM symbol demodulation and EVM computation.
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The following image shows the Modulation Accuracy tab for the NR constellation display.

Setting Available options Description
Measurement
Unit Slot Specifies the units for measurement offset and measurement length. Slot: Length

and offset are specified in units of slots.

Default value: Slot

Time Measurement offset and measurement length are specified in seconds.
Length Measurement length in units specified by the unit property.

Default value: 1

Offset Measurement offset to skip from the synchronization boundary.

Default value: 0

FFT Window
Type Custom Specifies FFT window type used for EVM calculation. The FFT window offset is

used when set to custom, and the window length is set to 3GPP OFDM FFT size
internally.

Default value: Custom

3GPP The FFT window length is used when set to 3GPP, and the window offset is set as
per 3GPP specs internally.

Length Specifies the FFT window length as a percentage of cyclic prefix. This value is
used when window type is set to 3GPP.

To manually specify the length, uncheck Auto.

Default value: 20

Offset The starting position of the FFT window as a percentage of cyclic prefix is used to
calculate the EVM when the FFT window yype is set to custom.

Default value: 50

Advanced
Spectral Flatness Normal Specifies the test condition for spectral flatness measurement as per normal

conditions in 3GPP Standard.

Default value: Normal

Extreme Specifies the test condition for spectral flatness measurement as per extreme
conditions in 3GPP Standard.

Phase Tracking Enables or disables the phase tracking method.
DC Subcarrier Removal Specifies whether the DC subcarrier is removed or not from the EVM results.
Table continued…
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Setting Available options Description
Spectrum Inverted Specifies whether the spectrum of the signal should be inverted before analysis of

modulation accuracy. This option can be utilized while analyzing down-converted
IQ data.

Timing Tracking Specifies whether to enable or disable timing tracking.
Composite Results
EVM Units dB Specifies the units of EVM results.

EVM is reported in dB.

Default value: Percent

Percent EVM is reported in percentage.
Include DMRS Specifies whether DMRS resource elements are included for composite EVM,

magnitude and phase error results, and traces.

Estimation tab
The Estimation tab allows you to configure advanced modulation accuracy measurement estimation. It includes parameters needed to
configure IQ impairments while using direct conversion architecture and timing related parameters.

The following image is of the Estimation tab for the NR constellation display.

Setting Available options Description
Modulation Accuracy Estimation
Channel DMRS and Data Select to improve the estimation of equalizer coefficients under high SNR

conditions.

Default value: DMRS and Data

DMRS Select to estimate the equalizer coefficients exclusively using DMRS symbols
under any SNR condition.

Frequency Error Normal Specifies the mode of carrier frequency error estimation. When normal is
selected, the range of estimation is limited to +/- half the sub-carrier spacing.

Default value: Normal

Disable Used to disable the estimation and correction of carrier frequency offset.
Wide When selected, frequency error estimation range is +/- half resource block when

auto RB detection enabled is true, or range is +/- number of guard subcarrier
when auto RB detection enabled is false.

Common Clock Source Specifies whether the same reference clock is used for local oscillator and
digital-to-analog converter.

When the same reference clock is used, the carrier frequency offset is
proportional to the sample clock error or/and digital-to-analog converter

Table continued…
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Setting Available options Description
IQ Origin Offset Enables or disables estimation of IQ origin offset.
IQ Impairments Enables or disables estimation of IQ gain and imbalance.
Symbol Clock Error Enables or disables estimation of symbol clock error

Traces tab
The Traces tab allows you to configure the display of constellation traces.

The following image is of the Traces tab for the NR constellation display.

Setting Available options Description
Component Carrier Index 1,2,3,4,5,6,7,8 Select the component carrier index to display the component carriers

demodulated data and DMRS. Also, the scalar results in the constellation display
are modified accordingly.

Default value: 1

Measurement Name
Data Enables or disables plotting the constellation of data symbols.
DMRS Enables or disables plotting the constellation of DMRS symbols.
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Bluetooth Analysis
Bluetooth Analysis
Overview
There are two Bluetooth Analysis options: Bluetooth (SV27) and Bluetooth 5 (SV31). These options allow you to evaluate short range RF
signals to ensure that they meet Bluetooth standard per Bluetooth Special Interests Group (SIG) Test Specifications for version 5. This
analysis option enables measurements and supports detection, demodulation, and decoding of packet information for the following three
standards: Basic Rate, Low Energy (LE), and Enhanced Data Rate (EDR).

• Basic Rate with uncoded data at 1 Mb/s
• Low Energy (the following three variants are supported):

• Low Energy 1M (LE 1M), with uncoded data at 1 Mb/s
• Low Energy 2M (LE 2M), with uncoded data at 2 Mb/s (Requires Option SV31NL or SV31FL)
• Low Energy Coded (LE Coded) with S=2 (500 Kb/s) or S=8 (125 Kb/s) (Requires Option SV31NL or SV31FL)

• Enhanced Data Rate (EDR) with 2 Mb/s or 3 Mb/s

You can also select from three RF test presets for the Low Energy standard and four test presets for the Basic Rate standard. This analysis
option includes modulation, power, carrier drift, and spectral measurements as mentioned in the Radio Frequency test specification
document by the Bluetooth SIG. These measurements are also compared with the limits provided by the standard to give pass/fail results.
(There are no pass/fail results for EDR.)

With the Bluetooth Analysis test suite, test engineers can simplify the execution of a number of transmitter tests while still enabled to
modify signal parameters for in-depth signal analysis. The analysis results give multiple views of Bluetooth signal characteristics to allow
the diagnosis of signal imperfections and impairments quickly and easily. Display controls allow you to selectively display the analysis
results to help locate trouble spots in the signal.

Bluetooth topics in this Help
The following information about Bluetooth Analysis is available:

• Bluetooth key features on page 381
• Reference table of supported Bluetooth measurements
• Bluetooth measurements and test setups on page 385
• Bluetooth Status Messages on page 389
• Bluetooth Standards presets on page 382
• Bluetooth displays on page 385
• Bluetooth Analysis Measurement Settings

Bluetooth key features
• Modulation/Carrier Drift/Output Power test setup in Bluetooth Standards Preset that will calculate results and compare against

recommended or user defined limits or Basic Rate, LE 1M, LE 2M, and LE coded.
• In-band Emission measurement preset with capability to compare results against recommended or user defined limits for Basic Rate,

LE 1M, LE 2M, and LE coded.
• 20 dB Bandwidth and Frequency Range measurement preset with capability to compare results against recommended or user defined

limits for Basic Rate.
• Appropriate masks for Out-of-band Spurious measurements for ETSI and FCC specifications.
• Enhanced Data Rate (EDR) demodulation of GFSK and PSK data and relative power measurement preset.
• Automatic detection of standards
• Automatic detection of test pattern.
• Automatic determination of packet type.
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• Summary display with decoded preamble, access code, packet header, payload header, and CRC packet information along with other
scalar measurements.

• Symbol Table display with color coding to show different regions in the packet.
• Freq Dev vs Time display with zoomed Octet viewing to help you understand how the modulation characteristics measurement is done.
• CF Offset & Drift display with offset (calculated in preamble and 10 bit intervals in payload) and drift results in a tabular view.
• Summary display that allows you to edit pass/fail limits for comparison with actual results. (Default is recommended limits from the

Bluetooth SIG Radio Frequency test specification document.)

Automatic detection of standards. This function can be enabled from the Standard Parameters control panel. This automatically detects
whether the Bluetooth standard is Basic Rate, Low Energy, or Enhanced Data Rate (EDR). This function is not available as a test setup
from the Standards Presets window.

Supported automated Bluetooth measurements

Bluetooth measurement Bluetooth standard(s)

Modulation characteristics Basic Rate

LE 1M, LE 2M, LE coded

Carrier frequency offset and drift Basic Rate

LE 1M, LE 2M, LE coded

Output power Basic Rate

LE 1M, LE 2M, LE coded

In-band emission /ACPR Basic Rate

LE 1M, LE 2M, LE coded

Out-of-band spurious emission Basic Rate

LE 1M, LE 2M, LE coded

20 dB bandwidth Basic Rate

Frequency range Basic Rate

Power density Basic Rate

Relative power Enhanced Data Rate (EDR)

Bluetooth Standards presets
Presets > Standards

The Bluetooth Standards preset allows you to access displays preconfigured for the Bluetooth standard and test setup you select. The test
setups load the displays and control setting options suggested by the standard to perform the measurements. You can read more about
how Presets work here..

There are four test setups for the LE 1M, LE 2M, and LE coded standard and eight test setups for the Basic Rate standard. There is one
preset (no test setups) for the EDR standard.

The following table shows the set of Preset displays that load when the specified standards and test setups are selected.
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Table 30: Bluetooth standards, test setups, and Preset displays

Standard Test setup Displays loaded with preset

LE 1M Modulation/Frequency Offset/Drift/Output Power BT Eye Diagram, BT Freq Dev vs Time, BT Summary, BT CF
Offset and Drift, Spectrum, Time Overview

In-band Emissions BT InBand Emission, Spectrum, Time Overview

Non-compliance BT Freq Dev vs Time, BT Constellation, BT Summary,
Spectrum, Spectrogram, Time Overview

LE 2M

LE Coded

(Requires Option
SV31NL or SV31FL)

Modulation/Frequency Offset/Drift/Output Power BT Eye Diagram, BT Freq Dev vs Time, BT Summary, BT CF
Offset and Drift, Spectrum, Time Overview

In-band Emissions BT InBand Emission, Spectrum, Time Overview

Non-compliance BT Freq Dev vs Time, BT Constellation, BT Summary,
Spectrum, Spectrogram, Time Overview

Basic Rate Modulation/Frequency Offset/Drift/Output Power BT Eye Diagram, BT Freq Dev vs Time, BT Summary, BT CF
Offset and Drift, Spectrum, Time Overview

In-band Emissions BT InBand Emission, Spectrum, Time Overview

Tx Output Spectrum — 20dB Bandwidth Bluetooth 20 dB BW, Spectrum, Time Overview

Non-compliance BT Freq Dev vs Time, BT Constellation, BT Summary,
Spectrum, Spectrogram, Time Overview

Enhanced Data Rate
(EDR)

Generic BT Eye Diagram, BT Constellation, BT Summary, BT Symbol
Table, Spectrum, Time Overview

Retain current center frequency and reference level settings
The Retain current Center Frequency setting appears when the Bluetooth Standards Preset is chosen. This setting allows you to retain
the previously used center frequency.

The Retain current Ref Level setting appears when the Bluetooth Standards Preset is chosen. This setting allows you to retain the
previously used reference level.

To activate these settings, check the box next to the desired setting.
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By default, the Ref Level setting box is checked.

By default, the Center Frequency setting box is unchecked and the Bluetooth preset displays will load with one of the center frequency
values shown in the following table.

Table 31: Default center frequencies for Bluetooth test setups

Standard Test setup Center frequency

Basic Rate

LE 1M

LE 2M

LE Coded

Modulation/Frequency Offset/Drift/Output Power 2.441 GHz

Basic Rate

LE 1M

LE 2M

LE Coded

In-band Emissions 2.441 GHz

Basic Rate

LE 1M

LE 2M

LE Coded

Out-of-band Spurious Emissions 2.441 GHz

Basic Rate Tx Output Spectrum — 20dB Bandwidth 2.441 GHz

Basic Rate Tx Output Spectrum — Power Density 2.441 GHz

Table continued…
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Standard Test setup Center frequency

Basic Rate

LE 1M

LE 2M

LE Coded

Non-compliance 2.441 GHz

Basic Rate Tx Output Spectrum — Frequency Range Lower 2.402 GHz

Basic Rate Tx Output Spectrum — Frequency Range Higher 2.480 GHz

Enhanced Data Rate Generic 2.441 GHz

Note: Changing analysis and display parameters recalculates the measurement results, but does not affect acquisitions.

Bluetooth displays
The displays in Bluetooth Analysis (Setup > Displays > Measurements: Bluetooth Analysis) are:

• Bluetooth 20dB Bandwidth display on page 408
• Bluetooth Carrier Frequency Offset and Drift display on page 395
• Bluetooth Constellation display on page 390
• Bluetooth Eye Diagram display on page 392
• Bluetooth Frequency Dev vs Time display on page 405
• Bluetooth InBand Emission display on page 411
• Bluetooth Summary display on page 397
• Bluetooth Symbol Table display on page 401
• Time Overview Display on page 53

Bluetooth measurements and test setups
A variety of measurements and test setups are provided by the Bluetooth Analysis option for use in performance testing of transmitters.
These test setups allow the analyzer to compare the measurement result to the standards limit. Test engineers can select from the test
setups and measurements described here. The following topics contain important information you should know about specific Bluetooth
measurements and test setups.

Note: Although the following information describes test setups for measurements recommended by the standard document, other
measurement results may also be provided as additional information for a given measurement. For example, carrier frequency
offset and drift results may be provided for modulation characteristics test setups.

Modulation characteristics (Basic Rate, LE 1M, LE 2M, LE Coded)
This measurement verifies that the modulation characteristics of the transmitted signal are correct. The Bluetooth test specification
recommends this measurement be done using fixed frequency, also known as hopping off, and can be done in Direct Tx mode. This
measurement can only be done if the payload has the bit pattern 10101010 or 11110000 for Basic Rate, LE 1M, and LE 2M; and 11001100
or 11110000 for LE Coded. This measurement and test setup are set to Free Run mode by default. However, you can set the analyzer to
Triggered mode (Setup > Trigger) to do the measurements.

More information about this measurement:

• Select the Modulation/Frequency Offset/Drift/Output Power test setup from Presets > Standards to perform modulation characteristics
measurements. This will load the displays found in the . Additionally, you can choose to load the BT Symbol Table and BT
Constellation displays, which can provide useful information.
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• The Bluetooth Analysis splits the frequency deviation results in the payload region into octets (8 bit intervals). If the payload pattern is
10101010 for LE 1M and LE 2M, and 11001100 for LE Coded, then the maximum frequency deviation is calculated in every bit interval
within an octet and recorded as Δfmax. The Δfmax results are averaged to give Δf2avg. The percentage of Δfmax values greater than
recommended lower limit is also found.

• If the payload is 11110000, the average frequency deviation is found in 4 bit intervals (2, 3, 6 and 7) and the average of these values is
calculated as Δf1avg. The ratio of Δf2avg and Δf1avg is also found.

• BT Freq Dev vs Time display has an octet view (zoomed view of the 8 bit intervals in Payload) and also shows the bit intervals in which
the Δfmax values are computed. The octet view option also allows you to see the regions in which the calculations are done.

Note: The octet view option is only available when Preamble is detected.

• Specify an octet to view by entering a value in the Octet # field in the BT Freq Dev vs Time display. This also shows the maximum
number of octets used for analysis. The start and end point for every octet can be clearly seen using the octet view.

• In the Summary display, the scalar results (Δf1avg, Δf2avg, Ratio, Percentage of Δfmax values greater than a limit) averaged over the
last 10 packets analyzed are shown along with the packet count. These averaged results can be compared against limits set in the
Limits tab of the Settings control panel.

• The Points/symbol option in the Trace tab can be used to control how many samples per symbol should be used for computation of
these measurements. The standard recommends 32 samples per symbol for Low Energy and 4 samples per symbol for Basic Rate.
These are the default values provided for the respective standards in the Bluetooth Standards presets.

Carrier frequency offset and drift (Basic Rate, LE 1M, LE 2M, LE Coded)
This measurement verifies that the carrier frequency offset and carrier drift of the transmitted signal is within the specified limits for the
specified standard. The Bluetooth test specification recommends this measurement be done using fixed frequency, also known as hopping
off, and can be done in Direct Tx mode. This test can be done only if the payload contains 10101010 bit pattern. This measurement
and test setup are set to Free Run mode by default. However, you can set the analyzer to Triggered mode (Setup > Trigger) to do the
measurements.

More information about this measurement:

• Select the Modulation/Frequency Offset/Drift/Output Power test setup from Presets > Standards to perform carrier frequency offset and
drift measurements. This will load the displays found in the Table 30 on page 383. Additionally, you can choose to load the BT Symbol
Table and BT Constellation displays, which can provide useful information.

• This measurement calculates the following:

• Frequency offset in Preamble (initial Carrier Frequency Offset). Calculated in 8 bits for LE 1M (f0),16 bits for LE 2M (f0) and 80 bits
for LE Coded. For LE Coded the 80 bits preamble is split into five 16 bits parts(f0-f4).

• For LE Coded there is an option to select only first 8 bits of f4. (Selection available in Analysis Params). This will ensure that
frequency offset computed in the interval f4 is not biased.

• Frequency offset in Payload (calculated in 10 bit intervals for LE 1M, 20 bits for LE 2M, and 16 bits for LE Coded in payload).
• Drift (the difference in frequency offset calculated in Payload from that calculated in Preamble).
• The drift is measured by taking the difference in frequency offset between two fixed intervals. For LE 1M, the interval length is

10 bits and the difference between intervals is 50 μs (5 intervals away). For LE 2M, the interval length is 20 bits and the interval
difference is 50 μs (5 intervals away). For LE Coded, the interval length is 16 bits and fhs interval difference is 48 μs (3 intervals
away).

• The BT CF Offset and Drift display shows all results in a table.
• The measurements shows the following scalar results:

• Preamble frequency offset (initial carrier frequency offset).
• Maximum frequency offset in Payload (along with the index number at which the offset is at maximum).
• Drift of frequency offset from Preamble to first 10 bit interval in Payload (f1-f0).
• Maximum drift between Payload and Preamble (fn-f0) (along with index number at which the drift is maximum).
• Drift between two 10 and 20 bits intervals is denoted as fn-fn-5 for LE 1M and LE 2M. For LE Coded, it is denoted as fn-fn-3, which

is 48 μs away. The Maximum interval difference at which these values occur is shown in Frequency Drift display.
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• The Preamble region in which the Preamble offset is calculated is shown in the BT Freq Dev vs Time display along with markings to
show the region in which maximum drift occurred. Maximum drift between Payload and Preamble is shown from the end of Preamble
to the end of 10 bit interval in Payload in which maximum drift occurred. Maximum drift in payload (in 50 μs duration) is also shown.

• In the Summary display, the scalar results (mentioned above) averaged over the last 10 packets are shown along with the packet
count. The results are compared against recommended limits. You can set these limits in the Limits tab of the Settings control panel.

In-band Emissions (Basic Rate, LE 1M, LE 2M, LE Coded)
This measurement verifies that the in-band spectral emissions are within limits. The standard document recommends that this
measurement be done with Hopping off, finding the integrated power in 1 MHz band (with RBW 100 kHz) in 80 channels starting
from 2401 MHz to 2481 MHz. The test can be done in Direct Tx mode. The integrated power values calculated in the adjacent channels
are compared against recommended limits (except the three channels around transmitted frequency). This measurement is referred to as
ACPR in the Radio Frequency Test Specification for Basic Rate. It is recommended to do this measurement in Free Run mode (set in
Setup > Trigger) if the analyzer does not support the required BW (80 MHz). The measurement internally searches for burst and aligns the
measurement to the on-slot region.

Note: For analyzers with limited bandwidth, this measurement will be done over multiple acquisitions to generate the data
required for the entire span. Therefore, it is important for the user to set an analysis length that will ensure that on slot region is
always included.

More information about this measurement:

• Select the In-band Emissions test setup from Presets > Standards to perform the in-band emissions measurements. This will load the
displays found in the Table 30 on page 383.

• The In-band Emissions display will set the Center Frequency to 2.441 GHz by default. When the Retain CF option is not enabled from
Standards Presets, 80 bands (each of bandwidth 1 MHz) are analyzed and the integrated power is found (indicated by Blue lines in the
plot).

• The integrated power is compared against limits for comparison (shown by white masks) in all bands except the three channels around
the transmitted frequency. If any band fails, that band is shown in red color. If more than three channels fail to meet the recommended
limits, a FAIL is shown in the top left corner of the display.

• The table below the plot shows the integrated power and also the limit for comparison.
• The limits for comparison are set to the values given by the standard by default, but you can manually set them from the Limits tab of

the Settings control panel.
• This measurement is done only on the on slot region if a ramp-up and ramp-down portions are available. However, the measurement is

done on the complete analysis region if a ramp up or ramp down is not available. It is recommended that a complete packet is included
in the analysis region.

• When the analyzer does not support the 80 MHz bandwidth requirement, multiple acquisitions are taken in different bands and stitched
together. This measurement is therefore best done in Free Run mode (set in Setup > Trigger) as Triggered mode might not find a
proper edge in an acquisition taken for stitching purposes.

Output Power (Basic Rate, LE 1M, LE 2M, LE Coded)
This test verifies the maximum peak and average power emitted from the EUT. The standards document recommends this test be done for
a PRBS payload pattern. Also, the measurement must be done over the duration of a burst starting at preamble position. The Bluetooth
test specification recommends this measurement be done using fixed frequency, also known as hopping off, and can be done in Direct Tx
mode.

More information about this measurement:

• Select the Modulation/Frequency Offset/Drift/Output Power test setup from Presets > Standards to perform carrier frequency offset and
drift measurements. This will load the displays found in the Table 30 on page 383.

• Calculates the average power and peak power for any Bluetooth signal. The peak power is the peak power value in the chosen on slot
region.

• The measurement is done only on preamble detection; otherwise, it is invalid.
• The BT Summary display shows the averaged result over 10 packets.
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20dB Bandwidth (Basic Rate)
This measurement verifies if the emissions inside the operating frequency range are within limits. This measurement is done with Hopping
off. The difference between frequency points at which the power level drops to 20 dB below the peak power of the emission is found at 20
dB Bandwidth.

More information about this measurement:

• Select the 20dB Bandwidth test setup from Presets > Standards to perform the 20 dB emissions measurements. This will load the
displays found in the Table 30 on page 383.

• The BT 20 dB BW display allows you to set the relative power level (x dB BW) compared to the peak power at which the frequency
points are to be found.

• When you select the 20dB Bandwidth test setup, the center frequency (CF), span, and relative bandwidth (RBW) are set as
recommended by the standard document.

• It is recommended this measurement be done over three different center frequencies. You can do this by changing the center
frequency as needed.

• From the Params tab of the Settings control panel, you can select that the search for the x dB relative power (20 dB in this case) be
performed in one of two modes: from the edges towards the peak power (inwards) or vice versa (outwards). The default for this setting
is Inwards (from edges to peak power) when this measurement is chosen from the Standards Preset menu, as recommended.

• The blue markings in the plot indicate the 20 dB bandwidth and the frequency points at which the power level drops down by 20 dB
from the peak power.

• The resulting 20 dB bandwidth is compared with the limits recommended by the standard document and Pass/Fail is shown in the top
left corner of the plot. This is not user defined.

If the highest power value measured in step d) is equal or higher than 0 dBm: f = |fH - fL| ≤ 1.0 MHz.

If the highest power value measured in step d) is lower than 0 dBm: f = |fH - fL| ≤ 1.5 MHz.

Frequency Range (Basic Rate)
These measurements verify if the emissions inside the operating frequency range are within limits. These measurements are done with
Hopping off in two steps. The first measurement is done at the lower frequency spectrum of the Bluetooth band. (Start – 2399 MHz and
Stop 2405 MHz). The second is done at the higher frequency spectrum of the Bluetooth band (Start -2475 MHz and Stop at 2485 MHz).
The difference between the frequency point at which the power level drops to -30 dBm from the center frequency is measured. fL is the
difference on the lower side from the center frequency when the lower end of the spectrum is being analyzed. fH is the difference from the
center frequency on the higher side when the higher end of the spectrum is analyzed. fH – fL is the Frequency Range.

More information about these measurements:

• The BT 20dB BW display allows you to set the absolute power level (x dBm level) from the Parameters tab of the Settings control
panel. The Bluetooth SIG Radio Frequency test specification document suggests that this value be set to -30 dBm for doing the
Frequency Range measurement. If you chose to set up this measurement using start and stop frequencies and RBW, those should be
set as recommended by the standard. Separate start and stop frequencies are given for the two steps of this measurement.

• You can select for the analysis to find the x dBm frequency difference from the center frequency either on the lower side, higher side,
or both sides. This option (Meas Range) can be set from the Params tab of the Settings control panel.

• The blue marking indicates the frequency difference from the center frequency based on the Meas Range option choice. You can set
this option to Low while analyzing in the lower range of the frequency spectrum, and set it to High when analyzing the higher range of
the frequency spectrum.

Power Density (Basic Rate)
This measurement verifies the maximum RF output power density.

More information about this measurement:

• This measurement can be done using the Spectrum display (Displays > Measurements > General Signal Viewing) and by setting
appropriate parameters as recommended in the Bluetooth SIG Radio Frequency test specification document.
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• The Bluetooth test specification recommends this measurement be done using fixed frequency, also known as hopping off, and can be
done in Direct Tx mode.

Out-of-band Spurious Emission (Basic Rate, LE 1M, LE 2M, LE Coded)
This measurement can be done for FCC or ETSI masks using the Spurious display.

Relative Power (Enhanced Data Rate)
This measurement calculates the relative power in the GFSK and PSK part of the Enhanced Data Rate (EDR) signal. This measurement is
supported only when an EDR signal is detected.

Select the Enhanced Data Rate standard from Presets > Standards to perform the measurement. This will load the displays found in the
Table 30 on page 383.

Bluetooth Status Messages
The following status messages may appear. Each message indicates the related condition (Description) shown in the following table.

Status message Description

Bluetooth Analysis: Preamble Not Detected Shown in the display and status bar when no valid Sync and Preamble are
found for the chosen standard. Also shown when no preamble is found for any
of the standards in Automatic Standard Detection mode.

Bluetooth Analysis: LE 1M Sequence Detected Shown in the status bar when the LE 1M standard is detected in Automatic
Standard Detection mode.

Bluetooth Analysis: LE 2M Sequence Detected Shown in the status bar when the LE 2M standard is detected in Automatic
Standard Detection mode.

Bluetooth Analysis: LE Coded Sequence Detected Shown in the status bar when the LE Coded standard is detected in Automatic
Standard Detection mode.

Bluetooth Analysis: Basic Rate Sequence Detected Shown in the status bar when the Basic Rate standard is detected in
Automatic Standard Detection mode.

Bluetooth Analysis: EDR Signal Detected Shown in the status bar when the EDR standard is detected in Automatic
Standard Detection mode.

Bluetooth Analysis: EDR Sync Word Not Detected Shown in the display and status bar when EDR Sync Word is not found (when
EDR standard is selected).

Bluetooth Analysis: Not enough payload data for
Bluetooth measurements

Shown in the display and status bar when Preamble and Access Address/
Sync Word is detected but there is not enough payload data for Modulation
Characteristics and CF Offset and Drift measurement.

Bluetooth Analysis: Meas BW may be too low Shown in the InBand Emission display and in status bar when Measurement
Bandwidth is too low.

Bluetooth Analysis: BT x dB BW detection failed Shown in the BT 20 dB BW display when x dB measurement detection fails.

Bluetooth Analysis: BT x dBm BW detection failed Shown in the BT 20 dB BW display when x dBm measurement detection fails.
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Bluetooth Constellation display
The BT Constellation display shows a digitally modulated signal in constellation form. The constellation can be viewed either as IQ or
Freq Dev. The default view is Freq Dev. The frequency deviation result that is shown in the Constellation display is compensated for the
frequency error (shown as readout). 

To show the BT Constellation display you can select Presets > Standards > Bluetooth or do the following:

1. Recall an appropriate acquisition data file.
2. Press the Displays button or select Setup > Displays.
3. In the Select Displays window, select Bluetooth Analysis in the Measurements box.
4. In the Available displays box, double-click the BT Constellation icon or select the icon and click Add. The BT Constellation icon will

appear in the Selected displays box and will no longer appear under Available displays.
5. Click the OK button to show the display.
6. Select Setup > Settings to display the control panel.
7. Select the Standard Params tab. Set the Standard, Power class (if required), and Measurement and Reference filters as appropriate

for the input signal. You can also check the Auto Detect Standard box.
8. Select the Trace tab and set the Trace Type to Freq Dev or IQ, as required.
9. Select Replay/Run to take measurements on the acquired data.
10. Press the Replay/Run button to take measurements on the acquired data.

Elements of the Display
The following image shows the BT Constellation display of QPSK data in an EDR signal. Trace Type is set to IQ.

Item Display element Description

A Trace Select and enable a trace.

B Trace Type Specifies Trace type (choice between Freq Dev and IQ). This option appears only when
EDR signal is detected.

Table continued…
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Item Display element Description

C Freq Eror / Freq Offset / marker
readouts

The Freq Error, Freq Offset, and marker readout values appear here or below the plot,
depending on the display view and size.

The Freq Error value is the difference between the maximum and the minimum values of
signal frequency during the measurement time. The Freq Error (Auto) value is displayed
when the Auto check box is selected in the Analysis Params tab in the Settings control
panel.

The Freq Offset (Manual) value is displayed when the Auto check box is unselected in the
Analysis Params tab in the Settings control panel.

When markers are enabled, marker information (including time, magnitude, phase,
symbol, and value) is displayed.

D Avg Dev Shows the average deviation result at every symbol point.

E Plot Bluetooth constellation graph. Shown as either IQ or as Frequency Deviation. The trace
type is controlled from the Settings > Trace tab.

F Show Vectors Specifies whether to show or hide the selected trace.

The following image shows the BT Constellation display of GFSK data in a Basic Rate signal. Trace Type is set to Freq Dev.

BT Constellation Settings
Main menu bar: Setup > Settings

The BT Constellation Settings control panel provides access to settings that control parameters of the Constellation Display. 

Settings tab Description

Standard Params Select the standard, measurement filters, reference filters, and power class (when applicable). You
can also set the analyzer to auto detect the standard.

Table continued…
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Settings tab Description

Analysis Params Specifies frequency error, frequency offset, measurement BW, and test patterns. You can also select
to auto detect test patterns. These parameters are used by the instrument to analyze the input signal.

Analysis Time Specifies parameters that define the portion of the acquisition record that is used for analysis. Also
allows you to specify the Units (Symbols or Seconds) and Time Zero Reference (Trigger or Acquisition
Start) for Bluetooth Analysis displays.

Traces Allows you to select the trace to view, the trace type (IQ or Freq Dev), the number of points per
symbol (when trace content is set to Vectors or Lines), and to show or freeze the selected trace.

Prefs Allows you to select to show or hide the graticule and marker readouts.

Bluetooth Eye Diagram display
The BT Eye Diagram display shows a digitally modulated signal overlapped on itself to reveal variations in the signal.

To show the BT Eye Diagram display:

1. Recall an appropriate acquisition data file.
2. Press the Displays button or select Setup > Displays.
3. From the Measurements box, select Bluetooth Analysis.
4. Double-click the BT Eye Diagram icon in the Available Displays box. This adds the BT Eye Diagram icon to the Selected displays

box.
5. Click OK button. This displays the BT Eye Diagram view.
6. Select Setup > Settings to display the control panel.
7. Select the Standard Params tab. Set the Standard, Power class (when appropriate), and Measurement and Reference filters as

appropriate for the input signal. You can also check the Auto Detect Standard box.
8. Select the Trace tab and set the Trace Type to Freq Dev or IQ, as required..
9. Select Replay/Run to take measurements on the acquired data.
10. Press the Replay/Run button to take measurements on the acquired data.

Elements of the Display
The following image shows the BT Eye display of a basic rate signal with Trace Type set to IQ.
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Item Display element Description

A Freq Error / Freq Offset The Freq Error value is the difference between the maximum and the minimum values of
signal frequency during the measurement time. The Freq Error (Auto) value is displayed
when the Auto check box is selected in the Analysis Params tab in the Settings control
panel.

The Freq Offset (Manual) value is displayed when the Auto check box is unselected in the
Analysis Params tab in the Settings control panel.

B Top of graph The vertical scale is normalized with no units (for IQ) and with Hz (for Freq Dev).

C Position Specifies the value shown at the center of the graph display.

D Bottom Readout Displays the value indicated by the bottom of graph.

E Autoscale Adjusts the vertical and horizontal settings to provide the best display.

F Position Displays the horizontal position of the trace on the graph display.

G Scale Adjusts the span of the graph in symbols.

H Plot Displays the input signal.

The following image shows the BT Eye display of a Basic Rate signal with Trace Type set to Freq Dev.
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BT Eye Diagram Settings
Main menu bar: Setup > Settings 

The settings for the BT Eye Diagram display are shown in the following table.

Note: You might save time configuring the BT Eye Diagram display by selecting the Standard Presets button in the Bluetooth Eye
Diagram Settings control panel. This allows you to select a preset optimized for the selected standard.

Settings tab Description

Standard Params Select the standard, measurement filters, reference filters, and power class (when applicable). You
can also set the analyzer to auto detect the standard.

Analysis Params Specifies frequency error, frequency offset, measurement BW, and test patterns. You can also select
to auto detect test patterns. These parameters are used by the instrument to analyze the input signal.

Analysis Time Specifies parameters that define the portion of the acquisition record that is used for analysis.
Also allows you to specify the Units (Symbols or Seconds) and Time Zero Reference (Trigger or
Acquisition Start) for Bluetooth Analysis displays.

Traces Allows you to select the trace to view, the trace type (IQ or Freq Dev), the number of points per
symbol (when trace content is set to Vectors or Lines), and to show the selected trace.

Scale Allows you to specify the horizontal and vertical scale settings.

Prefs Allows you to select to show or hide the graticule and marker readouts.
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Bluetooth Carrier Frequency Offset and Drift display
The BT CF (Carrier Frequency) Offset and Drift display shows the frequency offset preamble, payload regions, and the drift result values
are shown in this display. You can also view the values of frequency offset calculated in every ten bit interval in the payload and look for
excursions.

To show the BT CF (Carrier Frequency) Offset and Drift display:

1. Recall an appropriate acquisition data file.
2. Press the Displays button or select Setup > Displays.
3. In the Select Displays dialog, select Bluetooth Analysis in the Measurements box.
4. In the Available displays box, double-click the BT CF Offset and Drift icon or select the icon and click Add. The BT CF Offset and

Drift icon will appear in the Selected displays box and will no longer appear under Available displays.
5. Click OK to show the display.
6. Select Setup > Settings to display the control panel.
7. Select the Standard Params tab. Set the Standard, Power class (when appropriate), and Measurement and Reference filters as

appropriate for the input signal. You can also check the Auto Detect Standard box.
8. Select the Limits tab and set the limits , as required.
9. Select Replay/Run to take measurements on the acquired data.
10. Press the Replay/Run button to take measurements on the acquired data.

Elements of the Display
The following image shows the frequency offset and drift values of a basic rate (first image) and LE Coded signal in the BT Freq Offset and
Drift display.
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Display element Description

Column 1 Indicates ten bit interval numbers. Zero indicates preamble region and the non-zero number
indicate the ten bit intervals in payload.

Column 2 Shows the calculated frequency offset in the preamble and the ten bit intervals in the
payload.

Column 3 Shows the drift of offset from the preamble and over a 50 μs for LE 1M, LE 2M and 48 μs for
LE Coded duration.

Column 4 Shows the drift of offset over a 50 μs for LE 1M, LE 2M and 48 μs for LE Coded duration.

— Results that do not meet the limits are shown with a red colored background, indicating
failure. (Limits can be set in the Limits tab from the Settings control panel.)

Table continued…
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Display element Description

Scalar results The scalar results show below the table. They are as follows:

Freq Offset Preamble

Max Freq Offset (Payload)

For LE 1M, LE 2M:

Drift f1-f0

Max Drift fn-f

Max Drift fn-f(n-5)

For LE Coded:

Drift f0-f3

Max Drift f1-f4

Max Drift fn-f(n-3)

BT CF Offset and Drift Settings
Main menu bar: Setup > Settings 

The settings for the BT CF Offset and Drift display are shown in the following table.

Settings tab Description

Standard Params Select the standard, measurement filters, and power class (when applicable). You can also set the
analyzer to auto detect the standard.

Analysis Params Specifies frequency error, frequency offset, measurement BW, and test patterns. You can also select
to auto detect test patterns. These parameters are used by the instrument to analyze the input signal.

Analysis Time Specifies parameters that define the portion of the acquisition record that is used for analysis.
Also allows you to specify the Units (Symbols or Seconds) and Time Zero Reference (Trigger or
Acquisition Start) for Bluetooth Analysis displays.

Limits Allows you to load and define Bluetooth measurement limits for Pass/Fail comparison. You can save
defined limits as a .csv file and also load previously saved .csv files. These limits also apply to the
Settings control panel Limits tab of the BT Summary display.

Bluetooth Summary display
The BT Summary display shows a summary of all the scalar measurements done on the acquired test pattern. The summary display and
contents will vary according to the selected standard.

Pass/Fail information is also provided in this display for all enabled scalar measurements. You can set limits and choose which
measurement to compare for Pass/Fail from the Limits tab of the BT Summary Settings control panel. The default limits come from the
performance recommendation limits given by the Standards document. The default limits can be reloaded by selecting the Bluetooth
Standards Preset option.

Bluetooth Analysis

SignalVu™ Vector Signal Analysis Software Printable Help 397



The results presented in the BT Summary display include scalar results of modulation characteristics, frequency offset and drift and, output
power measurements (these are averaged over the last 10 acquired packets). The display also shows packet related information for the
current acquired packet.

To show the BT Summary display you can select Presets > Standards > Bluetooth or do the following:

1. Recall an appropriate acquisition data file.
2. Press the Displays button or select Setup > Displays.
3. In the Select Displays dialog, select Bluetooth Analysis in the Measurements box.
4. In the Available displays box, double-click the BT Summary icon or select the icon and click Add. The BT Summary icon will appear

in the Selected displays box and will no longer appear under Available displays.
5. Click OK to show the display.
6. Select Setup > Settings to display the control panel.
7. Select the Standard Params tab. Set the Standard, Power class (when appropriate), and Measurement and Reference filters as

appropriate for the input signal. You can also check the Auto Detect Standard box.
8. Select the Limits tab and set the limits , as required.
9. Select Replay/Run to take measurements on the acquired data.
10. Press the Replay/Run button to take measurements on the acquired data.

Elements of the display
The following image shows all average scalar results and packet information for a Basic Rate signal in the BT Summary display.
Modulation characteristics, carrier frequency offset and drift, and power measurements, along with packet information, are shown. The
packet information will vary depending on the chosen or detected standard. For more information about specific measurement results, see
the Bluetooth measurements and test setups section here.

Element Description

Standard Display of the selected standard or the detected standard (if the Auto Detect Standard setting is
chosen in the Standard Params tab of the Settings control panel).

Table continued…
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Element Description

Power class Display of the Power class in the Standard Params tab of the Settings control panel. Only available
when Basic Rate is the selected or detected standard.

Clear Click button to reset measurement. Clears all values and all results in the queue used for average
computation.

Modulation characteristics

(ten packet average)

Display of a group of scalar results related to Modulation Characteristics measurements. These scalar
results are only populated in the BT Summary display if preamble is detected in the acquired data.
The four scalar results are:

Δf1avg is calculated when analyzed test pattern (payload) is 11110000.

Δf2avg and the percentage of Δf2max value (greater than a given limit) are calculated only when
analyzed test pattern (payload) is 10101010 for LE 1M and LE 2M, and 11001100 for LE Coded.

The ratio of Δf2avg and Δf1avg is calculated provided both the results are available (or have been
done before).

All the results given are averaged over the last ten packets. The scalar results can be compared with
pass/fail limits set in the Limits tab of the Settings control panel.

More information can be found here.

Modulation index The Modulation index denotes if the transmitter of a BLE Packet is Stable or Standard. If it is Stable,
the modulation index will be between 0.495 and 0.505. If it is Standard, the modulation index will be
between 0.475 and 0.525. If neither of these conditions is satisfied, then no text is shown.

Frequency offset and drift

(ten packet average)

Display of a group of five scalar results related to the carrier frequency offset and drift measurement.
These scalar results are only populated in the BT Summary display if preamble is detected and if
the test pattern payload is a 10101010 pattern. All the results given are averaged over the last ten
packets. The scalar results can be compared with pass/fail limits set in the Limits tab of the Settings
control panel.

The eight scalar results are:

Preamble offset.

Maximum offset in Payload (calculated over 10 bit intervals for LE 1M, 20 bit intervals for LE 2M, and
16 bit intervals for LE Coded).

Drift (f1-f0)

Max Drift (fn-f0).

Max Drift (fn-fn-5) for LE 1M, LE 2M

Drift (f0-f3)

Max Drift (f1-f4)

Max Drift (fn-fn-3) for LE Coded

For more information about this measurement, see the Carrier frequency offset and drift (Basic Rate,
LE 1M, LE 2M, LE Coded) on page 386 topic in Bluetooth Measurements and test setups.

Table continued…
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Element Description

Output power Display of Average Power and Peak Power scalar results for Output Power. All the results given are
averaged over the last ten packets. The scalar results can be compared with pass/fail limits set in the
Limits tab of the Settings control panel.

For Enhanced Data Rate signals, the relative power in GFSK and PSK regions is measured.

For more information about this measurement, see the Output Power (Basic Rate, LE 1M, LE 2M, LE
Coded) on page 387 topic in Bluetooth Measurements and test setups.

Packet information The Packet information includes the Packet type, Preamble, Synchronization Word or Access Code,
Packet Header, Payload length, and CRC details. The decoded bits are shown for the current
analyzed packet.

The following image shows all average scalar results and packet information for a LE 1M< LE 2M, and LE Coded signal in the BT
Summary display.

The following image shows all average scalar results and packet information for an EDR signal in the BT Summary display.
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BT Summary Settings
Main menu bar: Setup > Settings 

The settings for the BT Summary display are shown in the following table.

Settings tab Description

Standard Params Select the standard, measurement filters, reference filters, and power class (when applicable). You
can also set the analyzer to auto detect the standard.

Analysis Params Specifies frequency error, frequency offset, measurement BW, and test patterns. You can also select
to auto detect test patterns. These parameters are used by the instrument to analyze the input signal.

Analysis Time Specifies parameters that define the portion of the acquisition record that is used for analysis. Also
allows you to specify the Units (Symbols or Seconds) and Time Zero Reference (Trigger or Acquisition
Start) for Bluetooth Analysis displays.

Limits Allows you to load and define Bluetooth measurement limits for Pass/Fail comparison. You can save
defined limits as a .csv file and also load previously saved .csv files. The frequency offset and drift
limits set here also apply to the CF Offset and Drift display.

Bluetooth Symbol Table display
The BT Symbol Table display shows decoded data values for each data symbol in the analyzed signal packet. It is like the BT Constellation
display except that a text table is used to display data instead of a graph. 

To show the BT Symbol Table display:

1. Recall an appropriate acquisition data file.
2. Press the Displays button or select Setup > Displays.
3. In the Select Displays dialog, select Bluetooth Analysis in the Measurements box.
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4. In the Available displays box, double-click the BT Symbol Table icon or select the icon and click Add. The BT Symbol Table icon will
appear in the Selected displays box and will no longer appear under Available displays.

5. Click OK to show the display.
6. Select Setup > Settings to display the control panel.
7. Select the Standard Params tab. Set the Standard, Power class (when appropriate), and Measurement and Reference filters as

appropriate for the input signal. You can also check the Auto Detect Standard box.
8. Select the Limits tab and set the limits , as required.
9. Select Replay/Run to take measurements on the acquired data.
10. Press the Replay/Run button to take measurements on the acquired data.

Regions of the Display
The BT Symbol Table is color coded to indicate different regions of the packet. The legend at the bottom of the symbol table lists the
packet contents in their associated colors. The following image shows values for a Basic Rate signal.

Packet standard Associated regions

Basic rate 4-bit preamble

64-bit access code

4-bit trailer

54-bit packet header

8- or 16-bit payload header based on packet type

Variable length payload data

16-bit CRC (Cyclic Redundancy Check)

Table continued…
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Packet standard Associated regions

LE 1M 8-bit preamble

32-bit access address / synchronization word

16-bit payload header

Variable length payload data (2–257 bytes)

24-bit CRC (Cyclic Redundancy Check)

LE 2M 8-bit preamble

32-bit access address / synchronization word

16-bit payload header

Variable length payload data (32–257 bytes)

24-bit CRC (Cyclic Redundancy Check)

LE Coded 80-bit preamble

256-bit access address / synchronization word

16-bit payload header

Variable length payload data (16–2057 bytes)

24-bit CRC (Cyclic Redundancy Check)

Enhanced Data Rate (EDR) 4-bit preamble

64-bit access code

4-bit trailer (if present, shown in black)

54-bit packet header

Guard region (shown as X)

EDR sync sequence (QPSK or 8PSK symbols)

16-bit payload header (QPSK or 8PSK symbols)

Variable length payload data (QPSK or 8PSK symbols)

16-bit CRC (Cyclic Redundancy Check) (QPSK or 8PSK symbols)

The following image shows values for a Low Energy signal.
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The following image shows values for an EDR signal.

Markers and the BT Symbol Table. Markers are indicators in the display that you can position on a trace to measure values such as
frequency, power, and time. A Marker always displays its position and, if the Delta Marker (M1-M4) readout is enabled, will display the
difference between its position and that of the Marker Reference (MR). In the BT Symbol Table, colored cells indicate the location of
markers. The selected Marker is highlighted with a light green background. All other markers are highlighted with a light gray background.
In the BT Symbol Table, the marker readout below the table shows the marker location in time, symbol numbers and symbol value.

BT Symbol Table Settings
Main menu bar: Setup > Settings 
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The settings for the BT Symbol Table display are shown in the following table.

Settings tab Description

Standard Params Select the standard, measurement filters, reference filters, and power class (when applicable). You
can also set the analyzer to auto detect the standard.

Analysis Params Specifies frequency error, frequency offset, measurement BW, and test patterns. You can also select
to auto detect test patterns. These parameters are used by the instrument to analyze the input signal.

Analysis Time Specifies parameters that define the portion of the acquisition record that is used for analysis.
Also allows you to specify the Units (Symbols or Seconds) and Time Zero Reference (Trigger or
Acquisition Start) for Bluetooth Analysis displays.

Prefs Allows you to select to show or hide the marker readouts and set the radix of shown symbols.

Bluetooth Frequency Dev vs Time display
The BT Freq Dev vs. Time display shows how the signal frequency varies with time.

To display the BT Freq Dev vs. Time display:

1. Recall an appropriate acquisition data file.
2. Select the Displays button or Setup > Displays.
3. In the Select Displays dialog, select Bluetooth Analysis in the Measurements box.
4. In the Available displays box, double-click the BT Freq Dev vs. Time icon or select the icon and click Add. The BT Freq Dev vs.

Time icon will appear in the Selected displays box and will no longer appear under Available displays.
5. Click OK to show the display.
6. Select the Standard Params tab. Set the Standard, Power class (when appropriate), and Measurement and Reference filters as

appropriate for the input signal. You can also check the Auto Detect Standard box.
7. Select the Trace tab and set the Content to Vectors or Points, as required.
8. Select Replay/Run to take measurements on the acquired data.
9. Press the Replay/Run button to take measurements on the acquired data.

Elements of the Display
The following image shows the frequency deviation of the complete packet of a Basic Rate signal in the BT Freq Dev vs. Time display.
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Item Display element Description

A Top of graph The vertical scale is normalized with Hz.

B View (This option is visible only when Preamble is detected.)

Select one of the following:

Packet: view frequency deviation for an entire packet.

Octet: view frequency deviation for a specified octet duration (8 μs). The Octet is specified
in the Octet # field.

C Octet # (xx of total) (This option is visible only when Preamble is detected and Octet is selected as the View.)

Specifies the Octet number. (The total number of octets is also indicated.) When View
is set to Octet, you can enter a particular octet in the Octet # field for zoom view. The
plot will show only 8 μs of information corresponding to the octet number chosen in the
payload. The regions that are used for doing the exact measurements are highlighted
in the Octet View. For F0F0 (Low Deviation) pattern in payload, bit intervals 2,3,6,7
regions are highlighted. For 10101010 LE 1M and LE 2M, and 11001100 for LE Coded
(high deviation) pattern, all bit regions are highlighted with appropriate results. The offset
calculated for every octet region (f1ccf or f2ccf) are also shown.

D Position (center) Adjust the frequency shown at the center of the display.

F Autoscale button Adjusts the offset and range for both vertical and horizontal to provide the best display.

G Position Displays the horizontal position of the trace on the graph display.

H Scale Adjusts the horizontal scale (time).

Table continued…

Bluetooth Analysis

SignalVu™ Vector Signal Analysis Software Printable Help 406



Item Display element Description

I Plot Displays the last analyzed complete packet or the selected octet (Octet zoom view) of the
signal. Markings are shown for Preamble offset and for Maximum Drift from preamble and
Maximum Drift for 50 μs.

J Scalar results The Scalar results for Modulation Characteristics and Frequency Offset and Drift
measurements are captured here. These results are from the last analyzed packet and
therefore could be different from the Averaged Scalar results shown in the BT Summary
display.

For Drift results, the index is also shown where the maximum drift occurred. The Drift
results are shown only when the preamble is detected and the test pattern payload
detected is 10101010 for LE 1M and LE 2M, and 11001100 for LE Coded. ΔF1avg or
ΔF2avg is shown only when the detected test pattern payload is (10101010) for LE 1M
and LE 2M or (11001100) for LE Coded.

Note: This display shows the frequency deviation results without compensating for the frequency error.

The following image shows the frequency deviation of the first octet in the payload of a Basic Rate signal (high deviation).

The following image shows the frequency deviation of the first octet in the payload of a Basic Rate signal (low deviation).
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BT Frequency Dev Vs Time Settings
Main menu bar: Setup > Settings 

The Setup settings for BT Freq Dev vs. Time are shown in the following table.

Settings tab Description

Standard Params Select the standard, measurement filters, reference filters, and power class (when applicable). You
can also set the analyzer to auto detect the standard.

Analysis Params Specifies frequency error, frequency offset, measurement BW, and test patterns. You can also select
to auto detect test patterns. These parameters are used by the instrument to analyze the input signal.

Analysis Time Specifies parameters that define the portion of the acquisition record that is used for analysis.
Also allows you to specify the Units (Symbols or Seconds) and Time Zero Reference (Trigger or
Acquisition Start) for Bluetooth Analysis displays.

Trace Allows you to select the number of points per symbol, content, and to choose between entire packet
view or zoom Octet view for a chosen octet number in a packet.

Scale Allows you to specify the horizontal and vertical scale settings.

Prefs Allows you to select to show or hide the graticule and marker readouts.

Bluetooth 20dB Bandwidth display
The BT 20dB BW display shows the results of two Bluetooth measurements: 20dB Bandwidth and Frequency Range. When the xdB BW is
chosen, the display shows the x dB bandwidth from the peak power. More detailed information about this measurement is available here.

To display the BT 20dB BW display:
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1. Recall an appropriate acquisition data file.
2. Select the Displays button or Setup > Displays.
3. In the Select Displays dialog, select Bluetooth Analysis in the Measurements box.
4. In the Available displays box, double-click the BT 20dB BW icon or select the icon and click Add. The BT 20dB BW icon will appear

in the Selected displays box and will no longer appear under Available displays.
5. Click OK to show the display.
6. Select the Standard Params tab. Set the Standard, Power class (when appropriate), and Measurement and Reference filters as

appropriate for the input signal. You can also check the Auto Detect Standard box.
7. Select the Trace tab and set the Content to Vectors or Points, as required.
8. Select Replay/Run to take measurements on the acquired data.
9. Press the Replay/Run button to take measurements on the acquired data.

Elements of the Display
The following image of the BT 20dB BW display shows a Basic Rate signal that would allow you to measure 20 dB bandwidth.

Item Display element Description

A PASS / FAIL Indicates Pass or Fail for the 20 dB BW measurement.

B Autoscale Adjusts the vertical and horizontal settings so that the entire trace fits in the graph.

C Normal / MaxHold Indicates whether the measurement is done with a MaxHold or a Normal condition.

Table continued…
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Item Display element Description

D Clear Resets count for Average and MaxHold functions. Enabled only when Averaging or
MaxHold is enabled. Pressing Clear will clear the trace and, if acquisition is running,
restart the averaging or hold process.

E Main results area Shows the xdBm and xdB results. The requested dB or dBm value can be set in the
controls below the result readout. Use the two radio buttons to select which of the two
results are illustrated in the graph with the blue lines and arrows. RBW also can be set
using the control. VBW enables the VBW (Video Bandwidth) filter. Displays current VBW
filter setting. See Setup > Settings > Freq & RBW tab.

F Position and dB/div

Units (not shown)

Fix. Slugger 2

Position sets the top of graph value. The dB/div setting is the vertical scale value.

Set the global Amplitude units for all the views in the analysis window using the drop down
menu that appears when you click on the box. This will change the amplitude selection in
the Units tab of the Amplitude control panel.

G Bottom readout Displays the value indicated by the bottom of graph.

H Position Displays the horizontal position of the trace on the graph display.

I Scale Adjust the span of the graph in symbols.

J Detailed results Displays the following additional measurements results:

Freq Error: The frequency difference between the measured carrier frequency of the
signal and the user-selected center frequency of the analyzer.

x db BW Ref Power: The peak power measured within the measurement bandwidth.

K Grid divider Determines the portion of the display allocated to the graph and detailed results area. You
can move the grid divider all the way to the top or bottom and any position in between.

L Blue lines Indicates the measurement positions.

M Plot Displays the input signal. Shaded areas indicate the measurement bandwidth (Settings >
Parameters tab > Measurement BW).

BT 20dB BW settings
Main menu bar: Setup > Settings 

The Setup settings for BT 20dB BW are shown in the following table.

Settings tab Description

Freq & RBW Allows you to specify the frequency, resolution bandwidth (RBW), step, and VBW used for the MCPR
measurements.

Table continued…
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Settings tab Description

Parameters Allows you to specify the x dB level, Measurement Direction, Measurement BW, xdBm level, xdBm
Range, count, and to enable averaging and the Max Hold function.

Scale Allows you to define the vertical and horizontal axes.

Prefs Allows you to select show or hide the graticule and marker readouts.

Bluetooth InBand Emission display
The BT InBand Emission display verifies whether the emissions inside the operating frequency range are within limits. The power in
adjacent channels of 1 MHz bandwidth around the frequency of transmission are calculated and compared against limits. The integrated
power in the 1 MHz band for the adjacent channels is shown in a table below the plot.

To display the BT InBand Emission display:

1. Recall an appropriate acquisition data file.
2. Select the Displays button or Setup > Displays.
3. In the Select Displays dialog, select BT Inband Emission in the Measurements box.
4. In the Available displays box, double-click the BT Inband Emission icon or select the icon and click Add. The BT Inband Emission

icon will appear in the Selected displays box and will no longer appear under Available displays.
5. Click OK to show the display.
6. Select the Standard Params tab and select the appropriate standard.
7. Select the Measurement Params tab and turn on averaging, if desired.
8. Select the Limits tab and set the desired limits.
9. Select Replay/Run to take measurements on the acquired data.
10. Press the Replay/Run button to take measurements on the acquired data.

Elements of the Display
The following image shows the BT Inband Emission display of a Basic Rate signal operating at 2.441 GHz (showing 80 adjacent bands).
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Item Display element Description

A PASS / FAIL Indicates Pass or Fail based on the number of adjacent channels that are below an upper
limit. A maximum of 3 adjacent channels can have integrated power higher than an upper
limit (Pass); otherwise, Fail is reported.

B Normal Displays Average Count if Average is turned on (set to Time Domain or Frequency
Domain) from the Measurement Params tab in the Settings control panel.

C Clear Resets measurement. Clears all values.

D Top of graph The vertical scale is normalized with appropriate power units.

(not
shown)

Units Sets the global Amplitude units for all the views in the analysis window. This will change
the amplitude selection in the Units tab of the Amplitude control panel.

E dB/div The vertical scale value.

F Bottom readout Displays the value indicated by the bottom of graph.

G Autoscale Adjusts the vertical and horizontal settings so that the entire trace fits in the graph.

H Position Displays the horizontal position of the trace on the graph display.

I Scale Adjust the span of the graph in symbols.

Table continued…
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Item Display element Description

J Plot Divides the spectrum into different adjacent channels (each of 1 MHz bandwidth) as
suggested in the standard document. You can select to show integrated power by
checking the Show power levels in graph box in the Prefs tab in the Settings control
panel). The integrated power level is shown in blue and the prescribed limits for
comparison (set in the Limits tab of the Settings control panel) are shown in white. The
region around the frequency of transmission is shown in a different color.

K Results table Reports the integrated power results (Channel frequency, Integrated power, and Limits)
from the display in a table.

Bluetooth Analysis Measurement Settings
Main menu bar: Setup &gt; Settings

Front panel: Settings

The control panel tabs in this section are shared between the displays in Bluetooth Analysis (Setup &gt; Displays). Some tabs are shared
by all the displays, some tabs are shared by only a subset of displays. The settings available on some tabs change depending on the
selected display.

Table 32: Common controls for Bluetooth Analysis displays

Settings tab Description

Standard Params Specifies the input signal standard and additional user-settable signal parameters.

Analysis Params Specifies parameters used by the application to analyze the input signal.

Analysis Time Specifies parameters that define the portion of the acquisition record that is used for analysis. Also
allows you to specify the Units (Symbols or Seconds) for Bluetooth Analysis displays.

Trace Specifies the trace type (Vectors, Points, and Lines), the number of points per symbol when chosen to
view as Vectors or Lines, and to control the view as Freq Dev or IQ.

Prefs Allows preferences with Radix display and marker readouts.

Scale Defines the vertical and horizontal axes.

Parameters Specifies parameters used to analyze the signal.

Freq RBW Allows you to set Frequency and RBW settings for the BT 20 dB BW display.

Limits Allows you to define limits for pass/fail comparison with calculated values. The default values are as
recommended in the test specification.

Measurement Params Allows you to set average (Time Domain, Off, or Frequency Domain) and to correct for noise floor.
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Standard Params tab - BT
The Standard Params tab allows you to specify the standard, measurement and reference filters, power class (for some standards), and
set standard auto detect.

The following image shows the tab for all of the Bluetooth displays except for the BT InBand Emission display. The Power Class menu only
appears when Basic Rate is the selected standard.

The following image shows the tab for the BT InBand Emission display.

Settings Description

Standard Select the appropriate standard: Basic Rate, LE 1M, LE 2M, LE Coded, or Enhanced Data
Rate.

Auto Detect Standard Check box to enable automatic detection of the Bluetooth standard (Basic Rate, Low
Energy, or Enhanced Data Rate). A status message will appear indicating which of the three
standards is detected and the result will show as Standard selection.

Measurement Filter Specifies the filter used for measurement. The default filters for the Low Energy and Basic
Rate standards are LE-Recommended and BR-Recommended, respectively.

Reference Filter Specifies the filter used as a reference.

Power Class

(only available for Basic Rate)

Select one out of three available power classes. This sets the default limits for comparison
(set in the Limits tab of the Settings control panel) for Average and Peak power
measurements.

Power class for the Basic Rate standard

The power class for Basic Rate is the reference receive power range as specified by the standard. It sets the default limits for comparison
in the Limits tab of the control panel for Average and Peak power measurements. The power classes are specified as follows:

Class 1: max power 20 dBm (100 mW) with mandatory power control.
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Class 2: max power 6 dBm (4 mW) with optional power control.

Class 3: max power 0 dBm (1 mW) with optional power control.

Recommended measurement and reference filters
The available measurement and reference filters depend on the selected standard. You can use the filters recommended by the standard
(shown in following table) or load your own filters by selecting one of the User defined filters from a file.

The measurement filter is applied before the demodulation bit is detected and the ideal reference is calculated.

The reference filter is applied to the internally generated ideal reference signal.

CAUTION: Although there may be other filter types listed in the drop down menu, if you select any filter other than that which is
recommended, the measurement results may not be accurate.

Standard Measurement filters Reference filters

Basic Rate BR-Recommended None

LE 1M LE-Recommended None

LE 2M LE-Recommended None

LE Coded LE-Recommended None

Enhanced Data Rate BR-Recommended None

How to select filters
In a signal transmitter/receiver system, the baseband signal might be filtered for bandwidth limiting or for another kind of necessary
shaping that needs to be applied. Normally, a filter in the transmitter (Ft) and a filter in the receiver (Fr) are applied.

The Measurement Filter setting in the analyzer corresponds to the baseband filter in the receiver (Fr): This setting tells the analyzer what
filter your receiver uses. When the analyzer is set to the same filter used by the receiver, the analyzer sees the signal as your receiver
would. The Measurement Filter setting should be the same as the filter used in the receiver under normal operation (as opposed to
testing).

Analysis Params tab - Bluetooth
The Analysis Params tab contains parameters that control the analysis of the input signal. The Test Patterns menu only appears when the
Auto Detect Test Pattern is not checked. This tab is available for all displays except for the BT 20dB BW and the BT InBand Emission
displays.
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Settings Description

Frequency Error When the Auto box is checked, the analysis determines the Frequency Error and the
measured Frequency Error is displayed. When the Auto box is unchecked, the entered value
is used by the analysis as a fixed frequency offset. This is useful when the exact frequency
offset of the signal is known.

Measurement BW Specifies the bandwidth about the center frequency at which measurements are made.
Select Manual, Auto, or Link to Span.

Auto Detect Test Pattern When this box is checked, automatic detection of the test pattern is enabled. When this box
is unchecked (Manual mode), automatic detection id disabled and you can select the test
pattern and specify the Δfavg for the other pattern for ratio computation.

Test Pattern Allows you to select the test pattern to be analyzed. This choice is available only when Auto
Detect Test Pattern is disabled.

Use 8 bits for f4 preamble interval This option allows you to select only the first 8 bits of f4 for LE Coded. This ensures that the
frequency offset computed in the interval f4 is not biased.

Analysis Time tab - Bluetooth
The Analysis Time tab contains parameters that define how the signal is analyzed in the Bluetooth Analysis displays. This tab is available
for all displays except for the BT 20dB BW and the BT InBand Emission displays.

Settings Description

Analysis Offset Specifies the location of the first time sample to use in measurements.

Auto When enabled, causes the instrument to set the Analysis Offset value based on the requirements of
the selected display.

Analysis Length Specifies the length of the analysis period to use in measurements. Length is specified in either
symbols or seconds, depending on the Units setting.

Auto When enabled, causes the instrument to set the Analysis Length value based on the requirements of
the selected display.

Available This is a displayed value, not a setting. It is the Analysis Length (time or symbols) being used by the
analyzer. This value may not match the Analysis Length requested (in manual mode).

Time Zero Reference Specifies the zero point for the analysis time.

Table continued…
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Settings Description

Units Specifies the units of the Analysis Length to either Symbols or Seconds.

Analysis Offset
Use analysis offset to specify where measurements begin. Be aware that you cannot set the Analysis Offset outside the range of time
covered by the current acquisition data. (All time values are relative to the Time Zero Reference.)

You can set the Analysis Length so that the requested analysis period falls partly or entirely outside the current range of acquisition
data settings. When the next acquisition is taken, its Acquisition Length will be increased to cover the new Analysis Length, as long as
the Sampling controls are set to Auto. If the Sampling parameters are set to manual, or if the instrument is analyzing saved data, the
actual analysis length will be constrained by the available data length, but in most cases, measurements are able to be made anyway.
The instrument will display a notification when measurement results are computed from less data than requested. Range: 0 to [(end of
acquisition) - Analysis Length)]. Resolution: 1 effective sample (or symbol).

Analysis Length
Use the analysis length to specify how long a period of time is analyzed. As you adjust this value, the actual amount of time for Analysis
Length, in Symbol or Seconds units, is shown below the control in the "Available" readout. This setting is not available when Auto is
checked. Range: minimum value depends on the standard. Resolution: 1 symbol.

Time Zero Reference
All time values are measured from this point (such as marker position or horizontal position (in Y vs Time displays). Choices are:
Acquisition Start or Trigger.

Parameter Description

Acquisition Start Time zero starts from the point at which the acquisition begins.

Trigger Time zero starts from the trigger point.

Limits tab - Bluetooth
This tab is only available for the BT CF Offset and Drift, BT InBand Emission, and BT Summary displays. It enables you to load an existing
limits table, save a limits table, or edit limits values. The content under Measurement Name varies based on the chosen standard and
power class.

Some measurements are done only when a specific test pattern is detected. If the specific pattern is not detected, then N/A appears in
blue in the BT Summary display because the measurement is not done. If the measurement is done, Pass or Fail is shown in the BT
Summary display.

The following image shows the Limits tab for the BT CF Offset and Drift and BT Summary displays.

The following image shows the Limits tab for the BT InBand Emission display.
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Settings Description

Load Click to load a saved Limits table from a .csv file.

Save Click to save the current Limits table to a .csv file.

Edit limits
To directly edit measurement limits in the table, click on the value in the Limit column that you want to change. The following table
describes the parameters that are set in the Limits Table.

Settings Description

On Click on the cell in the On column next to the measurement to specify whether or not measurements
are selected for limit comparison to indicate Pass or Fail. A check mark means the measurement will
be taken. An empty box means it will not be taken.

Measurement Name Specifies the name of the measurement related to the limit. (Not editable.) The content under
Measurement Name varies based on the chosen standard and power class.

Limit Specifies the value of the limit to the related measurement. When the cell is selected, the value is
shown along with the units.

Scale tab - Bluetooth
The Scale tab allows you to change the scale settings that control how the trace appears on the display but does not change control
settings such as Measurement Frequency. In effect, these controls operate like pan and zoom controls. The Scale tab values are unique to
each display. Also, note that each display uses horizontal and vertical units that are appropriate for that display. There are three versions of
the Scale tab for Bluetooth displays.

The following image shows the Scale tab for the BT 20dB BW and BT InBand Emission displays.

The following image shows the Scale tab for the BT Eye Diagram display.
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The following image shows the Scale tab for the BT Freq Dev vs Time display.

Settings Description

Vertical Controls the vertical position and scale of the trace display.

Scale Changes the vertical scale of the graph.

Position Adjusts the reference level away from top of the graph.

Autoscale Resets the scale of the vertical axis to contain the complete trace.

Horizontal Controls the horizontal span of the trace display and position of the trace.

Scale Allows you to, in effect, change the horizontal span.

Position Allows you to pan a zoomed trace without changing the frequency.

Autoscale Resets the scale of the horizontal axis to contain the complete trace.

Auto When Auto is checked, the scale and position values for the Symbols graph are automatically
adjusted to maintain the optimal display.

Reset Scale Resets all settings to their default values.

Note: The Units used for the horizontal scale for the BT Freq Dev vs Time display can be either Seconds or Symbols. To set the
units for the horizontal scale, display the Analysis Time tab. On the tab, select the appropriate units from the Units drop-down list.

Traces tab - Bluetooth
The Traces tab allows you to set the trace display characteristics of the BT Constellation, BT Eye Diagram, and BT Freq Dev vs Time
displays. The selections vary depending on the selected display.

The following image shows the tab for the BT Constellation display.
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The following image shows the tab for the BT Eye Diagram display.

The following image shows the tab for the BT Freq Dev vs Time display.

Setting Description

Trace Select the trace to display.

Show Shows / hides the selected by trace.

Freeze Halts updates to the selected trace.

Points/Symbol Select how many points to use between symbols when connecting the dots. Values: 1, 2, 4, 8, 16, and
32.

Content Select whether to display the trace as vectors (points connected by lines), points (symbols only
without lines), or lines (lines drawn between symbols, but no symbols are displayed). The choices
available depend on the display.

Trace Type Select to specify whether the plot is shown as IQ or as Frequency Deviation.

Table continued…
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Setting Description

View Allows you to see the full packet or only the chosen Octet.

Octet # (of xx) Allows you to view the specified octet. You can also select from the list of the available number of
Payload octets in the packet.

Comparing two traces in the BT Constellation display
You can use the Traces tab to enable the display of a second trace. The second trace is a version of the current acquisition. You can
choose to freeze a trace in order to display the current live trace to an earlier version of itself, you can display the trace as a second trace,
or you can choose to display both traces frozen in order to compare the trace to itself at different times.

To display a second trace in the BT Constellation display:

1. If more than one display is present, select the BT Constellation display to ensure it is the selected display.

2. Click .
3. Select the Trace tab.
4. Select Trace 2 from the Trace drop-down list.
5. Click the Show check box so that it is checked.
6. Specify the Content as desired.

The Trace 2 lines will appear in blue to help you distinguish Trace 2 from Trace 1.

Prefs tab - Bluetooth
The Prefs tab enables you to change appearance characteristics of some of the Bluetooth Analysis displays.

The following image shows the Prefs tab for the BT 20dB BW, BT Freq Dev vs Time, BT Eye Diagram, and BT Constellation displays.

The following image shows the Prefs tab for the BT InBand Emission display.

The following image shows the Prefs tab for the BT Symbol Table display.
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Setting Description

Show graticule Shows or hides the graticule.

Show Marker readout in graph
(selected marker)

Shows or hides the readout for the selected marker in the graph area.

Radix Specifies how symbols are displayed in the Symbol Table display and in the Marker readout in the
display. There are three choices for Radix: Binary (0,1) and Modulation Symbols (+1,-1). When EDR
is detected, the symbol table will always show results in Hex for the PSK region (after guard).

Trace detection +Peak: Shows the peak power in a bin (of chosen RBW) if there are multiple points to choose from
within a bin.

Avg (VRMS): Shows the average power in a bin (of chosen RBW) if there are multiple points to
choose from within a bin.

Show power levels graph Displays the calculated power levels in graph in each band.

Parameters tab - Bluetooth
The Parameters tab enables you to specify several parameters that control signal acquisition in the BT 20dB BW display.

Setting Description

x dB level x dB level defines the x dB BW level search threshold.

Meas Direction Specifies which way the search for the x dB level is done. Selecting Inwards directs the search for
x dB from the edges towards maximum power. Selecting Outwards directs the search for x dB from
maximum power (x dB ref power) to edges.

x dBm level x dBm level defines the x dBm BW level search threshold.

x dBm range Specifies the search direction for the x dBm level. The choices are Lower, Higher, or Both.

Table continued…
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Setting Description

Measurement BW Specifies the frequency range used by the measurement.

Max Hold spectral data Enables the Max Hold function.

Average results Enables/disables results average across acquisitions. (This is averaging of the results, not of the
trace.)

Count Specifies the number of results averaged to calculate the Occupied BW. Range: 2 to 10,000.

x dB level
The x dB level determines the x dB bandwidth. The analyzer analyses the spectrum trace to locate the frequencies at which the level
is x dB down from the peak level, calculated over the measurement bandwidth. The frequency difference between the upper and lower
crossing thresholds is the x dB BW.

Range: -80.0 to -1.0 dB; Resolution: 0.1%; Inc/dec small: 0.1%, large: 1%; Default: -20 dB

Meas Direction
The search for the x dB level or x dBm level can be done by selecting Inwards or Outwards in Meas Direction. Selecting Inwards directs
the search from the edges towards maximum power. Selecting Outwards directs the search from maximum power (x dB ref power or CF
for x dBm) to edges.

x dBm level
The x dBm level determines the x dBm bandwidth. The analyzer analyzes the spectrum trace to locate the frequencies at which the level is
x dBm down from the Center frequency. The frequency range is calculated based on the choice of x dBm Range. The value of x dBm is set
to -30 dBm when the BT 20dB BW display is launched from the Bluetooth Standards Presets.

Meas Range (Higher, Lower, Both)
This determines the search range for the x dB level. The options are as follows:

• Lower: Indicates the frequency range from center to the lower frequency at which the power level drops to x dBm.
• Higher: Indicates the frequency range from center to the higher frequency at which power level drops to x dBm.
• Both: Indicates the frequency between the upper and the lower crossing thresholds at which the power level drops to x dBm.

Max Hold spectral data
Max Hold displays the maximum value in the acquisition record for each display point. Each new trace display point is compared to the
previous maximum value and the greater value is retained for display and subsequent comparisons.

Freq & RBW tab - Bluetooth
The Freq & RBW tab allows you to specify the bandwidth parameters used for setting measurement bandwidth in the BT 20dB BW display.
This determines what acquisition bandwidth the measurement will request.

Bluetooth Analysis

SignalVu™ Vector Signal Analysis Software Printable Help 423



Setting Description

Meas Freq Specifies the measurement frequency.

RBW Select Auto or Manual. Adjusts the resolution bandwidth for the entire measurement. This setting is
independent of the Spectrum display’s RBW setting.

Step Sets the increment/decrement size for the adjustment of the center frequency. If Auto is enabled, the
analyzer will adjust the step size as required.

VBW Adjusts the video bandwidth.

Measurement Params tab - Bluetooth
The Measurement Params tab is only available for the BT InBand Emission display. It allows you to select the average domain.

Setting Description

Average Specify the average domain (Time Domain, Frequency Domain) or set Average to Off. If a domain is
selected, then you can also specify the number.

Number Specify the number value associated with the Average setting.
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Audio Analysis and Demodulation
Overview
Audio Analysis (Option SVA) measures basic time- and frequency-domain parameters of analog audio signals modulated on a carrier (AM,
FM and PM modulation) or unmodulated (non-carrier) audio signals (Direct).

For modulated signals, the measurement analysis first demodulates the signal to provide the Audio signal waveform. Direct input signals
bypass the demodulation step. For FM and PM demodulation, the carrier frequency error is estimated during demodulation.

The Audio signal waveform excursions are then measured to determine the Peak and RMS waveform parameters. Next, the analysis
detects the highest-amplitude frequency component within the audio bandwidth, and makes a high-accuracy frequency measurement of
the frequency component. This value is called the Audio Frequency.

A spectral analysis of the Audio signal waveform is performed to determine the presence and level of harmonically- and/or non-
harmonically-related narrowband spurs and wideband noise. The Audio signal, harmonic and non-harmonic spurs, and noise level data are
combined to produce signal summary parameters including SINAD, Modulation Distortion, Signal-to-Noise, Total Harmonic Distortion, and
Total Non-Harmonic Distortion.

Controls are provided to allow the user to select audio filters of Low Pass, High Pass, FM De-emphassis, or Standard-defined response,
as well as completely user-definable filter response. Filtering can be applied as needed to modify the audio spectrum result before
measurement to remove unwanted spurs or noise.

Flexible control parameters are provided to allow setting the Audio Bandwidth for analysis, the Resolution Bandwidth (RBW) and RBW
filter type of the spectral analysis, and number and level qualifications for Harmonic and Non-harmonic spur detection. Multiple-spectrum
averaging can be enabled to provide a smoothed spectrum for results with less variability than single-spectrum results.

The Audio Spectrum display shows the frequency spectrum waveform with detected harmonic and non-harmonic components identified
by markers, and a corresponding table of frequency and level values for the spur components. The markers and table provide easy
visualization of the significant spurs and their relation to the fundamental Audio frequency signal.

Audio Spectrum Display
The Audio Spectrum display shows audio modulation characteristics. You can choose to show just the spectrum of the audio signal or
show the audio spectrum of the signal and the results of distortion measurements. The Audio Spectrum display can show a table listing the
frequency of a Harmonic Distortion (HD) and Non-Harmonic Distortion (NHD) and its level. The Spectrum graph indicates these harmonics
and non-harmonics with special markers. 

To display the Audio Spectrum display:

1. Press the Displays button or select Setup > Displays. This shows the Select Displays dialog box.
2. From the Measurements box, select Audio Analysis.
3. Double-click the Audio Spectrum icon in the Available Displays box. This adds the Audio Spectrum icon to the Selected displays

box.
4. Click the OK button. This shows the Audio Spectrum display.
5. Press the Replay button to take measurements on the recalled acquisition data file.
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Elements of the Audio Spectrum Display

Item Display element Description

1 Vertical position Sets the top of graph value.

2 dB/div Sets the vertical scale value. The maximum value is 20.00 dB/division.

3 Audio BW Specifies the measurement bandwidth of the Audio Spectrum display, which in turn can
influence the acquisition bandwidth.

4 Table Displays a table that shows the distortion measurement results and displays indicators on
the graph that highlight the location of the harmonics on the trace.

5 Bottom of graph readout Displays the bottom of graph value.

6 Non-harmonic threshold indicator Displays the threshold for detecting non-harmonic components.

7 Analysis results Display of the audio analysis results.

Audio Spectrum Settings
Main menu bar: Setup > Settings 

The measurement settings for the Audio Spectrum display are shown in the following table.

Settings tab Description

Params1 Tab on page 429 Specifies signal type, Audio Bandwidth, RBW, RBW filter, and Ref Audio Frequency.

Params2 Tab on page 430 Specifies Harmonics and Non-Harmonics measurement parameters.

Audio Filters Tab on page 431 Specifies the audio filter characteristics.

Table continued…
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Settings tab Description

Scale Tab on page 135 Sets vertical and horizontal scale and position parameters.

Prefs Tab on page 435 Specifies vertical units, and whether on not some features are displayed in the graph.

Audio Summary Display
To display the Audio Summary display:

1. Press the Displays button or select Setup > Displays. This shows the Select Displays dialog box.
2. From the Measurements box, select Audio Analysis.
3. Double-click the Audio Summary icon in the Available Displays box. This adds the Audio Summary icon to the Selected displays

box.
4. Click the OK button. This shows the Audio Summary display.

The Audio Summary Display

Audio Summary Displayed Measurements
Table 33: Audio Summary Measurements

Signal type Item Description

AM, FM, PM Carrier Power Average power of the carrier signal with modulation removed.

Direct Signal Power Average power of the input signal

FM, PM Carr Freq Err Carrier frequency error

AM, FM, PM. Direct Audio Freq Fundamental audio frequency

+Peak +Peak modulation excursion (where the modulation excursion
readout depends on the signal type)1

-Peak -Peak modulation excursion (where the modulation excursion
readout depends on the signal type)2

Table continued…

1 For AM signal types, modulation excursion is "% Modulation Depth". For FM signal types, modulation excursion is "Frequency Deviation". For PM signal types,
modulation excursion is "Phase Deviation". For Direct, there is no modulation excursion, it is actually "signal excursion".
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Signal type Item Description

Peak-Peak/2 Half peak-peak modulation excursion (where the modulation
excursion readout depends on the signal type)3

RMS RMS modulation excursion (where the modulation excursion
readout depends on the signal type)4

SINAD Signal to noise and distortion

Mod Distor Modulation distortion

S/N An estimate of the Signal level to Noise (only) level, with the
HD and NHD components removed

THD Total harmonic distortion

TNHD Total non-harmonic distortion

Ref Ref is the RMS modulation value stored when the Capture
Reference button is pressed. (Displayed only when Hum &
Noise is enabled.)

Diff Diff is the difference between the current RMS mod value and
the Ref value captured previously. (Displayed only when Hum
& Noise is enabled.)

Audio Summary Settings
Main menu bar: Setup > Settings 

The measurement settings for the Audio Summary display are shown in the following table.

Settings tab Description

Params1 Tab on page 429 Specifies signal type, Audio Bandwidth, RBW, RBW filter, and Ref Audio Frequency.

Params2 Tab on page 430 Specifies Harmonics and Non-Harmonics measurement parameters.

Audio Filters Tab on page 431 Specifies the audio filter characteristics.

Hum & Noise Tab Specifies whether or not Hum & Noise is measured and enables the capture of a signal to be used as
a reference of the Hum & Noise measurement.

2 For AM signal types, modulation excursion is "% Modulation Depth". For FM signal types, modulation excursion is "Frequency Deviation". For PM signal types,
modulation excursion is "Phase Deviation". For Direct, there is no modulation excursion, it is actually "signal excursion".

3 For AM signal types, modulation excursion is "% Modulation Depth". For FM signal types, modulation excursion is "Frequency Deviation". For PM signal types,
modulation excursion is "Phase Deviation". For Direct, there is no modulation excursion, it is actually "signal excursion".

4 For AM signal types, modulation excursion is "% Modulation Depth". For FM signal types, modulation excursion is "Frequency Deviation". For PM signal types,
modulation excursion is "Phase Deviation". For Direct, there is no modulation excursion, it is actually "signal excursion".
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Audio Analysis Measurement Settings
The control panel tabs in this section are shared by the displays in the Audio Analysis folder (Setup > Displays).

Table 34: Common controls for Audio Analysis displays

Settings tab Description

Params1 Tab on page 429 Specifies characteristics about the audio signal and how measurements are made.

Params2 Tab on page 430 Specifies parameters that control how measurements are made on harmonics.

Audio Filters Tab on page 431 Specifies characteristics of filters applied to the signal before measurements are taken.

Scale Tab on page 135 Sets vertical and horizontal scale and position parameters.

Prefs Tab for Audio Analysis The Prefs tab enables you to change appearance characteristics of the Audio Analysis displays.

Params1 Tab
The Params1 tab is used to specify characteristics of the audio signal to be measured and how the signal will be measured.

Figure 48: Params1 tab for AM signal types

Setting Description

Signal Type Specifies the type of signal to be analyzed. The available choices are AM, FM, PM, and Direct.

Audio BW Specifies the bandwidth used for audio analysis.

Ref Audio Freq A measured value when Auto is selected. If you want to specify the reference audio frequency,
uncheck Auto and enter a value manually. If Ref Audio Freq is set manually, be aware that the
automated detection is still performed, but it is limited to a frequency range of ±1% of the Audio BW
centered around the manually specified value.

Carrier Freq Error / Carrier Freq
Offset

(FM and PM only) A measured value, when Auto is selected. If Auto is unchecked, you can specify
the Carrier Frequency Offset.

RBW Displays the Resolution Bandwidth for Audio measurements. This value is automatically set by default
to 1/500 of the measurement bandwidth. To manually specify the RBW, uncheck Auto. The minimum
RBW value is limited to the larger of 1 Hz or AudioBW/10000. The maximum is limited to AudioBW/
100.

RBW Filter Specifies the windowing method used for the transform.
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Setting Frequency for Direct Signal Types
Direct (unmodulated) signal analysis is only possible with the instrument Frequency control set to 0 Hz. You will receive a warning to
set Frequency to 0 Hz when Direct signal type is selected, if you haven’t already done so. Modulated signal types may be selected with
Frequency set to 0 Hz, but results are not meaningful in that case. For modulated signals, Frequency should always be set to a value ≥
Audio Bandwidth to avoid self-interference of the signal due to spectral folding.

Setting Audio Bandwidth
For AM, FM and PM, the Audio Bandwidth control sets not only the demodulated signal bandwidth, but also determines the pre-
demodulation bandwidth. Set it to a value at least half the pre-demodulation signal bandwidth, as in this equation:
Audio BW ≥ Signal Bandwidth / 2

Note: When performing audio analysis, you should allow the Audio BW control to automatically set the acquisition bandwidth,
rather than manually adjusting the Acq BW control on the Sampling Parameters tab of the Acquire control panel. The audio
measurement will cause the Acq BW setting to be ≥ Audio BW (Direct) or ≥ 2 × Audio BW (AM, FM, PM).

For Direct signals, set Audio Bandwidth large enough to include any significant harmonics/non-harmonics or other signal component of
interest. For example, to measure up to the 10th harmonic of a signal with a 5 kHz fundamental component, set Audio Bandwidth to 10 x
5 kHz = 50 kHz.

For modulated signals, Audio Bandwidth must be set wide enough to include all significant signal modulation components in addition to the
desired audio analysis bandwidth. For AM this is similar to Direct. For example, to measure up to the 10th harmonic of an AM signal with
3 kHz fundamental component, set Audio Bandwidth to 10 x 3 kHz = 30 kHz. This ensures that the bandwidth of the data provided by the
system to the measurement will be at least of 60 kHz (2 x 30 kHz) which is sufficient for this signal and analysis requirement.

FM and PM are more complex. For FM, the analysis bandwidth needs to be at least twice as wide as the the sum of peak Frequency
Deviation and the Fundamental Frequency (Carsons rule). This is a parallel condition along with setting Audio Bandwidth large enough for
the maximum audio bandwidth to analyze. Therefore, for FM, Audio Bandwidth should be:
AudioBW (FM) = MAX( MaxAudioAnalysisFreq, FreqDeviation+FundamentalFreq )
where MaxAudioAnalysisFreq is the highest audio frequency desired in the analysis. For example, for an FM signal with fundamental
signal of 5 kHz and peak frequency deviation (one-sided) of 10 kHz, Acquisition Bandwidth should be at least (2*(10k+5k)) = 30 kHz, or an
Audio Bandwidth of 15 kHz. Also if the analysis should extend to the 8th harmonic, then the Audio Bandwidth needs to be at least 8*5 kHz
= 40 kHz. So Audio Bandwidth should be set to 40 kHz. Using the equation:
AudioBW(FM) = MAX( 8x5kHz, (10+5)kHz ) = MAX( 40 kHz, 15kHz) = 40 kHz
The formula for PM is:
AudioBW (PM) = MAX (MaxAudioAnalysisFreq, PMFreqDeviation+FundamentalFreq)
where
PMFreqDeviation = PMPhaseDeviationInRadians x FundamentalFreq
RBW Filter Shape
Select Kaiser in most cases for best measurement performance. Select Flattop only if you want to use standard markers to measure signal
amplitude with highest accuracy.

Params2 Tab
The Params2 tab is used to specify how the signal harmonics are measured and to control spectrum averaging. 
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Setting Description

No. of Harmonics Specifies the number of harmonics to detect. The detected harmonics are tagged with a number on
the spectrum trace. The available range is 1–20.

No. of Non-Harmonics Specifies the number of non-harmonics to detect. The detected non-harmonics are tagged with a
number on the spectrum trace. The available range is 0–20.

Averaging Specifies the number of averages used to compute the results. Range: 2–100.

Ignore region Specifies the region about the signal frequency where the instrument will ignore non-harmonics.

Non-Harmonic Threshold Specifies the level which a spectrum peak must exceed to be declared a non-harmonic signal
component.

Non-Harmonic Excursion Specifies the difference in level between a spectrum peak and the average noise level that must be
exceeded for the peak to be declared a non-harmonic signal component.

About Averaging In Audio Analysis Displays
Analysis averaging is implemented using a “block” method. This means that the entire record required for multiple spectrum computations
is acquired and analyzed within one analysis cycle. The result of each analysis update is a complete, independent result from a set of N
spectrums averaged together, where N is the Averaging control value.. Since each update is a fully averaged result, no partially averaged
results are output before a final result is available, so each output is fully valid. However, with large Averaging values, acquisition record
sizes and measurement times may become large, so care should be taken to select the minimum amount of averaging needed.

Audio Filters Tab
The Audio Filters tab is used to specify filters to be applied to the acquired audio signal before measurements are taken. You can select
from pre-defined filters or use a filter you define in a text file. You can also specify the de-emphasis time constant applied to the audio
signal and the telecom weighting filters used to measure noise. 

Predefined Filters

You can specify low-pass filter (LPF) and high-pass filter (HPF) settings, a de-emphasis time constant and/or a telecom weighting filter to
match the response of your receiver. Alternatively, you can create a text file to specify the frequency response points.
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To use predefined filters:

1. Select the Predefined Filters option button.
2. Select the LPF, HPF, De-emphasis and Standard check boxes as appropriate.
3. Select the desired filter parameter from the drop-down list for each of the enabled filters or select User from the list if you wish to use a

custom value. For LPF and HPF, the listed frequencies represent the 3dB cutoff point of the filter.
4. If you select User from the drop-down list, enter a value in the text entry box that appears.

To disable all filtering:

1. Select the Predefined Filters option button.
2. Deselect all four filter check boxes.

Table 35: Predefined audio filters

Filter type Available settings

LPF (Low Pass Filter)

(5th-order Butterworth response)

300 Hz

3 kHz

15 kHz

30 kHz

80 kHz

300 kHz

User5

HPF (High Pass Filter)

(5th-order Butterworth response)

20 Hz

50 Hz

300 Hz

400 Hz

User5

Table continued…

5 User-entered values are restricted to maximum of 0.9 * Audio BW, and will automatically adjust downward to meet this limit (if required) when AudioBW is decreased.
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Filter type Available settings

De-emphasis (FM only) 25 μs

50 μs

75 μs

750 μs

User. Range: 25 μs to 10 ms

Standard CCITT

C-message

Standard. Use this setting to specify the telecom weighting filter. The characteristics of these filters are described in ITU-T
Recommendation O.41, Psophometer for Use on Telephone-type Circuits.

Using Custom Audio Filters
If you want to use audio filters that have a different response shape than the pre-defined filters, you can create a custom audio filter using
a text or CSV file to specify the desired filter frequency response.

To use a custom audio filter:

1. Verify that Audio Spectrum or Audio Summary is the selected display.
2. Click the Settings icon or select Setup > Settings.
3. Select the Audio Filters tab.
4. Click the File button.
5. Click the ... button and navigate to the location of the custom audio filter file you wish to use. Select the file you want to use and click

Open.
6. Acquire a new trace or replay a saved file to see the effect of the custom filter.

Creating a Custom Audio Filter. A custom audio filter file is either a plain text file or a CSV format file. The file contains frequency (in
Hz) and amplitude (in dB) value pairs which specify the filter frequency response shape. Each pair must be on a separate line. The filter
response between the points is interpolated using a cubic spline fit.

The following table shows the first few lines of a custom audio filter text file.

0, -100

16.66, -85

50, -63

100, -41

200, -21

300, -10.6

Table continued…
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400, -6.3

500, -3.6

600, -2

700, -0.9

800, 0

... ...

Format and rule-checking on custom audio filter files is performed as follows:

• The maximum number of frequency and amplitude pairs is 1000.
• Column 1 (frequency values in Hertz).

• Non-negative values only (zero is allowed).
• Strictly increasing order of frequencies (frequency value on each line > frequency value on previous line).
• There is no upper limit on the frequency value.

• Column 2 (amplitude values in dB units, where gain is a positive value and attenuation is a negative value).

• Values are restricted to the range -200 to +20 dB.

Scale Tab
The Scale tab allows you to change the vertical and horizontal scale settings. Changing the scale settings changes how the trace appears
on the display but does not change acquisition control settings. In effect, these controls operate like pan and zoom controls.

Setting Description

Vertical

Scale Changes the range shown between the top and bottom of the graph.

Position Adjusts the level shown at the top of the graph for linear units or the top of the graph for log units (for
example, dBm).

Autoscale Resets the Position so that the highest trace points are in the graph. For linear units (Volts, Watts), the
Autoscale also adjusts Scale.

Horizontal

Left Changes the frequency shown at the left side of the graph.

Table continued…
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Setting Description

Right Changes the frequency shown at the right side of the graph.

Autoscale Resets the Left and Right settings to show the entire trace.

Log Sets the graph horizontal axis to a logarithmic scale.

Reset Scale Resets the Vertical and Horizontal settings to their default values.

Hum & Noise Tab
Hum & Noise (available only when the Audio Summary display is the active display) is useful for comparing residual power or modulation
if the Ref value is captured when the Signal is On (Direct) or modulated (AM/FM/PM).  When the signal is turned off (Direct) or modulation
turned off (AM/FM/PM), Diff indicates how much residual Hum and Noise are still present in the measurement value.

To display Hum & Noise measurement:

1. Select Setup > Displays.
2. In the Select Displays window, select the Audio Analysis folder.
3. Double-click the Audio Summary icon so that it appears in the Selected displays box.
4. Click OK
5. With the Audio Summary display selected, select Setup > Settings.
6. Select the Hum & Noise tab. Click on the Measure Hum & Noise checkbox so that it is checked.

The Hum & Noise values appear at the bottom list of measurements in the Audio Summary display.
7. Acquire an appropriate signal.
8. While the analyzer is analyzing a signal you want to use as a reference, click the Capture reference now button to save a reference

value.

The Hum & Noise measurement compares the value of a specific signal quantity captured by the Capture reference now button with the
current measured value of that quantity. For Direct signal types (set on the Params1 tab), the Signal Level is captured and compared. The
Diff measurement is:
SignalLevel(current) – SignalLevel(Ref)
in dB.

For AM, FM, and PM signal types, the RMS modulation value (related to Modulation Depth, Frequency Deviation or Phase Deviation) is
captured and compared. The Diff measurement is:

20 x log10 (RMS(current)/RMS(Ref))

in dB.

Prefs Tab
The Prefs tab enables you to change appearance characteristics of the Audio Spectrum display.
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Setting Description

Units: Specifies the vertical scale units. The units available depend on the signal type selected.

Show graticule Select to display or hide the graticule.

Trace points Sets the number of trace points used for marker measurements and for results export.

Show Marker readout in graph
(selected marker)

Shows or hides the readout for the selected marker in the graph area.

Show Non-Harm Threshold Shows or hides the non-harmonic threshold line.
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GP Digital Modulation
Overview
The displays in General Purpose (GP) Digital Modulation (Displays > Measurements > GP Digital Modulation) are:

• Constellation
• Demod I & Q vs Time
• EVM vs Time
• Eye Diagram
• Frequency Deviation vs Time
• Magnitude Error vs Time
• Phase Error vs Time
• Signal Quality
• Symbol Table
• Trellis Diagram

The General Purpose Digital Modulation Analysis (Option 21) provides vector signal analyzer functionality. A wide variety of modulation
types are supported, allowing you to view your signals in Constellation, Eye and Trellis diagrams, measure the quality of the modulation,
display time-domain waveforms for demodulated I & Q signals, EVM, Phase Error, Magnitude Error, and more.

Modulation Measurements

Note: A maximum of approximately 163,800 samples can be analyzed by the General Purpose Digital Modulation measurements
(the actual value varies with modulation type).

Measurement Description

EVM The normalized RMS value of the error vector between the measured signal and the ideal reference
signal over the analysis length. The EVM is generally measured on symbol or chip instants and
can be reported in units of percent or dB. EVM is usually measured after best-fit estimates of the
frequency error and a fixed phase offset have been removed.

Phase Error The RMS phase difference between the measured signal and the ideal reference signal.

Magnitude Error The RMS magnitude difference between the measured signal and the ideal reference signal.

IQ Origin Offset The magnitude of the DC offset of the signal measured at the symbol times. It indicates the magnitude
of the carrier feed-through signal.

Gain Imbalance The gain difference between the I and Q channels in the signal generation path. Constellations with
gain imbalance show a pattern with a width that is different from height.

Rho ρ The normalized correlated power of the measured signal and the ideal reference signal. Like EVM,
Rho is a measure of modulation quality. The value of Rho is less than 1 in all practical cases and is
equal to 1 for a perfect signal measured in a perfect receiver.

Frequency Error The frequency difference between the measured carrier frequency of the signal and the user-selected
center frequency of the analyzer.

Table continued…
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Measurement Description

Quadrature Error The orthogonal error between the I and Q channels. The error shows the phase difference between
I and Q channels away from the ideal 90 degrees expected from the perfect I/Q modulation.
Constellations with quadrature error will show some leakage of I into Q and vice versa.

Constellation Display
The Constellation Display shows a digitally-modulated signal in constellation form.

To show the Constellation Display:

1. Select the Displays button or select Setup > Displays. This shows the Select Displays dialog box.
2. From the Measurements box, select GP Digital Modulation.
3. Double-click the Constellation icon in the Available Displays box. This adds the Constellation icon to the Selected displays box.
4. Click the OK button. This shows the Constellation display.

Elements of the Constellation Display

Item Display element Description

1 Check mark indicator The check mark indicator in the upper, left-hand corner of the display shows when the
Constellation display is the optimized display.

Note: When Best for multiple windows is selected in the Amplitude control
panel's RF & IF Optimization control, none of the measurement displays shows a
checkmark, as there is not a single optimized measurement.

2 Marker Readout Located to the left of the constellation plot or below it, depending on the size of the
window. If markers are enabled, the marker readout shows the time, mag, phase, symbol
marker and symbol value of the point with the selected marker.

3 EVM Readouts The EVM readouts are located below the Constellation plot. The readout shows EVM
Peak (%) and location, RMS (%).

Table continued…

GP Digital Modulation

SignalVu™ Vector Signal Analysis Software Printable Help 438



Item Display element Description

4 Plot Constellation graph.

Changing Constellation Settings

Constellation Settings
Main menu bar: Setup > Settings 

The settings for the Constellation view are shown in the following table.

Note: You might be able to save time configuring the Constellation display by pressing the Standard Settings button from the
Settings control panel. This allows you to select a preset optimized for a standard from the Select Standard dialog box. See
Standard Settings Button on page 460

Settings tab Description

Modulation Params
Tab on page 460

Specifies the type of modulation, symbol rate, and filters to be used in demodulating the input signal.

Freq & BW Sets values for frequency error/offset, measurement bandwidth, and frequency deviation (not every
control is present for every modulation type).

Equalizer Tab on page 467 Enable the Equalizer and adjust its parameters.

Advanced Params
Tab on page 468

Specifies additional parameters that are less frequently used.

Find Tab on page 471 Used to set parameters for finding a burst within the data record and for entering a Synch word.

Analysis Time Tab on page 472 Contains parameters that define the portion of the acquisition record that is used for analysis. Also
allows you to specify the Units (Seconds or Symbols) for the GP Digital Modulation displays.

Trace Tab on page 473 Allows you to set the trace display characteristics.

Prefs Tab on page 476 Enables you to set characteristics of the measurement display.

Demod I & Q vs Time Display
The Demod I & Q vs Time displays demodulated I and Q vs. Time. You can choose to display I only, Q only, or both.

Elements of the Display
To show the Demod I & Q vs Time display:

1. Select the Displays button or select Setup > Displays. This shows the Select Displays dialog box.
2. From the Measurements box, select GP Digital Modulation.
3. Double-click the Demod I&Q vs Time icon in the Available Displays box. This adds the Demod I&Q vs Time icon to the Selected

displays box.
4. Click the OK button. This shows the Demod I&Q vs Time display.
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Item Element Description

1 Check mark indicator The check mark indicator in the upper, left-hand corner of the display shows when the
Demod I & Q vs Time display is the optimized display.

Note: When Best for multiple windows is selected in the Amplitude control
panel's RF & IF Optimization control, none of the measurement displays shows a
checkmark, as there is not a single optimized measurement.

2 Top of Graph Sets the I and Q amplitude value indicated at the top of the graph. Changing the top value
affects the bottom of graph readout. Also, note that the top of graph setting interacts with
the internal vertical scale setting (which is not user settable) such that the range between
the top and bottom of the graph increases or decreases automatically.

3 Position Specifies the I and Q amplitude value shown at the center of the graph display.

4 Bottom Readout Displays the I and Q amplitude value shown at the bottom of graph.

5 Autoscale Adjusts the vertical and horizontal settings to provide the best display.

6 Position Specifies the horizontal position of the trace on the graph display.

7 Scale Adjusts the span of the graph. By decreasing the scale (time per division), the graph
essentially becomes a window that you can move over the acquisition record by adjusting
the offset.

8 Freq Error This readout can show Freq Error or Freq Offset. When it displays Freq Error, it shows
the difference between the instrument Frequency setting and the measured value of the
signal's carrier frequency. When it displays Freq Offset, it shows the frequency offset
specified on the Settings & Freq & BW tab. If Freq Error is displayed, it also indicates that
the Carrier frequency detection setting is Auto. If Freq Offset is displayed, it indicates that
the Carrier frequency detection setting is manual.

Changing Demod I&Q Settings.
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Demod I & Q vs Time Settings
Main menu bar: Setup > Settings 

The settings for the Demod I & Q vs Time display are shown in the following table.

Note: You might be able to save time configuring the Demod I & Q display by pressing the Standard Settings button from the
Settings control panel. This allows you to select a preset optimized for a standard from the Select Standard dialog box. See
Standard Settings Button on page 460

Settings tab Description

Modulation Params
Tab on page 460

Specifies the type of modulation used for the input signal and other parameters.

Freq & BW Specifies settings for frequency error, measurement BW and Frequency Deviation. Each of these
settings is set internally when set to Auto. Alternatively, you can specify values appropriate for specific
measurement needs.

Equalizer Tab on page 467 Enable the Equalizer and adjust its parameters.

Advanced Params
Tab on page 468

Specifies additional parameters.

Find Tab on page 471 Used to set parameters for finding a burst within the data record and for entering a Synch word.

Analysis Time Tab on page 472 Contains parameters that define the portion of the acquisition record that is used for analysis. Also
allows you to specify the Units (Seconds or Symbols) for the GP Digital Modulation displays.

Trace Tab on page 473 Allows you to set the trace display characteristics.

Scale Tab on page 475 Specifies the horizontal and vertical scale settings.

Prefs Tab on page 476 Enables you to set characteristics of the measurement display.

EVM vs Time Display
The EVM vs. Time Display shows the Error Vector Magnitude plotted over Time.

Note: A maximum of approximately 80,000 samples can be analyzed by the General Purpose Digital Modulation measurements
(the actual value varies with modulation type).

To show an EVM vs. Time display:

1. Press the Displays button or select Setup > Displays. This shows the Select Displays dialog box.
2. From the Measurements box, select GP Digital Modulation.
3. Double-click the EVM vs. Time icon in the Available Displays box. This adds the EVM vs. Time icon to the Selected displays box.
4. Click the OK button. This displays the EVM vs. Time view.

GP Digital Modulation

SignalVu™ Vector Signal Analysis Software Printable Help 441



Elements of the EVM vs Time Display

Item Display element Description

1 Top of graph adjustment Use the knob to adjust the vertical scale.

2 Position Adjusts the vertical position.

3 Autoscale Adjusts the Horizontal and Vertical scale to show the entire trace.

4 Peak and RMS value readout Shows the maximum result, the time it occurred, and the RMS of the result over the entire
analysis length.

5 Scale Sets the length of time shown in the graph.

Changing the EVM vs Time Display Settings

EVM vs Time Settings
Main menu bar: Setup > Settings 

The settings for the EVM vs. Time display are shown in the following table.

Note: You might be able to save time configuring the EVM vs. Time display by pressing the Standard Settings button from the
Settings control panel. This allows you to select a preset optimized for a standard from the Select Standard dialog box. See
Standard Settings Button on page 460

Settings tab Description

Modulation Params
Tab on page 460

Specifies the type of modulation used in the input signal and other parameters that controls the
demodulation of the input signal.

Table continued…
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Settings tab Description

Freq & BW Specifies settings for frequency error, measurement BW and Frequency Deviation. Each of these
settings is set internally when set to Auto. Alternatively, you can specify values appropriate for specific
measurement needs.

Equalizer Tab on page 467 Enable the Equalizer and adjust its parameters.

Advanced Params
Tab on page 468

Specifies Freq Offset, Magnitude normalization parameters, and enables swapping I and Q.

Find Tab on page 471 The Find tab is used to set parameters for finding bursts within the data record.

Analysis Time Tab on page 472 The Analysis Time tab contains parameters that define how the signal is analyzed in the general
purpose digital modulation displays.

Trace Tab on page 473 Specifies the display characteristics of the displayed trace.

Scale Tab on page 475 Specifies the horizontal and vertical scale settings.

Prefs Tab on page 476 Specifies whether certain display elements are visible.

Eye Diagram Display
The Eye Diagram Display shows a digitally modulated signal overlapped on itself to reveal variations in the signal.

To show an Eye Diagram display:

1. Press the Displays button or select Setup > Displays. This shows the Select Displays dialog box.
2. From the Measurements box, select GP Digital Modulation.
3. Double-click the Eye Diagram icon in the Available Displays box. This adds the Eye Diagram icon to the Selected displays box.
4. Click the OK button. This displays the Eye Diagram view.
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Elements of the Display

Item Element Description

1 Check mark indicator The check mark indicator in the upper, left-hand corner of the display shows when the
Frequency Deviation vs Time display is the optimized display.

Note: When Best for multiple windows is selected in the Amplitude control
panel's RF & IF Optimization control, none of the measurement displays shows a
checkmark, as there is not a single optimized measurement.

2 Top of Graph The vertical scale is normalized with no units (except for nFSK and C4FM modulation
types where the vertical units are Hz).

3 Position Specifies the value shown at the center of the graph display.

4 Bottom Readout Displays the value indicated by the bottom of graph.

5 Autoscale Adjusts the vertical and horizontal settings to provide the best display.

6 Position Displays the horizontal position of the trace on the graph display.

7 Scale Adjusts the span of the graph in symbols.

8 Freq Error Displays the difference between the maximum and minimum measured values of the
signal frequency during the Measurement Time. The displayed frequency error is followed
by either Auto or Manual. This indicates the selected carrier frequency detection method
(see Settings > Freq & BW).

Changing Eye Diagram Settings

Eye Diagram Settings
Main menu bar: Setup > Settings 
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The settings for the Eye Diagram display are shown in the following table.

Note: You might be able to save time configuring the Eye Diagram display by pressing the Standard Settings button from the
Settings control panel. This allows you to select a preset optimized for a standard from the Select Standard dialog box. See
Standard Settings Button on page 460

Settings tab Description

Modulation Params
Tab on page 460

Specifies the type of modulation used for the input signal and other parameters.

Freq & BW Specifies settings for frequency error, measurement BW and Frequency Deviation. Each of these
settings is set internally when set to Auto. Alternatively, you can specify values appropriate for specific
measurement needs.

Advanced Params
Tab on page 468

Specifies additional parameters.

Find Tab on page 471 Used to set parameters for finding a burst within the data record and for entering a Synch word.

Analysis Time Tab on page 472 Contains parameters that define the portion of the acquisition record that is used for analysis. Also
allows you to specify the Units (Seconds or Symbols) for the GP Digital Modulation displays.

Trace Tab on page 473 Allows you to set the trace display characteristics.

Scale Tab on page 475 Specifies the horizontal and vertical scale settings.

Prefs Tab on page 476 Enables you to set characteristics of the measurement display.

Frequency Deviation vs Time Display
To show a Frequency Deviation vs Time display:

1. Press the Displays button or select Setup > Displays. This shows the Select Displays dialog box.
2. From the Measurements box, select Frequency Deviation vs Time.
3. Double-click the Frequency Deviation vs Time icon in the Available Displays box. This adds the Frequency Deviation vs Time icon

to the Selected displays box.
4. Click the OK button. This displays the Frequency Deviation vs Time view.
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Elements of the Display

Item Element Description

1 Check mark indicator The check mark indicator in the upper, left-hand corner of the display shows when the
Frequency Deviation vs Time display is the optimized display.

Note: When Best for multiple windows is selected in the Amplitude control
panel's RF & IF Optimization control, none of the measurement displays shows a
checkmark, as there is not a single optimized measurement.

2 Top of Graph Sets the frequency deviation value indicated at the top of the graph. Changing the top
value affects the bottom of graph readout. Also, note that the top of graph setting interacts
with the internal vertical scale setting (which is not user settable) such that the range
between the top and bottom of the graph increases or decreases automatically.

3 Position Specifies the frequency deviation value shown at the center of the graph display.

4 Bottom Readout Displays the value of the frequency deviation value shown at the bottom of graph.

5 Autoscale Adjusts the vertical and horizontal settings to provide the best display.

6 Position Specifies the horizontal position of the trace on the graph display.

7 Scale Adjusts the span of the graph. By decreasing the scale (time per division), the graph
essentially becomes a window that you can move over the acquisition record by adjusting
the offset.

8 Freq Error Displays the difference between the maximum and minimum measured values of the
signal frequency during the Measurement Time. The displayed frequency error is followed
by either Auto or Manual. This indicates the selected carrier frequency detection method
(see Settings > Freq & BW).

Changing Frequency Deviation vs Time Settings
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Frequency Deviation vs Time Settings
Main menu bar: Setup > Settings 

The Setup settings for Frequency Deviation vs. Time are shown in the following table.

Note: You might be able to save time configuring the Frequency vs. Time display by pressing the Standard Settings button from
the Settings control panel. This allows you to select a preset optimized for a standard from the Select Standard dialog box. See
Standard Settings Button on page 460

Settings tab Description

Modulation Params
Tab on page 460

Specifies the type of modulation used for the input signal and other parameters.

Freq & BW Specifies settings for frequency error, measurement BW and Frequency Deviation. Each of these
settings is set internally when set to Auto. Alternatively, you can specify values appropriate for specific
measurement needs.

Equalizer Tab on page 467 Enable the Equalizer and adjust its parameters.

Advanced Params
Tab on page 468

Specifies additional parameters.

Find Tab on page 471 Used to set parameters for finding a burst within the data record and for entering a Synch word.

Analysis Time Tab on page 472 Contains parameters that define the portion of the acquisition record that is used for analysis. Also
allows you to specify the Units (Seconds or Symbols) for the GP Digital Modulation displays.

Trace Tab on page 473 Allows you to set the trace display characteristics.

Scale Tab on page 475 Specifies the horizontal and vertical scale settings.

Prefs Tab on page 476 Enables you to set characteristics of the measurement display.

Magnitude Error vs Time Display
The Magnitude Error displays the magnitude of the symbol error. The amplitude appears on the vertical axis while time is plotted along the
horizontal axis.

Note: A maximum of approximately 80,000 samples can be analyzed by the General Purpose Digital Modulation measurements
(the actual value varies with modulation type).

To display Magnitude Error vs. Time:

1. Select the Displays button or Setup > Displays. This displays the Select Displays dialog box.
2. Select GP Digital Modulation in the Measurements box.
3. Double-click the Mag Error vs. Time icon or select the icon and click Add. The icon will appear in the Selected displays box and will

no longer appear under Available displays.
4. Click OK.
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Elements of the Display

Item Display element Description

1 Top of graph adjustment Use the knob to adjust the value of the vertical scale.

2 Position Adjusts the level shown at the bottom of the display.

3 Autoscale button Adjusts the vertical and horizontal settings to provide the best display.

4 Horizontal Position Adjusts the horizontal position of the signal. Units can be either Symbols or Seconds
(Settings > Analysis Time tab > Units).

5 Peak and RMS value readout Displays the Peak value of the magnitude error, the RMS value of the magnitude error,
and the time at which it occurs within the acquisition. Units can be either Symbols or
Seconds (Settings > Analysis Time tab > Units).

6 Horizontal Scale Sets the time spanned by the graph. Units can be either Symbols or Seconds (Settings >
Analysis Time tab > Units).

7 Freq Error Freq Error is the difference between the Center Frequency and the measured frequency of
the signal being tested. This readout will be Freq Offset if the Freq Offset parameter on the
Settings > Advanced Params tab is set to Manual.

Changing Magnitude Error vs Time Display Settings

Magnitude Error vs Time Settings
Main menu bar: Setup > Settings 

The Setup settings for Magnitude Errors vs. Time are shown in the following table.
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Note: You might be able to save time configuring the Magnitude vs. Time display by pressing the Standard Settings button from
the Settings control panel. This allows you to select a preset optimized for a standard from the Select Standard dialog box. See
Standard Settings Button on page 460

Settings tab Description

Modulation Params
Tab on page 460

Specifies the type of modulation used for the input signal and other parameters.

Freq & BW Specifies settings for frequency error, measurement BW and Frequency Deviation. Each of these
settings is set internally when set to Auto. Alternatively, you can specify values appropriate for specific
measurement needs.

Equalizer Tab on page 467 Enable the Equalizer and adjust its parameters.

Advanced Params
Tab on page 468

Specifies additional parameters.

Find Tab on page 471 Used to set parameters for finding a burst within the data record and for entering a Synch word.

Analysis Time Tab on page 472 Contains parameters that define the portion of the acquisition record that is used for analysis. Also
allows you to specify the Units (Seconds or Symbols) for the GP Digital Modulation displays.

Trace Tab on page 473 Allows you to set the trace display characteristics.

Scale Tab on page 475 Specifies the horizontal and vertical scale settings.

Prefs Tab on page 476 Enables you to set characteristics of the measurement display.

Phase Error vs Time Display
The Phase Error vs. Time display shows the phase angle of the symbol error over time. The phase is plotted along the vertical axis while
time is plotted along the horizontal axis.

Note: A maximum of approximately 80,000 samples can be analyzed by the General Purpose Digital Modulation measurements
(the actual value varies with modulation type).

To show the Phase Error display:

1. Press the Displays button or select Setup > Displays.
2. In the Select Displays dialog, select GP Digital Modulation in the Measurements box.
3. In the Available displays box, double-click the Phase Error icon or select the icon and click Add. The Phase Error icon will appear in

the Selected displays box and will no longer appear under Available displays.
4. Click OK to display the Phase Error.
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Elements of the Phase Error vs Time Display

Item Display element Description

1 Freq Error Freq Error is the difference between the Center Frequency and the measured frequency of
the signal being tested. This readout will be Freq Offset if the Freq Offset parameter on the
Settings > Advanced Params Tab on page 468 tab is set to Manual.

2 Top of graph adjustment Adjusts the phase angle shown at the top of the graph.

3 Position Adjusts the vertical offset.

4 Autoscale Adjusts the vertical and horizontal settings so that the entire trace fits in the graph.

5 Offset Adjusts the horizontal offset.

6 Peak and RMS readouts Displays the Peak value of the phase error and the time at which it occurred. Also displays
the RMS value over the analysis length.

7 Scale Sets the time spanned by the graph.

Changing the Phase Error vs Time Display Settings

Phase Error vs. Time Settings
Main menu bar: Setup > Settings 

The settings for the Phase Error vs. Time display are shown in the following table.

Note: You might be able to save time configuring the Phase Error vs. Time display by pressing the Standard Settings button from
the Settings control panel. This allows you to select a preset optimized for a standard from the Select Standard dialog box. See
Standard Settings Button on page 460
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Settings tab Description

Modulation Params
Tab on page 460

Specifies the type of modulation used for the input signal and other parameters.

Freq & BW Specifies settings for frequency error, measurement BW and Frequency Deviation. Each of these
settings is set internally when set to Auto. Alternatively, you can specify values appropriate for specific
measurement needs.

Equalizer Tab on page 467 Enable the Equalizer and adjust its parameters.

Advanced Params
Tab on page 468

Specifies additional parameters.

Find Tab on page 471 Used to set parameters for finding a burst within the data record and for entering a Synch word.

Analysis Time Tab on page 472 Contains parameters that define the portion of the acquisition record that is used for analysis. Also
allows you to specify the Units (Seconds or Symbols) for the GP Digital Modulation displays.

Trace Tab on page 473 Allows you to set the trace display characteristics.

Scale Tab on page 475 Specifies the horizontal and vertical scale settings.

Prefs Tab on page 476 Enables you to set characteristics of the measurement display.

Signal Quality Display
The Signal Quality display shows several measurements of signal quality. The measurements displayed depend on the modulation type.
There is a set of measurements displayed for all modulation types except nFSK and C4FM. There is a second set of measurements
displayed for nFSK and C4FM modulation types.

Figure 49: Signal Quality display for all modulation types except nFSK, C4FM, OQPSK, and SOQPSK
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Figure 50: Signal Quality display for OQPSK and SOQPSK modulation types

Figure 51: Signal Quality display for nFSK modulation type

Figure 52: Signal Quality display for C4FM modulation type

Elements of the Display

GP Digital Modulation

SignalVu™ Vector Signal Analysis Software Printable Help 452



Table 36: Measurements for all modulation types except nFSK, C4FM, OQPSK and SOQPSK

Measurement Description

EVM The normalized RMS value of the error vector between the measured signal and the ideal reference
signal over the analysis length. The EVM is generally measured on symbol or chip instants and is
reported in units of percent and dB. EVM is usually measured after best-fit estimates of the frequency
error and a fixed phase offset have been removed. These estimates are made over the analysis
length. Displays RMS and Peak values with location of Peak value.

Phase Error The RMS phase difference between the measured signal and the ideal reference signal. Displays
RMS and Peak values with location of Peak value.

Mag Error The RMS magnitude difference between the measured signal and the reference signal magnitude.
Displays RMS and Peak values with location of Peak value.

MER (RMS) The MER is defined as the ratio of I/Q signal power to I/Q noise power; the result is indicated in dB.

IQ Origin Offset The magnitude of the DC offset of the signal measured at the symbol times. It indicates the magnitude
of the carrier feed-through signal.

Frequency Error The frequency difference between the measured carrier frequency of the signal and the user-selected
center frequency of the instrument.

Gain Imbalance The gain difference between the I and Q channels in the signal generation path. Constellations with
gain imbalance show a pattern with a width that is different form height.

Quadrature Error The orthogonal error between the I and Q channels. The error shows the phase difference between I
and Q channels away from the ideal 90 degrees expected from the perfect I/Q modulation. Not valid
for BPSK modulation type.

Rho The normalized correlated power of the measured signal and the ideal reference signal. Like EVM,
Rho is a measure of modulation quality. The value of Rho is less than 1 in all practical cases and is
equal to 1 for a perfect signal measured in a perfect receiver.

Table 37: Measurements for OQPSK and SOQPSK modulation types

Measurement Description

EVM The normalized RMS value of the error vector between the measured signal and the ideal reference
signal over the analysis length. The EVM is generally measured on symbol or chip instants and is
reported in units of percent and dB. EVM is usually measured after best-fit estimates of the frequency
error and a fixed phase offset have been removed. These estimates are made over the analysis
length. Displays RMS and Peak values with location of Peak value.

Offset EVM Offset EVM is like EVM except for a difference in the time alignment of the I and Q samples. For EVM,
I and Q samples are collected at the same time, for every symbol decision point (twice the symbol
rate for offset modulations). For Offset EVM, the I and Q symbol decision points are time-aligned
before collecting the I and Q samples. In this case, one I and one Q sample is collected for each
symbol (half as many samples as the same number of symbols for (non-offset) EVM.

Table continued…
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Measurement Description

Phase Error The RMS phase difference between the measured signal and the ideal reference signal. Displays
RMS and Peak values with location of Peak value.

Mag Error The RMS magnitude difference between the measured signal and the reference signal magnitude.
Displays RMS and Peak values with location of Peak value.

MER (RMS) The MER is defined as the ratio of I/Q signal power to I/Q noise power; the result is indicated in dB.

IQ Origin Offset The magnitude of the DC offset of the signal measured at the symbol times. It indicates the magnitude
of the carrier feed-through signal.

Frequency Error The frequency difference between the measured carrier frequency of the signal and the user-selected
center frequency of the instrument.

Gain Imbalance The gain difference between the I and Q channels in the signal generation path. Constellations with
gain imbalance show a pattern with a width that is different form height.

Quadrature Error The orthogonal error between the I and Q channels. The error shows the phase difference between I
and Q channels away from the ideal 90 degrees expected from the perfect I/Q modulation. Not valid
for BPSK modulation type.

Rho The normalized correlated power of the measured signal and the ideal reference signal. Like EVM,
Rho is a measure of modulation quality. The value of Rho is less than 1 in all practical cases and is
equal to 1 for a perfect signal measured in a perfect receiver.

Table 38: Measurements for nFSK modulation types

Measurement Description

Peak FSK err Peak value of the frequency deviation error at the symbol point.

RMS FSK Err RMS value of the frequency deviation error at the symbol point.

Peak Mag Err The Peak magnitude difference between the measured signal and the reference signal magnitude.

RMS Mag Err The RMS magnitude difference between the measured signal and the reference signal magnitude.

Freq Error The frequency difference between the measured carrier frequency of the signal and the user-selected
center frequency of the instrument.

Freq Deviation Frequency distance from the center frequency at the symbol point.

Symbol Rate Error This compares the user-entered symbol rate to the instrument calculated symbol rate of the analyzed
signal.

Symbol Rate When in Auto-symbol rate, the instrument calculates the symbol rate of the signal and the instrument
calculates the error between the user entered value and the instrument calculated value.
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Table 39: Measurements for C4FM modulation type

Measurement Description

RMS Error Magnitude RMS value of the frequency deviation error at the symbol point.

Carrier Frequency Error Frequency difference between averaged signal frequency and the center frequency.

Deviation Frequency distance from the center frequency at the symbol point.

Length Number of symbols in the analysis area.

Changing the Signal Quality Display Settings

Signal Quality Settings
Main menu bar: Setup > Settings 

The Setup settings for Signal Quality are accessible only when the Signal Quality display is selected.

Note: You might be able to save time configuring the Signal Quality display by pressing the Standard Settings button from the
Settings control panel. This allows you to select a preset optimized for a standard from the Select Standard dialog box. See
Standard Settings Button on page 460

Settings tab Description

Modulation Params
Tab on page 460

The Modulation tab specifies the type of modulation used for the input signal and other parameters.

Freq & BW Specifies settings for frequency error, measurement BW and Frequency Deviation. Each of these
settings is set internally when set to Auto. Alternatively, you can specify values appropriate for specific
measurement needs.

Equalizer Tab on page 467 Enable the Equalizer and adjust its parameters.

Advanced Params
Tab on page 468

The Advanced Params tab specifies frequency offset, magnitude normalization method and allows
you to swap the I and Q signals.

Find Tab on page 471 Find tab is used to set parameters for finding bursts within the data record.

Analysis Time Tab on page 472 The Analysis Time tab contains parameters that define the portion of the acquisition record that is
used for analysis.

Prefs Tab on page 476 The Prefs tab enables you to set characteristics of the measurement display.

Symbol Table Display
The Symbol Table Display is like the Constellation Display except that a text table is used to display data bits at a symbol rather than a
graph. The Synch Word characters, if used, are in bold font.

To display the Symbol Table:
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1. Recall an appropriate acquisition data file.
2. Select the Displays button or select Setup > Displays. This displays the Select Displays dialog box.
3. From the Measurements box, select GP Digital Modulation.
4. Double-click the Symbol Table icon in the Available Displays box. This adds the Symbol Table icon to the Selected displays box.
5. Click the OK button. This displays the Symbol Table view.
6. Press the Replay button to take measurements on the recalled acquisition data file.

Using Markers
Markers are indicators in the display that you can position on a trace to measure values such as frequency, power, and time. A Marker
always displays its position and, if the Delta readout is enabled, will display the difference between its position and that of the Marker
Reference. Within the Symbol Table, colored cells indicate the location of markers. The selected Marker is highlighted with a light green
background. All other markers are highlighted with a light gray background. In the Symbol Table, the marker readout below the table shows
the marker location in time, symbol numbers and symbol value.

Changing the Symbol Table Display Settings

Symbol Table Settings
Main menu bar: Setup > Settings 

The Setup settings for the Symbol Table view are shown in the following table.

Note: You might be able to save time configuring the Symbol Table display by pressing the Standard Settings button from the
Settings control panel. This allows you to select a preset optimized for a standard from the Select Standard dialog box. See
Standard Settings Button on page 460

Settings tab Description

Modulation Params
Tab on page 460

The Modulation tab specifies the type of modulation used for the input signal and other parameters.

Table continued…
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Settings tab Description

Freq & BW Specifies settings for frequency error, measurement BW and Frequency Deviation. Each of these
settings is set internally when set to Auto. Alternatively, you can specify values appropriate for specific
measurement needs.

Equalizer Tab on page 467 Enable the Equalizer and adjust its parameters.

Advanced Params
Tab on page 468

The Advanced Params tab specifies additional parameters.

Find Tab on page 471 Find tab is used to set parameters for finding bursts within the data record.

Analysis Time Tab on page 472 The Analysis Time tab contains parameters that define the portion of the acquisition record that is
used for analysis.

Prefs Tab on page 476 The Prefs tab enables you to set characteristics of the measurement display.

Trellis Diagram Display
To show an Trellis Diagram display:

1. Press the Displays button or select Setup > Displays. This shows the Select Displays dialog box.
2. From the Measurements box, select GP Digital Modulation.
3. Double-click the Trellis Diagram icon in the Available Displays box. This adds the Trellis Diagram icon to the Selected displays box.
4. Click the OK button. This displays the Trellis Diagram view.

Elements of the Display
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Item Element Description

1 Check mark indicator The check mark indicator in the upper, left-hand corner of the display shows when the
Frequency Deviation vs Time display is the optimized display.

Note: When Best for multiple windows is selected in the Amplitude control
panel's RF & IF Optimization control, none of the measurement displays shows a
checkmark, as there is not a single optimized measurement.

2 Top of Graph Sets the phase value indicated at the top of the graph. Changing the top value affects the
bottom of graph readout. Also, note that the top of graph setting interacts with the internal
vertical scale setting (which is not user settable) such that the range between the top and
bottom of the graph increases or decreases automatically.

3 Position Specifies the phase value shown at the center of the graph display.

4 Bottom Readout Displays the value of the phase value shown at the bottom of graph.

5 Autoscale Adjusts the vertical and horizontal settings to provide the best display.

6 Position Displays the horizontal position of the trace on the graph display.

7 Scale Adjusts the span of the graph in symbols.

8 Freq Error Displays the difference between the maximum and minimum measured values of the
signal frequency during the Measurement Time. The displayed frequency error is followed
by either Auto or Manual. This indicates the selected carrier frequency detection method
(see Settings > Freq & BW).

Changing the Trellis Diagram Settings

Trellis Diagram Settings
Main menu bar: Setup > Settings 

The settings for the Trellis Diagram display are shown in the following table.

Note: You might be able to save time configuring the Trellis Diagram display by pressing the Standard Settings button from the
Settings control panel. This allows you to select a preset optimized for a standard from the Select Standard dialog box. See
Standard Settings Button on page 460

Settings tab Description

Modulation Params
Tab on page 460

Specifies the type of modulation used for the input signal and other parameters.

Freq & BW Specifies settings for frequency error, measurement BW and Frequency Deviation. Each of these
settings is set internally when set to Auto. Alternatively, you can specify values appropriate for specific
measurement needs.

Table continued…
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Settings tab Description

Equalizer Tab on page 467 Enable the Equalizer and adjust its parameters.

Advanced Params
Tab on page 468

Specifies additional parameters.

Find Tab on page 471 Used to set parameters for finding a burst within the data record and for entering a Synch word.

Analysis Time Tab on page 472 Contains parameters that define the portion of the acquisition record that is used for analysis. Also
allows you to specify the Units (Seconds or Symbols) for the GP Digital Modulation displays.

Trace Tab on page 473 Allows you to set the trace display characteristics.

Scale Tab on page 475 Specifies the horizontal and vertical scale settings.

Prefs Tab on page 476 Enables you to set characteristics of the measurement display.

GP Digital Modulation Shared Measurement Settings
The displays in the GP Digital Modulation folder (Setup > Displays) are each a different format for presenting the results of a single
underlying analysis. For this reason, all controls that affect the analysis parameters are shared by all the displays in the GP Digital
Modulation folder.

Changing a setting on one tab changes that setting for all the GP Digital Modulation displays. For example, if you change the Modulation
Type for the Constellation Display, it also changes the Modulation type setting for the Signal Quality display. There are some controls that
affect only the way an individual display presents its results, such as graph scaling.

Table 40: Common controls for GP digital modulation displays

Settings tab Description

Modulation Params
Tab on page 460

Specifies the type of modulation, symbol rate, and filters to be used in demodulating the input signal.

Freq & BW Sets values for frequency error/offset, measurement bandwidth, and frequency deviation (not every
control is present for every modulation type).

Equalizer Tab on page 467 Enable the Equalizer and adjust its parameters.

Advanced Params
Tab on page 468

Specifies additional parameters that are less frequently used.

Find Tab on page 471 Used to set parameters for finding a burst within the data record and for entering a Synch word.

Analysis Time Tab on page 472 Contains parameters that define the portion of the acquisition record that is used for analysis. Also
allows you to specify the Units (Seconds or Symbols) for the GP Digital Modulation displays.

Trace Tab on page 473 Allows you to set the trace display characteristics.

Prefs Tab on page 476 Enables you to set characteristics of the measurement display.
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Standard Settings Button
On every GP Digital Modulation control panel there is a button labeled Standard Settings. This button is used to recall settings optimized
for analyzing the selected standard. See the following table for a list of the standards for which standard settings are available. Choosing a
standard from the dialog box changes only settings for GP Digital Modulation displays. 

All of the presets in the Standard Settings Dialog make the following settings:

• Analysis Length: Auto
• Points per Symbol: 4
• Data Differential: No
• Burst Mode: Off
• Burst Detection Threshold:  -10 dBc

Table 41: Parameter values set by presets in the standard settings dialog

Standard Modulation Symbol Rate Meas. Filter Reference Filter Filter Parameter Other

802.15.4 OQPSK 1e6 None Half sine NA

SBPSK-MIL SBPSK 2.4e3 None SBPSK-MIL NA

SOQPSK-MIL SOQPSK 2.4e3 None SOQPSK-MIL NA 6

CPM-MIL CPM 19.2e3 None None NA

SOQPSK-ARTM Tier 1 SOQPSK 2.5e6 None SOQPSK-ARTM NA 6

Project25 Phase 1 C4FM 4.8e3 C4FM-P25 RC 0.2

CDMA2000–Base QPSK 1.2288e6 IS-95
TXEQ_MEA

IS-95 REF NA

W-CDMA QPSK 3.84e6 RRC RC 0.22

Modulation Params Tab
Menu bar: Setup > Settings > Modulation Params 

The Modulation Params tab specifies the type of modulation on the input signal and other parameters that control the demodulation of the
input signal.

6 Center Symbol Position, Half Shift Removed
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Parameter Description

Modulation type Specifies the type of modulation on the input signal.

Symbol Rate Specifies the symbol rate in Hertz.

Measurement Filter Specifies the filter used for measurements.

Reference Filter Specifies the filter used as a reference.

Filter Parameter Enter a value used for defining the Reference Filter. (Not present for some filter types)

Modulation index (Present only for CPM modulation type)

Modulation Type
The modulation types that can be demodulated and analyzed are:

Modulation type Description

QPSK Quadrature Phase Shift Keying

8PSK 8-Phase Shift Keying

D8PSK Differential Eight Phase Shift Keying

D16PSK Differential Sixteen Phase Shift Keying

PI/2DBPSK Pi/2 Differential Binary Phase Shift Keying

DQPSK Differential Quadrature Phase Shift Keying

PI/4DQPSK Pi/4 Differential Quadrature Phase Shift Keying

BPSK Binary Phase Shift Keying

OQPSK Offset Quadrature Phase Shift Keying

16QAM 16-state Quadrature Amplitude Modulation

32QAM 32-state Quadrature Amplitude Modulation

64QAM 64-state Quadrature Amplitude Modulation

128QAM 128-state Quadrature Amplitude Modulation

256QAM 256-state Quadrature Amplitude Modulation

MSK Minimum Shift Keying

Table continued…
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Modulation type Description

2FSK 2-Frequency Shift Keying

4FSK 4-Frequency Shift Keying

8FSK 8-Frequency Shift Keying

16FSK 16-Frequency Shift Keying

CPM Continuous Phase Modulation

SOQPSK Shaped Offset Quadrature Phase Shift Keying

SBPSK Shaped Binary Phase Shift Keying

C4FM Constant Envelope 4-Level Frequency Modulation

Profiled row A, C, E, D, H

16APSK

16-symbol Amplitude Phase Shift Keying

Profiled row A, C, E, D, H

32APSK

32-symbol Amplitude Phase Shift Keying

Symbol Rate
Specifies the symbol rate for demodulating digitally modulated signals. The symbol rate and the bit rate are related as follows:

(Symbol rate) = (Bit rate)/(Number of bits per symbol)

For example, the number of bits per symbol is 3 for 8PSK.

Measurement and Reference Filters
The available measurement and reference filters depend on the selected modulation type. If a particular filter is not practical for a
selected modulation type, it is not presented as an available filter. To determine which filters are available, make certain that your desired
modulation type is selected. See the following table.
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Modulation type Measurement filters Reference filters

BPSK None

RootRaisedCosine

RaisedCosine

Gaussian

User

Rectangular (freq)

IS-95TX_MEA

IS-95TXEQ_MEA

None

RaisedCosine

Gaussian

User

Rectangular (freq)

IS-95REF

PI/2DBPSK

8PSK

D8PSK

DQPSK

PI/4DQPSK

16QAM

32QAM

64QAM

128QAM

256QAM

QPSK

Profiled as A, C, E, D, H

16APSK

Profiled as A, C, E, D, H

32APSK

MSK None

Root Raised Cosine

RaisedCosine

Gaussian

User

Rectangular (freq)

None

Gaussian

User

OQPSK None

RootRaisedCosine

User

IS-95TX_MEA

IS-95TXEQ_MEA

None

Half sine

RaisedCosine

User

IS-95REF

Table continued…
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Modulation type Measurement filters Reference filters

HDQPSK HDQPSK-P25 None

RaisedCosine

Gaussian

User

Rectangular (freq)

SOQPSK None

User

SOQPSK-MIL

SOQPSK-ARTM

User

CPM None

User

None

User

2FSK None

Gaussian

RootRaisedCosine

RaisedCosine

Rectangular (freq)

User

None

Gaussian

RaisedCosine

User

4FSK

8FSK

16FSK

C4FM C4FM-P25 RaisedCosine

User

SBPSK None

User

SBPSK-MIL

User

The measurement filter is applied before the demodulation bit is detected and the ideal reference is calculated.

The reference filter is applied to the internally generated ideal reference signal before the EVM is calculated.

Measurement BW
The measurement BW (reported on the Settings > Freq & BW tab) is computed based on the Modulation Type, the Symbol Rate (SR), the
Reference Filter type, and the Filter Parameter (alpha). The following table shows the formulas used, where SR= symbol rate, and α = filter
parameter.

Modulation type Measurement filter Measurement bandwidth

QPSK, 8PSK, D8PSK, DQPSK,
PI/4DQPSK, BPSK, PI/2DBPSK,
QAM16-256, APSK

Raised Cosine

None / Rectangular

All others

SR * (1 + α)

SR * 16

SR * 2

Table continued…
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Modulation type Measurement filter Measurement bandwidth

D16PSK Raised Cosine

None / Rectangular

All others

SR * (1.5 + α)

SR * 16

SR * 2.5

OQPSK Raised Cosine

Half Sine

None / Rectangular

All others

SR * 2

SR * 12

SR * 16

SR * 2

GMSK Gaussian

None / Rectangular

All others

SR * 12 * α

SR * 4

SR * 4

GFSK, FSKn, C4FM All SR * 8

How to Select Filters
In a signal transmitter/receiver system, the baseband signal might be filtered for bandwidth limiting or for another kind of necessary
shaping that needs to be applied. Normally, a filter in the transmitter (Ft) and a filter in the receiver (Fr) are applied.

The Measurement Filter setting in the analyzer corresponds to the baseband filter in the receiver (Fr): This setting tells the analyzer what
filter your receiver uses. When the analyzer is set to the same filter used by the receiver, the analyzer sees the signal as your receiver
would. The Measurement Filter setting should be the same as the filter used in the receiver under normal operation (as opposed to
testing).

The Reference Filter setting in the analyzer corresponds to the baseband filter in the transmitter-receiver combination (Fr * Ft). The
baseband filter for the transmitter-receiver combination is often referred to as the System Filter. This filter is called the reference filter
because it is used to recreate a reference signal that is compared to the received signal. This recreated reference signal is the ideal signal
with Fr * Ft applied; differences between this ideal signal and the received signal enables the determination of signal quality, such as EVM
measurements.

The following is an example of a hypothetical signal that is transmitted into a vector signal analyzer for analysis:

Assume that a signal is transmitted using a baseband filter (Ft). It then travels through a transmission medium (air/cable/etc) where it may
affected by the communication channel (Fc). The signal is received and filtered by the receiver’s filter (Fr). At this point, the signal has
passed through Ft and Fr, and in addition, the communication channel might have affected it (so: Ft * Fr * Fc). This double-filtered signal is
demodulated as it was received to determine the symbols/bits in it. The obtained bits are used to regenerate a baseband ideal signal that
can be compared against the received signal to determine signal quality. However, to determine the effect of the environment on the signal
quality, the ideal signal must be filtered by the REFERENCE FILTER (Ft * Fr), so that the ideal signal and the filtered signal differ only by
the effect of the environment. So, the received signal is the ideal signal filtered by Ft * Fr * Fc and the reference signal is the ideal
signal filtered by Ft * Fr, since they only differ by the effect of Fc, the comparison will show the effect of the communication channel
on the signal. The communication channel can also include the hardware path the signal follows after (Tx) or before (Rx) digitizing; this
would account for Tx/Rx hardware linear and non-linear distortion.

Common examples of how these filters are used are shown below:

• For Transmit Filter = Root Raised Cosine (RRC), Measurement Filter = RRC, the Reference Filter = RRC ^2 = Raised Cosine
• For Transmit Filter = Raised Cosine (RC), Measurement Filter = None, the Reference Filter = Raised Cosine (When the Measurement

Filter = None, the Reference Filter = Transmit Filter)
• For Transmit Filter = Gaussian, Measurement Filter = None, the Reference Filter = Gaussian
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Filter Parameter
The filter parameter specifies the alpha for the Root Raised Cosine or Raised Cosine filter, or the bandwidth-time product (BT) for the
Gaussian filter, when selected as the Reference filter. Some filter types have a fixed parameter value that is specified by industry standard,
while other filter types by definition have no filter parameter. For filter types with no filter parameter, there is no filter parameter control
present in the control panel.

Freq & BW Tab
The Freq & BW tab specifies a group of settings that affect how measurements are made.

Figure 53: Freq & BW tab with nFSK or C4FM modulation type selected and Frequency Error readout enabled (Auto selected)

Figure 54: Freq & BW tab with SOQPSK modulation type selected and Frequency Offset enabled (Auto deselected)

Setting Description

Frequency Error / Frequency
Offset

When Auto is enabled, this readout displays frequency error and the measurement is made at the
calculated frequency. When Auto is disabled, this setting changes to Frequency Offset. When set to
Frequency Offset, this setting is used to demodulate a signal that is not at the center frequency. The
measurement is made at the user-entered offset. The Measurement Filter (if any, specified on the
Modulation Params tab) is applied about the offset frequency whether set automatically or manually.

Measurement BW This setting allows you to override the automatic bandwidth calculation and directly enter a bandwidth
value. If you enter a value for the measurement bandwidth, be aware that the actual bandwidth of
data provided to the measurement will be at least as wide as the value you request and may be as
much as two times wider than requested. This override of the selected measurement bandwidth is
done so that the instrument uses sufficient bandwidth relative to the chosen symbol rate to ensure
good signal quality measurements.

Frequency Deviation For nFSK modulation types, this setting specifies the frequency deviation. Select Auto to make the
instrument do this automatically. Deselect Auto to enter a value manually.

This setting is present for only nFSK and C4FM modulation types.
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Equalizer Tab
The Equalizer tab enables you to apply an adaptive equalizer to a digitally modulated signal to compensate for linear distortions in the
signal. The Equalizer is available only for displays in the GP Digital Modulation folder (Select Displays window). The analyzer implements a
decision directed, feed-forward FIR filter to correct linear distortion in the input signal.

Parameter Description

Enable Equalization This setting turns the Equalizer on and off.

Reset Equalization Initializes the equalizer filter for training.

Enable EQ Export Exports a text file with equalizer taps in I/Q pairs.

Mode Specifies whether the equalizer is in learning (Train) mode or analysis (Hold) mode.

Convergence Specifies the update rate. Maximum value: 0.002. Default value: 0.0005

Taps/Symbol The number of filter coefficients per symbol used by the filter. Available choices are 1, 2, 4, and 8.

Taps The number of filter coefficients. Range: 3 to 100 (you can set a higher number, but 100 is the
practical limit).

Length Specifies the number of symbols analyzed (or filter length).

Selecting the Mode
When enabled, the Equalizer is in either Train mode or Hold mode. When the equalizer is in Train mode, it will update internal filter
parameters whenever you adjust the Convergence, Taps/Symbol, Taps, or Length values. When it is in Hold mode, the Equalizer uses the
parameter values (both internal and the values accessible on the Equalizer tab) in effect when it was placed into Hold mode.

Note: The Equalizer does not need to be retrained if the modulation type is changed. You can train the Equalizer by using a
simpler modulation type (such as QPSK), place the Equalizer into Hold mode and can then measure more complex modulation
types such as QAM.

Training the Equalizer
To obtain the desired results using the Equalizer, you must first train the Equalizer. This is an iterative process where you adjust some filter
parameters (and the analyzer adjusts internal parameters) to achieve the lowest error possible on the acquired signal.

To configure the Equalizer:

1. Press the Displays button or select Setup > Displays.
2. In the Select Displays window, select GP Digital Modulation from Measurements.
3. Add Signal Quality to the Selected Displays and select OK.
4. With the Signal Quality display selected, select Setup > Settings.
5. Select the Modulation Params tab set the parameters as necessary for the signal.
6. Select the Equalizer tab.
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7. Set the Convergence value to 0.0005.
8. Set Taps/Symbol to 2.
9. Click the Reset Equalization button to reset the equalizer.
10. Set the Mode to Train.
11. Click Enable Equalization so it is checked.
12. On the Signal Quality display, examine the value for EVM.
13. Change the Convergence, Taps/Symbol, and Taps values iteratively to achieve a minimum EVM value.

Note: Changing the Taps/symbol or Taps values resets the equalizer.

Using the Equalizer
To use the equalizer:

1. Select and configure a GP Digital Modulation display.
2. Select Setup > Settings.
3. Select the Equalizer tab.
4. Select Enable Equalization so it is checked.
5. Verify that Mode is set to Hold if you have previously trained the Equalizer. If you have not previously trained the Equalizer, Training

the Equalizer on page 467 and then set the Mode to Hold.

Exporting EQ Files
If the Enable EQ Export box is checked, the following outputs files are automatically generated to these locations after each measurement
update cycle if the EQ coefficients change: c:\temp\EqTaps.txt and c:\temp\EqTapsHdr.txt. These files have EQ taps in I/Q pairs (one pair
per row).

The Hdr version file has a five line header before the EQ tap data. Each line in the five line header of the Hdr version file has two data
values, with the second one always being "0":

<line1>Number_of_Header_Lines 0

<line2>EQ_Sample_Rate_Hz 0

<line3>Demod_Symbol_Rate_Sps 0

<line4>EQ_Samples_per_Symbol  0

<line5>Number_of_EQ_Taps_Following 0

Exporting EQ Files

Advanced Params Tab
The Advanced Params tab specifies additional parameters that control the demodulation of the signal.

Figure 55: Advanced Params tab for all modulation types except nFSK and C4FM
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Figure 56: Advanced Params tab for modulation type nFSK

Figure 57: Advanced Params tab for modulation type C4FM

Figure 58: Advanced Params tab for modulation type APSK

Parameter Description

Mag Normalize

(not present for nFSK or C4FM
modulation types)

Select RMS Symbol Magnitude or Max Symbol Magnitude. This setting applies to Mag Error and
EVM.

Swap I and Q When enabled, the I and Q data are exchanged before demodulating.

Profiled as A, C, E, D, H

APSK Parameters

(Present only for APSK
modulation types)

Sets Constellation display parameters for APSK modulation types.

Symbol rate search

(Present only for nFSK
modulation types)

Determines whether to automatically detect or manually set the symbol rate. When selected,
automatically detects the symbol rate to perform analysis. The calculated symbol rate is displayed in
the Signal Quality display. The Symbol Rate Error is also calculated and displayed when Symbol rate
search is enabled.

User Symbol Map (per Modulation
Type)

Enables the use of custom symbol maps. This enables you to specify the location of symbols in the
display. This control can be set independently for each of the modulation types.
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Mag Normalize
Specifies whether Magnitude Normalization uses the RMS Symbol Magnitude or the Maximum Symbol Magnitude as the basis for
normalization. Use RMS Symbol Magnitude on QPSK modulations (equal magnitude symbol locations), and use Maximum Symbol
Magnitude for signals that have a large difference in magnitude among the symbol locations (such as 128QAM). It prevents the instrument
from using the very low magnitude center symbols when normalizing the constellation. The outer symbols are a better normalization
reference than the center in this case.

Swap I and Q
Use the Swap I and Q control to correct a signal sourced by a downconverter that inverts the frequency of the signal under test.

APSK Parameters
Three parameters can be set for Constellation display of APSK modulation types.

Parameter Description

Ring Use to select which ring the radius and rotation values are being specified for. Values are 0 and 1 for
16APSK. 0, 1, and 2 for 32APSK.

Radius Sets the Ring ratio relative to Ring 0 (inner most ring). Set after selecting the appropriate Ring setting.

Rotation Sets the rotation value from the I axis. Set after selecting the appropriate Ring setting.

User Symbol Map
A User Symbol Map is a text file that specifies the location of symbols in the display. The symbol map is unique for each modulation type.
The easiest way to create a custom symbol map is to start with the default symbol map and modify it. The default symbol map file is
located at C:\SignalVu-PC\ExampleFiles. The default symbol map file is named DefaultSymbolMaps.txt. See for illustrations of the default
symbol mapping.

To specify a user symbol map:

1. Click the ... button.
2. Symbol Maps on page 476

Navigate to the directory containing the user symbol text file you want to use.
3. Select the desired file in the Open window and click Open.
4. Select User Symbol Map to enable the user symbol map.

Editing the User Symbol Map. The symbol map is a plain text file and can be edited with any plain text editor.

CAUTION: Whenever you reinstall the program software, the existing DefaultSymbolMaps.txt file will be overwritten. To create a
custom symbol map, you should make a copy of the default symbol map file, edit the copy to suit your needs, and save it with a
new name. Guidance on how to edit the symbol map file is contained within the default symbol map file.

The following excerpt from the default symbol map file explains the structure of the file and how to edit it.
## Symbol Mapping Definitions
## Version 1.2
## This file defines the mapping of modulation states to symbol values.
##
## File Format :
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## -------------
## 1. Comments begin with '##' and may appear after the last field in a line
## 2. A symbol map begins and ends with a line containing the name of the
## modulation type. These names must exactly match the name of one of the
## modulation types in the RSA software
## 3. Empty cells may be included to preserve the constellation shape.
## 4. Blank lines are ignored.
## 5. A modulation type which does not match the name of an existing
## type will be ignored.
##
## Usage :
## -------
## 1. The file is intended to be edited with Notepad or similar text editor
The following text is an example of a symbol map.
## Symbol Map for 32 QAM
## (Resembles the shape of the constellation)
                32QAM
        00011 00010 00001 00000
01001 01000 00111 00110 00101 00100
01111 01110 01101 01100 01011 01010
10101 10100 10011 10010 10001 10000
11011 11010 11001 11000 10111 10110
        11111 11110 11101 11100
                32QAM

Find Tab
The Find tab is used to set parameters for finding bursts within the data record. This is a post-acquisition operation. Synch Word search
controls are also on this tab.
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Setting Description

Burst Detection: Mode Select whether to analyze bursts

- Auto: If a burst is found, analyze just that burst period. If a burst is not found, analyze the whole
analysis length.

- On: If a burst is found, analyze just that burst period. If a burst is not found, display an error
message.

- Off: Analyze the whole analysis length.

If the signal isn't adequate for demodulation, an error message is shown.

Burst Detection: Threshold Sets the level required for the signal to qualify as a burst. Enter a value in dBc down from top of the
signal.

Use Synch Word When enabled, specifies the string of symbols to look for. Enter the search string with external
keyboard or the on-screen keyboard.

Clear Blanks the search string field.

Analysis Time Tab
The Analysis Time tab contains parameters that define how the signal is analyzed in the general purpose digital modulation displays.

The settings values on this tab are the same as those on the main Analysis control panel for the instrument with the only difference being
that Analysis Length can be set in either Seconds or Symbols in this location.

Setting Description

Analysis Offset Specifies the location of the first time sample to use in measurements.

Auto When enabled, causes the instrument to set the Analysis Offset value based on the requirements of
the selected display.

Analysis Length Specifies the length of the analysis period to use in measurements. Length is specified in either
seconds or symbols, depending on the Units setting. For most modulation types, the Analysis Length
set when Auto is enabled is 128 symbols. For some modulation types, a longer length is used.

Auto When enabled, causes the instrument to set the Analysis Length value based on the requirements of
the selected display.

Time Zero Reference Specifies the zero point for the analysis time.

Table continued…

GP Digital Modulation

SignalVu™ Vector Signal Analysis Software Printable Help 472



Setting Description

Actual This is a displayed value, not a setting. It is the Analysis Length (time or symbols) being used by the
analyzer; this value may not match the Analysis Length requested (in manual mode).

Units Sets the units of the Analysis Length to either Symbols or Seconds.

Analysis Offset
Use analysis offset to specify where measurements begin. Be aware that you cannot set the Analysis Offset outside the range of time
covered by the current acquisition data. (all time values are relative to the Time Zero Reference).

You can set the Analysis Length so that the requested analysis period falls partly or entirely outside the current range of acquisition
data settings. When the next acquisition is taken, its Acquisition Length will be increased to cover the new Analysis Length, as long as
the Sampling controls are set to Auto. If the Sampling parameters are set to manual, or if the instrument is analyzing saved data, the
actual analysis length will be constrained by the available data length, but in most cases, measurements are able to be made anyway.
The instrument will display a notification when measurement results are computed from less data than requested. Range: 0 to [(end of
acquisition) - Analysis Length)]. Resolution: 1 effective sample (or symbol).

Analysis Length
Use the analysis length to specify how long a period of time is analyzed by a measurement. As you adjust this value, the actual amount of
time for Analysis Length, in Symbol or Seconds units, is shown below the control in the "Actual" readout. This setting is not available when
Auto is checked. Range: minimum value depends on modulation type. Resolution: 1 symbol. A maximum of approximately 80,000 samples
can be analyzed (the actual value varies with modulation type).

Time Zero Reference
All time values are measured from this point (such as marker position or horizontal position (in Y vs Time displays). Choices are:
Acquisition Start or Trigger.

Parameter Description

Acquisition Start Offset is measured from the point at which acquisition begins.

Trigger Offset is measured from the trigger point.

Trace Tab
Menu Bar: Setup > Settings > Trace 

The Trace tab allows you to set the trace display characteristics of the selected display.

Figure 59: Example traces tab for constellation display set to SOQPSK modulation type

Note that some settings are not present for all modulation types and some settings are not present for all displays.
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Figure 60: Example trace tab for constellation display set to CPM modulation type

Figure 61: Example trace tab for Demod I&Q display

Setting Description

Trace Selects the trace that is hidden or displayed based on whether or not Show is selected.

Show Specifies whether the trace selected by Trace is displayed or hidden.

Freeze Halts updates to the trace selected by the Trace setting. Present for the Constellation display only.

Content Selects whether to display the trace as vectors (points connected by lines), points (symbols only
without lines), or lines (lines drawn between symbols, but no symbols are displayed). The choices
available depend on the display.

Q Offset For traces with offset modulation (OQPSK and SOQPSK), this setting enables the trace to be
displayed with Q offset or without Q offset. Choices available are Remove Q offset, Include Q
Offset, and Use Shared Pref. Selecting Use Shared Pref causes the analyzer to add or remove Q
offset according to the Remove Q Offset setting located on the Prefs tab. Setting the Q Offset on
the Traces tab changes the Q offset only for the Constellation display. If other GP Digital Modulation
displays are shown, they will use the use the Remove Q Offset setting on the Prefs tab regardless of
the Q Offset setting on the traces tab for the Constellation display. The Q Offset setting is available
only when the modulation type is set to OQPSK or SOQPSK.

Points/symbol Select how many points to use between symbols when connecting the dots. Values: 1, 2, 4, 8.

Symbol point location Selects whether to evaluate the symbol value at the center or the end of the eye opening. This control
is only present for some of the supported modulation types.

Phase Multiplier Sets the multiplication constant for the phase multiplication display: ×1 (default), ×2, ×4, ×8, ×16,
or ×32. The phase multiplication display facilitates observation of noisy CPM signals by multiplying
measurement signal phase by the constant to reduce the number of phase states and expand the
phase difference between adjacent symbols.

Comparing Two Traces in the Constellation Display
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When the Constellation display is the selected display, you can use the Traces tab to enable the display of a second trace. The second
trace is a version of the current acquisition. You can choose to freeze a trace in order to display the current live trace to an earlier version
of itself, you can display the trace as a second trace with or without Q Offset, or you can choose to display both traces frozen in order to
compare the trace to itself at different times.

To display a second trace in the Constellation display:

1. If more than one display is present, select the Constellation display to ensure it is the selected display.
2. Click the settings icon or select Setup > Settings from the menu bar.
3. Select the Traces tab.
4. Select Trace 2 from the Trace drop-down list.
5. Click the Show checkbox so that it is checked.
6. Specify the Content as desired. Trace 2 lines appear in blue to aid in distinguishing Trace 2 from Trace 1.

Scale Tab
The Scale tab allows you to change the vertical and horizontal scale settings. Changing the scale settings changes how the trace appears
on the display but does not change control settings such as Measurement Frequency.

Setting Description

Vertical Controls the vertical position and scale of the trace display.

Scale Changes the vertical scale units.

Position Position adjusts the reference level away from top of the graph.

Autoscale Resets the scale of the vertical axis to contain the complete trace.

Horizontal Controls the span of the trace display and position of the trace.

Scale Allows you to, in effect, change the span.

Position Allows you to pan a zoomed trace without changing the Measurement Frequency. Position is only
enabled when the span, as specified by Freq/div, is less than the acquisition bandwidth.

Autoscale Resets the scale of the horizontal axis to contain the complete trace.

Auto

A Note About Units
The Units used for the horizontal scale can be either Seconds or Symbols. To set the units for the horizontal scale, display the Analysis
Time tab. On the tab, select the appropriate units from the Units drop-down list.
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Prefs Tab
The Prefs tab enables you to change appearance characteristics of the GP Digital Modulation displays.

Setting Description

Show graticule Shows or hides the graticule.

Show Marker readout in graph
(selected marker)

Shows or hides the readout for the selected marker in the graph area.

Radix Specifies how symbols are displayed in the Symbol Table display and in the Marker readout in the
Constellation display.

Remove Q offset The I and Q data traces are displayed with an offset of half a symbol when the modulation type is
set to SOQPSK or OQPSK. You can remove this offset by selecting Remove Q offset. (Which is only
present when the modulation type is set to OQPSK or SOQPSK.)

Show EVM and Offset EVM
results

Adds EVM results in the display when enabled (Offset EVM is always displayed). Present only in
Signal Quality display and with SOQPSK and OQPSK modulation types only

Symbol Maps
This topic shows the symbol mapping for each digital modulation technique.
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D8PSK

Phase shift

(radians)

Symbol value

(binary)

0 000

π/4 001

π/2 011

3π/4 010

π 110

5π/4 111

3π/2 101

7π/4 100

Pi/2 DBPSK

Phase shift

(radians)

Symbol value

(binary)

+π/2 0

–π/2 1

DQPSK

Phase shift

(radians)

Symbol value

(binary)

0 00

π/2 01

π 11

3π/2 10
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Pi/4 DQPSK

Phase shift

(radians)

Symbol value

(binary)

+π/4 00

+3π/4 01

–π/4 10

-3π/4 11

MSK

Phase shift

direction

Symbol value

(binary)

– 0

+ 1
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CPM

Phase shift

(h = modulation index)

Symbol value

(binary)

–3h 11

–h 10

+h 01

+3h 00

Overview: User Defined Measurement and Reference Filters
The Modulation Parameters control tab for GP Digital Modulation displays enables you to load custom measurement and reference
filters. If the existing filters do not meet your requirements, you can create your own filters for use in the measurement and reference
settings. This section describes the structure of user filters and provides two examples of customized filters. See User Filter File
Format on page 481.

Loading a User Measurement Filter
To load a your own measurement filter:

1. From the Modulation Params control tab (Settings > Modulation Params), click on the drop-down list for Measurement Filter.
2. Select one of the filter names that starts with User. This displays the Manage user filters window.
3. Enter a name for the filter in one of the Name (editable) boxes. This name will appear in the drop-down list on the Modulation Params

tab, prefaced with User. The maximum number of characters for the filter name is 20.
4. Click the Browse button and navigate to the directory containing the filter you want to load. Select the filter and click Open. If you wish

to use a filter that is not in the list, select User other and locate and open the file you wish to use.
5. Click OK to load the filter and return to the Modulation Params page.

User Filter File Format
The filter file is selected on the Modulation Params control panel tab used by the GP Digital Modulation displays (Option 21 only). It stores
the user-defined measurement or reference filter coefficient data in CSV format. The following figure shows the file structure.

Figure 62: User filter file structure

A filter file is a plain text file, in comma-separated-variable format. The file extension must be CSV.
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The filter file contains the following variables:

Rate. Specifies the oversampling rate (the number of samples per symbol). The filter coefficient data will be interpolated by the specified
rate.

FilterI,FilterQ. Specifies IQ pairs (1 to 1024) of the filter coefficient in time domain.

Rules for Creating a Filter File
• A line beginning with “#” is a comment line.
• Enter a positive value for the oversampling rate.
• A decimal number can be expressed by fixed point or floating point. For example, 0.01 and 1.0E-2 are both valid.
• “0” (zero) and “,0” (comma zero) can be omitted. For example, “1.5,0”, “1.5,”, and “1.5” are equivalent.
• Lines with only a comma and blank lines are skipped.

Example filters. For your reference, two example filters, Raised Cosine and Gaussian, are shown here. Both filters contain 65 data points
with an oversampling rate of 8.

Raised Cosine (α = 0.3)

(Row 1 to 18) (Row 19 to 36) (Row 37 to 54) (Row 55 to 68)

# Rate 0.0383599,0 0.973215,0 0.0743803,0

8 0,0 0.895591,0 0.0720253,0

# FilterI,FilterQ -0.047715,0 0.774975,0 0.0594205,0

0,0 -0.0984502,0 0.623332,0 0.0405144,0

-0.0062255,0 -0.143898,0 0.455249,0 0.0194761,0

-0.0136498,0 -0.174718,0 0.286147,0 0,0

-0.0209294,0 -0.181776,0 0.130455,0 -0.0151973,0

-0.0263419,0 -0.157502,0 0,0 -0.0246357,0

-0.0280807,0 -0.0971877,0 -0.0971877,0 -0.0280807,0

-0.0246357,0 0,0 -0.157502,0 -0.0263419,0

-0.0151973,0 0.130455,0 -0.181776,0 -0.0209294,0

0,0 0.286147,0 -0.174718,0 -0.0136498,0

0.0194761,0 0.455249,0 -0.143898,0 -0.0062255,0

0.0405144,0 0.623332,0 -0.0984502,0 0,0

0.0594205,0 0.774975,0 -0.047715,0

0.0720253,0 0.895591,0 0,0

Table continued…
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Raised Cosine (α = 0.3)

(Row 1 to 18) (Row 19 to 36) (Row 37 to 54) (Row 55 to 68)

0.0743803,0 0.973215,0 0.0383599,0

0.063548,0 1,0 0.063548,0

Gaussian (BT = 0.5)

(Row 1 to 18) (Row 19 to 36) (Row 37 to 54) (Row 55 to 68)

# Rate 0.00191127,0 0.978572,0 0.000401796,0

8 0.00390625,0 0.917004,0 0.000172633,0

# FilterI,FilterQ 0.00764509,0 0.822878,0 7.10E--05,0

2.33E-10,0 0.0143282,0 0.707107,0 2.80E-05,0

9.11E-10,0 0.0257149,0 0.581862,0 1.06E-05,0

3.42E-09,0 0.0441942,0 0.458502,0 3.81E-06,0

1.23E- 08,0 0.0727328,0 0.345977,0 1.32E-06,0

4.21E-08,0 0.114626,0 0.25,0 4.37E-07,0

1.39E-07,0 0.172989,0 0.172989,0 1.39E-07,0

4.37E-07,0 0.25,0 0.114626,0 4.21E-08,0

1.32E-06,0 0.345977,0 0.0727328,0 1.23E-08,0

3.81E-06,0 0.458502,0 0.0441942,0 3.42E-09,0

1.06E-05,0 0.581862,0 0.0257149,0 9.11E-10,0

2.80E-05,0 0.707107,0 0.0143282,0 2.33E-10,0

7.10E-05,0 0.822878,0 0.00764509,0

0.000172633,0 0.917004,0 0.00390625,0

0.000401796,0 0.978572,0 0.00191127,0

0.000895512,0 1,0 0.000895512,0
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Marker Measurements
Using Markers
Markers are indicators in the display that you can position on a trace to measure values for the X and Y axes, such as frequency, power,
and time. A Marker always displays its position and, if enabled, will display the difference between its position and that of the Marker
Reference (MR).

You can display up to five markers including the reference marker. Markers can all be placed on the same trace or they can be placed on
different traces. There are three types of Markers: Reference, Delta, and Power Markers. The Marker Reference (labeled MR in the graph)
makes absolute measurements and is also used for calculating differences when Delta or Power readouts are enabled. The Delta Markers
(labeled M1 to M4 in the graph) are used to measure other points on the trace or the difference between the Marker Reference and the
Delta marker. The Power Markers (labeled M1 to M4 in the graph) function the same way as the Delta Markers, except they show power
density and integrated power density (dBm/Hz) instead of power level (dBm).

The following two tables show the appearance of the four types of marker readouts.

Marker Reference Readout Absolute Marker Readout Power Marker Readout Delta Marker Readout

The following table shows the appearance of the marker indicators as they appear on the trace. Whichever marker is active will appear as
a solid diamond.

Marker Reference Absolute, Delta, and Power Marker

Controlling Markers with the Touchscreen Actions Menu
In addition to controlling the marker actions from the front panel or screen menu items, you can use the touch screen actions menu to
move markers or add and delete markers.

Touchscreen Actions Menu
To use the Touchscreen Actions menu, touch the display and hold for one second, then remove your finger. You can also use a mouse to
display the Touchscreen Action menu by clicking the right mouse button.

Menu item Description

Marker to peak Moves the selected marker to the highest peak. If no marker is
turned on, this control automatically adds a marker.

Table continued…
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Menu item Description

Next peak Moves the selected marker to the next peak. Choices are Next left,
Next right, Next lower (absolute), and Next higher (absolute).

Add marker Defines a new marker located at the horizontal center of the graph.

Delete marker Removes the last added marker.

All markers off Removes the all markers.

Markers context menu
The Markers context menu appears when you right-click (or touch and hold) on a marker. The Markers context menu enables you
to assign a marker to a different trace, synchronize markers with oscilloscope cursors and pan the trace to place the marker at the
measurement frequency.

Menu Description

Pan to marker Adjusts horizontal position of the waveform to locate the selected
marker at the measurement frequency.

Assign to trace Assigns the selected marker to Trace 1, Trace 2, Trace 3 or the
Math trace. A trace must be enabled to assign a marker to it.

Sync scope C1 Synchronizes the position of oscilloscope Cursor 1 with the location
of the selected marker. Turns on cursors if necessary.

Sync scope C2 Synchronizes the position of oscilloscope Cursor 2 with the location
of the selected marker. Turns on cursors if necessary.

Controlling Markers with the Right-Click Actions Menu
In addition to controlling the marker actions from the menu controls, you can use the right-click actions menu to move markers or add and
delete markers. Some items are not available for certain displays.

You display the Right-click Action menu by clicking the right mouse button.
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Menu item Description

Marker to peak Moves the selected marker to the highest peak. If no marker is turned on, this control automatically
adds a marker.

Next Peak Moves the selected marker to the next peak. Choices are Next left, Next right, Next lower (absolute),
and Next higher (absolute).

Add marker Defines a new marker located at the horizontal center of the graph.

Delete marker Removes the last added marker.

All markers off Removes all markers.

Markers Context Menu
The Markers context menu appears when you right-click (or touch and hold) on a marker. The Markers context menu enables you to
assign a marker to a different trace and pan the trace to place the marker at the measurement frequency.

Icon Menu Description

- Pan to marker Adjusts horizontal position of the waveform to locate the selected marker at
the measurement frequency.

- Attach to trace Attaches the selected marker to Trace 1, Trace 2, Trace 3 or the Math trace. A
trace must be enabled to assign a marker to it.

Measuring Frequency and Power in the Spectrum Display
To measure the frequency and power at a point on a Spectrum trace:

1. Select Markers > Define Markers.
2. Select the Marker Properties tab.
3. Click Add. This displays a drop-down list under MR (Marker Reference), found inside the Reference box. The first marker defined is

always designated the Marker Reference. Subsequently defined markers are Delta Markers for which readouts can be selected for
Delta, Power, or Absolute. You can also select and adjust markers by clicking on an existing marker on a trace.

4. From the drop-down list, select the trace to which you want to assign the marker.
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5. Click the close control panel button to remove the Define Markers control panel.
6. Click on the marker on the trace to activate that marker.
7. Drag the marker in the graph using a mouse to move the marker to the desired location on the trace. You can also click on the

marker location text box in the Markers toolbar at the bottom of the screen and adjust it with your mouse wheel. The Peak button in
the Markers toolbar and the arrow buttons to the right of it control marker peak searching on the trace.

8. Read the frequency and power level of the marker position on the display.
9. Read the signal density, frequency, and power level of the marker position on the display.
10. If Power markers are selected, read the point power density and the integrated power density.

Marker Action Controls
Controls for enabling and moving markers and for initiating marker peak searches are found in several locations. There are buttons for a
few of the most common marker activities on the front panel of the instrument, used along with the knob for adjusting marker positions. The
Markers menu contains selections for peak searches. Each graph display has a Marker button on the status bar that provides access to
the Markers toolbar. The Markers toolbar has buttons for peak searches, centering, and defining markers.

Peak
Selecting Peak from the Markers menu moves the selected marker to the highest level peak within the acquisition record.

Next Peak
Selecting Next Peak displays a submenu that enables you to move the selected marker to the next peak.

Setting Description

Next Left Moves the selected marker to the next peak to the left of the current marker position.

Next Right Moves the selected marker to the next peak to the right of the current marker position.

Next Lower (absolute) Moves the selected marker to the lower level peak (in absolute terms) on the trace.

Next Higher (absolute) Moves the selected marker to the higher level peak (in absolute terms) on the trace.
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Marker to Center Frequency
Changes the center frequency to match the frequency of the selected marker.

Sync Scope C1/C2 to Active Marker
Moves the selected oscilloscope cursor (Cursor 1 or Cursor 2) to the location on the oscilloscope waveform that matches the location of
the active maker on the SignalVu active marker. If the oscilloscope cursors are off, this command turns them on. These commands are
also available from the Markers context menu.

Enabling Markers and Setting Marker Properties
The Define Markers Control Panel is used to enable markers and set their properties. You can set up to five markers including the marker
reference. Markers are shown in most displays.

Markers have three types of on-screen readouts: Absolute, Delta, and Power. When Readouts is set to Absolute, each readout displays
only the marker's position on the trace. In Frequency displays, this means the marker readout shows the frequency and power of the trace
at the marker position. When Readouts is set to Delta, each delta marker (M1-M4) readout displays both the marker's position on the
trace and the difference between its position and the position of the Reference Marker (MR). When Readouts is set to Power, each delta
marker (M1-M4) readout displays the marker's position on the trace, the difference between its position and the position of the Reference
Marker (MR), the point power density, and the integrated power density.

Defining Markers

1. Click the Markers button on the basic control toolbar to view the Markers toolbar.
2. Click the Define button on the Markers toolbar to open the Define Markers control panel.
3. In the Marker Properties tab, select Add to turn on the next marker. A drop-down list under the marker label allows you to assign the

marker to a trace.

Note: The first marker defined will always be MR. The MR marker is the reference for delta marker readouts.

4. Select the trace to which the marker should be attached from the drop-down list.
5. Click Add to add additional markers.
6. Click on the Readouts drop down menu to select the readout to view. If you select Delta from the drop down menu, you can check the

dBc/Hz box to measure noise in dBc/Hz and show that for the delta value. Checking this box if other readouts are selected will force
the readout to Delta. You can read more about marker noise (dBc/Hz) mode here.

7. Click the close button to remove the Define Markers control panel.

Using the Markers Toolbar

Favorites toolbar:

Status bar: Markers button 

Select Markers to display or hide the Markers toolbar at the bottom of the application window. The Markers toolbar enables you to operate
existing markers or define new markers.
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Enabling a marker or adjusting the position of a marker automatically opens the Markers toolbar.

Icon / Readout Description

Opens the Define Markers control panel.

Selected marker readout. This readout shows which marker is selected. The pop-up menu allows you
to choose the selected marker, add markers, and turn all markers off.

Marker position controls. For frequency displays, this readout shows the marker position in Hertz. For
time displays, this readout shows the marker position in seconds. The position of the selected marker
can be changed by selecting the numeric readout and using the knob to adjust the value.

Changes the analyzer's Center Frequency to the frequency of the selected marker. Not selectable for
time markers.

Moves the marker to the highest peak on the signal. On displays that scale about zero on the vertical
axis (for example, Magnitude Error, EVM, and Frequency vs. Time), the highest peak selected by
the Peak button is an "absolute value", therefore, negative peaks are included in the search for the
highest peak.

Moves the selected marker to the next peak to the left of the current position.

Moves the selected marker to the next peak to the right of the current position.

Moves the selected marker to the next lower peak value. The peak value here refers to the numeric
value of the peak amplitude. Thus, when repeatedly moving the marker, it can move to the right or left
depending on the location of the next lower value.

Moves the selected marker to the next higher peak value. The peak value here refers to the numeric
value of the peak amplitude. Thus, when repeatedly moving the marker, it can move to the right or left
depending on the location of the next higher value.

Displays/hides the marker table from the display.

Removes the Markers toolbar from the display.

Measuring Noise Using Delta Markers in the Spectrum Display
In the Spectrum display, you can set Markers to dBc/Hz to measure noise on the trace. Markers in this mode operate just as they do in
normal mode, but the readouts for the markers are in dBm/Hz and dBc/Hz.

dBm/Hz is the power in milliwatts referenced to a 1 Hz bandwidth. To make this measurement, the analyzer assumes that the measured
signal is random noise. It then converts the measured power (made at any RBW) to the power that would be measured had a 1 Hz filter
been applied for the measurement.

dBc/Hz represents dBm/Hz referenced to a carrier. Here, it is assumed that the carrier is a CW signal, and its signal level does not change
when the RBW is changed, so the Reference Marker measurement on the carrier is unchanged from any other marker measurement.
However, the delta marker values are converted to dBm/Hz, and then a difference value, in dBc/Hz, is calculated between each delta
measurement and the reference.
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Measuring Noise
To measure noise on a Spectrum trace:

1. Select Markers > Define to display the Markers control panel.
2. Click Add. The first marker defined is always designated the Marker Reference. Subsequently defined markers are Delta Markers

for which readouts can be selected for Delta, Power, or Absolute. You can also select and adjust markers by clicking on an existing
marker on a trace.

3. Click Add again so that there are at least two markers defined.
4. Check that Readouts is set to Delta and check the dBc/Hz box.
5. If you have more than one trace defined, use the drop-down list for each marker to set it to the trace on which you want to measure

noise.
6. Notice that Detection is set to Average for the trace you are using for this measurement.
7. Check that the Amplitude units are set to dBm (that is the default). If they are not, click the (Analysis) icon, select the Units tab, and

select dBm.
8. Click the Close button to remove the control panel.
9. Move the markers to the desired locations on the trace.
10. Read the frequency and power level for the selected marker in the upper corners of the display. To display the delta measurement

in dBc/Hz, select the delta marker (M1, M2, M3 or M4) by clicking on it or by selecting it in the drop-down marker list in the Markers
toolbar.

The following image shows the Spectrum display with a Delta Marker.

The following image shows the Spectrum display with Power Markers.
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Mask Testing
The Mask Test Tool
You can specify pass/fail and mask parameter conditions for the Spectrum, Spurious, Gain, Frequency Settling Time and Phase Settling
Time displays. When these conditions are met, the instrument can perform actions such as stopping acquisitions or saving data.

Mask Test Settings
Menu Bar: Tools > Mask Test 

Selecting Mask Test displays the Mask Test control panel. These settings define test parameters and specify actions to be performed
when the test conditions are met. Checking the Enable Test box sets the application to perform the test once the conditions are defined.

Setting Description

Enable Test Select to perform a test, then set the test conditions.

Define Specifies which result to test and what to test for.

Actions Specifies the action to take when the test condition is met.

Define Tab (Mask Test)
The Define tab sets the parameters for tests. From this tab, you specify which result to test and what kind of violation to test for.

The following image shows the Define tab with is great than selected. After you select that test, you will enter the desired signal level. The
procedure is the same if you select is less than.

The following image shows the Define tab with is outside mask selected. After you select that test, you need to click the Edit limits button
and set the desired test limits. The procedure is the same if you select is inside mask.
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Setting Description

Search in Specifies which result to test.

Test for Specifies what to test for. You can specify a test based on a signal level (“is greater than”, “is less
than”) or a mask (“is outside mask”, “is inside mask”). Options for Spurious and Settling Time are
Pass and Fail.

Search In
The possible choices for Search in include traces from Spectrum, DPX, Noise Figure, Spurious, and Setting Time displays. The available
choices are Trace 1, Trace 2, Trace 3, Math , Spectrogram Trace, Spurious, and Settling Time. The available choices include only results
from displays that are currently open.

Note: If you select a result that is not the selected trace or result in the target display, you will not see the results of the test. To
see the results, select the trace from the drop-down menu in the target measurement display and check the Show box:

Test For
The Test for setting has selections that vary based on which display's results you are testing.

Pass/Fail Tests for Spurious and Settling Time
The Frequency Settling Time, Phase Settling Time measurements, and Spurious measurements test functions provide pass/fail results.

Greater Than/Less Than Tests for Spectrum

If you select a greater than/less than test, you also specify the level that defines a violation. When you select either is greater than or is
less than, a text entry box appears to the right of the drop-down list. Use the text entry box to specify the signal level you wish to test for.
While not as flexible as mask testing, this type of test is quicker to set up.

The following figure shows the results of an is greater than test. The vertical red bar highlights results that match the test definition.
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Outside/Inside Mask Tests

If you specify a mask-based test, then you need to edit the mask to specify the levels that define a violation. When you select is outside
mask or is inside mask, an Edit limits button is displayed. Click the Edit limits button to display the Mask Test Editor window.

To set up and save mask test limits for a test. Perform the following procedure to set up a test using the mask limits.

1. After choosing the desired Search in and Test for items, click Edit limits to display the Mask Test Editor window.
2. Click the New button to create a table. This clears the existing points and loads the default table. You can also click Open to open an

existing table.
3. To edit values, add points, or delete points in a table:

a. To edit an existing value, double-click on the cell you want to edit and enter the desired value. The active point shows as a red
point on the plot.
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b. To add a new point, check the box next to the target mask (located below the Auto draw button).
c. Select Add points located below the Open button.
d. Select the target mask (Upper Mask Table or Lower Mask Table) from the drop-down menu.
e. Click in the desired location on the plot to add the point.

f. To use the auto draw feature to automatically place points on the chosen mask, enable the desired mask from the drop-down menu
and then click the Auto draw button.
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Note: Units may be changed for measurements other than Noise Figure in Setup > Analysis > Units.

1. To delete a point from the table, select the point to be removed, and click the X button.
2. To save the mask to a file for later recall, click Save As.
3. From the Save As dialog, name the file and save it in the desired location.

Note: Masks are saved in XML format with a .msk extension.

4. To dismiss the Mask Test Editor window, click Done.

Mask Test Result Example
The following figure shows the results of a Spectrum is outside mask test with Upper Mask enabled. The vertical red bar highlights results
that have exceeded the test limits. The shaded region shows the mask area.

Actions Tab
The Actions tab allows you to trigger the application when a signal in the frequency domain violates the mask.
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Setting Description

During Run or Replay Actions specified here will occur in either Run mode or Replay mode.

Beep The analyzer beeps when the test condition is met. There will be no sound if the instrument hardware
does not support audible output.

Stop The analyzer stops when the test condition is met.

During Run Only Actions specified here are taken only during Run mode (while acquiring live data).

Save acquisition data Saves acquisition data to a file when the test condition is met. Use the drop-down list to specify the
format of the saved data. The available file formats are: TIQ, CSV, and MAT.

Save trace Saves Trace data to a file when the test condition is met.

Save picture Saves a screen capture to a file when the test condition is met. Use the drop-down list to specify
the format of the saved picture. The available file formats are: PNG, JPG, and BMP. Note that no
trace will be saved if the tested trace isn't a saveable trace type. For example, a Spurious trace is not
saveable.

Max files Specifies the number of times a test action stores a file. After this limit is reached, no more files are
saved. The instrument will continue to run, but no additional files are saved when test conditions are
met.

Keep in mind when setting this number that picture files are counted as part of the total number
of files. For example, if you set Max files to 100, the instrument will save 100 acquisitions if only
acquisitions are saved or only pictures are saved. But, if both acquisitions and pictures are saved,
then 50 acquisitions and 50 pictures will be saved.

AutoSave File Naming
When one of the AutoSave actions is enabled, the name of the saved file is automatically incremented even if the Automatically
generate filenames option (Tools > Options > Save and Export) is not enabled. When the file is saved, it will be saved to C:\<instrument
name>Files\.
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Analyzing Data
Analysis Settings

Menu Bar: Setup > Analysis 

The Analysis control panel provides access to settings that are used by all displays. These settings affect only post processing and they do
not control hardware settings.

Setting Description

Analysis Time Tab on page 498 Specifies the length of time to use in measurements.

Spectrum Time Tab on page 499 Specifies whether the Spectrum Analysis display uses the same Analysis Time parameters as all the
other displays or if it uses a different Offset and Length.

Frequency Tab on page 500 Specifies the measurement frequency (center frequency).

Units Tab on page 502 Specifies the Power units for all displays.

Analysis Time Tab
The Analysis Time tab contains parameters that define the portion of the acquisition record that is used for analysis.

Setting Description

Analysis Offset Specifies the location of the first time sample to use in measurements.

Auto When enabled, causes the instrument to set the Analysis Offset value based on the requirements of
the selected display.

Analysis Length Specifies the length of time to use in measurements.

Auto When enabled, causes the instrument to set the Analysis Length value based on the requirements of
the selected display.

Table continued…
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Setting Description

Time Zero Reference Specifies the zero point for the analysis time.

Actual This is a displayed value, not a setting. It is the Analysis Length (time) being used by the analyzer;
this value may not match the Analysis Length requested (in manual mode).

Analysis Offset
Use analysis offset to specify where measurements begin. Range: 0 to [(end of acquisition) - Analysis Length)]. Resolution: 1 effective
sample (or symbol).

Analysis Length
Use the analysis length to specify how long a period of time is analyzed by a measurement. After you enter a value, this box changes
to show the actual value in use, which is constrained by Acquisition Time. This setting is not available when Auto is checked. Range:
minimum value depends on modulation type to Acquisition Length. Resolution: 1 effective sample (or symbol).

Time Zero Reference
The analysis offset is measured from this point. Choices are: Acquisition Start or Trigger Point.

Parameter Description

Acquisition Start Offset is measured from the point at which acquisition begins.

Trigger Point Offset is measured from the trigger point.

Spectrum Time Tab
This tab controls whether the Spectrum display uses the same Analysis Time parameters as all the other views or uses a different Offset
and Length.

Settings Description

Spectrum Time Mode

Independent Causes the spectrum analysis views to use the settings unique to those displays.

Use Analysis Time settings Causes the spectrum analysis views to use the settings on the Analysis Time tab.

Spectrum Time (only available when Independent is selected)

Spectrum Offset Sets the beginning of Spectrum Time with respect to the selected time reference point (selectable in
the Analysis Time tab as either Acquisition Start or Trigger).

Table continued…
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Settings Description

Spectrum Length The amount of data, in terms of time, from which spectrum traces are computed.

Auto When enabled, causes the instrument to set the Spectrum Length value based on the RBW setting.

Actual This is a displayed value, not a setting. It is the Spectrum Length (time) being used by the analyzer;
this value may not match the Spectrum Length requested (in manual mode). The actual spectrum
length is always an integer multiple of the time needed to support the RBW value.

Frequency Tab
The Frequency tab specifies two frequency values: the Measurement Frequency and the Spectrum Center Frequency. The Measurement
Frequency is the frequency at which most displays take measurements. The Spectrum Center Frequency is the center frequency used by
the Spectrum, DPX Spectrum, Spectrogram and Time Overview displays.

The following screen capture shows a display with both the Measurement Frequency and the Spectrum Center Frequency locked together.

Normally, the Measurement Frequency and the Spectrum Center Frequency are locked together so that both have the same setting. But
in some situations, for example, where a signal contains a set of channels, it is useful to unlock the Measurement Frequency from the
Spectrum Center Frequency. When the Spectrum Center Frequency is unlocked from the Measurement Frequency, you can adjust the
Measurement Frequency so that measurements can be taken at different frequencies without resetting the center frequency. The following
screen capture shows the magenta-colored measurement frequency indicator still located at the center frequency.
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The following screen capture shows the measurement frequency indicator located at 2.0402 GHz while the Spectrum Center Frequency is
still located at 2.0000 GHz.

You can drag the Measurement Frequency indicator on the screen to set the measurement frequency. Note the base of the Measurement
Frequency indicator. The width of the box indicates the widest measurement bandwidth in use among the open displays. You can see
how the width of this box changes with the measurement bandwidth by, in this example, adjusting the Measurement BW setting for the
Constellation display (Settings > Freq & BW tab). As you adjust the setting, you will see how the width of the box at the base of the
Measurement Frequency Indicator changes.

The Measurement Frequency indicator is useful for interpreting system behavior when MeasFreq is unlocked. If a measurement has a
wide bandwidth relative to the spectrum span, and the Measurement Frequency is far from spectrum center, the measurement is likely to
fail because its required frequency range exceeds the frequency range of the available data. In such a case, the navigation control will
show that the measurement bandwidth extends outside the Spectrum's span.
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There are interactions between frequency unlocking and RF & IF Optimization (see the Amplitude Settings on page 507). When Best for
multiple displays is the selected optimization, the instrument is allowed to use its full bandwidth to meet the needs of all open displays.
This is the most user-friendly optimization because it decreases the number of Acq BW too small errors, but it can increase noise and
slightly decrease measurement accuracies. For all other optimization types, the instrument optimizes the acquisition bandwidth for the
selected display, improving measurement quality somewhat, but reducing concurrent measurement capability.

There are also interactions with trigger settings. When the Spectrum Center Frequency is unlocked from Measurement Frequency, the RF
triggers (Trigger Source = RF Input) can tune to either Spectrum Center Frequency or Measurement Frequency. When a spectrum display
is selected, the trigger frequency is the same as the Spectrum Center Frequency. When one of the other displays that uses Measurement
Frequency is selected, the trigger is tuned to the Measurement Frequency also. This allows you to trigger on the signal you are measuring.
But, there is an exception: when the selected RF & IF Optimization is Best for multiple displays, the trigger is always tuned to the
Spectrum Center Frequency.

The reason the trigger frequency is affected by Measurement Frequency and RF & IF Optimization, is that these functions control how the
acquisition is tuned. The optimization Best for multiple displays keeps the acquisition centered about the Spectrum Center Frequency
at all times. To accommodate off-center Measurement Frequencies, it just widens the acquisition bandwidth. Other optimizations tune the
acquisition frequency to match that of whichever display is currently selected. The RF trigger module receives the same acquisition data as
all the measurements, tuned to the center of the current acquisition bandwidth.

Units Tab
The Units tab specifies the global Amplitude units for all the views in the analysis window.

Analyzing Data Using Replay: Replay Overview
The Replay function enables you to reanalyze data with different settings and even different measurements. You can replay all the
acquisitions in memory, a single acquisition, a single frame within an acquisition (if Fast Frame is enabled), or any contiguous set of data
records from acquisition history.

Displaying the Replay Control Panel
To display the Replay control panel:

1. Select View from the main menu bar.
2. Select Replay Toolbar in the menu. The toolbar will appear near the bottom of the display.

3. Click the Define button to open the Replay control panel.
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Tip: You can read more about the other toolbar buttons here.

Selecting the Data Type to Replay

To replay acquisition data, choose Acq Data.

Select Data Records Tab
The Select data records tab is used to select which data records to replay. A data record is the smallest unit that can be replayed. Note
that what constitutes a data record can vary. If FastFrame is not enabled, a data record consists of a single acquisition. If FastFrame is
enabled, each acquisition can contain multiple frames, and a data record consists of a single frame.

Figure 63: Without FastFrame enabled

Figure 64: With FastFrame enabled

Date and Time Stamps. The line that appears above each Start box (one for acquisitions and one for frames when FastFrame is enabled)
is a date stamp that displays the date and time the first record in the current acquisition was acquired. The line that appears below each
Stop box is a date stamp that displays the date and time the last record in the current acquisition was acquired.

The line that appears to the right of each Start box displays the date and time the selected acquisition or frame was acquired. The line that
appears to the right of each Stop box displays the date and time the selected record or frame in the current acquisition was acquired.

Select All button. Selecting Select All resets the Start and Stop values. The Start value is reset to the first acquisition or frame of the
current acquisition. The Stop value is reset to the last acquisition or frame in the current acquisition.

Acquisition Info Tab
Displays information about acquisition settings and sets the number of decimal places used for displaying the time stamp.
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Replay Speed Tab
Sets the speed at which data records are replayed.

Replay Menu
The Replay menu provides controls that let you choose how to replay acquisitions. The replay function enables you to, in effect, “rerun” an
analysis while applying different measurements to the same set of acquisition data.

Menu item Description

Acq Data Select Acq Data to replay acquisitions.

Replay all selected records Replays the sequence of records specified by Start and Stop on the Select data records tab.

Loop overall selected records Replays the sequence of records specified by Start and Stop on the Select data records tab
continuously.

Replay current record Replays the currently selected acquisition (or frame).

Replay from selected Displays a submenu that you use to specify which records are to be replayed.

First record Replays the first record within the selected set.

Previous Replays the previous record within the selected set.

Next Replays the next record within the selected set.

Last record Replays the last record within the selected set.

Pause Suspends replay of the data records as soon as the current record's replay action is completed. Press
Pause again to begin replay with the next record in the sequence.

Stop Halts the replay of acquisitions. If replay is started after Stop has been selected, replay starts from the
first acquisition.

Select all Selects all acquisitions for replay.

Select records from history Displays the Select data records tab of the Replay control panel. Use the Select data records tab to
specify which acquisitions and frames you would like to replay.

Replay toolbar Displays or hides the Replay toolbar.
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Acq Data
Selecting Acq Data selects acquisition data as the source for replay. Selecting Acq Data does not start replay, it only selects the type of
acquisition data that will be replayed.

Replay All Selected Records
Selecting Replay all selected records replays all the selected data records. The set of selected records may comprise a single record, all
records in acquisition history, or a subset of the records in history.

Replay Current Record
Selecting Replay current record replays the current data record. You can identify the current acquisition record by looking at the Replay
toolbar. The first number to the right of the Select button identifies the current data record. For example, if the number is 2:10, it means the
current record is the tenth frame of the second acquisition in history.

Replay from Selected
Select Replay from selected to replay records as selected from the submenu. The records replayed can be from the acquisition memory
(history) or from a saved acquisition data file that has already been recalled as the current acquisition data.

Pause
Select Pause to suspend playback. Selecting Pause again restarts the replay at the point it was paused.

Stop
Select Stop to halt the replay of data. Selecting any Replay action restarts replay of records from the beginning.

Select All
Select Select all to select all data records for replay.

Select Records from History
Selecting Select records from history displays the Select data records tab of the Replay control panel. The Select data records tab
allows you to specify which records in the acquisition history will be used when the Replay button is selected.

Replay Toolbar
Displays or hides the Replay toolbar that appears below the main tool bar.

Figure 65: Replay toolbar

Item Description

Replay Selects data type to be replayed.

Replays the first record in the selected set.

Table continued…
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Item Description

Replays the previous record in the selected set.

Replays the current record in the selected set.

Replays the next record in the selected set.

Replays the last record in the selected set.

Replays all records in the selected set.

Replays all records in the selected set continuously until stopped.

Pauses replay. Pressing pause suspends replay with the current record. Selecting pause again starts
Replay with the next record.

Stops replay. Starting any replay action after pressing stop starts a new Replay action rather than
continuing from the record at which the previous replay action was stopped.

Clicking Select All selects all records in history for replay. Selecting Select all resets the Start and
Stop values on the Select data records tab of the Replay control panel.

Clicking the Define button displays the Define Replay control panel. The Acquisition Info tab displays
information about the acquisition data such as acquisition bandwidth, sampling rate and acquisition
length. All data records in the acquisition history were acquired with identical parameters. When
any of these parameters are changed, all records in history are deleted as soon as the first record
acquired under the new parameter values is received.

You can also view and use the Select data records tab, Select DPX Spectra tab, and Replay Speed
tab.

This readout shows information about the data record being replayed. The information displayed
shows the acquisition and frame number and time stamp for the current data record.
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Amplitude Corrections
Amplitude Settings
Main menu Bar: Setup > Amplitude 

Favorites toolbar:

The Amplitude control panel provides access to power-related settings that are used by all displays within the SignalVu application.

Setting Description

External Gain/Loss Correction Specifies whether a correction is applied to the signal to compensate for the use of external
equipment.

External Gain/Loss Correction Tab
The External Gain/Loss Correction tab allows you to apply a correction to a signal to compensate for the use of external equipment, such
as an amplifier or attenuator. You can specify whether the corrections on this tab apply to all acquired data or only to a set group of
displays. You can also apply external corrections to traces in the Spectrum, Spectrogram, Spurious, and Amplitude vs Time displays.

External Gain Value
Use the External Gain Value setting to apply a flat gain/loss correction to the signal. Positive values represent a gain and negative values
represent a loss. The range is –80 to +50 dB. Resolution is 0.1 dB.

Note: Selecting Preset clears the check box, but it does not change the value.

Apply External Corrections To
Table corrections can be applied only to traces in the Spectrum, Spectrogram, Spurious and Amplitude vs Time displays.

Trace Corrections Versus Data Corrections
Because of the real-time nature of the analyzer and desire to frequently reanalyze stored acquisitions, it is possible to apply amplitude
corrections in real time. Applying real-time corrections to the incoming data means that, the correction factors present during the
acquisition are already part of the data when the data is stored and then reanalyzed. This also allows the DPX display to maintain its
update rate while presenting an amplitude-corrected display.
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Real-time gain/loss factors are applied by creating a correction filter that is applied by the same digital signal processing used to correct for
calibration and alignment factors in the instrument. This process does have limitations. In creating a digital filter to represent the gain/loss
table, a limited number of filter taps are be used in order for the filter to be practically realizable. If your amplitude corrections contain
discontinuities or extremely sharp transitions, the filter used will contains errors and ringing.

If the above is the case, we recommended that you use trace corrections. These are very similar to a conventional spectrum analyzer, and
may be applied to the Spectrum, Spectrogram, Spurious search and Amplitude vs. Time displays. These traces may contain transitions of
any type within the maximum and minimum correction values allowed in the tables.

External Loss Tables
Use an External Loss Table to apply a frequency dependent gain/loss correction to the signal. When an External Loss Table is selected,
the analyzer adjusts the signal according to the values in the table. An external loss table allows you to compensate the signal level for
variations in cable loss, antenna frequency response or preamp frequency response.

You can create external loss tables from the analyzer application and save them as files. External loss tables are saved as plain text files in
CSV (Comma Separated Value) format. The tables have a CSV file extension.

You can change the title for each table. However, note that the title is only a label. It is not tied to the file name of any table you may have
loaded or saved.

Note: If you are using an External Loss Table for antenna corrections, be sure to set the Amplitude units (Setup > Analysis >
Units) to dBuA/m or dBuV/m.

Creating an External Loss Table
You can create an external loss table with the analyzer application. No external application is required.

To create an external loss table:

1. Click Edit. to display the Table Editor.

2. Click New Table to create a table. This clears all entries in the existing table and loads the default table.
3. To edit values in the table:

a. To edit an existing value, double-click on the cell you want to edit.
b. To add a new point to the table, click on Add Point. Edit the values as required.
c. Click Apply if you want to test your table without closing the editor (the table must be enabled with the check box in the control

panel and measurements must already be running).

To specify a frequency multiplier, you can type K, M, or G.
4. To delete a point from the table, select the point to be removed, and click Delete.
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5. Select the Frequency Interpolation method:

• Select Linear when the frequency scale of the spectrum or spurious measurements are linear.
• Select Log when the frequency scale of the spectrum is logarithmic.

6. When you have entered all the necessary values, click Save As (to save the table in a file) or click OK.
7. From the Save As dialog, name the file and save it in the desired location.

External loss tables are saved in CSV (Comma Separated Value) format.

Loading an External Loss Table
To load an external loss table file:

1. Click Edit to display the Table Editor.
2. Click Load to display the Open dialog box.
3. Navigate to the location of the desired file, select it and click Open.
4. Click OK.
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Controlling the Acquisition of Data
Run
Run mode specifies whether the analyzer will stop acquiring data after it completes a measurement sequence.

• Continuous: In Continuous mode, once the analyzer completes a measurement sequence, it begins another.
• Single: In Single mode, once the analyzer completes a measurement sequence, it stops.

Note: A measurement sequence can require more than one acquisition. If the analyzer is configured to average 100 traces
together, the measurement sequence will not be completed until 100 traces have been acquired and averaged.

Resume
Favorites Bar: Run > Resume 

Restarts data acquisition, but does not reset accumulated results, such as Average or MaxHold. This allows you to stop acquisitions
temporarily, then continue. If the accumulation is already complete, for example, 10 acquisitions or 10 averages have already been
completed, each subsequent Resume command will cause one more acquisition to be taken, and its results added to the accumulation.
Not available if instrument settings have been changed.

Abort
Favorites Toolbar: Run > Abort 

Selecting Abort immediately halts the current acquisition/measurement cycle. In-process measurements and acquisitions are not allowed
to complete. Visibility and accuracy of results is unspecified after an abort.

Acquire
Main menu: Setup > Acquire 

Favorites toolbar:

Selecting Acquire displays the Acquire control panel. These settings control the hardware acquisition parameters for the oscilloscope.
Normally, sampling parameters are automatically adjusted for selected measurements. You can use Acquire to change these parameters if
necessary.

Setting Description

Vertical Sets the channel used, reference level, and termination.
IQ Sampling Parameters Sets sampling parameters.
Table continued…
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Setting Description

Scope Settings Sets the SignalVu software to control oscilloscope acquisition
parameters or use the current oscilloscope settings.

Scope Data Displays the sample rate and record length reported by the
oscilloscope.

Vertical
Use the Vertical tab to specify which oscilloscope channel is used for analysis by the SignalVu software. T

Signal inputs and tab settings
The number of signals analyzed by SignalVu depends on the selected signal input type. Input types are:

• RF
• I & Q
• Diff I & Q (Differential I & Q)

Setting Description
Signal Input Specifies the input signal type.
Ref Level Specifies the Reference Level, which determines the oscilloscope's

Vertical Scale setting. If Vertical settings are not enabled in the
Scope Settings tab, or while analyzing a recalled data file, the
Reference Level control only adjusts vertical display position.
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Setting Description
Null IQ Offset Removes DC offset that may be applied within the oscilloscope to

eliminate offset between I and Q channels.
Source Specifies the input source. Choices available are: CH1, CH2, CH3,

CH4, Math1, Math2, Math3, Math4, Ref1, Ref2, Ref3, and Ref4.
Coupling Display of the coupling setting on the selected channel.
Bandwidth Display of the oscilloscope bandwidth setting.
Termination Display of the termination setting for the selected channel.

Offset frequency
If the Signal Input is set to I & Q or Diff I & Q, the Freq: readout serves as the offset frequency readout. When the Signal Type is set to I &
Q or Diff I & Q, the default measurement frequency is 0 Hz. However, for signals that have near-zero IFs, the measurement frequency can
be changed by entering an offset frequency value in the measurement frequency entry box (Freq: in the Favorites toolbar).

IQ Sampling Parameters
The IQ Sampling Parameters tab enables you to set the controls for real-time acquisition. Depending on the setting chosen for Adjust, two
additional parameters can be set. Normally, the best results are achieved by leaving the Adjust control set to All Auto.

Sampling control
There are three acquisition parameters that interact with each other: acquisition bandwidth, oscilloscope acquisition sampling rate, and
memory usage. The oscilloscope's sampling rate is displayed in the status bar at the bottom of the SignalVu window. This sample
rate is decimated by the SignalVu software to meet the requirements of the current measurement settings (such as the selected span,
acquisition bandwidth or resolution bandwidth of a measurement). The resulting decimated sample rate is shown in the figure above (391
MSamples/sec). This is the sample rate of the IQ data analyzed and acquisition data file stored by SignalVu.

Adjust User Sets Analyzer Calculates

All Auto N /A N /A All values based on the selected
measurement

Acq BW / Acq Samples Acq BW Acq Samples Acq Length

Acq BW / Acq Length Acq BW Acquisition Length Acq Samples

Acquisition Memory Usage
The center portion of the tab shows how the acquisition memory is used.
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Readout Description

Samples/s, sec/Sample Readout of the acquisition sample rate and sample period.

Capacity The maximum period of time and number of samples that can be
acquired with the current sampling parameters.

Using The total amount of acquisition memory that will be used based on
the current settings.

Fast Frame
FastFrame is a feature that allows you to segment the acquisition record into a series of frames, or data records. A typical use of
FastFrame is to record data samples around signal events of interest, while not wasting memory on irrelevant data between these events.
FastFrame acquisitions are only valid for live waveforms and is not supported for Math or Reference Waveforms.

Setting Description

Fast Frame Enables Fast Frame acquisition mode when box is checked.

Max frames Specifies the maximum number of frames to record in a single
acquisition process.

Actual Shows the actual number of frames that will be acquired into the
acquisition memory. This number changes based on the Acq BW,
Acq Samples, and Acq Length values. This number will never be
greater than the value set by Max frames.

Scope Settings
The Scope Settings tab is where you specify which oscilloscope settings are controlled by the SignalVu software.

Setting Description
Sample rate When enabled, SignalVu adjusts the sample rate as required based

on measurement settings in the analysis software. Sample rate
determines the maximum available measurement bandwidth.

Auto When Sample Rate is enabled and Auto is enabled, SignalVu
adjusts the sample rate automatically. When Sample Rate is
enabled and Auto is disabled, you can specify the sample rate
using the text entry box. You can set the sample rate to any of
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Setting Description
the standard oscilloscope sample rate settings. If you choose an
arbitrary value, SignalVu will adjust the value to the closest standard
sample rate.

Other acquisition/horizontal settings When enabled, SignalVu adjusts the oscilloscope horizontal and
acquisition settings of the oscilloscope as needed to provide the
best results. For example, SignalVu sets Sampling Mode to Real
Time Only and Horizontal Mode to Manual when it is allowed
to control these parameters. Checking these boxes helps reduce
variability in the SignalVu results.

Vertical settings When enabled, SignalVu adjusts the oscilloscope's vertical
settings. Vertical settings include Coupling, Bandwidth, Scale and
Termination. SignalVu sets these to values appropriate for RF
signals. The Scale value sent to the oscilloscope is calculated from
SignalVu's Reference Level control value.

Trigger Position When enabled, SignalVu controls the trigger position on the
oscilloscope. When enabled, the trigger position can be specified
manually by entering a value into the text entry box or automatically,
which allows SignalVu to set the trigger position.

Reset all scope settings to default values Press this button to change all oscilloscope settings to the
oscilloscope's default values.

Scope Data tab
The Scope Data tab displays the sample rate and record length of the data received from the oscilloscope or from a recalled oscilloscope
waveform file.

Transfer Again
The Transfer Again button, selectable only when run is stopped, causes SignalVu to request that the last acquisition made by the
oscilloscope be transferred again and analyzed. This enables you to change measurement settings and then reanalyze the acquisition
data with the revised measurement settings in effect. If FastFrame is enabled, all frames are replayed when the transfer is completed.

The Transfer Again function is most useful when measurements in SignalVu are set up to require less acquisition bandwidth than what
is available from the oscilloscope (based on the sample rate used by the oscilloscope to acquire the waveform record). In this case, the
data is decimated before being supplied to SignalVu (because SignalVu doesn't need the excess bandwidth. If you need a wider bandwidth
than SignalVu was originally set up for and the original scope acquisition supports the new value, you can change the SignalVu settings,
then click Transfer Again. This time, the waveform data is sent to SignalVu with its bandwidth (sample rate) adjusted to match the current
measurement settings.
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Acquisition Data
The Acquisition Data tab lists the Sample Rate and Record length of the recalled acquisition data file.

This tab is only available when not connected to an instrument.
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GNSS and Antenna Features
How to set up GNSS
The combined use of the GNSS, Antenna, and Map It features allows you to capture and map location coordinates when using an antenna
and a GNSS receiver. The Map It feature requires that the optional MAP application license be installed.

You can use the GNSS and Map It features to connect a Global Navigation Satellite System (GNSS) receiver to a communication (COM)
port on your PC to capture the timing and positioning data of the receiver for a measurement from a satellite or constellation of satellites.
The receiver must output navigation messages using NMEA 0183 serial data format, and the messages must include at least one of these
sentence types: RMC, GGA or GNS.

The RSA7100 with Option GPS, the RSA500A series, and the RSA600A series instruments have an internal GNSS receiver.

How to access the GNSS/Antenna control panel

Click the  icon or select Setup > GNSS/Antenna from the Main menu bar to view the GNSS/Antenna control panel.

GNSS settings
The following images and table show the GNSS tab of the GNSS/Antenna control panel and its contents.

Figure 66: The above image shows the GNSS tab as it appears when the GNSS selection is External, None, or Simulator.

Figure 67: The above image shows the GNSS tab as it appears when the GNSS selection is RSA Device. This selection is only available when an RSA7100 (with Option
GPS), RSA500A series, or RSA600A series instrument is connected.
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Setting Description

Source Select the GNSS source as None, RSA Device (GPS), or External.

None disables use of GNSS data.

RSA Device selects the internal GNSS receiver in the connected analyzer.

External selects a user-provided GNSS receiver in the PC with SignalVu-PC installed, or it may be one you
connect through USB or some other method.

Note: When recording with XDAT format, a marker file (.xmrk) is generated that lists GPS data,
such as time, location, and the time stamp of the GPS event during recording. You can read more
about file formats in the Saved File Types topic.

Antenna Power This item appears when RSA Device is the GNSS selection. Check this box to supply power to an
attached antenna. Power is provided as a DC voltage on the connector center conductor.

Unchecking the box turns power to the antenna off. Changing the selection from RSA Device to any other
selection also turns the power to the antenna off.

COM Port This list is auto-populated with the COM ports on your PC, as well as a simulation port.

This selection is not available when RSA Device is selected.

Note: You must first select the COM port to which the antenna is connected before an antenna
connection can be established.

Baud rate Select a baud rate. Selection of this rate will depend on your GNSS receiver and COM port specifications.
Options are 4800, 9600, 19200, and 38400.

This selection does not apply when RSA Device is selected.

Satellite System Select a satellite system: GPS, GLONASS; GPS, BeiDou; GPS; GLONASS, BeiDou.

GNSS readout This readout shows the status of the GNSS connection and time, location, and satellite information. Each
item is described below.

GNSS Status GNSS receiver connection status: Off, Comm error, Unlocked, Locked.

Time Date (yyyy-mm-dd) and time (hh:mm:ss).

Longitude East-west position (shown in degrees), where the prime meridian is 0°. Positive numbers indicate East and
negative numbers indicate West.

Latitude North-south position between the poles (shown in degrees), where the equator is 0°. Positive numbers
indicate North and negative numbers indicate South.

Altitude Elevation from sea level (shown in meters).

Satellites Number of GNSS satellites currently tracked by the GNSS receiver.

HDOP Horizontal Dilution of Precision (HDOP). This value indicates the quality of the satellite signal using the
relative geometry of the satellite to receiver. An ideal value is <1. The lower the value, the better the
positional precision.

Table continued…
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Setting Description

Speed Speed of receiver (shown in km/s).

Course Compass bearing (shown in degrees).

The icon  appears in the right corner of the Status Bar. It is green when GNSS is locked, yellow if unlocked, and red if there is a
communication error.

How to set up the GNSS feature with an external GNSS receiver

1. Install a GNSS receiver to a COM port on your PC.
2. Select Setup > GNSS/Antenna from the Main menu bar to view the GNSS/Antenna control panel.
3. Select External from the drop-down menu in the GNSS tab.
4. From the COM Port drop-down list, select the COM port to which the GNSS receiver is connected.

You can also select RSA Device as your GNSS source if you are using an RSA500A or RSA600A series, or RSA7100 instrument.

Note: You can select Simulation Port to run a simulation when no GNSS receiver is present. Copy the file GnssSimCom19
from C:/RSAMap Files/Example Files and place it in the Windows C:/Temp directory, then select Simulation Port from the
COM Port drop down menu.

5. Set the Baud Rate as appropriate for the connected GNSS receiver. The default is 4800, which is a typical rate.

When the GNSS receiver is communicating with the analyzer, the readouts in the right portion of the GNSS panel (status area) will update
to display current location information and GNSS receiver status. Lock times will vary depending on the receiver and receiving conditions.

See also:
How to use the Antenna feature

How to use Map It

Frequency Reference tab and GNSS settings

Timing Reference tab and GNSS settings

How to use the Antenna feature
The antenna feature allows you to connect to an Alaris DF-A0047 USB-connected antenna that reports bearing/azimuth data over USB.
In conjunction with a GNSS receiver, you can capture location and azimuth data using the Map It feature. If you do not use an Alaris
DF-A0047 antenna, you can use the manual controls to enter an azimuth.

Explore the following topics in this section:

Note: A USB driver is installed for the Alaris antenna with SignalVu-PC. However, Windows will search for new drivers if the PC is
connected to the internet. The first time you plug an antenna into the port, it may take several minutes for the driver to be installed
(when connected to the internet).
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• Antenna settings.
• How to set up the Antenna feature with an antenna.
• How to use the antenna Simulator.
• How to use the Alaris function button

How to access the Antenna control panel

Click  or select Setup > GNSS/Antenna from the Main menu bar to view the GNSS/Antenna control panel. Then click on the
Antenna tab in the control panel.

Antenna settings
Following is an image and a description of the Antenna tab of the GNSS/Antenna control panel.

Setting Description

Antenna Select the antenna. Choices are None, Alaris DF-A0047, and Simulator. The Simulator simulates
an antenna connection and readouts for demonstration purposes.

Manual Azimuth Enter a value here to force the azimuth (compass direction in degrees) to be a specific value. The
azimuth is the angle measured clockwise between the reference meridian (geographic north) and
the current antenna direction. It can range from 0 to 360°.

Force Manual Azimuth Check this box to force the analyzer to read the azimuth at the entered value instead of the
antenna generated value.

Show Compass Check this box to view a visual, qualitative representation of the bearing (a virtual compass).
To remove the compass, uncheck the box. To adjust the compass size, click and drag from the
bottom right corner.

Configure... This button opens the Antenna Setup window. In this window you can enter the antenna serial
number and set the following antenna related parameters: baud rate, data bits, stop bits, and
parity.

Connect Click this button to connect to the antenna or to start the antenna simulator.

Note: You must first select the COM port to which the antenna is connected before a
connection can be established. Use the Windows Device Manager to find the port used
by your antenna.

Manual Declination Enter a value here to force the declination (angle in degrees between magnetic (true) north and
geographic north) to be a specific value.

Table continued…
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Setting Description

Force Manual Declination Check this box to force the analyzer to use the manually entered declination value. Otherwise, the
analyzer will assume that geographic north and magnetic north are the same and use 0°.

Antenna readout This readout field will contain some or all of the following readings, depending on your setup.

Amplifier Shows Off or On depending on whether or not you have enabled the amplifier on the antenna.

Freq Band The current operating frequency band of the antenna. For the Alaris DF-A0047, this value can be
one of the following:

A (0.009 - 20 MHz)

B (20 - 50 MHz)

C (50 - 8500 MHz)

Uncorrected Compass Bearing Shows the azimuth reading from geographic north.

Declination Shows the declination.

True North Azimuth Shows the azimuth reading after declination is applied.

Elevation Shows the antenna elevation.

Roll Shows the antenna roll.

How to set up the Antenna feature with an antenna

1. Install the Alaris DF-A0047 driver. The driver can be copied from the SignalVu-PC Software and Documentation USB stick
supplied with the RSA306, RSA306B, RSA500A series, and RSA600A series instruments. It can also be download from
www.Tek.com\downloads.

2. Connect an Alaris DF-A0047 antenna to the PC.

Note: Connecting an RSA306, RSA306B, RSA500A series, or RSA600A series is not required, but provides increased
functionality of this feature.

Note: A USB driver is installed for the Alaris antenna with SignalVu-PC. However, Windows will search for new drivers if the
PC is connected to the internet. The first time you plug an antenna into the port, it may take several minutes for the driver to
be installed (when connected to the internet).

3. Select Setup > GNSS/Antenna to open the GNSS/Antenna control panel.
4. Select Alaris DF-A0047 from the Antenna drop-down menu. Selections also include None (default) and Simulator.
5. Click the Configure... button to launch the Antenna Setup window.
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6. Do the following in the Antenna Setup window:

a. Enter the serial number of the antenna, if desired.
b. Select the COM port to which the antenna is connected. You can see a list of COM ports for your PC in the Microsoft Windows

Control Panel. Use the Windows Device Manager to find the port used by your antenna.
c. You can change the following parameters; however, the default values are set for the Alaris DF-A0047 antenna. If you change

these parameters, you may lose communication with the Alaris antenna: baud Rate, data bits, stop bits, and parity.
7. Click OK to save the changes and close the Antenna Setup window.
8. You can now choose to manually set the declination, if desired. To do this, check the box next to Force Manual Declination in the

Antenna tab of the GNSS/Antenna control panel and then enter the desired value. Notice that the value you enter will appear in the
antenna readout to the right of the Connect button. The True North Azimuth reading is the sum of the Uncorrected Compass Bearing
and the Declination.

You can also check the box next to Force Manual Azimuth and enter a desired value if you want to force the azimuth or are using
an antenna that does not report azimuth.

When you select to manually force the declination and/or azimuth, those values will not change in the readout, even if the antenna
direction changes.

9. Check the Show Compass box to view a visual, qualitative representation of the bearing. As you move the antenna, the compass
needle will move.

TIP : You can adjust the size of the compass by clicking on the right bottom corner and dragging it.
10. Click the Connect button to connect to the antenna. Connection may take about 10 seconds. Once connected, the antenna readout

will reflect the antenna direction and other readings.
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How to use the antenna Simulator
1. Select Setup > GNSS/Antenna to open the GNSS/Antenna control panel.
2. Select Simulator from the Antenna drop-down menu. Selections also include None (default) and Alaris DF-A0047.
3. Click the Connect button to launch the Smart Antenna Control Form.

4. Click on the various areas of the Smart Antenna window to adjust azimuth, roll, or elevation. You can also enter the values directly
in the Azimuth, Elevation, and Roll Angle fields. This Smart Antenna window simulates a physical antenna, except that there is no
amplification available (the Passive/Active switch in non-functional).

5. Click the Button1 button to capture the GNSS information. (See the How to use Map It topic for more information on capturing data.)
6. You can now choose to manually set the declination, if desired. To do this, check the box next to Force Manual Declination in the

Antenna tab of the GNSS/Antenna control panel and then enter the desired value. Notice that the value you enter will appear in the
antenna readout to the right of the Connect button. The True North Azimuth reading is the sum of the Uncorrected Compass Bearing
and the Declination.

You can also check the box next to Force Manual Azimuth and enter a desired value if you want to force the azimuth or are using an
antenna that does not report azimuth.

When you select to manually force the declination and/or azimuth, those values will not change in the readout, even if the antenna
direction changes.

7. Check the Show Compass box to view a visual, qualitative representation of the bearing. As you move the antenna, the compass
needle will move.
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TIP : You can adjust the size of the compass by clicking on the right bottom corner and dragging it.

How to use the Alaris function button

The Alaris antenna has a function button that allows you to make Band and Mode selections. These can be selected using the rotary
encoder and push button located on the front of the Alaris antenna grip.

To select a frequency:

1. Turn the rotary switch either to the left or right.
2. Watch the LEDs on the back of the grip. The LEDs indicate which frequency band is selected. Selections are:

• Top LED, Band A: 9 kHz – 20 MHz
• Middle LED, Band B: 20 MHz – 500 MHz
• Bottom LED, Band C: 500 MHz – 8500 MHz

To select an amplifier mode:

1. Push the button on the front of the antenna grip.
2. Watch the LED on the back of the grip. It indicates the mode status as:

• LED on: Active mode (amplifier on)
• LED off: Bypass mode (amplifier off)

To take a measurement using the button:

1. Hold the button down for two seconds.
2. Release the button. The measurement is transferred and stored via the Map It function of SignalVu-PC.

See also:
How to set up GNSS

How to use Map It

How to use Map It
Select View > Map It Toolbar from the Main menu bar to open the Map It toolbar.

Once you have set up the GNSS receiver as shown herehere, perform the following steps to capture the data. A Map It file includes trace
data, measurement data, time, and location information for use in the RSA Map program.

Note: The Map It feature requires that the optional MAP application license be installed.

1. Check that at least one of the following displays is active: Spectrum, DPX, Spectrogram, Amplitude vs Time, Channel Power, or
Occupied Bandwidth.
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2. If an RSA306, RSA306B, RSA500A series, RSA600A series, or RSA7100 is not currently connected to the PC, you can connect one
now, if desired.

3. Select View > Map It Toolbar from the main menu bar to view the Map It toolbar. Notice that the current GNSS location and time
information are shown on the toolbar.

4. Click the Edit... button to open the Map It Editor window.
5. In the Map It Editor window, click the Capture button to capture data. If you prefer, you can click the Capture button on the Map It

toolbar first, and then click Edit... to open the Map It Editor window to view the result.
6. You can now import, export, or recall captured data using the related buttons at the bottom of the Map It Editor window. If you export a

file, you can then open it using the RSAMap application (open from the Tools menu).

Importing and exporting Map It files
The information you capture can be zipped and stored as a single file with multiple captures. Recalling results will recall the trace data
and settings stored with Map It. Make sure to uncheck the Show box in the traces menu of the selected display when you have completed
examination of the Map It data.

The Map It zip file is structured as follows:
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Viewing live updates after viewing an imported file
When you want to view live updates again in a Spectrum, DPX, or Spectrogram display, you must go into the Traces tab of the Settings
control panel and uncheck the Show recalled trace box. If you are using a DPX display, do this twice, once each for Bitmap and Trace 1.

See also:
How to use the Antenna feature How to set up GNSS
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Signal Database and Channel Navigation
How to use the Signal Database
Select Tools > Signal Database to open the Signal Database window. Here you can select which signal standards and types are listed
(and selectable) in the Channel Navigation toolbar and/or the Define Survey control panel.

Signal standards and signal types defined
The analyzer uses the following definitions of signal standards and signal types to populate the Signal Database.

• Signal standard: A group of channels that adheres to the parameters and characteristics of a given signal type. These channels could
include both uplink and downlink frequencies.

• Signal type: Parameters and characteristics (bandwidth, spectral shape) common to a given signal. A signal type can be shared by
multiple signal standards.

How to select signal standards in the database window

The following image is of the Signal Database window with the Signal Standards tab selected. The table describes the fields and buttons of
the tab. The standards selected here show in the Define Survey control panel and the Channel Navigation toolbar.

Setting Description

Signal Standards
Supported

List of all available signal standards. Click a standard to select it or click and drag to select a contiguous range
of standards.

Add > > Adds (moves) selected items from the Signal Standards Supported list to the Signal Standards selected
list.

Table continued…
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Setting Description

< < Delete Deletes (moves) selected items from the Signal Standards selected list to the Signal Standards Supported
list.

Signal Standards
selected

List of selected signal standards that will be made available in the Channel Navigation toolbar and the Region
tab of Define Survey control panel. To delete items, select one or more signal standards and click the Delete
button.

Factory Reset Sets the supported and selected fields to the factory-specified signal standards.

Channel Nav Toolbar
check box

Check box to open the Channel Navigation toolbar. The Signal Database window stays open. You can read
more about the Channel Navigation toolbar here.

Signal Survey Toolbar
check box

Check box to open the Signal Survey toolbar. The Signal Database window stays open. You can read more
about the Signal Survey toolbar here.

How to merge the H500 signal database with SignalVu-PC default database

You can merge all user-defined signal types and signal standards from the Tektronix H500 instrument into the default SignalVu-PC signal
database. This provides the advantages the new items introduced in SignalVu-PC without losing your user-defined additions. Merge
databases as follows:

1. Close SignalVu-PC.
2. Make a copy of \BuiltInDisk\NetTekApps\Database\sst_db file to a USB memory stick from the H500 instrument.
3. Rename the copy of the sst_db file to SignalDatabase.rsadb.
4. On the PC with SignalVu-PC installed, overwrite the C:\SignalVu-PC Files\SignalDatabase\SignalDatabase.rsadb file with that you

made in step 3 on page 527.
5. Start SignalVu-PC.
6. Verify all H500 user-defined signal standards and signal types are now available in SignalVu-PC.

How to select signal types in the database window

The following image is of the Signal Database window with the Signal Types tab selected. The table describes the fields and buttons of the
tab. The types selected here show in the Define Survey control panel.
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Item Description

Signal Types supported List of all available signal types. Click a type to select it or click and drag to select a contiguous range of types.

Add > > Adds (moves) selected items from the Signal Types Supported list to the Signal Types selected list.

< < Delete Deletes (moves) selected items from the Signal Types selected list to the Signal Types Supported list.

Signal Types selected List of selected signal types made available in the Region tab of the Define Survey control panel. To delete
items, select one or more signal types and tap the Delete button.

Factory Reset Sets the supported and selected fields to the factory-specified signal types.

Channel Nav Toolbar
check box

Check box to open the Channel Navigation toolbar. The Signal Database window stays open. You can read
more about the Channel Navigation toolbar here..

Signal Survey Toolbar
check box

Check box to open the Signal Survey toolbar. The Signal Database window stays open. You can read more
about the Signal Survey toolbar here..

How to select channels in the database window

The following image is of the Signal Database window with the Channel Table tab selected. The table describes the fields and
buttons of the tab. The channels selected here are included in the Signal Channel Selection window. (See the Channel Navigation
toolbar on page 529 section for information about channel selection.)
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Item Description

Selected Signal Standard Drop down list allows you to select the signal standard, the channels of which will populate the channel table.
This list is taken from the enabled standards in the Signal Standards tab.

Enabled column
checkboxes

Enables/disables the channel in the row.

Mark All Selects all channels in the table to enable them.

Unmark All Deselects all channels in the table to disable them.

Hide unmarked checkbox Hides any deselected channels so that you can view only the enabled channels in the table.

Factory Reset Sets each channel to the factory-specified enabled/disabled state.

Channel Nav Toolbar
checkbox

Check box to open the Channel Navigation toolbar. The Signal Database window stays open. You can read
more about the Channel Navigation toolbar here..

Signal Survey Toolbar
checkbox

Check box to open the Signal Survey toolbar. The Signal Database window stays open. You can read more
about the Signal Survey toolbar here..

Channel Navigation toolbar
Select View > Chan Nav Toolbar to view the Channel Navigation toolbar. This toolbar allows you to navigate easily from channel to
channel in any measurement display. It provides the following capabilities:

• Select a channel for enabled standards (only standards selected in the Signal Database).
• Select the channel direction, if applicable (uplink or downlink).
• Access the Signal Channel Selection window, which allows you to select from a list of enabled channels.

The following image shows the toolbar and the following table describes how it functions. 
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Item Description

Signal Standard Drop down list allows you to select the signal standard, the channels of which will populate the Channel field
to the right . This list is taken from the enabled standards in the Signal Standards tab of the Signal Database.

Channel This field shows the channel number of the currently selected signal standard that the instrument is currently
tuned to. An entry of "--" indicates that the current instrument frequency does not match that of any of the
currently enabled channels.

Clicking in this field allows for direct channel number entry. To select the next or previous channel, you can
use the up and down arrow keys on your keyboard or the arrows in the Numeric Keypad (in the View menu,
check the Numeric Keypad box). Note that this applies to enabled channels only.

If you see a ≈ in front of the channel number, it means that the current instrument frequency is close to, but
not exactly equal to, the currently selected channel. It means that the current instrument frequency does not
exactly match the currently selected channel frequency, but that it is within the current channel bandwidth.

You cannot directly enter or use the arrow keys to select non-numeric channel names for signal standards You
must use the Select Channel button.

Select Channel Opens the Signal Channel Selection window. This window shows a table of enabled channels for the selected
standard. Click on the channel you want to view in the plot and then click the OK button. This window also
allows you to access the Signal Database window (using the Enabled Channels button) so that you can
enable different channels or change standards or types, if desired.

Uplink Click to select the uplink channels for the currently selected signal standard.

Downlink Click to select the downlink channels for the currently selected signal standard.

See also:
How to use the Signal Database on page 526
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Managing Data, Settings, and Pictures
Saving and Recalling Data, Settings, and Pictures
You can save different types of data for later recall and analysis.

Data type Description Save as type

Setup files Saves all of the setup information for all
displays, except those settings that are not
part of Preset.

Setup (.Setup)

Picture of Selected Display (PNG/JPG/BMP) Saves a capture of the screen in the
specified format. This option is useful for
including the graphic in reports or other
applications. Marker readouts and other
information are included.

Picture (.BMP, .PNG, .JPG)

Results Export files Saves the trace and numeric data for the
selected display. The trace and numeric
data are saved as CSV files.

Results export (various)

Measurement Settings Saves a list of settings relevant to the
selected measurement to a text file.
This option is useful for including the
measurement settings in reports.

Measurement settings export (TXT)

Trace Saves a trace for later recall into the display
from which it was saved.

Selected trace (various)

Data Saves data for reanalysis later or as data
to use with external software (either CSV
(comma-separated value) or MAT (MATLAB
format).

Acquisition data with setup (TIQ); or
Acquisition data export (CSV or MAT)

Saving Files

Saving files follows the same procedure regardless of the type of data being saved. To save setups (including application presets),
pictures, results, or acquisition data:

1. If you are going to save DPX Spectra (DPXogram) acquisition data, stop acquisitions.

Saving while running is allowed by the analyzer, but data files saved while running will not contain any DPX spectral data.
2. Select Save As from the File menu to open the Save As dialog box.
3. Navigate to the folder where you want to save the setups, or use the default location.

• To save setups so that they appear in the Application Presets window, save your setup in the folder C:\SignalVu-PC Files\User
Presets. The saved setup will appear in the Application Presets window with the name you give the file.

4. Enter a file name.
5. Select the type of file to save from the Save as type drop-down list.
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6. Click Save.

Recalling Files
You can recall three types of files: Setup files, Selected Trace, and Acquisition data with setup. Recalling data follows the same procedure
regardless of the type of data being recalled.

1. Select Recall from the File menu to open the Open dialog box.
2. Navigate to the folder containing the file you want to recall.
3. Select the type of file to recall from the Files of type drop-down list. This selection determines the files that appear in the Open dialog

box.
4. Select the file to recall.
5. Click Open.

Recalling waveforms with SignalVu-PC
SignalVu-PC can recall waveform files saved by Tektronix oscilloscopes and spectrum analyzers. It can also read files saved in MATLAB
level 5 and level 7.3 formats. Waveform files can be recalled two ways: as Data and setup, and as Data only.

The following tables lists the supported file formats and includes notes about using the files.

Table 42: RSA5000/RSA6000/SPECMON file formats supported by SignalVu-PC

Generated by   RSA5000/ RSA6000/ SPECMON  

File type   .tiq .mat

File description   Contains corrected I and Q time-
domain data, all settings and
measurement setup

Contains I and Q time-domain
data, center frequency,
sample rate

What SignalVu-PC
can do with this
format

Open with
settings

All Settings and
Measurements are
Recalled

✓ ✓

Open as data
only

Uses settings from
SignalVu-PC when
opened

✓ ✓

Notes   This is the native format for SignalVu-
PC. It contains all information needed
to open and analyze all displays
available, plus system information not
used in analysis.

Contains all information
needed to open and analyzer
files with SignalVu-PC. Can
be opened by MATLAB.

Table 43: RSA3000 and WCA200 file formats supported by SignalVu-PC

Generated by   RSA3000, WCA200  

File type   .iqt .mat

Table continued…
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File description   Contains I and Q time-domain
data, center frequency, sample rate,
amplitude and phase corrections

Contains I and Q time-domain
data, center frequency, sample
rate

What SignalVu-PC
can do with this
format

Open with
settings

All Settings and
Measurements are
Recalled

  

Automatically Sets
Span, Center Frequency

✓ ✓

Open as data
only

Uses settings from
SignalVu-PC when
opened

✓ ✓

Notes   Recommend saving as .tiq file after
opening

Recommend saving as .tiq file
after opening

Table 44: WCA300 file formats supported by SignalVu-PC

Generated by   WCA300

File type   .iqt

File description   Contains I and Q time-domain data, center
frequency, sample rate, amplitude and phase
corrections

What SignalVu-PC can do
with this format

Open with settings All Settings and Measurements
are Recalled

 

Automatically Sets Span, Center
Frequency

✓

Open as data only Uses settings from SignalVu-PC
when opened

✓

Notes   Recommend saving as .tiq file after opening

Table 45: SignalVu on oscilloscopes file formats supported by SignalVu-PC

Generated by   SignalVu on oscilloscopes  

File type   .tiq .mat

File description   .tiq format as used by SignalVu,
all versions, includes I and Q
time domain data, all settings and
measurement setup

Contains I and Q
time-domain data, center
frequency, sample rate

Table continued…
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What SignalVu-PC
can do with this
format

Open with
settings

All Settings and
Measurements are Recalled

✓ ✓

Automatically Sets Span,
Center Frequency

 ✓

Open as data
only

Uses settings from
SignalVu-PC when opened

✓ ✓

Notes   This is the native format for
SignalVu-PC. It contains all
information needed to open and
analyze all displays available

Recommend saving as .tiq
file after opening

Table 46: Performance Oscilloscope (without SignalVu) file formats supported by SignalVu-PC

Generated by   MSO/DPO/DSA5000/7000/70000

File type   .wfm

File description   Amplitude vs. Time, includes sample rate
information

What SignalVu-PC can do
with this format

Open with settings All Settings and Measurements are
Recalled

 

Automatically Sets Span, Center
Frequency

 

Open as data only Uses settings from SignalVu-PC
when opened

✓

Notes   Prior to opening: Preset SignalVu-PC. Set
span and center frequency. After opening,
save as .tiq file. Reopen the .tiq file for further
changes to the measurement settings and
opening additional displays

Table 47: Bench Oscilloscope file formats supported by SignalVu-PC

Generated by   MSO/DPO 2000, 3000, 4000

File type   .isf

File description   Amplitude vs. Time, includes sample rate
information

Table continued…
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What SignalVu-PC can do
with this format

Open with settings All Settings and Measurements are
Recalled

 

Automatically Sets Span, Center
Frequency

 

Open as data only Uses settings from SignalVu-PC
when opened

✓

Notes   Prior to opening: Preset SignalVu-PC. Set
span and center frequency. After opening,
save as .tiq file. Reopen the .tiq file for further
changes to the measurement settings and
opening additional displays

Table 48: MDO4000B/C mixed domain oscilloscope file formats supported by SignalVu-PC

Generated by   MDO4000B/C, RF channel

File type   .tiq

File description   Contains I and Q time domain data. Opens with
spectrum analyzer and time overview.

What SignalVu-PC can do
with this format

Open with settings All Settings and Measurements
are Recalled

 

Automatically Sets Span, Center
Frequency

 

Open as data only Uses settings from SignalVu-PC
when opened

✓

Notes   Native format for SignalVu-PC. Opens with
Time Overview and Spectrum Display active

Table 49: H500 and SA2500 file formats supported by SignalVu-PC

Generated by   RF Hawk  

File type   .iqt .mat

File description   Contains I and Q time-domain
data, center frequency, sample
rate

Contains I and Q time-domain
data, center frequency, sample rate

Table continued…
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What SignalVu-PC
can do with this
format

Open with
settings

All Settings and
Measurements are
Recalled

  

Automatically Sets Span,
Center Frequency

✓ ✓

Open as data
only

Uses settings from
SignalVu-PC when
opened

✓ ✓

Notes   Recommend saving as .tiq file
after opening

Recommend saving as .tiq file after
opening

Table 50: User generated (including Agilent 89601 software) file formats supported by SignalVu-PC

Generated by   User generated (including Agilent 89601
software)

File type   .mat

File description   MATLAB level 5 and level 7.3 formats,
must contain at least InputCenter, InputZoom,
Xdelta, and Y

What SignalVu-PC can do
with this format

Open with settings All Settings and Measurements are
Recalled

 

Automatically Sets Span, Center
Frequency

✓

Open as data only Uses settings from SignalVu-PC
when opened

✓

Notes   Recommend saving as .tiq file after opening

To recall a acquisition data file, see Recalling Files on page 532 above.

Supported MAT File versions
Data recall and saving using .mat file supports two versions: MATLAB Level 5 (v6) and MATLAB v7.3.

MATLAB v7.3 uses HDF5 format to store data and does not have the limit of 2 GB per variable that Level 5 does. If you try to save more
than 2 GB in MATLAB Level 5 (v6 format), a warning shows and prompts you to select Level 7.3 format.

Opening .iqt files saved by RSA3000 and WCA300 analyzers. To open a .iqt file:
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1. Select File > Preset (Main).
2. Select File > Recall and select Acq Data with Settings (IQT) (*.iqt) in the Open dialog. Select the desired file and click OK to open

the file.
3. Save the file by selecting File > Save As and set the file type to Acq data with setup (TIQ) (*.tiq). Save the file by clicking OK.

Saving the file in .tiq format preserves all of the settings in the analyzer and associates them with the data set. After saving the file
in .tiq format, recall the saved .tiq file and add measurements and change settings.

The .iqt file format contains I and Q waveforms plus instrument amplitude/phase correction data, analysis bandwidth and center frequency.
When SignalVu-PC opens an .iqt file, the amplitude and phase corrections are applied to the IQ data to produce a corrected data set. The
span and center frequency information present in the .iqt file are used to set the SignalVu-PC span and center frequency. However, no
information about analysis length, offset or type is preserved in the .iqt file.

Opening .mat files saved by RSA5000/6000/SPECMON series and third party waveforms. To open a .mat file from these instruments:

1. Select File > Preset (Main).
2. Select File > Recall and select Acq Data with Setup (MAT) (*.mat) in the Open dialog. Select the desired file and click OK to open

the file

If you choose to save the file in .mat format, SignalVu-PC automatically adds all of the SignalVu-PC settings needed for your analysis into
the stored .mat file.

Opening files saved with oscilloscopes. Oscilloscopes acquire and store data in an amplitude vs. time format that must be converted
by SignalVu-PC into an IQ format for further processing. Sample-rate and amplitude information is available in these files, but no other
information is available to SignalVu-PC.

To open files stored in either .ISF or .WFM format saved by Tektronix oscilloscopes, use the following procedure:

1. Preset SignalVu-PC. This resets the analysis so that only the spectrum analyzer display is present, with a center frequency of 250 MHz
and a span of 200 MHz.

2. Set the Span of SignalVu-PC to 0.2 × Sample Rate of the acquisition.

How to determine the maximum available span for your .ISF or .WFM file: The maximum span is calculated to be 0.4 × Sample Rate.
For example, a waveform sampled at 1 GSample/second will have a maximum span of 0.4 × (109) = 400 MHz. This represents the
Nyquist bandwidth of the sampling system plus an allowance for filter bandwidth. Note that this span may exceed the bandwidth of the
oscilloscope used, and results at frequencies higher than the oscilloscope bandwidth will be attenuated.

When processing the waveform, SignalVu-PC automatically sets the bandwidth to twice the entered span to allow for increasing the
span in later analysis. Set the span of the spectrum analyzer to ½ the calculated maximum span. In the case of the example of above,
this is ½ × 400 MHz, or 200 MHz.

3. Set the center frequency to ½ of the span. This puts the analysis frequency within the first Nyquist zone to prevent aliasing of the
signal.

4. Open the .ISF or .WFM file with the settings above.
5. Set the span to the calculated maximum (in the example above, 0.4 × Sample Rate = 400 MHz) and reanalyze.
6. Save the results as a .TIQ file. This preserves all of the settings in the analyzer and associates them with the data set.

Setup Files
You can set up the instrument as desired and then save the settings in a setup file. This enables you to quickly setup the instrument by
recalling previously saved setups.

Exporting Results
Save for further analysis of results in other programs, such as MATLAB or Excel.

Pictures of the Selected Display
You can save pictures of the instrument display for documentation purposes. When saving pictures of the display, you can select from
three file types: BMP, JPG, or PNG.
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Measurement Settings
You can save a list of settings relevant to the selected display to a file for documentation purposes. The exported file uses tab characters to
separate values. The settings included in the file depend on the selected display. The contents of the file are the same as a Results export
except it does not include the results.

Saving Acquisition Data with Setup
Save for later analysis with the analyzer. The setup is saved as part of the acquisition data file so you can choose when recalling data
whether or not to also recall the associated acquisition and analysis parameters.

Saving Acquisition Data Export in CSV Format
Save for examining results in other programs, such as MATLAB or Excel.

Data, Settings, and Picture File Formats
You can save different types of data for later recall and analysis.

Saved File Types

File type File extension Description

Setup files .setup Setup files enable you to save instrument settings for later recall. Using these
files saves setup time and ensures consistent measurements.

Picture .png/.jpg/.bmp Screen capture of SignalVu-PC application window. They are useful for
documenting results in test reports.

Results Export .csv Results files contain the trace points and numeric values that were produced by
the selected measurement. The header of a Results file includes key acquisition
and analysis settings to aid in the interpretation of the data. The file is saved
as a plain text file, but the contents are formatted as CSV (comma-separated
values). Results files can be opened from applications such as Microsoft Excel
and MATLAB.

Measurement Settings .txt Measurement settings files contain a list of settings that describe how
the instrument is set up for the selected measurement. The list contains
measurement settings (for example, Span), trace settings (for example, whether
or not a trace is selected) and global settings (for example, Frequency and
Reference Level). The list of settings contained in the file varies depending on
which display is selected.

Selected Trace Varies with display Trace files contain the trace results data in binary format. These files are
only readable by the SignalVu-PC application. Several of the instrument's
measurements allow you to recall a Trace file for visually comparing a saved
trace to a live trace.

Table continued…
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File type File extension Description

Acquisition Data with
Setup

.tiq These files contain the acquisition data record and complete instrument setup (in
binary format). Use these files to save data for later recall and analysis. When
you save an Acquisition Data file, the current Setup is always saved with the
file. At the time of recall, you will be asked whether you want to restore only the
acquisition data or both data and setup. If the instrument is already set up for a
specific measurement, you will probably want to recall only the acquisition data.
Recalling both data and setup returns the instrument to the same state it was in
at the time you saved the file.

GNSS time locked with GPS enabled.

Acquisition Data .csv These files contain IQ sample data before it has been processed by a
measurement. The acquisition data points are saved as IQ pairs. Use this format
to import the acquisition data into Microsoft Excel for further analysis.

Acquisition Data .mat These files contain IQ sample data before it has been processed by a
measurement. The acquisition data points are saved as IQ pairs. Use this format
to import the acquisition data into MATLAB for further analysis.

These files also contain instrument setting information. You do not have to use
the settings information. To remove it, you can load all information to MATLAB,
then write out is a .mat file without the settings information. (See the Acquisition
Data Files (.mat) topic for required .mat format.)

Range file .csv These files contain a list of settings that describe how the instrument is set up for
the Spurious measurement. The file contains the number of ranges enabled, the
start and stop frequencies for each enabled range, the limits for each enabled
range, the mask type and more.

Recorded file

(RSA500A series,
RSA600A series, and
RSA306B only)

.r3f These files contain acquisition data that was recorded directly to a file from an
RSA306B, RSA500A series, RSA600A series spectrum analyzer.

These files can be played back using the Playback feature located in the
Acquisition control panel (with Option SV56-SVPC).

Recorded file

(When connected to an
RSA)

.cdif This combined file contains header and IF samples (IQ samples for the
RSA7100) in Midas 2.0 (Platinum BLUE) format. These files contain acquisition
data that was recorded directly to a file from an RSA306B, RSA500A series,
RSA600A series, or RSA7100 spectrum analyzer.

Recorded file

(When connected to an
RSA)

.cdif + .det (or .det12) This is a separate header (.cdif) file and an IF sample (IQ sample for RSA7100)
data (.det or .det12) file in Midas 2.0 (Platinum BLUE) format.

When using the RSA7100, recordings at 800 MHz bandwidth with the packed
data setting on will generate a .cdif and a .det12 file. (See the Midas recording
choices table for more information about the .det12 file type.)

Table continued…
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File type File extension Description

Recorded file

(RSA7100 only)

xdat, .xhdr, .xmrk These 3 files (all with the same file name) are generated when XDAT is the
selected format for recording. They can be played back using an external
application. GNSS time locked with GPS enabled.

.xdat: sample data file containing binary IQ samples in normal (16 bit integer) or
packed (12-bit integer) data type.

.xhdr: header file containing instrument setup information in XML format.

.xmrk: marker file in XML format containing time, location (GPS only), and
the time stamp of the GPS, PPS, or IRIGUID-A88BD14F-0A29-4276-A887-
CB84AB2B2A94B event during recording. Includes time qualified triggers.

See the Record Setup topic for more information.

Results Export File Format
The Results Export format contains trace points and/or scalar results produced by the measurement. The file contains general information
about the measurement settings at the top of the file and the results data in the second part of the file. Groups of settings or results are
headed with [text], as described below.

At the top of the file is the measurement name and the date and time data was acquired.

The first group of settings is [Global Parameters]. These settings include the Measurement Frequency, Acquisition Data, Reference Level
and others.

The second group of settings is [Parameters]. These settings are specific parameters which vary depending on the measurement.

The next group is [Trace Parameters], which may not be present, depending on the measurement. Within this group, there are parameters
specific to a trace. There will be a Trace Parameters group for each trace shown on the display.

The next group is [Results]. These are scalar results for the measurement.

Next is [Traces]. The Traces group consists of one or more [Trace] groups. There is one Trace group for each trace. Each [Trace] group
contains background information about the trace (units, number of points, x scaling, and others depending on the measurement) at the top
of the group, followed by the trace points.

Acquisition Data with Setup File (.tiq) Format
The file consists of two parts: the header that is in XML and the data that is in binary format.

Header. The header consists entirely of the DataFile element. This element is broken down into sub-elements.

1. DataSetsCollection
2. Setup
3. GNSS data

The GnssData group starts at byte location 612,312. GNSS data is bracketed as <GnssData></GnssData>. Each GNSS parameter is
bracketed by its name. For example, <PositionX>76.854334</PositionX>.

In order of occurrence:

• Status
• Position X
• Position Y
• Altitude
• Timestamp
• Speed
• Course

Managing Data, Settings, and Pictures

SignalVu™ Vector Signal Analysis Software Printable Help 540



• Satellites Locked

DataSetsCollection. The DataSetsCollection contains a DataDescription element, a DataSet element, and a ProductSpecific element.

Binary data. Binary data is a sequence of Int32 values, which are IQ pairs (I,Q,I,Q, ...) in binary Little Endian format.

To convert these values to volts, multiply the individual values by the Scaling value in the DataDescription.

The binary data starts at an offset into the file == the "offset" attribute in the DataFile element. This offset number will always start at the
19th character into the file (starting with 1), and will always be 9 characters long.

Note: Modifying the XML header will change the offset to the start of the binary data.

Acquisition Data Files (.csv)
The acquisition data files have two sections. At the top of the file is the following information:

• SamplingFrequency - The sampling frequency in Hertz.
• NumberSamples - The number of IQ samples in the file.
• DateTime - When the data was acquired.
• Frequency - The center frequency in Hertz.
• AcquisitionBandwidth - The acquisition bandwidth Hz.

Following the AcquisitionBandwidth are the data. The data are IQ pairs, in volts.

Groups of settings or results are headed with [some text].

The first thing in the file is the measurement name and the date/time when the acquisition was taken.

The first group [Parameters] are global parameters. Measurement Bandwidth in this group is the measurement bandwidth used by the
General Signal Viewing measurements (Spectrum, Amplitude vs. Time, etc). It also includes some source settings, like Acq BW, Dither,
Preamp, and RF Attenuation.

The second group [Parameters] are measurement-specific parameters.

Another group which can occur is [Trace Parameters]. Within this group, there will be a set of parameters, one for each trace that is
currently shown.

Another group is [Results]. These are scalar results for the measurement.

Another group is [Traces]. It has [Trace] groups under it, one for each trace. Each [Trace] group has some background information about
the trace (units, number of points, x scaling, etc), and the trace points themselves.

Acquisition Data Files (.mat)
The acquisition data files saved in MATLAB format contain the following MATLAB variables:

• InputCenter - The center frequency in Hertz.
• XDelta - The sample period in seconds.
• Y - A complex array containing IQ pairs.
• InputZoom - The acquisition bandwidth in Hertz.

The MATLAB format used to save acquisition data has the following properties and limitations:

• Files are stored in MATLAB Level 5 (when v6 is selected) or Level 7.3 (when v7.3 is selected) format.
• MATLAB Level 5 file size is limited to 2 GB. If you try to save more than 2 GB in MATLAB Level 5 (v6 format), the following warning

shows and prompts you to select Level 7.3 format.
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Printing Screen Shots
You can print screen shots (screen captures) two ways: use File >Print or save a picture file and print the file using a separate graphics
program. Printing a screen capture is the same as printing with any windows program. For details on the available file formats for saving a
screen capture, refer to Data, Settings, and Picture File Formats. For details on saving a picture to a file, see Saving and Recalling Data,
Settings, and Pictures.

To print a screen shot:

1. Select File >Print.
2. Select File >Print Preview if you wish to review the screen shot before sending it to the printer.
3. Select File >Print to print the file to a printer.
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Reference
Application Help
Menu Bar: Help > User Manual 

This menu item displays this Help. It is a standard Windows help system. The Help menu item is the only method available to display the
help; there are no other links to the help within the software.

How to install product software
Available software upgrades can be downloaded from the Tektronix Web site. To see if a software upgrade is available for your product,
use your browser to go to www.tek.com/software. Search by the product model number.

About the Vector Signal Analysis software
To add additional software options or features, you will need an option key from Tektronix. In some instances, you may need to upgrade
the product software before adding the new option key. Follow the installation instructions provided with your software option.

To determine the currently installed software, options licenses, and hardware, select the About menu. This window displays information
about the SignalVu software.
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Version
At the top of the window is a line that displays the version of the SignalVu-PC software.

Installed Options
This text box lists the software options installed.

Hardware Information
This text box lists the serial number of the software and information about connected instruments.

Copy Info
The Copy Info button copies the information to the Windows clipboard, which you can then paste into a document. This information may be
useful if you need to contact Tektronix about the software.

Main menu overview
The main menus are:

Menu Description

Favorites bar toggle This icon allows you to toggle to hide or show the Favorites bar. The Favorites bar is located just
below the Main Menu bar, is editable, and provides icons for quick and easy access to functions and
menus.

File Select measurements, open and save files, print documents, and preset.

View Change display size, display the Marker toolbar and Status bar.

Replay Replay measurements; select which record(s) to play, Replay/Stop/Pause, or enable continuous loop.

Markers Search for signal peaks, center the display to a marker, and access the Define Marker panel.

Setup Change settings for acquisition, analysis, and measurements.

Presets Load and configure presets.

Window Controls the size and layout of displays within the SignalVu-PC application.

Help Menu on page 553 Access the help and display information about the application software.

File Menu
Command Description

Recall The Recall dialog enables you to recall saved data, setups and traces.

Save Saves a file without asking for a file parameters (based on most recent settings).

Save As Displays the Save dialog enabling you to specify the parameters of the save operation.

Table continued…
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Command Description

Save on trigger Displays the Actions tab of the Trigger control panel which allows you to configure the Save on
Trigger function. This is only available when connected to an RSA306, RSA306B, RSA500A series,
and RSA600A series or MDO4000B/C.

Acquisition save options Displays the Save and Export tab of the Options control panel which allows you to specify how much
data is saved in acquisition files.

Acquisition data info Displays the Acquisition Info tab of the Replay control panel. The info on this tab describes such
acquisition parameters as acquisition bandwidth, sampling rate, RF attenuation, and acquisition
length.

Measurement Data Info Displays the characteristics of the most recently analyzed record in the display.

Print Prints the selected display.

Print Preview Displays a preview of the print output.

Exit Closes the SignalVu-PC application.

Recall
Main menu bar: File > Recall

Use the Recall command to load previously saved acquisition data, setups or trace data.

To Recall Data or Setups
1. Select File > Recall. This displays the Open dialog box.

2. Select the file type to be recalled and click Open.
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Save / Save As
Menu Bar: File > Save / Save As

Use Save / Save As to store acquisition data, setups, and traces. Save is also used to export traces, results and pictures of the display for
use in other programs.

Difference Between Save and Save As
Use Save As to specify what kind of data you want to save and where the data should be saved. Use Save to quickly save the same data
as you saved the last time you executed a Save, without having to specify the data type and location.

For example, suppose you want to save a picture of a spectrum trace each time you adjust a circuit to document how the adjustments
affect the output of the circuit. The first time you want to save a picture of the display, you will need to select Save As. From the Save As
dialog box, you specify the type of data you want to save (Picture of Selected Display) and specify the location of the saved file. As long as
the Save and Export option is set to automatically name saved files, the next time you want to save a picture of the display, you can just
press Save on the front panel and a picture of the selected display will be saved without requiring you to type a file name or the location of
the file to be saved.

What Data Types Can Be Saved

Data type Description

Acquisition Data Data collected during acquisition that can be recalled for later analysis. Data is saved in a
format readable only by RSA6100/RSA5100/SPECMON Series instruments or oscilloscopes running
SignalVu software.

Setup Configuration information detailing instrument settings. Data can be saved in a format readable only
by SignalVu-PC, oscilloscopes running SignalVu software, or RSA6100/RSA5100/SPECMON Series
instruments.

Selected Trace Saves the selected trace for later analysis by the analyzer. Data is saved in a format readable only
by SignalVu-PC, oscilloscopes running SignalVu software, or RSA6100/RSA5100/SPECMON Series
instruments.

Exported Traces and Numeric
Results

Save traces and results in a file format that can be used by other programs.

Pictures of the Display Save screen images in graphic image file formats that can be used in other programs.

Exported Acquisition Data Save acquisition data records in a file format that can be used by other programs. Acquisition data
can be saved in either comma-separated-variable format or MATLAB format.

Data, Settings, and Picture File Formats.

Options for Saving Pictures of the Display

Option Setting Description

Image Format PNG Saves exported screen captures in Portable Network Graphics format.

JPG Saves exported screen captures in Joint Photographic Experts Group (JPEG) format.

BMP Saves exported screen captures in Windows bitmap format.
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Measurement Data Info
The Measurement Data Info command in the File menu displays a listing of acquisition-related information about the last data analyzed by
the selected measurement. The last data can be from the current acquisition or it could be from a recalled data file. 

Scope Data
The Scope Data tab displays the sample rate and record length of the data received from the oscilloscope or from a recalled oscilloscope
waveform file.

Print
Menu Bar: File > Print 

Print displays the Windows Print dialog box for printing a screen capture of the display. To save ink when printing, use the Colors tab to set
the color scheme. See Options Settings.

Print Preview
Menu Bar: File > Print Preview 

Print Preview shows how a print out will appear when it is printed.
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View Menu
The View menu enables you to control the display of views and toolbars in the application window.

Command Description

Full Screen Toggles all views between full-screen size and user-selected size.

Navigator View Selecting Navigator View adds the Time Overview display to the existing measurement displays to
provide a better perspective of the signal.

When the Navigator View is enabled, the Time Overview display is always located above any other
measurement displays and uses the maximum horizontal resolution of the display area, regardless of
the Window Tile setting.

Numeric Keypad When selected, any time you place the cursor within a control or setting that takes a numeric value,
you are presented with a dialog box to easily enter a value.

For instance, placing the cursor in the Frequency setting, displays the following dialog screen.

Use the arrow buttons to change the value.

Press the calculator icon to display a keypad that allows you to enter values and suffixes.

Chan Nav Toolbar Check to view the Channel Navigation toolbar. Uncheck to hide it. Detailed information about this
toolbar is available in the Channel Navigation toolbar topic.

Signal Survey Toolbar Check to view the Signal Survey toolbar. Uncheck to hide it. Detailed information about this toolbar is
available in the Signal Survey toolbar topic.

Map It Toolbar

(Only available with optional MAP
application license.)

Check to view the Signal Survey toolbar. Uncheck to hide it. Detailed information about this toolbar is
available in the How to use Map It topic.

Replay Toolbar Check to view the Replay toolbar. Uncheck to hide it.

Traces Toolbar Check to view the Traces toolbar. Uncheck to hide it. This toolbar can also be accessed from the
Basic Controls Toolbar. It allows quick access to the trace controls of the selected measurement
display. This example is the Spectrum trace toolbar.

Table continued…
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Command Description

Markers Toolbar Check to view the Markers toolbar. Uncheck to hide it. This toolbar can also be accessed from the
Basic Controls Toolbar. It enables you to define Markers and perform Peak searches. Click the Define
button on the toolbar to define markers. See the Define Markers menu topic for detailed information.

Basic Controls Toobar The Basic Controls toolbar is defaulted to on and is located just above the Status Bar. It allows quick
access to controls and settings of the selected measurement display. This example is the Spectrum
Basic Controls toolbar.

It contains the following:

• Name of selected measurement window

• Frequency: The center frequency in the active display. To change the value, click the text and
enter a value with a keyboard or the numeric keypad. For fine adjustments, you can use the
mouse wheel.

• Reference: Reference level in the active display. To change the value, click the text and enter a
value with a keyboard or the numeric keypad.

• Span: The span in the active display. To change the value, click the text and enter a value with a
keyboard or the numeric keypad. For fine adjustments, you can use the mouse wheel.

• Res BW: The resolution bandwidth (RBW) in the active display. To change the value, click the text
and enter a value with a keyboard or the numeric keypad. For fine adjustments, you can use the
mouse wheel.

• Show or hide the Markers toolbar

• Show or hide the Traces toolbar

• Show or hide the Settings Control Panel

Status Bar The Status bar is defaulted to on and is located at the bottom of the application window.

Full Screen
Menu Bar: View > Full Screen 

When unchecked, clicking Full Screen resizes the application window to fill the screen. Full Screen mode maximizes the application
window, and turns off the application title bar.

When checked, clicking Full Screen restores the application window to its previous size. The application title bar is restored.

Status Bar
The Status Bar displays information on specific instrument settings. It contains only status information; it does not display any error
information. The Status bar has no controls. It cannot be hidden.
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Elements of the Status Bar

Area within Bar Description

Run status Displays the running state. For example, some run states are
Acquiring, Analyzing, Ready, or Stopped.

Status message area Displays status messages (for example, ADC Overrange). When
there no status messages to report, displays current acquisition
parameters (for example, Acq Length: 22.320 μs).

Acquisition parameters Displays parameters of the acquisition, such as acquisition
bandwidth and acquisition length.

Scope Sample Rate Displays the oscilloscope sample rate, for example, 25.00 GS/s.

Run Status Indicators

Indicator Description

Acquiring The analyzer is capturing the signal.
Analyzing The analyzer has captured the signal and is processing the signal

record.
Replaying The analyzer is analyzing recalled waveform or acquisition records.
Stopped If Stopped is displayed, Signal acquisition has been halted. This

can occur because the Run button has been pressed or because a
trigger event has occurred, signal acquisition has occurred and Run
mode was set to Single.

Run Menu
The Run menu provides access to commands that control the signal acquisition.

Command Description

Run If acquisition mode is Stopped, selecting Run begins a new measurement/acquisition cycle. If
acquisition mode is Run, pressing Run halts the current measurement/acquisition cycle after it
completes.

Resume Restarts data acquisition, but does not reset accumulated results, such as Average or MaxHold. This
allows you to stop acquisitions temporarily, then continue. If the accumulation is already complete, for
example, 10 acquisitions or 10 averages have already been completed, each subsequent Resume
command will cause one more acquisition to be taken, and its results added to the accumulation.
Resume is not available if instrument settings have been changed.

Abort Immediately halts the current measurement/acquisition cycle.

Single Sequence Selects the single-sequence acquisition mode. This is only a mode selector; it does not initiate an
acquisition.

Continuous Selects the continuous acquisition mode. Selecting Continuous does initiate acquisitions.

Single Sequence Acquisition Mode
Selecting Single sets the Run mode to Single. In Single mode, as soon as one acquisition sequence completes, acquisition stops.
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Note that a single acquisition sequence can require more than one acquisition. For example, in a spectrum view, the trace function might
be set to Average 100 acquisitions. Thus, a complete acquisition sequence would consist of 100 acquisitions to produce 100 intermediate
traces that are averaged together to create the final trace that is displayed. Once the 100 acquisitions have been completed, acquisition
stops.

Continuous Acquisition Mode
Selecting Continuous places the analyzer in the Continuous acquisition mode. In Continuous mode, the analyzer acquires and displays
acquisitions repeatedly. The Continuous and Single Sequence acquisition modes are mutually exclusive.

Selecting Continuous restarts acquisitions.

Replay Menu
Reruns measurements using the current acquisition data or a saved file. Use this to compute new results for old data after you change
settings. If you are working with a recalled oscilloscope waveform file, you should recall the file again rather than using Replay.

Markers Menu
The Markers menu provides to settings that define and control the location of markers.

Setting Description

Peak Moves the selected marker to the highest peak on the trace.

Next Peak > Moves the selected marker to next peak depending on the setting chosen.

Marker to Center Frequency Sets center frequency to the frequency of the selected marker.

Define Markers Displays the Define Marker control panel.

Sync Scope C1 to Active Marker Moves oscilloscope Cursor 1 to the location on the oscilloscope waveform that matches the location
of the active maker on the SignalVu active marker. If the oscilloscope cursors are off, this command
turns them on.

Sync Scope C2 to Active Marker Moves oscilloscope Cursor 2 to the location on the oscilloscope waveform that matches the location
of the active maker on the SignalVu active marker. If the oscilloscope cursors are off, this command
turns them on.

Setup Menu
The Setup menu provides access to control panels that specify parameters for numerous signal analyzer functions.

Command Description

Displays Displays the Select Displays window.

Settings Displays the Settings control panel for the selected display.

Acquire Displays the Acquire control panel.

Analysis Displays the Analysis control panel.

Amplitude Displays the Amplitude control panel.

Table continued…
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Command Description

GNSS/Antenna Displays the GNSS/Antenna control panel.

Presets Menu
The Presets menu provides you access to instrument presets and preset options.

Command Description

Main Resets the instrument to factory defaults. Acquisition data and settings that have not been saved will
be lost.

DPX Recalls the DPX presets.

Standard Presets Recalls the Standards presets.

Application Recalls the Application presets.

User (Favorites) Recalls the User (Favorites) presets.

Preset Options Displays a control panel where you can configure options for Presets.

Tools Menu
Provides access to several utilities for controlling instrument functions.

Command Description

Mask Test Enables you to locate and highlight specified signal levels in specified displays.

Options Displays the Options control panel.

Signal Database Allows you to select which signal standards and types are listed (and selectable) in the Channel
Navigation toolbar and/or the Define Survey control panel.

RSAMap Launches the optional MAP application.

Restore Scope Moves the SignalVu application to the background and displays the TekScope application in the
foreground.

Window menu
Use the Window menu to arrange how windows are displayed. Displays can be set to appear full screen (one display at a time) or with
all (selected) displays visible at once. When all displays are visible at once, you can rearrange the displays by dragging the title bar of a
window (deselect Window > Lock Windows to move displays around).

Command Description

Close View Closes the selected view.

Table continued…
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Command Description

Cascade Positions windows in a cascade view (not available when Lock Windows is selected).

Tile Horizontally Positions widows in a horizontal orientation (top to bottom).

Tile Vertically Positions widows in a vertical orientation (side by side).

Lock Windows Locks the windows into their current position, preventing them from being moved. If the windows are
locked, the Cascade arrangement is not selectable.

(List of windows) A numbered list of open windows.

Help Menu
The Help menu provides access to the Help and version information about the vector signal analysis software 

Command Description

User Manual Displays a navigable, searchable Help tool.

User Manual (PDF) Displays a PDF version of the Help.

Application Reference (PDF) Displays a PDF version of the vector analysis software application Reference Manual.

Quick Start Manual (PDF) Displays a PDF version of the vector analysis software application Quick Start User Manual.

PI Command Search Displays a navigable, searchable PI command search tool.

About Tektronix Real Time Signal
Analyzer Software

Displays information about the vector analysis software application and installed options.

PI Command Search tool
The PI Command search tool allows you to search for programming commands by typing the syntax or key words into the search text box.

For a quick search, do the following:

1. Select the Search tab from the dialog box.
2. Type in the syntax or key word you are looking for in the text box.
3. Click on List Topics.

TO obtain an updated version of the PI commands manual, do the following:

1. Download the latest PI manual .CHM file from www.Tek.com/downloads.
2. Copy the downloaded PICommandSearch.chm file into the installer path C:\Program Files\Tektronix\SignalVu\RSA.

CAUTION: Do not change the file name PICommandSearch.chm or the file will not be found by the application.

Favorites bar menus
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Menu Description

Icons The icons on the Favorites bar are detailed in the Elements of the
Display on page 26 topic.

Preset Recalls the Main preset.

Replay Replay measurements; select which record(s) to play, Replay/Stop/
Pause, or enable continuous loop.

Run Start, stop and abort acquisitions, select single or continuous
acquisition mode.

Click this icon to view the Edit Favorites menu:

Error and Information Messages
The following list describes some of the common error and information messages that might appear during instrument operation.
Messages that apply specifically to one or more measurements appear in the displays. Messages that pertain globally, such as those
about hardware status, are shown in the Status Bar at the bottom of the analyzer application window.

Acq BW too small for current setup

The display needs a wider acquisition bandwidth than what the current data record contains. This can be due to any of the following
reasons:

• The sampling parameters are being manually controlled.

In the Acquire control panel > Sampling Parameters tab, set the Adjust control to All Auto to allow the software to pick the sample rate
and record length that it needs.

• A display other than the one you intended has been selected. The selected display has requested a smaller acquisition bandwidth to
achieve a better accuracy or dynamic range for its particular measurement.
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Select the display that contains the message. Click Run if the instrument is not already acquiring data.

• Acquisitions are not running and the measurement now requests a wider bandwidth than the last acquisition.

Click Run to perform a new acquisition with a wider bandwidth.

• The data is from a recalled TIQ file.

There is no way to increase the acquisition bandwidth for saved IQ data. You must adjust the measurement settings so that less
bandwidth is required.

• The data is from a recalled oscilloscope waveform file.

In the Acquire control panel, compare the Samples/s readout on the IQ Sampling Parameters tab to the Sample Rate readout on the
Scope Data tab. If the sample rate for the oscilloscope data is more than twice the value of the IQ sample rate, it means that the
recalled waveform data was decimated for a previous analysis that didn't need the full bandwidth of the oscilloscope waveform. Recall
the oscilloscope waveform file again to force the software to perform a new conversion based on your new measurement settings.
Each time you change measurement settings in a way that increases the required acquisition bandwidth, you will need to recall the
oscilloscope waveform file.

• The current Frequency setting is different than that of the data record, causing the measurement bandwidth to fall at least partly
outside the bandwidth of the data.

If you are using a recalled oscilloscope waveform file, try recalling it again with the new Frequency setting. This will force a new
conversion from oscilloscope samples to IQ samples.

Analysis failure: <description of error>

The instrument is unable to complete a measurement due to difficulty in characterizing the signal. For example, due to either the signal or
settings, the instrument may not be able to recognize a pulse so it can compute the pulse measurements.

• Try changing settings to improve analysis. For example, when Pulse Trace is displayed, try changing the settings on the Settings >
Params.

Analysis failure: Carrier detection failed

The instrument was unable to locate a carrier signal. Try adjusting the Carrier Threshold or Integration BW values, if the measurement has
these controls.

Analysis Length was limited

This message appears if the "Results Length", the time over which the measurement computed its results, is less than the Actual Analysis
Length reported in the Analysis Time control panel tab and the Time Overview display. The Results Length is indicated by the magenta line
below the Time Overview graph. This can occur because the acquisition contained more data samples than a measurement can process
(for example, digital demodulation is limited to 80,000 samples) or the measurement had to use some of the first and last samples for
pre-measurement processes.

Analysis length too small for current setup

Increase the Analysis Length or decrease the RBW (Spectrum, ACPR, MCPR).

Avg Tx not available in Volts units

The Average Transmitted Power measurement is not defined for Volts.

Can't get acquisition data record

No acquisition record currently exists in memory (run an acquisition or recall a file), or an error has occurred. Repeat the acquisition.

Can't replay data from swept acq

The measurement could not produce results because it is a real-time only measurement but was asked to reanalyze (Replay) an
acquisition taken in swept mode.

Can't replay. Live data needed for swept settings
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The measurement could not produce results because it was asked to reanalyze (Replay) the acquisition but it is in Swept acquisition
mode. Swept-mode measurements cannot analyze recalled data.

CISPR accuracy limited by acq memory. Adjust RBW or freq range

The CISPR function was applied, but the available data did not represent a long enough time to satisfy CISPR requirements. Increasing
RBW reduces the amount of time needed for analysis. Reducing frequency range (for example, by reducing Span), decreases sample rate,
allowing the available memory to cover a longer time period.

If this data is from a saved file, this error cannot be cleared.

This data was acquired when the input signal contained peaks greater than 6 dB above the Reference Level setting.

If the data is from a file, this error cannot be cleared.

Data acquired during hardware failure

An acquisition was completed even though a hardware failure was detected. This message refers to the acquisition data currently being
analyzed, but not necessarily to the current status of the instrument.

If this data is from a saved file, the error cannot be cleared.

Data acquired during RF ADC overrange

An acquisition was completed but the signal was outside the range of the analog-to-digital converter at the time this data was acquired.
This message refers to the acquisition data currently being analyzed, but not necessarily to the current status of the instrument.

If this data is from a saved file, the error cannot be cleared.

Data acquired during RF digital gain overflow

This data was acquired when the input signal contained peaks greater than 6&#xa0;dB above the Reference Level setting.

If this data is from a file, the error cannot be cleared.

Data from unaligned instrument

The acquisition data was captured when the instrument was not aligned. This message refers to the acquisition data currently being
analyzed, but not necessarily to the current status of the instrument. Measurements made on this data might not be accurate.

Data from warm-up period

This data was acquired while the analyzer was warming up. The warm-up period is 30 minutes. Until this warm-up period is completed, the
analyzer is considered uncalibrated.

Disabled: data is from swept acquisition

The display needs to run in real-time mode. The display associated with this message cannot run now because it is not the selected
display, and the selected display is performing multiple acquisitions (it is in swept mode).

• Change the settings of the selected display so it is performing real-time acquisitions.
• Select the associated display to make it the selected display. When it is selected, it will force the acquisition parameters to change to

meet its own needs.

Frequency exceeds preamp range

This is a warning that signals below the minimum preamp operating frequency are likely to be severely attenuated (this is 100 kHz for
option 51, 1 MHz for option 50).

Needs swept acq or larger AcqBW - Acquire data while display is selected

The display is not running because it needs to perform multiple acquisitions (it must be in swept mode) but it is not the selected display.
Only the selected display can perform multiple acquisitions.

• Select the display showing this message to give it control of acquisitions parameters.
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Sometimes, only one display can work and the others will be blank and show errors. This happens when different displays have conflicting
demands on the acquisition data record.

Export failure: file not saved

An error occurred while exporting Results. The file was not created.

• Export the results again.

Export failure: unable to open results file for export. File not saved.

The Export Results file could not be opened for writing, so the export of results was not completed.

• Verify that there is sufficient free space on hard disk.

Insufficient data for CISPR. Acquire while display is selected

This message appears when a measurement is not the selected measurement and CISPR filters are selected. Set the measurement to be
the selected measurement and reacquire the signal.

IQ Processing Error: 8012

This message occurs in GP Digital Modulation displays. The most likely cause for this message is that there are not enough symbols to
analyze. This can happen if:

• The Analysis Length is set too short. Increase the Analysis Length on the Analysis Time tab.
• The Analysis Offset has pushed the Analysis Time so far out that the actual Analysis Length is too short, even though the

user-requested Analysis Length would have been long enough without the excessive offset. Decrease the Analysis Offset on the
Analysis Time tab.

• The input signal is bursted, and the burst does not contain enough symbols.

Needs swept acq or larger Acq BW - Acquire data while display is selected

The display has one of two problems: It is not the selected display, which prevents it from controlling the hardware acquisition parameters,
and setting the acquisition mode to Swept; or its settings require a wider data bandwidth.

• Select the display that you are interested in and it will change the acquisition to meet its own needs.
• Increase the acquisition bandwidth manually or by changing the selected display's settings to cause the wider bandwidth.

No Math trace: unmatched trace lengths

A math trace could not produced because the traces selected to generate the math trace do not have the same number of points. This can
easily happen if both traces are recalled, but were saved under different “Points” settings. This can also occur if one of the selected traces
is a live trace and the other trace is a recalled trace.

• In a Spectrum display, as long as one trace is live, you can change the “Points” setting (Setup > Settings > Freq &amp; Span tab) to
match the recalled trace.

• If you are using two recalled traces to generate the Math trace. You must recreate at least one of the traces.

No burst detected

The Burst Detection Mode is On, but no burst was detected in the signal.

• Check that the Threshold setting is properly set.

Not enough samples for current setup

The measurement was not able to run because the combination of analysis length, offset, and measurement bandwidth relative to
acquisition bandwidth, were such that not enough samples were available for the measurement to analyze. This can occur when two or
more displays are shown and one display requires a wide acquisition bandwidth and another display requires a much narrower bandwidth.
The display requiring the much narrower bandwidth must decimate and filter the acquisition record which can result in too few samples left
for the measurement.

• Increase the Analysis Length to provide more samples.
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• Close any displays you don't currently need.

Not enough samples – try increasing MeasBW

The measurement was not able to run because there are not enough samples available for the measurement to analyze. The Settling
Time measurement requires at least 256 samples. This can occur when two or more displays are shown and one display requires a wide
acquisition bandwidth and another display requires a much narrower bandwidth. The display requiring the much narrower bandwidth must
decimate and filter the acquisition record which can result in too few samples left for the measurement.

• Increase the Analysis Length to provide more samples.
• Close any displays you don't currently need.

No FFT (not all pulses have results)

If a pulse cannot be measured (because its shape is too indistinct or it does not meet the parameters that define a pulse), its results will be
“- -" for every measurement on that pulse. The instrument cannot compute an FFT.

No pulses found

The instrument was unable to find any complete pulses in the signal.

• Make sure the analysis length includes at least one complete pulse cycle, from before one rising edge until after the next rising edge.

Pulse Detection Error

The instrument was unable to detect a pulse.

• The pulse Measurement Filter needs to be smaller. Try reducing the bandwidth and/or selecting the Gaussian filter.
• Detection threshold is not set to the proper level for the signal. Adjust the Power threshold to detect pulses.
• The pulse interval is too long for the current settings. Try decreasing the filter bandwidth, as this may reduce the number of data points

to a manageable quantity.

RBW conflict. Increase Span or Analysis Length

The measurement is not running because the actual RBW used by the measurement is too large for the current acquisition span. Typically,
the analysis length is too short as well.

• Either increase the span or increase the Analysis Length.

RBW decreased

The current span or acquisition bandwidth is too small to allow a wider RBW filter.

• Increase the span or acquisition bandwidth if the decreased RBW is not acceptable.

RBW increased

The current Spectrum Length (or Analysis Length if Spectrum Length is not Independent) is too small to allow the requested RBW.

• Increase the Spectrum Length (or Analysis Length) if the increased RBW is not acceptable.

RBW limited by AcqBW to: XX Hz

The requested RBW is too close to the acquisition BW. Increase the frequency range of the measurement (for example, Span).

RBW too small/large for current Acq BW

If the RBW is set manually, it is possible for the acquisition bandwidth to be incompatible with the RBW setting.

• Change the RBW setting.
• Adjust the Acq BW setting, either directly (Setup > Acquire > Sampling Params: select on of the manual modes) or by adjusting the

measurement bandwidth of the selected display (Setup > Acquire > Sampling Params: All Auto).

Recall error: Setup not completely restored

An error occurred while recalling a Setup file. Thus, the current setup may be a combination of settings from the Setup file and the previous
Setup.
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• Recall the setup again.

Recall failure: problem with file or file contents

An error occurred while recalling a Setup, Trace or Data file. This can occur because of a problem opening the file (operating system error)
or because of a problem with the contents of the file.

• Recall the file again.

Restoring acquisition data

This is a status message displayed while data is being restored from a file.

Save failure: file not saved

An error occurred while saving a Setup or Data file.

• Save the file again.

Saving acquisition data

This is a status message displayed while data is being saved to a file.

Selected VBW does not use full Spectrum Length

This message can occur when the Spectrum Length is greater than required for the VBW filter. If you look at the Time Overview display,
the Magenta line for Results Length indicates the part of the Spectrum Length that was actually used. The measurement results are
correct, but don't include some of the data in the selected Spectrum Length. To clear this message, you can set the Spectrum Length to
Auto.

Setup error: <description of error>

When this message appears, it includes text that explains the problem. For example, the ACPR display might show: “Setup error: channels
can’t overlap”. Setup errors are the result of conflicts in instrument settings. These types of errors occur when a user makes manual
changes to settings. In the example above, the channel settings in the Channel Power and ACPR display have been set so that the
channels overlap in frequency.

• Adjust the instrument settings, or change a setting back to Auto, to eliminate the error.

Setup error: Integration BW exceeds Measurement BW

When this message appears, it includes text that explains the problem. Setup errors are the result of conflicts in instrument settings. These
types of errors occur when a user makes manual changes to settings.

• Adjust the instrument settings, or change a setting back to Auto, to eliminate the error.

Setup error: Measurement time for Freq & Phase results

The Measurement time for Freq & Phase results specifies how far across the pulse top the instrument should wait before measuring
the Phase Difference and Frequency Difference for each pulse. If this value is set too large for any of the pulses in the signal, the
measurement point ends up on the falling edge or during the pulse off time.

• Decrease the Measurement time for Freq & Phase results setting (Settings > Define tab).

Unexpected software error. Please cycle power and try again. If the problem persists, contact your Tektronix Service Center.

An unrecoverable error has occurred, and the instrument application software will shut down.

• Switch the instrument off and restart it or relaunch the TekScope and SignalVu applications.

VBW not applied - Acq BW too small

Increase VBW or measurement bandwidth. Make sure Sampling Parameters are set to Auto.

VBW not applied - Spectrum Length too short

This message occurs when the requested VBW can't be produced because the Spectrum Length is too short.
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To clear this problem, set the Spectrum Length to Auto or manually increase the Spectrum Length (see Setup > Analysis > Spectrum
Time tab). If Spectrum Length is coupled to Analysis Length, set Analysis Length to Auto or manually increase it (see Setup > Analysis >
Analysis Time tab).

Dealing with Sluggish Instrument Operation
You might notice that acquisitions seem to be occurring sluggishly over time. This can occur if the disk is too full or if someone has
accidently deleted the instrument cache file. While the instrument automatically recreates a missing 4 GB cache file, if the disk is too full
when the replacement cache file is created, the cache file can be fragmented and result in sluggish performance.

If your instrument appears to be performing acquisitions slowly, do the following:

• Delete unnecessary files to create free space. After deleting unnecessary files, run a commercial disk defragmentation program.
• If removing unnecessary files and defragging the hard drive does not improve instrument performance, reinstall the operating system

and application software. To do this, back up all your data and files, and then reinstall the instrument operating system. After
reinstalling the operating system, reinstall the application software.

Displaying the Windows Event Viewer
When the analyzer generates an error message, information about the error is logged to the Windows Event Viewer.

To display the Windows Event Viewer:

1. Select Start > Control Panel.
2. Select Administrative Tools. (If your instrument displays control panels in Category View, select System and Security, and then select

Administrative Tools.)
3. Double-click Event Viewer.
4. From the Event Viewer window, select Windows Logs, then select Application. This displays a list of all errors that have been

reported to the operating system from applications.

Errors reported to the Event Viewer from the analyzer application appear under Source as TekRSA.
5. Double-click the last error reported for TekRSA to see details on the most recently reported error. Please note that many items reported

as “errors” are simply informational and do not mean that your instrument is impaired. Contact the Tektronix Customer Support Center
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or Service Center if you are concerned about an error shown in the Event Viewer. Do not send an instrument out for repair based solely
on these event reports.

How to Find Out if Software Upgrades are Available
Software upgrades might be available can be downloaded from the Tektronix Web site. To see if a software upgrade is available for your
product, use your browser to go to www.tektronix.com/software. Search by the product model number.

To add additional software options or features, you will need an option key from Tektronix. In some instances, you may need to upgrade
the product software before adding the new option key. Follow the installation instructions provided with your software option.

Settings

Main menu bar: Setup > Settings 

The Settings menu item enables access to control panels that allow you to change settings for the selected display. The control panel that
appears when you select Settings depends on the selected display. The Settings control panel for the Spectrum display is shown in the
following figure.

The control panel for the CCDF display is shown in the following figure.

Settings Control Panels
AM Settings on page 86

FM Settings on page 92

PM Settings on page 97

Channel Power and ACPR Settings on page 104

Signal Strength Settings on page 108

MCPR Settings on page 115

Occupied BW & x dB BW Settings on page 122

Spurious display settings on page 127

CCDF Settings on page 134

Settling Time Settings on page 146

Common Controls Settling Time Displays Shared Measurement Settings on page 147

Spectrum Emission Mask Settings on page 155

Common Controls RF Measurements Shared Measurement Settings on page 161
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WLAN Channel Response Settings on page 170

WLAN Constellation Settings on page 172

WLAN EVM Settings on page 173

WLAN Magnitude Error Settings on page 175

WLAN Phase Error Settings on page 177

WLAN Power vs Time Settings on page 179

WLAN Spectral Flatness Settings on page 181

WLAN Summary Settings on page 185

802.11ad/11ay Control Panel Settings on page 212

OFDM Channel Response Settings on page 224

OFDM Constellation Settings on page 225

OFDM EVM Settings on page 227

OFDM Spectral Flatness Settings on page 228

OFDM Magnitude Error Settings on page 230

OFDM Phase Error Settings on page 231

OFDM Power Settings on page 233

OFDM Summary Settings on page 235

OFDM Symbol Table Settings on page 236

Common Controls OFDM Analysis Shared Measurement Settings on page 236

Cumulative Histogram display settings on page 248

Cumulative Statistics Table display settings on page 252

Pulse-Ogram display settings on page 253

Pulse Table display settings on page 255

Pulse Trace display settings on page 257

Pulse Statistics settings on page 260

Pulsed RF Measurement Settings on page 261

P25 Constellation Settings on page 288

P25 Eye Diagram Settings on page 291

P25 Power vs Time Settings on page 293

P25 Summary Settings on page 296

P25 Symbol Table Settings on page 298

P25 Frequency Dev Vs Time Settings on page 301

LTE ACLR Settings on page 325

LTE Channel Spectrum Settings on page 328

LTE Constellation Settings on page 329

LTE Power vs Time Settings on page 331
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LTE Analysis Measurement Settings on page 332

NR Adjacent Channel Power display settings on page 354

NR Analysis measurement settings on page 363

NR Channel Power display settings on page 357

NR Constellation settings on page 358

NR Spectral Emission Mask settings on page 360

NR Summary settings on page 363

BT Constellation Settings on page 391

BT Eye Diagram Settings on page 394

BT CF Offset and Drift Settings on page 397

BT Summary Settings on page 401

BT Symbol Table Settings on page 404

BT Frequency Dev Vs Time Settings on page 408

BT 20dB BW settings on page 410

Bluetooth Analysis Measurement Settings

Audio Spectrum Settings on page 426

Audio Summary Settings on page 428

Audio Analysis Measurement Settings on page 429

Constellation Settings on page 439

Demod I & Q vs Time Settings on page 441

EVM vs Time Settings on page 442

Eye Diagram Settings on page 444

Frequency Deviation vs Time Settings on page 447

Magnitude Error vs Time Settings on page 448

Phase Error vs. Time Settings on page 450

Signal Quality Settings on page 455

Symbol Table Settings on page 456

Trellis Diagram Settings on page 458

GP Digital Modulation Shared Measurement Settings on page 459

Mask Test Settings on page 492

Analysis Settings on page 498

Amplitude Settings on page 507
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Glossary
Accuracy
The closeness of the indicated value to the true value.

ACLR
Adjacent Channel Leakage power Ratio is the ratio of the RRC (Root Raised Cosine) filtered mean power centered on the assigned
channel frequency to the RRC filtered mean power centered on an adjacent frequency (defined in 3GPP).

ACPR Measurement
Adjacent Channel Power Ratio (ACPR) is the ratio of the mean power centered on the assigned channel frequency to the mean power
centered on an adjacent channel frequency. In the 3GPP specification, it is called ACLR (Adjacent Channel Level Ratio) and both the main
channel and adjacent channels are required to be filtered with RRC (Root Raised Cosine) filters.

Acquisition
A series of time-contiguous frames. This is also called a Block.

Analysis Length
The length of time in the Analysis Time.

Analysis Time
The portion of the acquisition record over which one or more measurements are calculated.

ASK
Acronym for Amplitude Shift Keying. The process, or result of a process, in which the amplitude of the carrier is varied in accordance with
the state of a digital input signal.

Block
An integer number of time-contiguous frames. See also: Acquisition.

Calibrator
A signal generator producing a specified output used for calibration purposes.

Carrier
The RF signal upon which modulation resides.

Carrier Frequency
The frequency of the CW component of the carrier signal.
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Carrier Signal
The electrical signal, typically a sine wave, upon which modulation is impressed.

Carrier-to-Noise Ratio (C/N)
The ratio of carrier signal power to average noise power in a given bandwidth surrounding the carrier; usually expressed in decibels.

CCDF - Complimentary Cumulative Distribution Function
The Complementary Cumulative Distribution Function (CCDF) represents the probability that the peak power above average power of a
measured signal exceeds a threshold.

CCDF is a plot of the percent of time that a signal's power value exceeds it average value versus the amount by which it exceeds the
average. The CCDF plot has a log of probability on the Y-axis (100% at the top) and dB above average amplitude on the X-axis (0 at the
left).

CDMA
Acronym for Code Division Multiple Access.

Center Frequency
The frequency corresponding to the center of a frequency span of the analyzer display.

Check Mark Indicator
The check mark indicator in the upper-left corner of the display indicates the display for which the acquisition hardware is optimized. When
you have more than one display open, the display with the check mark indicator has control over the acquisition hardware. To give a
display priority over any others, click its title bar.

When Best for multiple windows is selected in the Amplitude control panel's RF & IF Optimization control, none of the measurement
displays shows a checkmark, as there is not a single optimized measurement.

CISPR
International special committee on radio interference. (Comité international spécial des perturbations radioélectriques)

CW
Acronym for Continuous Wave.

CW Signal
Continuous wave signal - a sine wave.

DANL
Acronym for Displayed Average Noise Level. See Sensitivity on page 571.

dBfs
A unit to express power level in decibels referenced to full scale. Depending on the context, this is either the full scale of the display screen
or the full scale of the analog-to-digital converter (ADC).
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dBm
A unit of expressed power level in decibels referenced to 1 milliwatt.

dBmV
A unit to express voltage levels in decibels referenced to 1 millivolt.

dBuV
A unit to express voltage levels in decibels referenced to 1 microvolt.

Decibel
Ten times the logarithm of the ratio of one electrical power to another.

Detection
The process by which a long waveform is decimated (reduced) down to the desired number of trace points, by dividing the waveform into
intervals and choosing a single value to represent each interval in the trace.

Display Reference Level
A designated vertical position representing a specified input level. The level may be expressed in dBm, volts, or any other units.

Distortion
Degradation of a signal, often a result of nonlinear operations, resulting in unwanted signal components. Harmonic and intermodulation
distortion are common types.

Dynamic Range
The maximum ratio of the levels of two signals simultaneously present at the input which can be measured to a specified accuracy.

EVM
Acronym for Error Vector Magnitude.

Export
Save data to a file in a format other than application-native.

FastFrame
FastFrame segments the acquisition record into a series of frames and then captures acquisitions as single frames. You can then view and
measure each frame individually.

FFT
Fast Fourier Transform - a mathematical process to calculate the frequency spectrum of a discrete number of time domain sample points.

Filter
A circuit that separates electrical signals or signal components based on their frequencies.
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FM
Acronym for Frequency Modulation.

Frame
A series of time-contiguous samples, long enough in duration and at a sufficient sample rate to produce a spectrum view of a specified
span and RBW.

Frequency
A series of time-contiguous samples, long enough in duration and at a sufficient sample rate to produce a spectrum view of a specified
span and RBW.

Frequency Band
The continuous range of frequencies extending between two limiting frequencies, expressed in hertz.

Frequency Domain View
The representation of the power of the spectral components of a signal as a function frequency; the spectrum of the signal.

Frequency Drift
Gradual shift or change in displayed frequency over the specified time due to internal changes in the analyzer, where other conditions
remain constant. Expressed in hertz per second.

Frequency Range
The range of frequencies over which the performance of the instrument is specified.

Frequency Span
A continuous range of frequencies extending between two frequency limits.

Frequency Settling Time
The time measured from a reference point to when the signal of interest settles to within user-defined tolerance.

GPIB
Acronym for General Purpose Interface Bus, the common name for the communications interface system defined in IEEE Std. 488.

Graticule
The calibrated grid overlaying the display screen of analyzers, oscilloscopes, and other test instruments.

Grayed Out
An on-screen control is “Grayed Out” if it is not adjustable.

I/Q
Acronym for In-phase / Quadrature.
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IF
Acronym for Intermediate Frequency.

Import
Bring data into the application from a file of some format other than application-native.

Impulse Response
The Impulse Response trace display shows normalized power on the vertical axis and time on the horizontal axis.

Input Impedance
The impedance at the desired input terminal. Usually expressed in terms of VSWR, return loss, or other related terms for low impedance
devices and resistance-capacitance parameters for high impedance devices.

LISN
Acronym for Line Impedance Stabilization Network.

Local Oscillator (LO)
An oscillator which produces the internal signal that is mixed with an incoming signal to produce the IF signal.

Marker
A visually identifiable point on a waveform trace, used to extract a readout of domain and range values represented by that point.

Max Hold
Digitally stored display mode which, at each frequency address, compares the incoming signal level to the stored level and retains the
greater level. In this mode, the display indicates the peak level at each frequency after several successive acquisitions.

MCPR (Multiple Carrier Power Ratio)
The ratio of the signal power in the reference channel or group of channel to the power in adjacent channels.

Min Hold
Digitally stored display mode which, at each frequency address, compares the incoming signal level to the stored level and retains the
lower level. In this mode, the display indicates the minimum level at each frequency after several successive sweeps.

Modulate
To regulate or vary a characteristic of a signal, typically in order to transmit information.

Modulating Signal
The signal which modulates a carrier. The signal which varies or regulates some characteristic of another signal.

Modulation
The process of varying some characteristic of a signal with a second signal.
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Noise
Unwanted random disturbances superimposed on a signal which tend to obscure it.

Noise Bandwidth (NBW)
The exact bandwidth of a filter that is used to calculate the absolute power in dBm/Hz.

Noise Floor
The noise intrinsic to a system that represents the minimum limit at which input signals can be observed; ultimately limited by thermal
noise (kTB). The analyzer noise floor appears as a “grassy” baseline in the display, even when no signal is present.

Open (Recall)
Bring data into the application from a file of application-native format.

OQPSK
Acronym for Offset QPSK (Quadrature Phase Shift Keying).

Phase Settling Time
The time measured from a reference point to when the signal of interest settles to within user-defined tolerance.

PM
Acronym for Phase Modulation.

Primary Marker
The marker displayed in the Single Marker mode whose frequency and/or position is changed when tuning with the general purpose knob.

PSK
Acronym for Phase Shift Keying. The process, or result of a process, in which the carrier phase is varied discretely in accordance with a
digital code.

QAM
Acronym for Quadrature Amplitude Modulation. The process, or result of a process, in which the amplitude and phase of the carrier are
varied concurrently by synthesizing two orthogonal ASK waves (see ASK).

Real-Time Analysis
Measurement technique based on triggering on an RF signal, seamlessly capturing it into memory, and analyzing it in the frequency, time,
and modulation domains.

Real-Time Bandwidth
The frequency span over which real-time seamless capture can be performed, which is a function of the digitizer and the IF bandwidth of a
Real-Time Signal Analyzer.
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Real-Time Seamless Capture
The ability to acquire and store an uninterrupted series of time domain samples that represent the behavior of an RF signal over a long
period of time.

Reference Level
The signal level represented by the uppermost graticule line of the analyzer display.

Residual FM (Incidental FM)
Short term displayed frequency instability or jitter due to instability in the analyzer local oscillators. Given in terms of peak-to-peak
frequency deviation and expressed in hertz or percent of the displayed frequency.

Residual Response
A spurious response in the absence of an input signal. (Noise and zero pip are excluded.)

RBW
The RBW determines how well the analyzer can resolve or separate two or more closely spaced signal components.

Ripple
The Ripple measurement result is displayed in either Watts or Volts. The amplitude units selected on the Setup > Analysis > Units tab
determine whether the measurement is presented in Watts or Volts. Volts are shown for linear units (for example, volts or amps); Watts are
shown for non-linear units (for example, watts or dBm).

The Ripple measurement, in Watts, is calculated as follows:

%RippleWatts =10 0× RatioPos+RatioNeg

Where:

RatioNeg= DelNeg RefNeg +1 2 -1

RatioPos= DelPos RefPos +1 2 -1

• DelPos = Delta Positive in Volts
• RefPos = Reference Positive in Volts
• DelNeg = Delta Negative in Volts (this is a positive value)
• RefNeg = Reference Negative in Volts

The Ripple measurement, in Volts, is calculated as follows:

%RippleVolts =100× RatioPosV+RatioNegV

Where:

• RatioPosV = DelPos/RefPos
• RatioNegV = DelNeg/RefNeg

Secondary Marker
The “second” marker displayed only in the Delta Marker mode.
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Sensitivity
Measure of a analyzer’s ability to display minimum level signals, usually expressed as displayed average noise level (DANL on page 565).

Shape Factor (Skirt Selectivity)
The ratio of the frequency separation of the two (60 dB/3 dB) down points on the response curve to the static resolution bandwidth.

Signal
As used in this help, the signal refers to the input signal before it is processed. The signal is an input.

Span
Span is the range of frequencies displayed in a spectrum window. Span, start frequency and stop frequency are related by the following
equation: Span = (stop frequency) - (start frequency). The settings for center, start and stop frequencies are related to the setting for span;
when one parameter is changed, the others are changed automatically.

Span Per Division (Span/Div)
Frequency difference represented by each major horizontal division of the graticule.

Spectrogram
Frequency vs. time vs. amplitude display where the frequency is represented on the x-axis and time on the y-axis. The power level is
indicated by variations in color.

Spectrum
The frequency domain representation of a signal showing the power distribution of its spectral component versus frequency.

Spectrum Analysis
The technique or process of determining the frequency content of an RF signal.

Spectrum Analyzer
A device for determining the frequency components of a signal.

Spectrum Time
Analysis Time for spectrum analysis views. Spectrum time can be the same as Analysis Time, but it can be different.

Spur/Spot
A spur is a signal peak that exceeds a user-definable threshold (See Spurious > Settings > Ranges) and excursion setting. A spur that
also exceeds a limit (either Absolute or Relative) specified on the Settings > Limits tab is considered a violation. This is called a spot in the
EMC-EMI display.
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analysis length 564
Analysis Params tab

P25 Analysis displays 304
WLAN Analysis displays 190

Analysis tab
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Application preset (continued)
pulse analysis 35
spectrum analysis 36
Time-Frequency analysis 36

application presets
saving 531

Apply ampl corrections 264
APSK 462, 463
APSK parameters 470
APSK Parameters 469
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Audio BW

setting 430
audio filters

custom 433
Audio Filters tab
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Average Transmitted Power 50, 244
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Parameters tab 422
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Constellation display (continued)
displaying a second trace 475

Constellation display settings 439
Controls 22
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Enable EQ Export

Equalizer tab 467
Enable Equalization

Equalizer tab 467
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Windows Event Viewer 560
Error messages 554
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Ranges and Limits table 131
Find tab

GP Digital Modulation displays 471
Flatness

OFDM 43
WLAN 43

FM 567
FM display 90
FM measurements 47
frame 567
Freq and RBW tab

LTE 341
Freq Deviation 46, 51, 245
Freq Diff, Phase Diff, Freq Abs settings 265
Freq Error 46
Freq Estimation tab
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P25 48
Help Menu 553
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IF 568
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Params2 tab 431
import 568
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Impulse Response setting 264
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MCPR (multiple carrier power ratio) 568
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MCPR settings 115
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Output power (continued)
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Scale tab (continued)
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